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2 CHAPTER

Note: Visit our Web site at www.blackbaud.com for the latest documentation and information.

Mail is the central location for all mail tasks in The Financial Edge. With Mail you can use the information stored
in your Financial Edge database to create items for mailing or electronic transmission. The types of mail you can
create depend on the program in which you are working. For example, in Accounts Payable you can create
mailings like purchase orders, while in Accounts Receivable you can create credit and debits memos, statements,
and receipts.Output from Mail is distinguished from Reports in that it is intended to be sent to parties outside of
the organization.

This chapter explains the basic tools used in Mail and tab functions for each mail task in The Financial Edge. This
guide also contains procedures for accessing Mail and finding, opening, previewing, sending as email, and
exporting a mailing.

Mail Basics is intended to provide only an overview of each mailing and mail task. For detailed information, see
that mail category in its respective chapter.

Note: A parameter is any field, option, or filter that narrows information included in an import, mailing, report,
or global change. By specifying parameters, you define the output of the process. You can save parameter files
to use again.

As in other areas of The Financial Edge, you can access Mail on the navigation bar. Each form has a parameter file
in which you set up information on tabs and save for repeated use.

Accessing Mail Tasks

You access the Mail page by clicking Mail on the navigation bar. The Mail page appears, displaying links to mail
categories:

Note: A mail task is a specific mailing process, such as envelopes. Fields and options for a mail task are
arranged on tabs so you can access all the information quickly and easily.

Accounts Payable — Forms and Labels, Cards, and Envelopes

Fixed Assets — Labels

Accounts Receivable — Forms and Labels, Cards, and Envelopes

Cash Receipts — Forms

Student Billing — Forms and Labels and Envelopes
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To select a mailing, click the link for the category of mail tasks you need from the Mail page, for example, Forms.

#% The Financial Edge

File Edit Yiew Go Favortes Tool: Help

4 Back & Eorward I Community Services Inc. ™ + Accounts Payable ™

|F|H—' Home d Mail I
- b Forms Forms

b Labels, Cards, and Envelopes

Shorkcuts

Labels,
Cards, and
Envelopes

E Plug-ins

Monthly Reparts
Wieh Links LI

‘wWelcome to Accounts Payable |Done

On the Forms page, select 1099 Forms in the list on the left. If any 1099 forms have been saved, they appear on
the right of the screen. You can either open one of the saved 1099 forms or create new 1099 forms. For more
information about creating or opening 1099 forms, see the Forms chapter.

The Financial Edge

File Edit View Go Favaortes Tools Help

4 Back % Forward ] Comrunity Services Inc, ™ « Accounts Payable ™

& Mail « Forms
":"T fiarie Mew |Dpen ‘Qalale_. |LJ

Wﬁ B 1033 Foms 1099 Forms Farms
. . Purchase Order Forms Labels,

Cieated By Others bay Modify Cards, and

Shorkcuts

Mame Description Date Created
Envelopes
AmatoB.. 05/06/2002 Supervisor
1099's .. 05/06/2002 Supervisor -
Wendors ... 05/06/2002 Supervizor r

Mail Tabs

Whether you create a new mailing or open a saved mailing, a screen appears with tabs to specify how the mailing
should look and the information included in the mailing. Each tab helps you enter information in an easy and
logical manner. You move among the tabs by clicking Back or Next at the bottom of the screen or by selecting the
tab itself. The General, Filters, and Format tabs appear in every mail task in The Financial Edge. Once you learn to
run one mailing, it is easy to run other mailings because the tabs have similar features.

Note: A mail task is a specific mailing process, such as printing envelopes. Fields and options for a mail task are
arranged on tabs so you can access all the information quickly and easily.
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General tab. On the General tab, you set parameters specific to the mailing you have open. You can make
selections for the format and information in the mailing. The General tab appears on all mail tasks.

lE Mew Purchase Order Forms [ x| I
Fil= Edit “iew Fawortes Tools Help

IR IRl el R

2 Filtersl 3 .-’-‘n.ttributesl 4: Format

Include: IHeguIar and blanket purchase orders j

Include purchaze orders with theze order dates -

Order date: IIncIude all dates j

Include purchase orders created on thesze dates -
Creation date: [Include all dates =]

Include purchase orders last changed on these dates
Change date: [Include all dates =]

Include purchase orders with these statuses -

[¥ Unprinted purchase order
[¥ Unprinted change order

[¥ Reprint order

[¥ Unprinted cancellstion natice

Fieport Qrientatiot: Portrait

< Back | Hext > Cancel Frrint Preview Layout

Filters tab. On the Filters tab, you can include records based on selected criteria such as purchase orders,
vendors, invoices, purchase order attributes, and vendor attributes. The Filters tab appears on all mail tasks.
For more information about filtering in The Financial Edge, see the Program Basics Guide.

M@ Mew 1099 Forms E
File Edit Yiew Favortes Tool: Help

B2 S R ] 2- |

: Attributes | 5. Format

1 General' 2. Magnetic Media :

" Clear All Filters

Filters Include I Selected Filters
Wendors all <Al vendors=
Wendor Attributes all <Al vendor attributes=

< Back Mest > Cancel FBrrint Preview Lapaut
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Relationship Filters tab. For Student Billing labels, label truncation reports, and envelopes, if you select a
relationship record type in the Create <mailing> for field on the General tab, the Relationship Filters tab
appears. On this tab, you select filters to determine which relationship types to include in the mail run.

I New Envelopes
File  Edt “iew Fawaortes Toolz Help

= MW= R i

]|

1 Generall 2: Fieldz to Includel 3 Filers

5 .&ttributesl = Addressl i Formatl

Limit results b

Payers: Ilgnore 'I
Statement recipients: Ilgnore 'I
Statement copy recipients: Ilgnnre 'I

Filkers | Include | Selecked Filkers |
Relationship Types all <Al Relationship Tvpes>
Relsked Records all <Al Related Records =
Relsted Record Tvpes all =4l Related Record Types =

< Back | Mest = Cancel

Print Freview Layout

Note: An attribute is a tool used to group information based on a common theme. With attributes defined, you
can filter information to your specifications. Records in The Financial Edge that can have attributes include
accounts, projects, transactions, actions, vendors, purchase orders, invoices, credit memos, and assets.

Attributes tab. The Attributes tab appears for all mail tasks except the label truncation report. On this tab, you
can add, update, or delete attributes for records included in the mailing. You define attribute types in
Configuration. For example, possible purchase order attributes include voucher number, authorized by, or

expense type.

1@ New Invoices
File Edt “iew Fawortes Toolz Help

= = RES = gl B

1: General | 2: Filter. Altributes || 4: Formatl

Actionl Attribute Type | Description IStht Descripti...l Date |Hequired|

Cormments |

-
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Format tab. On the Format tab, you designate the format of the mailing. The settings on this tab determine the
appearance of the mailing. The list on the left of the screen displays formatting options for the mailing. When
you select an item in the list, the right side of the screen changes to present selections for that section of the
mailing. The Format tab appears for all mail types.

I} New Statements I
File Edt “iew Fawortes Toolz Help

daaaQa=?- |
|

Statement Sort

i Generall 2 Tranzaction Detailsl ar Filters| 4 .-’-‘«ttributesl 5 Avuto Pay

Miscelaneous [ Show statement reference number
Alignment [~ Show barcods
DOrgarization Marne . =
Address Detail - ISDFS Farcode H I'ID jv
Finance Charge Format | [ Show print date on statement
M arne Formats [~ Show credit balances as $0.00
Transaction Sort [~ Show statement due date
g:a:emen: ::Imat BlLe dates | <Statement dates =l plus a0 | daps

atement Meszage

[ Shaw minimum amaount due as; |F'ercent of total arount j | percent

¥ Display tranzaction comments

< Back | [dEnts Cancel Frrint Freview Layout

Note: The fields you select appear on the labels, cards, or envelopes in the order you select. Use the up and
down arrows to change the order of the fields.
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Fields to Include tab. On the Fields to Include tab, you can select the fields to print on a label, card, or
envelope and format how the information will appear. Certain fields have options associated with them.
Options generally exist for attributes, user-defined messages, and many-to-one relationships to the main
record such as phone numbers. The Fields to Include tab is available for labels, label truncation reports,
envelopes, and cards.

I New Labels I

File Edit “iew Fawortes Toolz Help
SR |

1. General 2 Fields to Include |§: Filtersl 4 Attributes | B: Format

Select optional fields wou wizh to include by mowving them to the right-hand box

Aveailable Fields: Fields ta Inchude:

Sddress =] s |
Address description

Aliaz

Contact name
Contact position
Phone number
Subsidiary name
TaxlD

Wendor ID

Yendar name

USPS bar code
User-defined message

Blark row LI

[ T T S P o

BN

/¥

< Back Hest = Eancell Erint | F'reviegl Layout
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Details tab (Accounts Receivable). On the Details tab for Accounts Receivable statements and single
statements, you can show summarized or detailed activity and group the information by client. You can also
select whether to summarize and display finance charges.

I New Statements I
File  Edt “iew Fawaortes Toolz Help
FlER = |

1: General : Filters | 4: Attributes | 5: Farmat

[ Summarize transactions before: I The zame day of previous month bazed on tranzaction cutoff date j

Surnmary kERk | Surnmary balance as of ¥ | [elide stmmany date
Show tranzaction detail for
¥ Fully paid charges

¥ Invoices and retums

¥ Sales tax ransactions

Show tranzaction summary for;
[ Transactions on this statement

[ | Show combined summany acress multiple elients omn each statement
Summarize by ITransactinn type j
[™ Transactions across this date range: | This fiscal pear j 07140 #2003 bo 1243142003

I | Shaw combined summan acrass multiple elients on each statement

Surnmarize by: ITransaction woe |l

< Back | Mest = | Cancel | Frrint | Freview | Layout |

Details tab (Student Billing). On the Details tab for Student Billing statements, you can format information
that appears in the details section of the statement. This tab is enabled only if you selected “Summary and
Detail” or “Detail only” in the Format field of the General tab.

1@ new Statements [ x| I
File Edit WView Favorites Tools Help

oS8 =2 |

|§: Summar_l,.l' 4 Filtersl 5 Attlibutes' E: Addless' 7 Auto Pay | 8: Format

1: General

[~ Combine previous balances inta one surmmary line

Summarize befare: ISame day of previous month based on cutoff date j

Summary text: ISummary balance az of ¥ Include summany date
[~ Combine fully paid transactions into one summary line [~ Include ungenerated financial aid
[~ Shaw line item information for invoices and retumns [ Include ungenerated advance deposits

[~ Shaw credit/papment applications as a single transaction [ Show credits/payments with their related charges

Show zales lax as | part of its associated transaction j

Sort by I Order by I Subtotal? I
Record Mame Ascending
Transaction Date Ascending

i A e 3

[~ Summarize praducts and Billing items

< Back | Hext > Cancel Frirnt Preview Layout




MAIL BAsics 9

Summary tab. On the Summary tab for statements, you can format information that appears in the summary

section of the statement. This tab is enabled only if you selected “Summary and Detai

the Format field of the General tab.

I3 New Statements E3 I
File Edit View Favorites Tools Help
FIEEETEIEEIE |

1 Generall 2 Detailz & Filters | B Attibutes | B Address | £ohuto F'a_l,ll 2 Format

Specify how the Summary zection of the statement should dizplay information.

Summary zections to include: IStatement Summary and Date Range Summary j

Statement Summary

Sumrarize included transactions by: ITransaclinn type ﬂ

[~ Show combined summary across multiple records on each statement

Date Range Summary -

IThis fiscal pear j 01400 /2006 to 12/31 /2006

[~ Show combined summary across multiple records on each statemet

Summarnze by ITransaction type j

[~ Ungenerated advance deposits in date range using descrption: IUngeneraled advance depozits

[~ Ungenerated financial aid in date range using description: IUngeneraled financial aid

< Back | Mest > Cancel | Prrint | Presiew I Layout |

|

I”o

r “Summary only” in

Clients tab. For Accounts Receivable single statements, you can use the Clients tab to add additional
information for clients related to the client you are creating the statement for. You can also select the clients

and payers who should receive statements or copies of statements.

M@ Mew Single Statement
File Edt “iew Fawaortes Toolz Help

= D= R = e 2

1: General | 2 Tranzaction Details 4: Filters | 5: Attributes | B: Farmat |

eVl Tranzactions for these clents j M Includ

Include | Client Mare | Client 1D | SSH | CFDA #
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Records tab. For Student Billing single statements, you can use the Records tab to add additional information
for records related to the record you are creating the statement for. You can also select the records and
payers who should receive statements or copies of statements.

I New Single Statement
File Edit View Favorites Tools Help

A S |2

1 Genelall 2 Details' 3 Summary |

UglelMal= Trangactions for these records 'I

Indude I Record Mame | Record ID

| SSN/CFDA= |

Address tab. In Student Billing, you can use the Address tab to specify which addresses to use for mailings. The
program compares parameters you define on this tab with address information entered on the Addresses tab
of the student, individual, or organization record to identify the appropriate address to use.

Ig Hew Statements of Projected Charges
File Edit Wiew Favorites Tools Help

H &S =2

=]|

1 Genelall s Filtersl 3 Altributes _

[ Show statement recipient address

Validate addresszes as of: IToda_l,J j

¥ Consider seasonal addresses

If no zeazonal addreszes are found. conzider these addreszes -

<First address found: -
Home

Business

W acation

Schoal =l

Addresses Addreszes to congider, in order of importance

Action Attribute Tvpe I

Yalue

<] |

If o address iz found, IPlint with no address j

il

< Back | Hext > | Cancel

Erirt

Preview | Layout |
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Auto Pay tab. For Student Billing statements, if you have the optional module Electronic Funds Transfer, you
can use the Auto Pay tab to create automatic EFT payments for records with variable amount automatic
payments set up on the Automatic Payments tab of their record.

I New Statements I
File Edit View Favorites Tools Help

da I3 a2 |

1 Generall 2 Details' 2 5ummary| 4 Filtersl 5 Attributes | B: Address

[~ Create autornatic variable armount payments based on statement critenia

Deposit [nformation -

Deposit date: I‘I2.-"I 32006 "'"'ll Post status: INUt_I,Jet posted 'l
Entry date: |‘|2£‘| /2006 "'"'|I Post date: I12.-"13a"2DEIB —"'Il
Shatus: IDpen vI

Drezcription: I

Bank account: ISB & AR vI GL zash account: II:I‘I-‘IIJ4IJ-DEI
Fayment [nfarmation -
FPayrment date: |1 2M3/2006 _"'"'|I Post statuz INot yet posted
Cource: I - I Post date: |1 241342008

Cornmert: I

< Back | Mest = | Cancel | Frrint | Freview Layout

Mail Categories

The mail tasks in each mail category serve very different purposes. The following is a brief description of each
Mail category and its corresponding mail tasks. For detailed descriptions, see that mail category in its respective
chapter.

Forms

Forms are documents similar to reports, but intended for an audience outside of your organization. You can
create forms in Accounts Payable, Accounts Receivable, Cash Receipts, and Student Billing.

Note: Before you can print 1099 forms, you must enter your organization’s Federal and State Identification
Numbers in Configuration.

1099 Forms. In Accounts Payable, you can create 1099 forms to report miscellaneous income you paid to
vendors in a calendar year. Once you enter your 1099 information, you select Display Report to connect with
Aatrix. Your actual 1099s are processed within Aatrix, not The Financial Edge.

Purchase Order Forms. In Accounts Payable, you can prepare multiple purchase orders or multiple copies of
a single form from Mail. You can print forms for regular or blanket purchase orders. For more information
about creating purchase orders, see the Purchase Orders chapter of the Records Guide for Accounts Payable.
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Note: We offer the only checks, student bills, statements, invoices, purchase orders, tax forms, envelopes and
other forms that are 100% compatible with The Financial Edge and fully supported by our support team. These
quality forms are pre-printed in color with your organization’s logo and information. For details, call

866-4-BB-Forms, visit http://forms.blackbaud.com, or send an email with questions to forms@blackbaud.com.

Debit Memos. In Accounts Receivable, you can print multiple debit memos or multiple copies of a single form
from Mail.

Credit Memos. In Accounts Receivable, you can print multiple credit memos or multiple copies of a single form
from Mail.

AR Receipts. In Accounts Receivable, you can print receipts for clients for payments received.
Invoices. In Accounts Receivable, you can print copies of invoice and return information to mail to clients.

Single Statements. In Accounts Receivable, you can print a statement for a single client or third party
statement recipient.

Statements. In Accounts Receivable, you can print all or selected statements for clients or third party statement
recipients.

CR Receipts. In Cash Receipts, you can print receipts for clients for miscellaneous payments received.

Debit Memos. In Student Billing, you can print debit memos for standalone charges such as finance charges,
memberships dues, and non-sufficient funds.

Credit Memos. In Student Billing, you can print credit memos to reflect standalone credits such as those for
overpayments.

AR Receipts. In Student Billing, you can generate receipts for payments received and include details about the
charges to which payments were applied or the records to which payments were distributed.

Single Statements. In Student Billing, you can print statements of charge and payment activity for one
specified record or third party statement recipient.

Statements. In Student Billing, you can print statements of charge and payment activity for multiple students,
individuals, and organizations at one time.

Statements of Projected Charges. In Student Billing, you can print statements of projected charges to
report charges and credits that will be assessed to students, individuals, and organizations for a given period
of time. These statements include generated and ungenerated transactions that are scheduled (or will be
scheduled based on bill codes) for a specified time period.

Labels, Cards, and Envelopes

You can use mail tasks in the Labels, Cards, and Envelopes category to print labels, cards, or envelopes for
Accounts Payable, Accounts Receivable, and Student Billing. In Fixed Assets, the mail category is Labels
because you can create only labels and label truncation reports.

Note: We offer the only checks, student bills, statements, invoices, purchase orders, tax forms, envelopes and
other forms that are 100% compatible with The Financial Edge and fully supported by our support team. These
quality forms are pre-printed in color with your organization’s logo and information. For details, call

866-4-BB-Forms, visit http://forms.blackbaud.com, or send an email with questions to forms@blackbaud.com.

Envelopes. In Accounts Payable, Accounts Receivable, and Student Billing, you can print envelopes for
vendors, clients, students, employees, individuals, or organizations. You can also filter to select certain
addresses for records with multiple addresses in the database.

Label Truncation Reports. In Accounts Payable, Accounts Receivable, and Student Billing you can
create label truncation reports to identify which labels have information that does not fit on the label. It tests
both the vertical and horizontal formatting.
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Labels. You can use the Labels mail task to print labels with vendor information in Accounts Payable; client
information in Account Receivable; and student, individual, or organization information in Student Billing.

In Fixed Assets, you can print labels with barcodes for maintaining inventory. You set parameters for the
information included and format the layout of the labels.

Cards. You can use the Cards mail task in Accounts Payable or Accounts Receivable to print vendor or client
information on index or Rolodex cards. For example, you can print Rolodex cards for all banks and contacts in
your database or index cards for vendors including information such as tax ID numbers or 1099 status.

Mail Tasks

You can use a variety of parameters to define the output for mailings in The Financial Edge. Saving these
parameters also makes creating future mailings more efficient. Once you create and save mailings, you can open
and edit them at any time. You can also preview a mailing prior to printing to make sure the information is
accurate and that the mailing is formatted as you want it. For information about creating specific mailings, see
the chapter for that mail category.

Note: A mail task is a specific mailing process, such as printing envelopes. Fields and options for a mail task are
arranged on tabs so you can access all the information quickly and easily.

The following procedures include finding and opening, previewing, sending as email, and exporting mailings.
While these procedures are written specifically for 1099 forms, you can use these same basic steps as a model for
all mailings in The Financial Edge. For information about creating specific mailings, see the chapter for that mail
category.

Finding and Opening a Saved Mailing

You can edit the parameters of a mailing saved in The Financial Edge. For this procedure we focus on opening
and editing 1099 forms.

» Finding and opening a mailing
1. From the Mail page, click Forms. The Forms page appears.
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Note: While these procedures are written specifically for 1099 forms, you can use these same basic steps as a
model for all mailings in The Financial Edge. For procedures for another mailing, see the chapter for that mail

category.
2. Inthe list on the left, select 1099 Forms. A list of saved 1099 forms appears in a grid on the right.

## The Financial Edge
File Edit “iew Go Favortes Tookk Help

% Back & Forward ] Community Services Inc, ~ * Accounts Payable ~

% Mail + Forms

Hew ‘ Open |Qelata |Mai|
1099 F Fems |
) B Labels,

Purchase Order Foims
Created By Others Mayp Modity Cards, and
Envelopes

Shorteuts

0z Supervisor
05/06/2002 Supervisar r
05/06/2002 Supervisar [l

3. Select the 1099 forms you want to open.
4. On the action bar, click Open. The <Selected> 1099 screen opens on the General tab.

Previewing a Mailing

You can preview the format and information in a mailing without opening the mailing. We recommend
previewing a mailing before printing or sending it to another person. By previewing, you can make sure the
information is accurate and that the mailing is formatted as you want it.

» Previewing a mailing
1. From the Mail page, click Forms. The Forms page appears.

Note: While these procedures are written specifically for 1099 forms, you can use these same basic steps as a
model for all mailings in The Financial Edge. For procedures for another mailing, see the chapter for that mail

category.
2. Inthe list on the left, select 1099 Forms. A list of saved 1099 forms appears in a grid on the right.

##% The Financial Edge
File Edit “iew Go Favortes Tool: Help

4 Back % Forwand ] Cornrunity Services Inc, ~ + Accounts Payahle ~

% Mail « Forms

Mail

Hew ‘Upen |Delete...
= Forms
1099 Forms L,
0

Cards, and
Envelopes

Shorteuts

Supervisor
Wendors .. 05/06/2002 Supervisor r

3. Inthe grid, highlight the 1099 forms you want to preview.
4. From the menu bar, select File, Print Preview.

Tip: You can also print the 1099 forms from the preview screen by clicking the Print button on the toolbar.

5. A processing screen appears. Once processing is complete, the <1099 Forms> Preview screen appears.
6. When you finish previewing the forms, click the red X to close the screen. You return to the 1099 Forms
page.
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Exporting a Mailing

To use mail information in another software application, for example, Microsoft Excel or Crystal Reports, you can
export the mailing. You can create an electronic file to send 1099 data to the IRS electronically. When you export
a mailing, you send mail information from the database to another software application using a data file. You can

export a mailing without opening the mailing.

» Exporting a mailing
1. From the Mail page, click Forms. The Forms page appears.

Note: While these procedures are written specifically for 1099 forms, you can use these same basic steps as a
model for all mailings in The Financial Edge. For procedures for another mailing, see the chapter for that mail

category.
2. Inthe list on the left, select 1099 Forms. A list of saved 1099 Forms appears in a grid on the right.

#% The Financial Edge
File Edit “iew Go Favortes Took: Help
4 Back % Foriward ] Cornrunity Services Inc, ~ « Accounts Payahle ~

% Mail « Forms

Hew ‘ Open |Delete... |Mai|
099 Forms
B 1099 Farms 1099 Forms mj
s

Furchase Order Fomms
Description | Date Cieated | Created By | Dthers May Modify Gy, &
- " Envelopes

Shorteuts

2 TWIS0r
05/06/2002 Supervisar r
05/06/2002 Supervisar r

3. Inthe grid, highlight the 1099 forms you want to export.

4. From the menu bar, select File, Export.
5. A processing screen appears. Once processing is complete, the Export screen appears.

Export
FEormat:
ICr_l,lstaI Reports [RPT] j
. Cancel |
Destination:
| Disk file =l

In the Format field, select a format (such as dBase, Crystal Reports, or Microsoft Excel) for the data file.
In the Destination field, select where you want the information exported.

Click OK. The Choose Export File screen appears.

In the File name field, enter a name for the export file.

10. Click Save. A message appears indicating the program is exporting the data. Once the data has been
exported to your file, you return to the 1099 Forms page.

L 0N
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Sending a Mailing as Emaiil

In The Financial Edge, you can share mail information with other users through email. You can send the
information on a form to another user for further analysis or to use in other applications. When you send form
information through email, you perform two functions: changing the format of the information to a data file and
sending this data file to another person. Before you can send a form to another user, you must first select a
format (dBase, Lotus 1-2-3, Microsoft Excel) for the data file. The format determines the appearance of the form
and the software applications in which you can open the data file. Sending a form by email can be particularly
useful when an individual needs to quickly reference form information but does not need to access or edit the
form. You can send form information by email without opening the form.

» Sending a mailing as email
1. From the Mail page, click Forms. The Forms page appears.

Note: While these procedures are written specifically for 1099 forms, you can use these same basic steps as a
model for all mailings in The Financial Edge. For procedures for another mailing, see the chapter for that mail

category.
2. Inthe list on the left, select 1099 Forms. A list of saved 1099 forms appears in a grid on the right.

#% The Financial Edge
Ele Edit Yiew Go Favortes Tools Help
& Back % Fantvand ] Community Services Inc, ~ « Accounts Payable ~

% Mail » Forms

Mail

Sharteuts

Hew ‘Dgen |Qelata

099 - Forms
ITU-HEST 1099 Forms o |
Purchase Order Forms Labels,

iZards, and
Envelopes

Wendors 05/08/2002 Supervizor r

3. Inthe grid, highlight the 1099 form you want to send as email.
From the menu bar, select File, Send as Mail.
5. A processing screen appears. Once processing is complete, the Export screen appears.

sl [ x|
o Ok
ICr_l,JstaI Reportz [RPT] j

L Cancel |
Destination:
| Microsoft Mail (MaPI) =l

In the Format field, select a format for the data file.
In the Destination field, select “Microsoft Mail (MAPI)”.
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8. Click OK. The Send Mail screen appears.

10.
11.
12.

Send Mail
Send I Check Mames | Address | Cancel |
Io |
Ce: |
Subject: I
Meszage
[
| |

In the To field, enter an email address.
In the Subject field, enter a subject for the email.

In the Message box, enter a message to the recipient.

Click Send. The form is sent as an attachment to your message. You return to the 1099 Forms page.
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The Mail page in The Financial Edge is the central location for generating forms for Accounts Payable, Accounts
Receivable, Cash Receipts, and Student Billing. On the navigation bar, click Mail to access the Mail page. This
page contains a link to the Forms page. From here, you can create new forms, open saved forms, and delete
forms. Select mailing in the list, for example, Invoices, and a grid appears on the right listing saved invoice forms.
You can use a variety of parameters to define the output for forms in The Financial Edge. Saving these
parameters also makes future form preparation easier.

Note: We recommend you read the documentation for The Financial Edge thoroughly. Descriptions presented
here provides you with basic information about forms in Mail. Hands-on experience is the best way to learn, so
we encourage you to try various options with the sample database.

When creating forms, you use tabs to specify parameters such as the records to include and formatting options
for the forms. Each tab helps you enter information in an easy and logical manner. Keep in mind that options,
fields, and other selections vary from form to form. In some cases, selections on tabs are similar — for example,
filters on the Filters tab and sorting selections on the Format tab. When you learn how to prepare one form, it is
easy to learn to prepare other forms because of the similarities.To move among the tabs in a form, use Next and
Back at the bottom of the screen or select the tab itself.

This chapter describes each type of form you can create in Accounts Payable, Accounts Receivable, Cash
Receipts, and Student Billing. It provides details about the tabs, options, and fields you use to create forms. There
are also procedures that walk you through creating each type of form. For information about general mail tasks
such as previewing or exporting a mailing, see the Mail Basics chapter.

Accounts Payable Forms

In Accounts Payable, you can create 1099 forms to report miscellaneous income you paid to vendors in a
calendar year. If you have the optional module Purchase Orders, you can prepare multiple purchase orders or
multiple copies of a single form from Mail. You can print forms for regular or blanket purchase orders. For more
information about creating purchase order forms, see “Purchase Order Forms” on page 23.

1099 Forms

Note: We offer the only checks, student bills, statements, invoices, purchase orders, tax forms, envelopes and
other forms that are 100% compatible with The Financial Edge and fully supported by our support team. These
quality forms are pre-printed in color with your organization’s logo and information. For details, call

866-4-BB-Forms, visit http://forms.blackbaud.com, or send an email with questions to forms@blackbaud.com.

You can create 1099s to report miscellaneous income you paid to vendors in a calendar year. Amounts reported
on 1099 forms are taken from the check date for checks printed during that calendar year. The address marked as
the primary address on the vendor record prints on the 1099.

Need end of year help? Check out these resources:
¢ The Financial End of Year Guide (PDF) to help you with the end of year process.

¢ The Ledger blog for insight about the end of year process from Blackbaud employees.

1099 Form Tabs

A 1099 has tabs on which you select parameters: General, Filters, and Attributes. To move among the tabs, click
Next and Back at the bottom of the screen or select the tab. On these tabs you specify the records to include in
the mailing and how the forms should look.


http://www.blackbaud.com/files/support/guides/fe/feeofyr.pdf
http://forums.blackbaud.com/blogs/financialedge/archive/tags/AP+end-of-year/default.aspx
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General Tab

On the General tab for 1099 forms, you select parameter settings specific to 1099s.

Generate 1099s for. In the Generate 1099s for field, you can select the year for which you want to print 1099
forms.

Corrected return. If you mark the Corrected return checkbox, forms print as corrected returns and are marked
accordingly on the 1099s.

Include activity below minimum. If you mark the Include activity below minimum checkbox, 1099s include
vendors who do not meet the minimum amount required by the IRS for 1099 reporting. Marking this
checkbox activates the Include vendor with no activity checkbox.

Include vendors with no activity. If you mark the Include vendors with no activity checkbox, vendors with
no 1099 activity for the year are included.

Filters Tab

You can use the Filters tab to include records based on selected criteria such as vendors or vendor attributes. For
example, you may not be preparing 1099s for all vendors at one time. You can include only those vendors whose
names begin with A through H. For more information about filtering, see the Program Basics Guide.

Open. To open a selection screen to designate specific filters for the form, select a filter in the grid and click
Open on the action bar.

Clear All Filters. To reset each filter to include all, you can click Clear All Filters.

Note: A filter is a requirement items must meet to be included in a form. For example, if you apply the Vendors
filter, only transactions for the selected vendors appear in the form.

Filters. The Filters column lists all the filters for the form. You cannot edit this column.

Include. By default, in the Include column, each filter is set to All. To open a selection screen to designate
specific filters for the form, choose Selected.

Selected Filters. Filters you specify on the selection screen appear in the Selected Filters column.

Selected Filters Screen

From the Filters tab, you can open a selection screen for a filter in several ways: by double-clicking the filter in the
grid, selecting the filter in the grid and clicking Open on the action bar, or choosing Selected in the Include
column for the filter.

Attributes Tab. You can use the Attributes tab to add, delete, or update attributes for the vendors whose 1099
forms you want to include.

Action. In the Action column, you can select to add, delete, or update attributes on the vendor record when you
generate 1099s.

Note: Attribute types are established in Configuration. For more information about creating attribute types,
see the Configuration Guide for Accounts Payable.

Attribute Type. In the Attribute Type column, you can select an attribute type.
Description. In the Description column you can enter or select a description for the attribute type.

Short Description. If you selected a table type attribute that uses short descriptions, in the Short Description
column, select the attribute description. The Description column completes automatically.

Date. In the Date column, select the date you add, delete, or update the attribute.
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Note: An attribute is a tool used to group information based on a common theme. With attributes defined, you
can filter information to your specifications.

Required. If the attribute type you select is required, the program automatically marks the checkbox in the
Required? column.

Comments. In the Comments column, you can enter free-form text for additional information about the
attribute type.

Purchase Order Forms

Note: We offer the only checks, student bills, statements, invoices, purchase orders, tax forms, envelopes and
other forms that are 100% compatible with The Financial Edge and fully supported by our support team. These
quality forms are pre-printed in color with your organization's logo and information. For details, call

866-4-BB-Forms, visit http://forms.blackbaud.com, or send an email with questions to forms@blackbaud.com.

In Mail, you can print regular or blanket purchase orders. A regular purchase order is an order placed with a
vendor for goods or services. A blanket purchase order is an order for a larger quantity of an item than is
currently needed. For more information about purchase orders, see the Purchase Orders chapter of the Records
Guide for Accounts Payable.

Purchase Order Tabs

A purchase order form has tabs on which you select parameters: General, Filters, and Format. To move among
the tabs in a form, use Next and Back at the bottom of the screen or select the tab itself. On these tabs you
specify the records to include in the forms and how the forms should look.
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General Tab

On the General tab for purchase order forms, you select parameter settings specific to purchase orders.

I@ Hew Purchase Order Forms
Fil=e Edit “iew Favortes Toolz Help

H &= & ?-

l 2 Filtersl 3 Attributes | 4: Format

Inelude: |Hegular and blanket purchaze orders j

Ihclude purchasze arders with these arder dates

Order date: [Include all dates =l

Include purchaze orders created on these dates

Creation date: [ Include all dates =l

Inciude purchaze orders last changed on these dates

Change date: |Inc|ude all dates ﬂ

Ihciude purchaze orders with these statuzes

[¥ Urnprinted purchase order

[¥ Unprinted change order

[¥ Reprint order

[V Unprinted cancelation notice

R eport Orientation: Portrait

Hemt » | Cancel | Print Preview Layout

Note: Purchase orders with an Open status cannot print. When you print, export, or mail a purchase order, the
status of the purchase order automatically updates to Open in the record.

Include. In the Include field, you can select Regular and blanket purchase orders, Regular purchase orders, or
Blanket purchase orders.

Include purchase orders with these order dates. In the Order date field, you can include all dates, specify
a range of dates, or select from dates such as This fiscal year or Calendar year-to-date.

Include purchase orders created on these dates. In the Creation date field, you can include all dates,
specify a range of dates, or select from dates such as This fiscal year or Calendar year-to-date.

Include purchase orders last changed on these dates. In the Change date field, you can include all
dates, specify a range of dates, or select from dates such as This fiscal year or Calendar year-to-date.

Include purchase orders with these statuses. In the Include purchase orders with these statuses frame,
you can include purchase orders by marking Unprinted purchase order, Unprinted change order, Reprint
order, and Unprinted cancellation notice. You can mark one or any combination of these checkboxes. These
statuses are recorded in the purchase order record.

Report Orientation. Purchase order forms automatically print in portrait orientation (vertically).



ForRMS 25

Filters Tab

You can use the Filters tab to include records based on criteria such as vendors, vendor attributes, purchase
orders, purchase orders added by, purchase orders last changed by, and purchase order attributes. For example,
you may not be preparing purchase orders for all vendors at one time. You can include only those vendors whose
names begin with A through H. For more information about filtering, see the Program Basics Guide.

IQ Mew Purchaze Order Forms E

File Edit ‘“iew Fawortez Tool: Help

FlERE A= |

1: General  2: Filters |§: .-’-\ltributesl 4 Formall

@2 0pen ) Clear Al Filters
Filters I Include I Selected Filkers
Yendors all <Al Yendors =
Yendor Attributes all <Al Yendor Attributes =
Purchase Orders all <Al Purchase Orders=
Purchase Orders Added By all <Al Purchase Orders Added By =

Purchase Orders Last Changed By Al <Al Purchase Orders Last Changed By =
Purchase Order Attributes all <All Purchase Order Attribubes =

Open. To open a selection screen to designate specific filters for the form, select a filter in the grid and click
Open on the action bar.

Clear All Filters. To reset each filter to include all, you can click Clear All Filters.

Note: A filter is a requirement items must meet to be included in a form. For example, if you apply the Vendors
filter, only transactions for the selected vendors appear in the form.

Filters. The Filters column lists all the filters for the form. You cannot edit this column.

Include. By default, in the Include column, each filter is set to All. To open a selection screen to designate
specific filters for the form, choose Selected.

Selected Filters. Filters you specify on the selection screen appear in the Selected Filters column.
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Selected Filters Screen

From the Filters tab, you can open a selection screen for a filter in several ways: by double-clicking the filter in the
grid, selecting the filter in the grid and clicking Open on the action bar, or choosing Selected in the Include
column for the filter.

Selected Vendors x| I

Inchude: @ Al P e ® Range @ Ouery | Eravious Filizr  Mest Filker

Vendor Mame | Yendor ID |

ar. I Cancel |

Include. For each filter, you can include all or select specific filters. Depending on the filter, you may also be able
to filter by a range or query.

All. If you mark Include: All, you cannot designate specific filters.

Selected or Range. If you mark Include: Selected or Range, a grid appears in which you can specify filters. In a
field, you can click the binoculars to search for information.

Query. If you mark Include: Query, the Query name field appears for you to enter the name of the query by
which to filter the form. In the field, you can click the binoculars to search for the query name.

To create a new query, click the binoculars. Then click Add a New Query on the Open Query screen. For more
information about creating queries, see the Query Guide.

Previous Filter. To view or edit the previous filter without returning to the Filters tab, click Previous Filter.
Next Filter. To view or edit the next filter without returning to the Filters tab, click Next Filter.

Attributes Tab

You can use the Attributes tab to add, delete, or update attributes for the vendors whose purchase orders you
generate. For example, when printing purchase orders for vendors with an attribute type of PO Printed and a
description of Yes, you can update the date to record the date for printing the next month.

1@ New Purchase Order Forms
File Edit ‘iew Favortes Help

FIEE =l |

Generall Filters -"-"-tlfibUlesl Fnlmatl

.-'lc:liu:nnl Altribute Type I Description IShnrtDescriptionI Date IFlequiredI Comments I

-
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Note: An attribute is a tool used to group information based on a common theme. With attributes defined, you
can filter information to your specifications.

Action. In the Action column, you can select to add, delete, or update attributes on the vendor record when you
generate purchase orders.

Attribute Type. In the Attribute Type column, you can select an attribute type.
Description. In the Description column you can enter or select a description for the attribute type.

Short Description. If you selected a table type attribute that uses short descriptions, in the Short Description
column, select the attribute description. The Description column completes automatically.

Date. In the Date column, you can select the date you add, delete, or update the attribute.

Required. If the attribute type you select is required, the program automatically marks the checkbox in the
Required? column.

Comments. In the Comments column, you can enter free-form text for additional information about the
attribute type.

Format Tab

On the Format tab, you designate the format for the mailing. Settings on this tab determine the appearance of
the forms. You can select details, headings, and logos to print on the purchase orders, sort the mailing, and select
the format for displaying monetary amounts.

Detail. You can use Detail to select information to print on the purchase orders.

lE Mew Purchase Order Forms [ x| I
Fil= Edit “iew Fawortes Tools Help

IR IRl el R |

1 Genelall 2 Filtersl 3 Attributes 4 Farmat |

] Sart

Mizcellaneous Frint the following addresses .

PO Format [ 'Bill to' address |<Primar_l,- address> j&l
Eg :‘I:::;es ¥ 'Ship to' address

Fomm Alignment [~ USPS barcode for vendor address

Frint the fallowing wendor infarmation .
¥ Phone number

[V Fax number

[V E-mail address

MNumber of copies ta print for each purchase order I‘I ::ll
I~ Collate

< Back | [Hexts Cancel Frrint Preview Layout

Note: If you make no sorting selections, forms automatically sort by purchase order number in ascending
order.
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In the Print the following addresses frame, mark ‘Bill to’ address to print the billing address for the vendor.
In the accompanying field, select Shipping Address, <Primary address>, or <Add a new address>. If you leave
‘Ship to’ address marked, the delivery addresses for the vendors print on the forms. Mark USPS bar code for
vendor address to print the postal service barcode for the vendor.

In the Print the following vendor information frame, you can mark Phone number, Fax number, or Email
address to print these details for the vendor.

In the Number of copies to print for each purchase order field, you can select from one to nine copies.
Mark Collate if you want to collate multiple copies.

Sort. You can use Sort to select the order to print forms. When you select Sort, a grid appears displaying the
categories you can sort for the mailing. When preparing purchase orders, if you make no sorting selections,
forms automatically sort by purchase order number in ascending order.

lE Mew Purchase Order Forms
File Edit “iew Favoritez Toolz Help

RS R ] 2 |

1 Generall z Filters| 2 Attributez  4: Farmat |

Detai Sort

Mizcellaneous Sart by | Categarny I Order by I
PO Farmat Purchase Order Mumber Azcending

PO Header

PO Messages
Form Alignment

Tip: Make selections for displaying amounts and view them in the Sample amount display before printing the
forms.

In the first row in the Sort by column, select the item to sort the mailing by. With purchase orders, you can
sort by purchase order number, vendor name, order date, purchase order attributes, and vendor attributes.

In the Order by column, select Ascending to sort the forms alphabetically or Descending order to sort in
reverse alphabetical order.
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Miscellaneous. You can use Miscellaneous to specify how to display numerical amounts and to make font
selections for the forms. For example, you can use a comma to separate thousands and select whether to
print a currency character. The Sample amount display gives you a view of formatting selections.

lE Mew Purchasze Order Forms I
File  Edt “iew Fawaortes Toolz Help

B e R =] 2 |

1 Generall 2 Filtersl 2 Attributes 4 Farmat |

Detail Miscellaneous

Sort
B Mi us Show currency characker on all amounts
PO Farmat Show percent sign on All amaounts
PO Header Meqgative amaunt Format {1234.56)
EEI:;E;:?’IZSI’II Murnber of digits after decimal For amounts z

Murnber of digits after decimal For percentages z

Show 1000's separator ¥es

Show blanks instead of zeros Mo

Font size g

Sample amount:

Armount ($1,234.56)
Percent 100, 00%
< Back | L= | Cancel | Print | Freview | Layout |

In the Show currency character on row, you can select to see the dollar sign before monetary values on the
first amount and totals, on all amounts, or not at all.

In the Show percent sign on row, you can select to see the percent sign for the first amount and totals, for all
amounts, or not at all.

In the Negative amount format row, you can select to display negative amounts in parentheses or with a
minus sign.

In the Number of digits after decimal for amounts row, you can specify to show from zero to four decimal
places on amounts.

In the Number of digits after decimal for percentages row, you can specify to show from zero to four decimal
places on percentages.

In the Show 1000’s separator row, you can select whether to include commas in numeric values.

In the Show blanks instead of zeros row, you can select whether to leave a blank in place of amount fields
that are zero.

In the Font size row, you can select the font size to use in printing the forms.
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PO Format. You can use PO Format to select formatting features for the purchase orders.

Ig New Purchase Order Forms

File Edit “iew Favorites

=]|

Tools Help

== RN =

?.

1 Genelall s Filtersl 3 Altributes  4: Format |

Detail PO Format
Sort
Mizcellaneous PO format: IPUHPDUSDDLPPDD1 j ILaser format (pre-printed]
‘B PO Format .
PO Header S?gnatures-
PO Messages Signature 1: IJohn Doe j M\nm
Farm Alignment [~ Show two signature lines
Signature 2; IJDhn Doe j
= Britit & lege ar ke farm -
Loga flle name: I _I
Laga size: fLarge (53/3in 1 1in) =
Mizcellanecus information-
Line item spacing ISingIe space j
[ Print & gray background for every ather line item
= Eritit & gray backaround fer each heading
< Back | et | Cancel | Print | Preview | Layout |

In the PO Format field, select the laser form you use for printing purchase orders. If you select a blank paper
format, you can print an electronic signature and a logo on the forms.

To print an electronic signature, mark Use an electronic signature. In the Authorized signature field, select
the signature to use on the forms. For more information about creating electronic signatures, see the
Administration Guide.

Note: If you mark Print a logo on the form, you must select the logo file name and logo size. Large logos are
53/8in.x1in; small logos are 2 1/2 in. x 1 in.

To print your organization’s logo on the forms, mark Print a logo on the form. In the Logo file name field,
browse to the file where your logo is saved in *.bmp or *.jpg format. In the Logo size field, select Large or
Small for the logo size to use on the forms.

In the Miscellaneous information frame, you can make additional formatting selections. In the Line item
spacing field, select single space or double space for the amount of space to leave between lines. To make
reading the forms easier, you can mark Print a gray background for every other line item or Print a gray
background for each heading.
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PO Header. You can use PO Header to enter information to appear as a heading for the forms. You can use
free-form text in this box, up to 254 characters, and the text prints on the purchase orders between the
information and line item sections of the forms.

lﬂ MNew Purchase Order Forms E
File Edit “iew Favortes Tools Help

SN s |

1: Generall 2 Filtersl 3 Attributes  4: Format |

Deetai PO Header
Sart
Wizcelaneous This text will print between the purchase order information and the line item sections.

PO Farmnat
B PO Header

PO Messages
Form dlignment

PO Messages. You can use PO Messages to create a message, up to 60 characters, to print on purchase order
forms. You can print only one message on each run of purchase order forms.

I3 New Purchase Order Forms I
File Edit Wiew Favorites Tools Help

e = e |

1 Genelall s Filtersl 3 Altributes  4: Format |

Detail PO Messages
5] Sort

Mizcelaneous Regular PO: |
PO Farmat
PO Header Blarket PO: [

Form Alignment Regular from blanket: I

Feprint order: I

Cancellation notice: |

Change natice: I

Drop ship: I

< Back | et | Cancel | Print | Preview | Layout |

In the Regular PO field, the text you enter prints on the forms for all regular purchase orders.
In the Blanket PO field, the text you enter prints on the forms for all blanket purchase orders.

In the Regular from blanket field, the text you enter prints on the forms for all regular purchase orders
created from a blanket purchase order.

In the Reprint order field, the text you enter prints on the forms for all purchase orders with a status of
Reprint order.

In the Cancellation notice field, the text you enter prints on the forms for all purchase orders with a status of
Cancellation notice.

In the Change notice field, the text you enter prints on the forms for all purchase orders with a status of
Unprinted change notice.
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In the Drop ship field, the text you enter prints on the forms for all purchase orders with the drop ship
address selected in the Ship to field on the purchase order record.

Form Alignment. You can use Form Alignment to specify vertical and horizontal alighment of the forms when
you print.

lE MNew Purchase Order Forms %]
File Edit “iew Favortes Tools Help

e e = e e |

1: General' 2 Filtersl 3 Attributes  4: Format |

Detail Form Alignment

Sart

Miscellaneous WVertical alignment: IDefauIt alignment =] I urits = 0 inch
PO Farmat . : - : :
PO Header Harizantal alignment: IDefauIt alignment j I itz = 0 inch
-r.--.r Mote: 1 unit equals 1/100th of aninch ar 0.254 millimeters.

Note: The maximum alignment adjustment you can enter is 99. This moves the margin .99 inch.

In the Vertical alighment field, you can adjust the top margin for printing. You can select Default alignment,
Move printed information up, or Move printed information down and enter how much to move the

information. For example, if you select Move printed information up and enter 2, the information prints .02
inch higher on the page.

In the Horizontal alignment field, you can adjust the left margin for printing. You can select Default
alignment, Move printed information left, or Move printed information right and enter how much to move

the information. For example, if you select Move printed information left and enter 2, the information prints
.02 inch toward the left on the page.

Creating Purchase Order Forms

You can prepare multiple purchase orders or multiple copies of a single form from Mail. Purchase orders with an

Open status cannot print. When you print, export, or mail a purchase order, the status of the purchase order
automatically updates to Open in the record.

» Creating purchase order forms

In this example, we print purchase orders entered the previous week for a particular buyer.

1. From the Accounts Payable Mail page, click Forms or select the Forms navigation tab. The Forms page
appears.
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In the list on the left, select Purchase Order Forms and click New on the action bar. The New Purchase
Order Forms screen opens on the General tab.

IQ MNew Purchase Order Forms I
File Edit “iew Favortes Toolz Help

= el |

2 Filtersl 3 Attributes | 4 Formatl

Include: IFleguIar and blanket purchase arders j

Ihclude purchasze orders with these order dates -

Order date: IIncIude all dates 'l

Include purchaze orders created on these dates -

Creation date: Ilnclude all dates 'l

Include purchaze orders last changed on these dates -

Chahge date: IIncIude all dates 'I

Include purchaze orders with these statuses -

[¥ Unprinted purchase order

¥ Unprinted change order

¥ Feprint order

¥ Unprinted cancellation notice

Fieport Drientation: Portrait

In the Include field, select “Regular purchase orders”.

In the Include purchase orders with these order dates frame, leave the default “Include all dates” in the
Order Date field.

In the Include purchase orders created on these dates frame, select “Last week” in the Creation Date
field.

In the Include purchase orders last changed on these dates frame, select “Today” in the Change date
field.

In the Include purchase orders with these statuses frame, leave all statuses marked so that all purchase
orders for these vendors print:

Unprinted purchase order — When purchase orders print, the status automatically updates to Open
order on the purchase order record.

Unprinted change order — When purchase orders print, the status automatically updates to Open order
on the purchase order record.

Reprint order — When purchase orders print, the status automatically updates to Open order on the
purchase order record.
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Unprinted cancellation notice — When cancellation notices print, the status automatically updates to
Cancelled on the purchase order record.

IQ Mew Purchase Order Forms
File Edit “iew Fawortez Toolz Help

I = e |

1: Gereral |2: Filters| 3 Attributes | 4: Format

Include: IHeguIar purchaze orders j

Include purchaze orders with these order dates -

Order date: I Include all dates hd l

Include purchase orders created on these dates -

Creation date: ILagt week vl 05/26,/2005 to 06/01./2005

Include purchasze orders last changed on these dates -

Change date: Ingay vl 06/07,/2005

Include purchaze orders with these statuses -

¥ Unprinted purchase arder

¥ Unprinted change arder

W Reprint order

¥ Unprinted cancellation natice

Repaort Orientation: Partrait

8. Click Next or select the Filters tab. Filter for purchase orders last changed by Barton. For more
information about filtering, see the Program Basics Guide.

lﬂ HNew Purchase Order Forms E

File Edit “iew Favortes Tools Help

= e = R el \

1. General 2 Filkers |§: Attributesl ES Folmatl

= Clear &0 Filkers
Filbers I Include I Selected Filkers

Wendors &l <&l Wendors=
Yendor Attributes all <Al Yendor Attributes >
Purchase Orders &l <&l Purchase Orders>
Purchase Orders Added By all <Al Purchase Orders Added By =
Purchase Orders Last Changed By Selected barton
Purchase Order Attributes all <Al Purchase Order Attributes:

9. Select the Format tab.
10. In the list on the left, select Sort.
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11. Inthe Sort by and Order by columns on the second row, select “Vendor Name” and “Ascending” to sort
the purchase orders alphabetically by vendor names.

l@ Mew Purchase Order Forms E

File Edit “iew Favorites

HEE R =2

Tool: Help

Detail

Miscellaneous
PO Format
PO Header
PO Messages
Faorm dlignment

1 Generall 2 Filtersl 3 Aftributes  4; Format |

Sort

Sort by | Categony | Order by |
Purchase Order Mumber Ascending
Yendor Mame Azcending

12. Inthe list on the left, select Miscellaneous. Miscellaneous formatting selections for purchase orders
appear on the right.

13. In the Show currency character on and Show percent sign on rows, select “First amount and totals”. The
dollar sign and percent sign print only for the first amount and totals on the forms.

14. In the Negative amount format row, select -1234.56. Negative amounts print with the minus sign
preceding the amount.

lQ Mew Purchase Order Forms

File Edit View Favorites

Tool: Help

HkeE R == ?-

Detail
Sort
g

PO Format
PO Header
PO Messages
Farm Alignment

1 Generall 2 Filtersl 3: Attributes  4: Format |

Miscellaneous

Show currency character on

Show percent zign on

Font size

Sample amaourt:

First armount and totals

First amount and totals

MHegative amount format 1234 56
Mumber of digits after decimal for amounts 2
MHumber of digits after decimal for percentages 2

Show 1000 zeparator ez
Show blanks instead of zeros Mo

Arnaunt 31,234 56

Percent 100.00%

15. Click Preview. A message appears telling you the program is processing the forms.

16. The preview screen for the purchase orders appears. Close the view and return to the Format tab.

17. Click the Save button on the action bar to save the forms. The Save Mailing as screen appears.

18. In the Mailing name field, enter “Corrected POs”.
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19. In the Description field, enter “Correcting buyer’s name”.

Save Mailing as

Mailing name: |Conected POs

Desenptian: | Carecting buyer's name

¥ Others can un thiz mailing
[~ Others can modify this mailing

[H save | Cancel |

20. Click Save to save the forms. You return to the Format tab.

21. Close the New Purchase Order Forms screen. You return to the Forms page, and the purchase order
forms named “Corrected POs” appears in the grid.

#% The Financial Edge

File Edit “iew Go Favortes Tools Help
% Back ® Eorwiard J Blackbaud Sample Schoal + Accounts Payable ~

B Mail - Forms

New |Dpen ‘Qelete

Mail

Forms

Purchase Order Forms

Date Created | Created By | Others May Modify

Carrected POs Canecting buyer's name 09/04/2002

Drescription

Supervizor

Accounts Recelvable Forms

In Accounts Receivable, you can create several types of forms to help manage client billing and tracking
outstanding accounts receivable.

¢ Debit Memos — You can create debit memos for standalone charges such as finance charges, memberships
dues, and non-sufficient funds.

¢ Credit Memos — You can send credit memos to reflect standalone credits such as those for overpayments.

¢ AR Receipts —You can generate AR receipts for payments received and include details about the charges to
which payments were applied or the clients to which payments were distributed.

¢ Invoices — Invoices are payment requests you send for goods or services rendered.

¢ Single Statements — Single statements are records of charge and payment activity you send to one specified
client or third party statement recipient. These are helpful in instances such as when a client requests an
additional copy of their statement.

¢ Statements — Statements are records of charge and payment activity you create for multiple clients at one
time. You can send statements to the client who received the goods or services and his payers. A client can also
receive a copy of another client’s statement.

Debit Memo Forms

Note: We offer the only checks, student bills, statements, invoices, purchase orders, tax forms, envelopes and
other forms that are 100% compatible with The Financial Edge and fully supported by our support team. These
quality forms are pre-printed in color with your organization's logo and information. For details, call

866-4-BB-Forms, visit http://forms.blackbaud.com, or send an email with questions to forms@blackbaud.com.
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You can create debit memos for standalone charges such as finance charges, memberships dues, and
non-sufficient funds. For example, a client makes a payment by check but it is returned by the bank for
non-sufficient funds. You can send the client a debit memo notifying him that the check was returned and he now
owes for the non-sufficient fund fee plus the original payment amount.

Debit Memo Tabs

A debit memo has tabs on which you select parameters: General, Filters, Attributes, and Format. To move among
the tabs, click Next and Back at the bottom of the screen or select the tab. On these tabs you specify the records
to include in the mailing and how the forms should look.

General Tab

On the General tab for debit memos, you select parameter settings specific to debit memos.

N3 Mew Debit Memos I
Fil= Edit “iew Favartes Toolz Help

H2S R - |

: Filtersl 3 .l’-‘n.ttributesl 4 Format I

Include charges with these dates:

Transaction date: IIncIude all dates j
Post date: IIncIude all dates =l
Include charge fransaction numbers fram I ﬁl tar I ﬁl

Ihclude charges whoze status iz IUnprinted vl then change the status to printed.
[~ Create an output query of IEhargeS 'I

< Hack | Mewut » | Cancel | Prrint | Preview | Layout |

Transaction date. In the Transaction date field, select a date or date range for the transactions to include in
the form.

If you select <Specific range>, you can specify a start and end date. If the Start date field is blank, all activity is
included up to the end date. If the End date field is blank, all activity from the start date until present is
included. If both fields are blank, all activity is included.

Post date. In the Post date field, select a date or date range of post dates of transactions to include in the form.

If you select <Specific range>, you can specify a start and end date. If the Start date field is blank, all activity is
included up to the end date. If the End date field is blank, all activity from the start date until present is
included. If both fields are blank, all activity is included.

Include charge transaction numbers from [ ] to [ ]. In the Include charge transaction numbers from [ ] to
[ 1field, enter or select a range of charge transaction numbers to include in the form. If you leave both fields
blank, the form includes all charge transaction numbers.
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Include charges whose status is [ ] then change the status to printed. In the Include charges whose
status is [ ] field, select Not yet printed, Reprint, or Both. After printing the debit memo, the print status is
changed to printed on the charge record.

Create an output query of [ ]. Mark Create an output query of [ ] to create a query of the clients or charges
included in the debit memo. You can save and use an output query later for other mailings or reports.

Filters Tab

On the Filters tab, you select criteria that determines which items to include in a debit memo. For more
information about filtering, see the Program Basics Guide.

I3 New Debit Memos I
File Edit “iew Favortez Toolz Help
WS G -] 2 |

1. General ¢ |§: Attributesl EN Formatl

&8 0pen 7 Clear &ll Filters

Filters I Include I Selected Filters

Clients all <Al Clients=>

Client Attributes all <All Client Attributes=

Charges all <8l Charges =

Zharge Attribukes all <Al Charge attributes =

< Back | Mewut » | Cancel | Prrint | Preview | Layout |

Open. To open a selection screen to designate specific filters for the form, select a filter in the grid and click
Open on the action bar.

Clear All Filters. To reset each filter to include all, you can click Clear All Filters.

Note: A filter is a requirement items must meet to be included in a form. For example, if you apply the Clients
filter, only transactions for the selected clients appear in the form.

Filters. The Filters column lists all the filters for the form. You cannot edit this column.

Include. By default, in the Include column, each filter is set to All. To open a selection screen to designate
specific filters for the form, choose Selected.

Selected Filters. Filters you specify on the selection screen appear in the Selected Filters column.
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Selected Filters Screen

From the Filters tab, you can open a selection screen for a filter in several ways: by double-clicking the filter in the
grid, selecting the filter in the grid and clicking Open on the action bar, or choosing Selected in the Include
column for the filter.

Clients I

Include: Al = ® Range @ Ouery

Client Name | Cliert ID |

0 I Cancel |

Include. For each filter, you can include all or select specific filters. Depending on the filter, you may also be able
to filter by a range or query.

All. If you mark Include: All, you cannot designate specific filters.

Selected or Range. If you mark Include: Selected or Range, a grid appears in which you can specify filters. In a
field, you can click the binoculars to search for information.

Query. If you mark Include: Query, the Query name field appears for you to enter the name of the query by
which to filter the form. In the field, you can click the binoculars to search for the query name.

To create a new query, click the binoculars. Then click Add a New Query on the Open Query screen. For more
information about creating queries, see the Query Guide.

Previous Filter. To view or edit the previous filter without returning to the Filters tab, click Previous Filter.
Next Filter. To view or edit the next filter without returning to the Filters tab, click Next Filter.

Attributes Tab

Note: An attribute is a tool used to group information based on a common theme. With attributes defined, you
can filter information to your specifications.
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You can use the Attributes tab to add, delete, or update transaction attributes for the charges included in the
debit memo.

A3 Mew Debit Memos
Fil= Edit “iew Favartes Toolz Help

B R0 - |

1. General I 2 Filters

: Format I

.t’-‘n.ctionl Abtribute Type I Description IShnltDescripti...I Date IHequiledI Comments I

| r

Action. In the Action column, you can select to add, delete, or update attributes on the charge record when you
generate debit memos.

Note: Attribute types are established in Configuration. For more information about creating attribute types,
see the Configuration Guide for Accounts Receivable.

Attribute Type. In the Attribute Type column, you can select an attribute type.
Description. In the Description column you can enter or select a description for the attribute type.

Short Description. If you selected a table type attribute that uses short descriptions, in the Short Description
column, select the attribute description. The Description column completes automatically.

Date. In the Date column, select the date you add, delete, or update the attribute.

Required. If the attribute type you select is required, the program automatically marks the checkbox in the
Required? column.

Comments. In the Comments column, you can enter free-form text for additional information about the
attribute type.

Format Tab

On the Format tab, you designate the format for the mailing. Settings on this tab determine the appearance of
the forms. You can sort the mailing and select formats for displaying monetary amounts.
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Detail. Mark Show contact information in address to include contact information on the debit memo. You can
select which contact numbers to use. Mark USPS bar code and Ship to address to include these items on the

form. The Address quick view box displays the contact information as it will appear on the form.

n Mew Debit Memos

File  Edt “iew Fawaortes Toolz Help
H &= 5w i
1 General] 2 Filters] 3 Attributes
Detai
=] Mame Formats
2 Soit Include this infarmation on the memo:
2] Miscellaneous V' Client address: | < Primany: 4|
2] Debit Memo Format " .
. [ Client contact:
2] Oraarization Mame
] Form Alignment :I
[~ USPS bar code
[~ Ship to address
Address quick view:
Client name
Address lines
< Back | Cancel Print | Freview | Layout |

Name Formats. Use Name Formats to select the client name, formal or informal address, or a salutation, as it
appears on the client record.

u New Debit Memos

File Edit “iew Favorites

H &2 @&

1 Genelal] s Filters] 3 Altributes  4: Format ]

Tools Help
> .

®

5] Detail Name Formats
3 ot Farmat names in debit memao address uzing: |Elient harne j if present
2] Miscellanzous Othenwize use: | J
2] Debit Memo Format L —
5] Orgarization Name For organizations, use name followed by [ Organization (D
] Form Alignment [ CFDa &
Farmat names in debit memao body uzsing: |Elient harne j if prezent
Othenwize use: | J
For organizations, use name followed by: ™ Organization 1D
[ Contact name
[T CFDa& #
< Back | | Cancel Print Preview Layout
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Tip: We strongly recommend you use <Client name>. If you select Formal Salutation, Informal Salutation,
Salutation 1, Salutation 2, or any user-defined salutations from Configuration, the program reformats each
name, therefore taking much longer to run debit memos.

The selection you make in the Format names in debit memo address using: [ ] if present field appears in the
address area of the debit memo.

The selection you make in the Format names in debit memo body using: [ ] if present appears in the body of
the debit memo in the section for client activity.

You can select a second name format in the Otherwise use field in situations where the first selection is not
present on the client record. For example, if you select Formal Salutation, and you have clients without a
defined Formal Salutation on the Client 2 tab, the second name format is used. If <Client name> is the first
formatting selection, the Otherwise use field is disabled.

Note: You must have the appropriate security rights to output an addressee/salutation with Social Security
numbers. If you do not have security rights, the numbers are masked. For more information, see the Security
chapter of the Administration Guide for The Financial Edge.

In the For organizations, use name followed by box, mark Organization ID, Contact name, and CFDA # for
these items to appear after the organization name in the different areas of the debit memo.

Sort. You can use Sort to select the order for items to appear in the debit memo.

I New Debit Memos [ x|
Fil= Edit “iew Favortes Tools Help

IR = e |

1 Genelall 2 Filtersl 3 Attributes 4 Farmat |

Detail Sort
Mame Formats

: Sort by | Order by I
Miscellaneous Charge Date Azcending

Debit bMemo Format
Orgarization Marme
Form alignment

In the first row in the Sort by column, select the item to sort the debit memo by. You can sort by charge date,
charge number, client name, or zip code.

In the Order by column, select Ascending to sort the forms alphabetically or Descending to sort them in
reverse alphabetical order.
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Miscellaneous. Use Miscellaneous to specify how you want numbers to appear on the debit memos and the
font size for debit memos.

n MNew Debit Memos

EH <=2

Fil= Edit “iew Fawortes Tools Help

1 Genelal] 2 Filters] 3 Attributes 4 Farmat ]

2 -

H

=] Detail
2] Mame Formats

5] Sart

i LIz
=] Debit Memo Format
2] Orgarization Marme
2] Form Alignment

Miscellaneous

Show curmency character on All amaounts
Show percent sign an All amaounts
MWegative amount format [1234.56]
MNumber of digits after decimal for amounts 2

MNumber of digitz after decimal for percentages 2

Show 1000's zeparator Yes

Show blankz instead of zeros Mo

Font size a

Sample amaoLint:

Armnount [$1,234.5E]
Percent 100.00%
< Back | | Cancel | Frrint | Preview | Layout |

Debit Memo Format. You can use Debit Memo Format to select formatting features for debit memos.

n Mew Debit Memos

File Edit “iew Fawortes Toolz Help
u _5- é —a mJ ? -
1 General] 2 Filters] 2 Attributes 4 Format ]
2] Detai Debit Memo Format
2] Mame Formats
Z] Sart Farmat;: |INVBBUSDLF’F’DD1 ﬂ |Laser farmat [pre-printed)
5] Mizcellaneaus
Debit Memo Format I
] Drganization Mame | J
2] Form Alignment | J
tizcellaneous infarmation
Tranzaction spacing |Single zpace ﬂ
[v Print a gray background for every other transaction
r
< Back | | Caticel | Erint | Freview | Lapout |

In the Format field, select the laser form you use for printing debit memos. If you select a blank paper format,
you can print an electronic signature and a logo on the forms.
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Note: If you mark Print a logo on the form, you must select the logo file name and logo size. Large logos are
53/8in.x1in; small logosare 2 1/2in.x 1 in.

To print your organization’s logo on the forms, mark Print a logo on the form. In the Logo file name field,

browse to the file where your logo is saved in *.bmp format. In the Logo size field, select Large or Small for
the logo size to use on the forms.

In the Miscellaneous information frame, you can make additional formatting selections. In the Transaction
spacing field, select single space or double space for the amount of space to leave between lines. To make

reading the forms easier, you can mark Print a gray background for every other transaction or Print a gray
background for each heading.

Organization Name. Use Organization Name to print your organization’s information at the top left of the
form. The information that appears in the Organization name and Address fields defaults from the General
tab of Configuration. If you mark Show organization address, you can enter or edit the name and address.
The Address quick view box displays the information as it will appear on debit memos.

I New Debit Memos I
Fil= Edit “iew Fawortes Tools Help

HEE R0 =2 |

1 Genelall 2 Filtersl 3 Attributes 4 Farmat |

Detai Organization Name
Mame Formats

Soart ¥ Show organization address
Miscelaneous
Drehit Memo Fomat
‘B Organization Mare Address: [1234 Main Street ﬂ
Foim Alignment Charleston, 5C 23123

Organization name: |Eommunit_l,l Services Inc.

Address quick wiew:

Community Services Inc.
1234 Main Street
Charleston, 5C 29123

< Back | L= Cancel Print Freview Layout
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Form Alignment. You can use Form Alignment to specify vertical and horizontal alighment of the forms when

you print.
I New Debit Memos
Fil= Edit “iew Fawortes Tools Help
H (&= W L
1 Genelal] 2 Filters] 3 Attributes 4 Farmat ]
=] Detal Form Alignment
Marne Forrmats
j Sart Wertical slignment: [ Default alignment i units = 0 inch
2] Miscellaneous Horizontal alignment: | Default slignment - unitz = 0 inch
=] Debit Memo Format | ? J
5] Draanization Marme Mate: 1 unit equals 14100tk of an inch or 0.254 millimeters.
< Back | | Cancel | Frrint | Preview | Layout |

Note: The maximum alignment adjustment you can enter is 99. This moves the margin .99 inch.

In the Vertical alighment field, you can adjust the top margin for printing. You can select Default alignment,
Move printed information up, or Move printed information down and enter how much to move the

information. For example, if you select Move printed information up and enter 2, the information prints .02
inch higher on the page.

In the Horizontal alignment field, you can adjust the left margin for printing. You can select Default
alignment, Move printed information left, or Move printed information right and enter how much to move

the information. For example, if you select Move printed information left and enter 2, the information prints
.02 inch toward the left on the page.

Creating Debit Memo Forms

Note: We offer high-quality, customized forms that are specifically designed for use with our software. These
forms, including checks, student bills, statements, invoices, purchase orders, tax forms, and envelopes, are
pre-printed in color with your organization’s logo and information. For more information, visit our Web site at
http://forms.blackbaud.com or call us toll-free at 866-4-BB-FORMS (866-422-3676).

You can print debit memos on blank or pre-printed forms. For blank forms, you can add your organization’s logo.
You can also select the format to use for client names in the address and body of the memo.

» Creating debit memo forms

In this example, we print debit memos for clients whose names begin with A through H who had standalone
charges between February 19th and March 19th, 2003.

1. From the Accounts Receivable Mail page, click Forms. The Forms page appears.
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2. Inthe list on the left, select Debit Memos and click New on the action bar. The New Debit Memos screen
opens on the General tab.

3. In the Transaction date field, select “Specific range”.
4. In Start date field, select “February 19th” using the calendar. In the End date field, select “March 19th”.
5. Inthe Post date field, select “Include all dates”.
6. Inthe Include charges whose status is [ ] then change the status to printed field, select “Not yet
printed”.
T ||

File Edit “iew Favontes Tools Help
== R el |

2 Filters | 3 .&ttlibutesl 4: Format |

Include charges with these dates:

Tranzaction date: |<Specific ranges ﬂ Start date: ID2H‘ISH2DDEEI End date: IDSH 9/2005 EII

Past date: Ilnclude all dates 'l

Include charge transaction numbers from I QI to I QI

Include charges whose status is: INgt yet printed vl then change the status to printed.
[~ Create an output query of ICharges 'I

¢ Bach | Mest » | Cancel | Print Freview Layout

7. Click Next or select the Filters tab.

8. Select clients whose names begin with A through H. For more information about filtering, see the
Program Basics Guide.

I3 Mew Debit Memos
Eile Edit “iew Favortez Tools Help

RS R0 2 |

1: General 2 Filters |§: Attributesl 4 Format'

& Open ) Clear Al Filkers

Filkers I Include I Selected Filkers I
Clients Selected Javid Adams to Mr, John Edward Harrison| ﬁl
Client attribukes all <Al Client attributes =
Charges Al <Al Charges =
Charge attributes ol <all Charge Attributes=

9. Select the Format tab.
10. In the list on the left, select Detail.
11. Mark Client address and select “Primary”.



12. Mark USPS bar code.

u MNew Debit Memos

Eile Edit “iew Favortez Tools Help
EH &S & e

1 Eeneral] 2 Filters] 2 Attibutes  4: Farmat l

2 Sort Include this information on the memo:
= Miscellaneous
=] Debit Memo Format
=] Organization Narme
g Form Alignment

W Client address: |<P[ima[_|,|> j
[ Client contact:

[ Ship to address

Address quick view:

Detail
=] Mame Formats

el Ll LT
Clignt narme
Address lines

< Back | | Cancel | Print Freview

Layout

13. In the list on the left, select Sort.

Forms 47

14. In the Sort by and Order by columns on the first row, select “Client Name” and “Ascending” to sort the

debit memos alphabetically by client names.

u MNew Debit Memos

File Edit “iew Favortes Toolz Help
H (&= (&E ?-

1 General] 2 Filters] 3 Aftnbutes  4; Format l

2] Detail Sort
=] Name Formats

Sort by

Order by
¥ | Azcending

=] Mizcellaneous
=] Debit Memao Format
5] Organization Mame
=] Form Aligniment

Client Name

Note: If you mark Create an output query of [ ] on the General tab, the Save Static Query screen appears so

you can name and save the query.

15.
screen for the debit memos appears.

16. Close the preview and return to the Format tab.
17.

18. In the Mailing name field, enter “February/March A to H”.

Click Preview. A message appears telling you the program is processing the mailing, and the preview

Click the Save button on the action bar to save the new forms. The Save Mailing as screen appears.
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19. In the Description field, enter “Debit Memos for Clients A to H for Feb. 19th through Mar. 19th”.

Save Mailing as
I ailing name: IFebJMarch AtoH
Drescription: [Dehit Memos for Clients & to H for Feb. 15th through Mar. 19th

Iv Others zan run thiz mailing
[~ Others can modify this mailing

Hsave | Cancel |

20. Click Save to save the new forms. You return to the Format tab.

21. Close the screen. You return to the Forms page, and the debit memo form named “February/March
A to H” appears in the grid.

Credit Memo Forms

Note: We offer high-quality, customized forms that are specifically designed for use with our software. These
forms, including checks, student bills, statements, invoices, purchase orders, tax forms, and envelopes, are
pre-printed in color with your organization’s logo and information. For more information, visit our Web site at
http://forms.blackbaud.com or call us toll-free at 866-4-BB-FORMS (866-422-3676).

You can send credit memos to reflect standalone credits such as those for overcharges. For example, a client calls
to notify your organization that he was overcharged on his last bill. You verify the mistake, credit the client’s
account for the amount he was overcharged, and mail him a credit memo as a record that the credit was made.

Credit Memo Tabs

A credit memo has tabs on which you select parameters: General, Filters, Attributes, and Format. To move among
the tabs, click Next and Back at the bottom of the screen or select the tab. On these tabs you specify the records
to include in the mailing and how the forms should look.
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General Tab

On the General tab for credit memos, you select parameter settings specific to credit memos.

A3 New Credit Memos I
Fil=e Edit “iew Favortes Toolz Help

n||ﬁ%&"|-|@|"' |

| Z Flltersl K3 .t’-‘n.ttnbutesl 4 Folmatl

Ihclude credits with these dates:

Tranzaction date: IIncIude all dates j
Past date: IIncIude all dates =l
Incfude credit transaction numbers from | ﬁl [ | El

Include credits whoze status iz IUnplinted vl then change the gtatus to printed.
[~ Create an output query of IEredits "I

< Back | Hemt » | Cancel | Print | Preview | Layout |

Transaction date. In the Transaction date field, select a date or date range for the credit transactions to
include in the credit memo.

If you select <Specific range>, you can specify a start and end date. If the Start date field is blank, all activity is
included up to the end date. If the End date field is blank, all activity from the start date until present is
included. If both fields are blank, all activity is included.

Post date. In the Post date field, select a date or date range of post dates to include in the credit memo.

If you select <Specific range>, you can specify a start and end date. If the Start date field is blank, all activity is
included up to the end date. If the End date field is blank, all activity from the start date until present is
included. If both fields are blank, all activity is included.

Include credit transaction numbers from [ ] to [ ]. In the Include credit transaction numbers from [ ] to[ ]
field, enter or select a range of credit transaction numbers to include in the credit memo. If you leave both
fields blank, the credit memo includes all credit transaction numbers.

Include credits whose status is [ ] then change the status to printed. In the Include credits whose
status is [ ] field, select Not yet printed, Reprint, or Both. After printing the credit memo, the print status is
changed to printed on the credit record.

Create an output query of [ ]. Mark Create an output query of [ ] to create a query of the clients or credits
included in the credit memos. You can save and use an output query later for other mailings or reports.
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Filters Tab

On the Filters tab, you select criteria that determines which items to include in a credit memo. For more
information about filtering, see the Program Basics Guide.

1@ Hew Credit Memos I
Fil=e Edit “iew Favortes Toolz Help
=R = |
Filters I Include I Selected Filkers

Clients all <Al Clients=

Clienk Atkribukes all <Al Client Attributes=

Credits all <All Credits >

Credit Attributes all <All Credit Attributes =

< Back | MHewt » | Cancel | Prrint | Preview | Layout |

Open. To open a selection screen to designate specific filters for the form, select a filter in the grid and click
Open on the action bar.

Clear All Filters. To reset each filter to include all, you can click Clear All Filters.

Note: A filter is a requirement items must meet to be included in a form. For example, if you apply the Clients
filter, only transactions for the selected clients appear in the form.

Filters. The Filters column lists all the filters for the form. You cannot edit this column.

Include. By default, in the Include column, each filter is set to All. To open a selection screen to designate
specific filters for the form, choose Selected.

Selected Filters. Filters you specify on the selection screen appear in the Selected Filters column.
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Selected Filters Screen

From the Filters tab, you can open a selection screen for a filter in several ways: by double-clicking the filter in the
grid, selecting the filter in the grid and clicking Open on the action bar, or choosing Selected in the Include
column for the filter.

T ||

Inchude: @ Al P e ® Range @ Ouery | Eravious Filizr  Mest Filker

Clientt Name | Client 1D |

ar. I Cancel |

Include. For each filter, you can include all or select specific filters. Depending on the filter, you may also be able
to filter by a range or query.

All. If you mark Include: All, you cannot designate specific filters.

Selected or Range. If you mark Include: Selected or Range, a grid appears in which you can specify filters. In a
field, you can click the binoculars to search for information.

Query. If you mark Include: Query, the Query name field appears for you to enter the name of the query by
which to filter the form. In the field, you can click the binoculars to search for the query name.

To create a new query, click the binoculars. Then click Add a New Query on the Open Query screen. For more
information about creating queries, see the Query Guide.

Previous Filter. To view or edit the previous filter without returning to the Filters tab, click Previous Filter.
Next Filter. To view or edit the next filter without returning to the Filters tab, click Next Filter.

Attributes Tab

You can use the Attributes tab to add, delete, or update transaction attributes for the credits included in the
credit memo.

1@ Hew Credit Memos
Fil=e Edit “iew Favortez Toolz Help

HRER = - |

1. General | 2 Filters

: Format I

.t’-‘n.ctiunl Altribute Type I Description IShUltDescripti...I Date IHequiledI Comments I

=
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Action. In the Action column, you can select to add, delete, or update attributes on credit records when you
generate credit memos.

Note: Attribute types are established in Configuration. For more information about creating attribute types,
see the Configuration Guide for Accounts Receivable.

Attribute Type. In the Attribute Type column, you can select an attribute type.
Description. In the Description column you can enter or select a description for the attribute type.

Short Description. If you selected a table type attribute that uses short descriptions, in the Short Description
column, select the attribute description. The Description column completes automatically.

Date. In the Date column, select the date you add, delete, or update the attribute.

Note: An attribute is a tool used to group information based on a common theme. With attributes defined, you
can filter information to your specifications.

Required. If the attribute type you select is required, the program automatically marks the checkbox in the
Required? column.

Comments. In the Comments column, you can enter free-form text for additional information about the
attribute type.
Format Tab

On the Format tab, you designate the format for the mailing. Settings on this tab determine the appearance of
the forms. You can sort the mailing and select formats for displaying monetary amounts.

Detail. You can use Detail to select the contact information to include on the credit memo.

I3 New Credit Memos I
File Edit Wiew Favorites Tools Help

ClEE A=l il |
g
2] Mame Formats

Sart Inzlude this infarmation o the memo:

Miscellansous IV Client address: | <Primary> |
Credit tMemao Farmat W] e et

E;?r:rlzli‘;tr:?eglame Contact rumbe: |<Nnne> 'l
Contact number: |<Nnne> 'l
™ USPS bar code
[" Ship to address

Address quick view:

1 Genelall s Filtersl 3 Altributes

Client narme
Address lines

< Back | et | Cancel | Print | Preview | Layout |

You can select which client address and contact phone numbers to use. Mark USPS bar code and Ship to
address to include these items on the form. The Address quick view box displays the contact information as
it will appear on the form.
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Name Formats. Use Name Formats to select the client name, formal or informal address, or a salutation, as it
appears on the client record.

I New Credit Memos
Fil= Edit “iew Fawortes Tools Help
H (&= W L
1 Genelal] 2 Filters] 3 Attributes 4 Farmat ]
5] Detail Name Formats
A ot Farmat names in credit memo address uzsing: |Elient hame j if present
2] Mizcellaneous Othenwize Lse: | J
2] Credit Mema Format L —
5] Orgarization Mame For organizations, use name followed by: | ™ Orgarization |0
2] Form Alignment [ CFDA®
Format namesz in credit memo body uzing: |Elient hame ﬂ if present
Otherwize uze: | J
For organizations, use name followed by: [ Organization |0
[ Contact name
[T CFDa &
< Back | Cancel | Frrint | Preview | Layout |

Tip: We strongly recommend you use <Client name>. If you select Formal Salutation, Informal Salutation,
Salutation 1, Salutation 2, or any user-defined salutations from Configuration, the program reformats each
name, therefore taking much longer to run credit memos.

The selection you make in the Format names in credit memo address using: [ ] if present field appears in the
address area of the credit memo.

The selection you make in the Format names in credit memo body using: [ ] if present appears in the body of
the credit memo in the section for client activity.

You can select a second name format in the Otherwise use field in situations where the first selection is not
present on the client record. For example, if you select Formal Salutation, and you have clients without a
defined Formal Salutation on the Client 2 tab, the second name format is used. If <Client name> is the first
formatting selection, the Otherwise use field is disabled.

Note: You must have the appropriate security rights to output an addressee/salutation with Social Security
numbers. If you do not have security rights, the numbers are masked. For more information, see the Security
chapter of the Administration Guide for The Financial Edge.

In the For organizations, use name followed by box, mark Organization ID, Contact name, and CFDA # for

these items to appear after the organization name in the different areas of the credit memo.
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Sort. You can use Sort to select the order for items to appear in the credit memo.

I New Credit Memos
File Edit %iew Favortes Tools Help

e = el

1 Genelall s Filtersl 3 Altibutes  4: Format |

Detal Sort
Mame Formats

| 3 Sort by | Order by I
Miscellaneows Credit Date Ascending

Credit Memo Format
Orgarization Marme
Farm &ligrment

In the first row in the Sort by column, select the item to sort the credit memo by. You can sort by credit date,
credit number, client name, or zip code.

In the Order by column, select Ascending to sort the forms alphabetically or Descending to sort them in
reverse alphabetical order.

Miscellaneous. Use Miscellaneous to specify how you want numbers to appear on the credit memos and the
font size for credit memos.

I New Credit Memos I
File Edt “iew Faworites Toolz Help

SN = e e

1 Generall 2 Filtersl 2 Attributes 4 Farmat |

Detail Miscellaneous

Mame Formats

Soart Show cumency character on All amaounts
B Mizcellaneous Show percent zign on All amounts
Credit _Me!'nu:- Format Megative amount format [1234.56]
E;?:lz“‘;tr:?e:? me Mumber of digits after decimal for amounts 2

Mumber of digitz after decimal for percentages 2

Show 1000's zeparator Yes

Show blanks inztead of zeros Ma

Fant zize g

Sample amount;

Amat [$1.234.56)
Percent 100.00%

< Back [dEnt s Caticel Erint Freview Lapout
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Credit Memo Format. You can use Credit Memo Format to select formatting features for credit memos.

I3 New Credit Memos I
File Edit Wiew Favorites Tools Help

e = el |

1 Genelall s Filtersl 3 Altributes  4: Format |

Detail Credit Memo Format
Mame Formats

Snrt Farmat: I|N\IBB|_|5[||_PP[|D1 j ILasel farmat [pre-printed)
Miscellaneous

‘B Credit Memo Fomnat I= | Briritya lgm o the farm

Orgarization Mame Logo file name: I _I
Form &lignment

Laga size; |Large (53/8in x 1in) =
tizcelaneous information

Transaction spacing ISingle space j

[¥ Print a gray background for every other transaction
I | Britt & araw backanaund fer each e ading

< Back | et | Cancel | Print | Preview | Layout |

In the Format field, select the laser form you use for printing credit memos. If you select a blank paper
format, you can print an electronic signature and a logo on the forms.

Note: If you mark Print a logo on the form, you must select the logo file name and logo size. Large logos are
53/8in.x1in; small logosare 2 1/2in. x 1 in.

To print your organization’s logo on the forms, mark Print a logo on the form. In the Logo file name field,

browse to the file where your logo is saved in *.bmp format. In the Logo size field, select Large or Small for
the logo size to use on the forms.

In the Miscellaneous information frame, you can make additional formatting selections. In the Transaction
spacing field, select single space or double space for the amount of space to leave between lines. To make

reading the forms easier, you can mark Print a gray background for every other transaction or Print a gray
background for each heading.
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Organization Name. Use Organization Name to print your organization’s information at the top left of the
form. The information that appears in the Organization name and Address fields defaults from the General
tab of Configuration. If you mark Show organization address, you can enter or edit the name and address.
The Address quick view box displays the information as it will appear on credit memos.

n Mew Credit Memos
File  Edit “iew Fawarites

H <=2 W

1 General] 2 Filters] 2 Attributes 4 Farmat ]

Tonlz Help

? -

=] Detail
=] Mame Formats

=] Sort

=] Miscellaneous

[ Show crganization address

Organization Name

5] Credit Mema Farmat

Organization name: |Eommunity Semvices [ne.

Organization Mame
] Form Alignment

Address: (1234 Main Street
Charleston, SC 29123

Address quick wiew:

Community Services Inc.
1234 Main Street
Charleston, SC 29123

< Back | Cancel |

Print | Freview | Layout |

Form Alignment. You can use Form Alignment to specify vertical and horizontal alighment of the forms when

you print.

n MNew Credit Memos
Fil=  Edit Toolzs Help

EH <=2 @ -

1 Genelal] 2 Filters] 3 Attributes 4 Farmat ]

Wiew  Fawarites

5] Detail Form Alignment
=] Mame Formats : ) -
3 sat Wertical alignment: |Defau|t alighment

j unitz = 0 inch

2] Mizcellaneous
2] Credit Memo Format
2] Organization Marne
B Fom Alignment

Horizontal alignment; | Default alignment

MHate: 1 unit equals 1,/100th of an inch or 0,254 millimeters,

ﬂ units = Dinch

Note: The maximum alignment adjustment you can enter is 99. This moves the margin .99 inch.

In the Vertical alignment field, you can adjust the top margin for printing. You can select Default alignment,
Move printed information up, or Move printed information down and enter how much to move the
information. For example, if you select Move printed information up and enter 2, the information prints .02

inch higher on the page.
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In the Horizontal alignment field, you can adjust the left margin for printing. You can select Default
alignment, Move printed information left, or Move printed information right and enter how much to move
the information. For example, if you select Move printed information left and enter 2, the information prints
.02 inch toward the left on the page.

Creating Credit Memo Forms

Note: We offer high-quality, customized forms that are specifically designed for use with our software. These
forms, including checks, student bills, statements, invoices, purchase orders, tax forms, and envelopes, are
pre-printed in color with your organization’s logo and information. For more information, visit our Web site at
http://forms.blackbaud.com or call us toll-free at 866-4-BB-FORMS (866-422-3676).

You can print credit memos on blank or pre-printed forms. For blank forms, you can add your organization’s logo.
You can also select the format to use for client names in the address and body of the memo.
» Creating credit memo forms

In this example, we print credit memos for clients whose names begin with A through H who had standalone
credits between February 19th and March 19th, 2003.

1. From the Accounts Receivable Mail page, click Forms. The Forms page appears.

2. Inthe list on the left, select Credit Memos and click New on the action bar. The New Credit Memos
screen opens on the General tab.

3. In the Transaction date field, select “Specific range”.
4. In Start date field, select “February 19th” using the calendar. In the End date field, select “March 19th”.

12 MNew Credit Memos I
File Edit “iew Favortes Toolz Help

= Hie= R el |

Filters| K3 .&ttlibutesl 4 Formatl

Include credits with these dates:

Tiansaction date:  [<Speciic range> ] Startdate: [02/13/2003 (=] Enddate: [03/13/2003 (=]

Post date: Ilnclude all dates 'I

Include credit transaction numbers from I ﬂl ta I ﬁl

Include credits whose status ig: IUnprinted vl then change the status to printed.
[~ Create an output query of IC[edits 'l

< Back | Mext > | Cancel | Erint Freview Lapout

5. Inthe Post date field, select “Include all dates”.

6. In the Include credits whose status is [ ] then change the status to printed field, select “Not yet printed”.
7. Click Next or select the Filters tab.
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8. Select clients whose names begin with A through H. For more information about filtering, see the
Program Basics Guide.

I3 Mew Credit Memos
File Edit “iew Favortes Tools Help

=R R e |

1: General

2 Filters |§: .&ttlibutesl 4: Format |

Credit Attributes

Al

Filters I Include I Selected Filkers I
Clients Selacted yavid ddams ko Mr, John Edward Harrison ﬁl
Client Attributes all <Al Client Attribukes =
Credits All <Al Credits=

<Al Credit atkributes>

Select the Format tab.
10.
11.
12.

In the list on the left, select Detail.
Mark Client address and select “Primary”.
Mark USPS bar code.

I3 Mew Credit Memos

File Edit “iew Favortes Tools Help
=R R e |

1 Generall 2 Filters| 3 Aftnbutes  4; Format |

Detail
Name Formats

Sort

Miscellaneous
Credit Memo Format
Orgarmization Name
Form Alignment

Include this infarmation on the memo:

v Client address: |<P[ima[_|,|> ﬂ

™ Client cantact:

Caortact number: |<None> 'l
Caortact number: |<None> 'l
I )

[~ Ship to address
Address quick view:

wld Ll LG
Clignt name:
Address lines

< Back | et | Cancel | Print Freview Layout

13. In the list on the left, select Sort.
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14. In the Sort by and Order by columns on the first row, select “Client Name” and “Ascending” to sort the
credit memos alphabetically by client names.

I3 Mew Credit Memos
File Edit “iew Favortes Toolz Help

= Hie= R el |

1 Generall 2 Filters| 3 Aftnbutes  4; Format I

D etail Sort

ame Formats

= Sort by I Order by I
Miscellaneous Client Name Azcending

Credit Memo Format
Orgarmization Name
Form Alignment

Note: If you mark Create an output query of [ ] on the General tab, the Save Static Query screen appears so
you can name and save the query.

15. Click Preview. A message appears telling you the program is processing the mailing, and the preview
screen for the credit memos appears.

16. Close the preview and return to the Format tab.

17. Click the Save button on the action bar to save the new forms. The Save Mailing as screen appears.
18. In the Mailing name field, enter “February/March A to H”.

19. In the Description field, enter “Credit Memos for Clients A to H for Feb. 19th through Mar. 19th”.

Save Mailing as
b ailing name: |Feb£March AtaH

Deescription: [ Credit temos far Clients & to H far Feb. 13th through Mar.
15th

¥ Others zan mun thiz mailing
[~ Others can modify this mailing

Hsave | Cancel |

20. Click Save to save the new forms. You return to the Format tab.

21. Close the screen. You return to the Forms page, and the credit memo form named “February/March
A to H” appears in the grid.

AR Receipt Forms

Note: We offer high-quality, customized forms that are specifically designed for use with our software. These
forms, including checks, student bills, statements, invoices, purchase orders, tax forms, and envelopes, are
pre-printed in color with your organization’s logo and information. For more information, visit our Web site at
http://forms.blackbaud.com or call us toll-free at 866-4-BB-FORMS (866-422-3676).

You can generate AR receipts for payments received and include details about the charges to which payments
were applied or the clients to which payments were distributed.
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AR Receipt Tabs
An AR receipt has tabs on which you select parameters: General, Filters, Attributes, and Format. To move among

the tabs, click Next and Back at the bottom of the screen or select the tab. On these tabs you specify the records
to include in the mailing and how the forms should look.

General Tab

On the General tab for AR receipts, you select parameter settings specific to AR receipts.

M@ Mew AR Receipts I
File Edit “iew Favartes Toolz Help

u|@@tan|-|gr|v- |

| 2 Flltersl K3 .l’-‘n.ttnbutesl 4 Folmatl

Inciude payments with these dates:

Papment date: [Include all dates =]
Depaosit date: IIncIude all dates j
Ihclude pavment numbers fram: I ﬁl ta I QI
Include deposit numbers from: I ﬁl to I ﬂl

Include papmentz whoze status iz IUnprinted vI then change the statuz to printed.
[~ Create an output query of IF'aymentS 'I

< Hack | Mewut » | Cancel | Prrint | Preview | Layout |

Note: You must have the appropriate security rights to output credit card numbers. If you do not have security
rights, the numbers are masked. For more information, see the Security chapter of the Administration Guide
for The Financial Edge.

Payment date. In the Payment date field, select a date or date range for payment dates to include in the
receipt.

If you select <Specific range>, you can specify a start and end date. If the Start date field is blank, all activity is
included up to the end date. If the End date field is blank, all activity from the start date until present is
included. If both fields are blank, all activity is included.

Deposit date. In the Deposit Date field, select a date or date range for deposit dates to include in the receipt.

If you select <Specific range>, you can specify a start and end date. If the Start date field is blank, all activity is
included up to the end date. If the End date field is blank, all activity from the start date until present is
included. If both fields are blank, all activity is included.

Include payment numbers from [ ] to [ ]. In the Include payment numbers from [ ] to [ ] field, enter or
select a range of payment numbers to include in the receipt. If you leave both fields blank, the form includes
all payment numbers.
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Include deposit numbers from [ ] to [ ]. In the Include deposit numbers from [ ] to [ ] field, enter or select a
range of deposit numbers to include in the receipt. If you leave both fields blank, the form includes all deposit
numbers.

Include payments whose status is [ ] then change the status to printed. In the Include payments
whose status is [ ] field, select Not yet printed, Reprint, or Both. After printing the receipt, the print status is
changed to printed on the payment record.

Create an output query of [ ]. Mark this option to create a query of payments, deposits, or clients that
appear in the receipts. You can save and use an output query later for other mailings or reports.

Filters Tab

On the Filters tab, you select criteria that determines which items to include in an AR receipt. For more
information about filtering, see the Program Basics Guide.

M@ Mew AR Receipts I
Fil= Edit “iew Favartes Toolz Help
W& R -2 |
| 3 Attributes I 4 Format I
7 Clear All Filters
Filters I Include I Selected Filkers
Clients all <Al Clients=
Clienk Atkributes all <Al Client Attributes=
Barks all <All Banks >
Depasits all <Al Depaosits =
Pavments all <Al Payments =
Pavment Aktribukes all <Al Payment Attributes =
Pavment Sources all <Al Payment Sources =
< Back | MHewt » | Cancel | Prrint | Preview | Layout |

Open. To open a selection screen to designate specific filters for the form, select a filter in the grid and click
Open on the action bar.

Clear All Filters. To reset each filter to include all, you can click Clear All Filters.

Note: A filter is a requirement items must meet to be included in a form. For example, if you apply the Clients
filter, only transactions for the selected clients appear in the form.

Filters. The Filters column lists all the filters for the form. You cannot edit this column.

Include. By default, in the Include column, each filter is set to All. To open a selection screen to designate
specific filters for the form, choose Selected.

Selected Filters. Filters you specify on the selection screen appear in the Selected Filters column.
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Selected Filters Screen

From the Filters tab, you can open a selection screen for a filter in several ways: by double-clicking the filter in the
grid, selecting the filter in the grid and clicking Open on the action bar, or choosing Selected in the Include
column for the filter.

T ||

Inchude: @ Al P e ® Range @ Ouery | Eravious Filizr  Mest Filker

Clientt Name | Client 1D |

ar. I Cancel |

Include. For each filter, you can include all or select specific filters. Depending on the filter, you may also be able
to filter by a range or query.

All. If you mark Include: All, you cannot designate specific filters.

Selected or Range. If you mark Include: Selected or Range, a grid appears in which you can specify filters. In a
field, you can click the binoculars to search for information.

Query. If you mark Include: Query, the Query name field appears for you to enter the name of the query by
which to filter the form. In the field, you can click the binoculars to search for the query name.

To create a new query, click the binoculars. Then click Add a New Query on the Open Query screen. For more
information about creating queries, see the Query Guide.

Previous Filter. To view or edit the previous filter without returning to the Filters tab, click Previous Filter.
Next Filter. To view or edit the next filter without returning to the Filters tab, click Next Filter.

Attributes Tab

You can use the Attributes tab to add, delete, or update transaction attributes for payments.

I3 Mew AR Receipts E

File Edit “iew Favontez Toolz Help
e E A= |

1. General | 2 Filters

: Format I

Actionl Altribute Type I Drescription IShortDescripti...I Date IFlequiredI Comments I

-
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Action. In the Action column, you can select to add, delete, or update attributes on the payment record when
you generate receipts.

Note: Attribute types are established in Configuration. For more information about creating attribute types,
see the Configuration Guide for Accounts Receivable.

Attribute Type. In the Attribute Type column, you can select an attribute type.
Description. In the Description column you can enter or select a description for the attribute type.

Short Description. If you selected a table type attribute that uses short descriptions, in the Short Description
column, select the attribute description. The Description column completes automatically.

Date. In the Date column, select the date you add, delete, or update the attribute.

Note: An attribute is a tool used to group information based on a common theme. With attributes defined, you
can filter information to your specifications.

Required. If the attribute type you select is required, the program automatically marks the checkbox in the
Required? column.

Comments. In the Comments column, you can enter free-form text for additional information about the
attribute type.
Format Tab

On the Format tab, you designate the format for the mailing. Settings on this tab determine the appearance of
the receipts. You can sort the mailing and select formats for displaying monetary amounts.

Detail. Use Detail to select what items of detail to print on AR receipts.

I New AR Receipts I
File Edit Wiew Favorites Tools Help
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Detail
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Contact number: |<Ngne> 'I
Contact number: |<Ngne> 'I

" USPS bar code
Address quick view:
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Address lines

< Back | et | Cancel | Print | Preview | Layout |

To show payment applications or distributions, mark Show and select Charges this payment was applied to or
Client this payment was distributed to. To display the reference number as a barcode, mark Show barcode.

You can select for the line item description to be invoice information (invoice and line item number) or the
billing item description.
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You can also select which client address and contact phone numbers to use. Mark USPS bar code and Ship to
address to include these items on the form. The Address quick view box displays the contact information as
it will appear on the form.

Tip: We strongly recommend you use <Client name>. If you select Formal Salutation, Informal Salutation,
Salutation 1, Salutation 2, or any user-defined salutations from Configuration, the program reformats each
name, therefore taking much longer to run AR receipts.

Sort. You can use Sort to select the order for items to appear in the AR receipt.

I New AR Receipts [ x|
Fil= Edit “iew Favortes Tools Help

e = e |

1 Genelall 2 Filtersl 3 Attributes 4 Farmat |

Detail Sort
. Mizcellaneous Sart by | Order by |
Receipt Message Receipt Date Azcending

Alignment

Fieceipt Fomat
Organization Mame
Mame Formats

In the first row in the Sort by column, select the item to sort the AR receipt by. You can sort by receipt date,
deposit number, receipt number, client name, payment type, or zip code.

In the Order by column, select Ascending to sort the forms alphabetically or Descending to sort them in
reverse alphabetical order.
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Miscellaneous. Use Miscellaneous to specify how you want numbers to appear on the receipts and the font
size for receipts.

I New AR Receipts I
Fil= Edit “iew Fawortes Tools Help

G E R0 =2

1 Genelall 2 Filtersl 3 Attributes 4 Farmat |

D etail Miscellaneous

Sart
B el Show curency character on Al armounts
Feceipt Message Show percent sign an All amaounts
.-’-‘n.lignr!'lent MWegative amount format [1234.56]
E?gcaer:?zlaiiz:n;lame MNumber of digits after decimal for amounts 2
Mame Formats MNumber of digitz after decimal for percentages 2

Show 1000's zeparator Yes

Show blankz instead of zeros Mo

Font size a

Sample amaoLint:

Armnount [$1,234.5E]
Percent 100.00%
< Back | [Hexts | Cancel | Frrint | Preview | Layout |

Receipt Message. Use Receipt Message to enter text you want to appear at the end of each receipt.

I New AR Receipts
File Edt “iew Fawortes Toolz Help

I I =l

1 Generall 2 Filtersl 2 Attributes 4 Format |

Detai Receipt Message
Sort

Miscellansous Thiz text will print at the end of each receipt:

Alignment

Receipt Format
Organization Mame
Mamme Formats
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Alignment. You can use Alignment to specify vertical and horizontal alignment of the forms and addresses
when you print.

I New AR Receipts I
Fil= Edit “iew Fawortes Tools Help

G E R0 =2 |

1 Genelall 2 Filtersl 3 Attributes 4 Farmat |

Deta

5'.3” Farm Alighment: -
Miscellaneaus
Receipt Meszage Wertical alignment: IDefauIt aligriment ﬂ I units = D inch

‘B Alignment : _ _ _
Receipt Format Harizantal alignmet: IDefauIt aligriment j | utitz = Oinch
Drganization Mame
Mame Formats

Mate: 1 unit equals 1,/100th of an inch or 0.254 millimeters,

Address Alignment;

Wertical alignment: IDefauIt aligrment j | units = Oinch

Harizontal alignment: IDefauIt aligrment j I units = Dinch

Mate: 1 unit equals 1/100th of an inch or 0.254 millimeters.

< Back | [Hexts Cancel Frrint Preview Layout

Note: The maximum alignment adjustment you can enter is 99. This moves the margin .99 inch.

In the Form Alignment frame, you can adjust the form’s top and left margins for printing using the Vertical
alignment and Horizontal alignment fields. You can move printed information up or down or left or right and
enter how much to move the information. For example, if you select Move printed information up and enter
2, the information prints .02 inch higher on the page.

Addresses for the receipt recipient are aligned by default to fit the first five lines in a standard envelope
address window. If you need to make adjustments, in the Address Alignment frame, you can move printed
information up or down or left or right and enter how much to move the information. For example, if you
select Move printed information up and enter 2, the address prints .02 inch higher on the page.



Receipt Format. You can use Receipt Format to select formatting features for receipts.

I New AR Receipts

File Edit “iew Favorites

=]|

Tools Help

= D= R e 2

Dretail

Sort
Miscellanenus
Receipt Message
Alignment

‘B Receipt Farmat
Orgarization Marme
Marne Formats

1 Genelall s Filtersl 3 Altributes  4: Format |

Receipt Format

[~ Use an electronic signature -

Avtharized signature: |<Ng signature: j

[~ Print & logo on the form
Loga file name: I _I

Logosize: Large (5 3/Gin #1in) =
Mizcelaneous information
Tranzaction spacing ISingle space j

[~ Print & gray background far every ather transaction
[~ Print a gray backaground for each heading

< Back | et |

Cancel | Print | F'reviegl Layout |
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To print an electronic signature, mark Use an electronic signature. In the Authorized signature field, select

the signature to use on the forms. For more information about creating electronic signatures, see the
Administration Guide.

Note: If you mark Print a logo on the form, you must select the logo file name and logo size. Large logos are
53/8in.x1in; small logosare 21/2in. x 1 in.

To print your organization’s logo on the forms, mark Print a logo on the form. In the Logo file name field,

browse to the file where your logo is saved in *.bmp format. In the Logo size field, select Large or Small for
the logo size to use on the forms.

In the Miscellaneous information frame, you can make additional formatting selections. In the Transaction
spacing field, select single space or double space for the amount of space to leave between lines. To make

reading the forms easier, you can mark Print a gray background for every other transaction or Print a gray
background for each heading.
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Organization Name. Use Organization Name to print your organization’s information at the top left of the

form. The information that appears in the Organization name and Address fields defaults from the General
tab of Configuration. If you mark Show organization address, you can enter or edit the name and address.
The Address quick view box displays the information as it will appear on receipts.

n Mew AR Receipts
File  Edit “iew Fawarites

H <=2 W

1 General] 2 Filters] 2 Attributes 4 Farmat ]

Tonlz Help

? -

=] Detal Organization Name
=] Sort
2] Miscellaneous ¥ Show organization address
=l cheupt Message Organization name: |Eommunity Semvices [ne.
2] alignment
5] Receipt Fomat Address: [1234 Main Street J
Orgarization Mame Charleston, SC 29123
2] Mame Formats J
Address quick wiew:
Community Services Inc.
1234 Main Street
Charleston, 5C 29123
< Back | Cancel Print | Freview | Layout |

appears on the client record.

Name Formats. Use Name Formats to select the client name, formal or informal address, or a salutation, as it

n MNew AR Receipts
Fil=  Edit Wiew Faworites

EH <=2

1 Genelal] 2 Filters] 3 Attributes 4 Farmat ]

Toolz: Help

? -

=] Detal Name Formats
Sart ) . ) .
j Miscellaneaus Farmat names in receipt address using: |Elient hame j if present
=] Receipt Message Othenwise use: | J
5] &lignment o
] Rreceipt Format For organizations, use name followed by: ™ Orgarization |0
5| Organization Mame [ CFDA®
Format names in receipt body using: |Elient hame ﬂ if present
Otherwize uze: | J
For organizations, use name followed by: [ Organization |0
[ Contact name
[T CFDa &
< Back Cancel Frrint Preview Layout
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Tip: We strongly recommend you use <Client name>. If you select Formal Salutation, Informal Salutation,
Salutation 1, Salutation 2, or any user-defined salutations from Configuration, the program reformats each
name, therefore taking much longer to run receipts.

The selection you make in the Format names in receipt address using: [ ] if present field appears in the
address area of the receipt.

The selection you make in the Format names in receipt body using: [ ] if present appears in the body of the
receipt in the section for client activity.

You can select a second name format in the Otherwise use field in situations where the first selection is not
present on the client record. For example, if you select Formal Salutation, and you have clients without a
defined Formal Salutation on the Client 2 tab, the second name format is used. If <Client name> is the first
formatting selection, the Otherwise use field is disabled.

Note: You must have the appropriate security rights to output an addressee/salutation with Social Security
numbers. If you do not have security rights, the numbers are masked. For more information, see the Security
chapter of the Administration Guide for The Financial Edge.

In the For organizations, use name followed by box, mark Organization ID, Contact name, and CFDA # for
these items to appear after the organization name in the different areas of the receipt.

Creating AR Receipt Forms

Note: We offer high-quality, customized forms that are specifically designed for use with our software. These
forms, including checks, student bills, statements, invoices, purchase orders, tax forms, and envelopes, are
pre-printed in color with your organization’s logo and information. For more information, visit our Web site at
http://forms.blackbaud.com or call us toll-free at 866-4-BB-FORMS (866-422-3676).

You can add a message to the receipt, use an electronic signature, and print your organization’s logo. You can also
select the format to use for client names in the address and body of the memo.

» Creating AR receipt forms

In this example, we print AR receipts for clients whose names begin with A through H who made payments
between February 19th and March 19th, 2003.

1.
2.

From the Accounts Receivable Mail page, click Forms. The Forms page appears.

In the list on the left, select AR Receipts and click New on the action bar. The New AR Receipts screen
opens on the General tab.

In the Payment date field, select “Specific range”.
In Start date field, select “February 19th” using the calendar. In the End date field, select “March 19th”.
In the Deposit date field, select “Include all dates”.
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6. Inthe Include payments whose status is [ ] then change the status to printed field, select “Not yet
printed”.

I3 Mew AR Receipts I
File Edit “iew Favortes Tools Help

=R R e |

2 Filters | K3 .&ttlibutesl 4: Format |

L leneral:

Include payments with these dates:

Paprnert date: |<Specific range x| Start date: [02/19/2003 || End date: |03;1 9/2003 EII

Deposit date: Ilnclude all dates i I

Include payment numbers from; I ﬂl ta I ﬂl
Irciude deposit numbers from: I ﬁl ta I ﬁl

Include payments whose status is: ILInprinted vI then change the status to printed.
[~ Create an output queny of IF'ayments VI

< Bach | Mext = | Cancel | Print Freview Layout

7. Click Next or select the Filters tab.

8. Select clients whose names begin with A through H. For more information about filtering, see the
Program Basics Guide.

M@ Mew AR Receipts E

File Edit “iew Favontes Tools Help

=R R e |

1: General & .&ttlibutesl 4: Format |
&8 0pen ) Clear All Filters
Filters I Include I Selected Filkers I
Clients Selected David Adams ko Mr, John Edward Harrison
Client Attributes All <Al Client Attributes =
Banks All <Al Banks>
Deposits Al <Al Deposits=
Payments all <All Payments =
Payment Atkributes Al <All Payment Attributes=
Payment Sources all <Al Payment Sources>

9. Select the Format tab.
10. In the list on the left, select Detail.
11. Mark Show and select “Charges this payment was applied to”.
12. Mark Client address and select “Primary”.



13. Mark USPS bar code.

I Mew AR Receipts

Eile Edit “iew Favortez Tools

Help

= D= RE I ey A

]|

1 Eenerall 2 Filters| 2 Attibutes  4: Farmat |

B Detal |
Sort

Miscellaneous

Receipt Message
Aligriment

Fieceipt Formnat
Organization Name

V¥ Show I Charges thiz payment was applied to j
Include thiz information on the receipt:
¥ Client address: |<F'rimar_l,l> j

™ Clignt contact:

Name Formats

Caontact number: I(None> 'l
Caontact number: I(None> 'l
I~

Address quick view:

el Ll LT
Client name
Address lines

< Back | et | Cancel |

Print

Freview

Layout

14. In the list on the left, select Sort.
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15. In the Sort by and Order by columns on the first row, select “Client Name” and “Ascending” to sort the

AR receipts alphabetically by client names.

I3 Mew AR Receipts

File Edit “iew Favortes Toolz Help

= D= RES = eyl B 25

1 Generall 2 Filters| 3 Aftnbutes  4; Format I

Receipt Format
Organization Mame
Mame Formats

D ekail Sort

t
Miscellansous Sort by I Order by I
Receipt Message Client Marne Lzcending
Aligriment

Note: If you mark Create an output query of [ ] on the General tab, the Save Static Query screen appears so

you can name and save the query.

16. Inthe list on the left, select Receipt Message.
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17. Enter “Thank you for your prompt payment.” in the text box.

I Mew AR Receipts
Eile Edit “iew Favortez Tools Help

FlERE Rl |
1 Eeneral' 2 Filters| 2 Attibutes  4: Farmat |

Detail Receipt Message
2] Sort

Miscellaneous Thig text will print at the end of each receipt:

Thark. you for your prompt payment.

Aligriment

Fieceipt Formnat
Organization Name
Name Formats

18. In the list on the left, select Receipt Format.

19. Mark Print a logo on the form.

20. Inthe Logo file name field, browse to the graphic file containing your organization’s logo.
21. In the Logo size field, select “Large (5 3/8in. X 1in.)".

M@ Mew AR Receipts E I

File Edit “iew Favontes Tools Help
== R e |

1 Generall 2 Filtersl 2 Aftnbutes  4: Format I

Detail Receipt Format
] Sart

Miscellaneous [~ Use an electronic signature
H?Ce'pt Message Authorized signature: |<Ng signatures j
Aligriment
p
Organization Name

M Fi t .
ame Formats [ Frint & logo o the Farm

Laga file name: IE:\M_-,I Pictures\Orglogo.jpg _I

Logosize:  [Large[53/8in. x1in] =l
Mizcellaneous information -

Transactioh spacing ISingle space ﬂ

[ Frint a gray backaround for every other ianzaction
[ Frint a gray backaround for each heading

¢ Back | Ii [ | Cancel | Print | Freview | Layout |

| Press F7 for lookup

22. Click Preview. A message appears telling you the program is processing the mailing, and the preview
screen for the AR receipts appears.

23. Close the preview and return to the Format tab.
24. Click the Save button on the action bar to save the new forms. The Save Mailing as screen appears.
25. In the Mailing name field, enter “February/March A to H”.



Forms 73

26. In the Description field, enter “AR Receipts for Clients A to H for Feb. 19th through Mar. 19th”.

Save Mailing as I
Mailing name: IFeb!March Ao H
Description: [4R Receipts for Clisnts & to H for Feb. 19th thraugh Mar. 15th

¥ Others can wn this mailing
[ Others can madify this maiing

EHsave | Cancel |

27. Click Save to save the new forms. You return to the Format tab.

28. Close the screen. You return to the Forms page, and the AR receipt form named “February/March A to H”
appears in the grid.

Invoice Forms

Note: We offer high-quality, customized forms that are specifically designed for use with our software. These
forms, including checks, student bills, statements, invoices, purchase orders, tax forms, and envelopes, are
pre-printed in color with your organization’s logo and information. For more information, visit our Web site at
http://forms.blackbaud.com or call us toll-free at 866-4-BB-FORMS (866-422-3676).

Invoices are payment requests you send for goods or services rendered. Using the Invoices link in Mail, you can
generate invoices or returns, or invoices and returns in one run. You can print invoices or returns for only the
client who received the goods or services, or for all clients who are assigned charges on the invoice.

Invoice Tabs

A Invoice has tabs on which you select parameters: General, Filters, Attributes, and Format. To move among the
tabs, click Next and Back at the bottom of the screen or select the tab. On these tabs you specify the records to
include in the mailing and how the forms should look.
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General Tab

On the General tab for Invoices, you select parameter settings specific to invoice forms.

1@ Hew Invoices I
Fil=e Edit “iew Favortes Toolz Help

RS W -2 |

2 Filtersl a .t’-‘n.ttributesl ES Folmatl

Ihclude ; IInvoice3 j

Transaction date: IIncIude all dates j

Ordsred on date IIncIude sl dates 7|

Include invaoice 10s fmm:l ﬂl to I ﬁl

Include invoices whose status is: IUnprinled vl then change the status to printed.
Include returnz whoze gtatus i IUnplinted vl then change the gtatus to printed.

Frint an invaice: | Only for the client wha the invoice is for j

I- Create an output guery of IInvoices 'I

< Back Hemt » Cancel Print Preview Layout

Note: If you include only returns, the field names become specific to returns.

Include. In the Include field, select to include Invoices, Returns, or Invoices and Returns in the run of forms.

Invoice date/Returns date. In the Invoice date field, select a date or date range for invoices or returns to
include in the run of forms.

If you select <Specific range>, you can specify a start and end date. If the Start date field is blank, all activity is
included up to the end date. If the End date field is blank, all activity from the start date until present is
included. If both fields are blank, all activity is included.

Ordered on date. In the Ordered on date field, select a date or date range for when orders were placed.

Include invoice/return IDs from [ ] to [ ]. In the Include invoice/return IDs from [ ] to [ ] field, enter or
select a range of invoice/return numbers to include in the invoice. If you leave both fields blank, the invoice
includes all invoice/return numbers.

Include invoices/returns whose status is [ ] then change the status to printed. In the Include
invoices/returns whose status is [ ] field, select Not yet printed, Reprint, or Both. After printing the invoice,
the print status is changed to printed on the invoice record.

Print an invoice. In the Print an invoice [ ] field, select who you want to receive the invoice. To print invoices
for only invoice owners, select Only for the client who the invoice is for. To print invoices for any client who is
named a payer on a charge distribution for that invoice, select For all clients who are assigned charges on the
invoice.

When an invoice prints for a client who is a payer but not the owner of the invoice, the information on the
invoice is only that associated with the owner of the invoice. Any charge information for the payer is not
included on this invoice.
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Create an output query of [ ]. Mark Create an output query of [ ] to create a query of the invoices, returns,
or clients included in the invoice. You can save and use an output query later for other mailings or reports.

Filters Tab

On the Filters tab, you select criteria that determines which items to include in an invoice. For more information
about filtering, see the Program Basics Guide.

1@ Hew Invoices I
Fil=e Edit “iew Favortes Toolz Help
== e |

1: General a .t’-‘n.ttributesl 4 Format |

f®0pen ) Clear Al Filters

Filkars I Include I Selected Filkers

Clignts all <Al Clients=

Client Atkributes all <All Client Attributes>

Invoices all <Al Invoices =

Irvvoice Akbribukes all <Al Inwoice Attributes =

Print Statuses all <All Prink Skatuses >

Returns all <Al Returns =

Rekurn Atkributes all <Al Rekurn Attributes =

Return Ikem Statuses all <Al Return Tkem Statuses =

< Back | Hemt » | Cancel | Print | Preview | Layout |

Open. To open a selection screen to designate specific filters for the form, select a filter in the grid and click
Open on the action bar.

Clear All Filters. To reset each filter to include all, you can click Clear All Filters.

Note: A filter is a requirement items must meet to be included in a form. For example, if you apply the Clients
filter, only transactions for the selected clients appear in the form.

Filters. The Filters column lists all the filters for the form. You cannot edit this column.

Include. By default, in the Include column, each filter is set to All. To open a selection screen to designate
specific filters for the form, choose Selected.

Selected Filters. Filters you specify on the selection screen appear in the Selected Filters column.
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Selected Filters Screen

From the Filters tab, you can open a selection screen for a filter in several ways: by double-clicking the filter in the
grid, selecting the filter in the grid and clicking Open on the action bar, or choosing Selected in the Include
column for the filter.

T ||

Inchude: @ Al P e ® Range @ Ouery | Eravious Filizr  Mest Filker

Clientt Name | Client 1D |

ar. I Cancel |

Include. For each filter, you can include all or select specific filters. Depending on the filter, you may also be able
to filter by a range or query.

All. If you mark Include: All, you cannot designate specific filters.

Selected or Range. If you mark Include: Selected or Range, a grid appears in which you can specify filters. In a
field, you can click the binoculars to search for information.

Query. If you mark Include: Query, the Query name field appears for you to enter the name of the query by
which to filter the form. In the field, you can click the binoculars to search for the query name.

To create a new query, click the binoculars. Then click Add a New Query on the Open Query screen. For more
information about creating queries, see the Query Guide.

Previous Filter. To view or edit the previous filter without returning to the Filters tab, click Previous Filter.
Next Filter. To view or edit the next filter without returning to the Filters tab, click Next Filter.

Attributes Tab

You can use the Attributes tab to add, delete, or update transaction attributes for invoices and returns.

I3 Hew Invoices E

Fil=  Edit “iew Fawortez Toolz Help
A= |

1: General | 2: Filters

: Format I

.-’-'n.ctionl Altribute Type I Description IShortDescripti...I Date IFlequiredI Comments I

-

Action. In the Action column, you can select to add, delete, or update attributes on invoice or return records
when you generate invoice and return forms.
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Note: Attribute types are established in Configuration. For more information about creating attribute types,
see the Configuration Guide for Accounts Receivable.

Attribute Type. In the Attribute Type column, you can select an attribute type.
Description. In the Description column you can enter or select a description for the attribute type.

Short Description. If you selected a table type attribute that uses short descriptions, in the Short Description
column, select the attribute description. The Description column completes automatically.

Date. In the Date column, select the date you add, delete, or update the attribute.

Note: An attribute is a tool used to group information based on a common theme. With attributes defined, you
can filter information to your specifications.

Required. If the attribute type you select is required, the program automatically marks the checkbox in the
Required? column.

Comments. In the Comments column, you can enter free-form text for additional information about the
attribute type.

Format Tab

On the Format tab, you designate the format for the mailing. Settings on this tab determine the appearance of
the forms. You can sort the mailing and select formats for displaying monetary amounts.

Detail. Use Detail to select what items of detail to print on invoices.

I Mew Invoices I
File  Edt “iew Fawaortes Toolz Help

W3S R = 2 |
¥

1 Generall 2 Filtersl 3 Attributes

Sort
Miscellaneous V¥ Show payment and credit detail
Alignment Include this infarmation on the invoice:

Ireoice Format )
Organization Mame W Client addhess: |<Pfimaf}'> j

Mame Formats [ Client contact:

Contact number: |<Ngne> 'I
Contact number: |<Ngne> 'I

" USPS bar code
[~ Ship to address

Address quick wiew:

Client name
Address lines

< Back | L= | Cancel | Print | Freview | Layout |

You can mark Show payment and credit detail to show payments or credits applied to invoices.

You can also select which client address and contact phone numbers to use. Mark USPS bar code and Ship to
address to include these items on the form. The Address quick view box displays the contact information as
it will appear on the form.
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Sort. You can use Sort to select the order for items to appear in the invoices.

I New Invoices

File Edit %iew Favortes Tools Help
u _1 % —a mJ ? .
1 Genelal] s Filters] 3 Altibutes  4: Format ]
5| Detail Sort
=] Mizcellaneous Sort by | Order by |
=] Alignment Irwoice Date Azcending

2] Ireoice Format
2] Organization Marne
=] Mame Formats

In the first row in the Sort by column, select the item to sort the invoice by. You can sort by invoice date,
invoice number, client name, or zip code.

In the Order by column, select Ascending to sort the forms alphabetically or Descending to sort them in
reverse alphabetical order.

Alignment. You can use Alignment to specify vertical and horizontal alignment of the forms and addresses
when you print.

I New Invoices

File Edit Wiew Favorites Tools Help

u _1 % —a mJ ? .
1 Genelal] s Filters] 3 Altributes  4: Format ]
] Detail Alignment
=l Sqrt Form Alignment:
5] Mizcellaneaus

Alignment
=] Inwoice Fomat
2] Orgarization Marme
2] Mame Formats

Wertical alignment; |Defau|t sligrment

ﬂ units = D inch
ﬂ unitz = D inch

Mate: 1 unit equals 1,/100th of an inch or 0.254 millimeters.

Harizantal alignment; | Default alignment

Addrezs Alignment:

Wertical alignment: |Defau|t alignment

j unitz = Jinch
ﬂ units = 0 inch

Mate: 1 unit equals 1/100th of an inch or 0.254 millimeters.

Harizontal alignment: | Diefault aligrment

< Back | | Cancel | Frrint | Preview | Layout |

Note: The maximum alignment adjustment you can enter is 99. This moves the margin .99 inch.

In the Form Alignment frame, you can adjust the form’s top and left margins for printing using the Vertical
alignment and Horizontal alignment fields. You can move printed information up or down or left or right and

enter how much to move the information. For example, if you select Move printed information up and enter
2, the information prints .02 inch higher on the page.
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Addresses for the invoice recipient are aligned by default to fit the first five lines in a standard envelope
address window. If you need to make adjustments, in the Address Alignment frame, you can move printed
information up or down or left or right and enter how much to move the information. For example, if you
select Move printed information up and enter 2, the address prints .02 inch higher on the page.

Invoice Format. You can use Invoice Format to select formatting features for invoices.

1@ New Invoices I
File Edit “iew Fawortes Toolz Help

I = el |

1 Generall 2 Filtersl 2 Attributes 4 Format |

Detail In¥oice Format
5] Sort

Miscellaneous Fomat: ||N\IBB|_|SD|_BPUD1 j ILaser format [blark paper]
ligriment

= Format [+ Print IAmount due "I on invaice header

Organization Mame
Mame Formats [~ Print a logo on the farm

Logo file name: I _I
Logasiezt fLarge (5 3/8in.#1in.) =
tizcellaneous information

Tranzaction spacing ISingle zpace j

[~ Print a gray background for every other transaction
[~ Print a gray background for each heading

< Back | [dEnt s | Caticel | Erint | Freview | Lapout |

In the Format field, select the laser form you use for printing invoices. If you select a blank paper format, you
can print an electronic signature and a logo on the forms.

Note: If you mark Print a logo on the form, you must select the logo file name and logo size. Large logos are
53/8in.x1in; small logos are 2 1/2 in. x 1 in.

You can print in the header the invoice amount due or the date the invoice was printed.

To print your organization’s logo on the forms, mark Print a logo on the form. In the Logo file name field,

browse to the file where your logo is saved in *.bmp format. In the Logo size field, select Large or Small for
the logo size to use on the forms.

In the Miscellaneous information frame, you can make additional formatting selections. In the Line item
spacing field, select single space or double space for the amount of space to leave between lines. To make

reading the forms easier, you can mark Print a gray background for every other line item or Print a gray
background for each heading.
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Organization Name. Use Organization Name to print your organization’s information at the top left of the

form. The information that appears in the Organization name and Address fields defaults from the General
tab of Configuration. If you mark Show organization address, you can enter or edit the name and address.
The Address quick view box displays the information as it will appear on invoices.

n Mew Invoices
File  Edit “iew Fawarites

H <=2 W

1 General] 2 Filters] 2 Attributes 4 Farmat ]

Tonlz Help

? -

Address: (1234 Main Street
Charleston, SC 29123
Phone: [843] 524-6789

Organization Mame
=] Mame Formats

Address quick wiew:

Community Services Inc.
1234 Main Street

Charleston, SC 29123

Phaone: (843) 524-5789

2] Detai Organization Name

=] Sort

2] Miscellaneous ¥ Show organization address

j -;'-"-'lgﬂl'ﬂe:t t Diganization name: [Community Services Inc.
rrvoice Formal

< Back | Cancel

Print | F'levieg| Layout

appears on the client record.

Name Formats. Use Name Formats to select the client name, formal or informal address, or a salutation, as it

n New Invoices
Fil=  Edit Wiew Faworites

EH <=2

1 Genelal] 2 Filters] 3 Attributes 4 Farmat ]

Toolz: Help

? -

2 Detal Name Formats
Sart o . :
j Miscellaneaus Farmat names in invaice address using: |Elient hame j if present
=] Alignment Otherwize use: | J
=] Irmwoice Format L —
5] Urgarization Name For organizations, use name followed by: [ Organization 1D
[T CFDaA#
Format names in inwoice body using: |Elient hame ﬂ if present
Otherwize uze: | J
For organizations, use name followed by: [ Organization |0
[ Contact name
[T CFDa &
< Back Cancel Frrint Preview Layout
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Tip: We strongly recommend you use <Client name>. If you select Formal Salutation, Informal Salutation,
Salutation 1, Salutation 2, or any user-defined salutations from Configuration, the program reformats each
name, therefore taking much longer to run invoices.

The selection you make in the Format names in invoice address using: [ ] if present field appears in the
address area of the invoice.

The selection you make in the Format names in invoice body using: [ ] if present appears in the body of the
invoice in the section for client activity.

You can select a second name format in the Otherwise use field in situations where the first selection is not
present on the client record. For example, if you select Formal Salutation, and you have clients without a
defined Formal Salutation on the Client 2 tab, the second name format is used. If <Client name> is the first
formatting selection, the Otherwise use field is disabled.

Note: You must have the appropriate security rights to output an addressee/salutation with Social Security
numbers. If you do not have security rights, the numbers are masked. For more information, see the Security
chapter of the Administration Guide for The Financial Edge.

In the For organizations, use name followed by box, mark Organization ID, Contact name, and CFDA # for
these items to appear after the organization name in the different areas of the invoice.

Creating Invoice Forms

Note: We offer high-quality, customized forms that are specifically designed for use with our software. These
forms, including checks, student bills, statements, invoices, purchase orders, tax forms, and envelopes, are
pre-printed in color with your organization’s logo and information. For more information, visit our Web site at
http://forms.blackbaud.com or call us toll-free at 866-4-BB-FORMS (866-422-3676).

You can print invoices on blank or pre-printed forms. For blank forms, you can add your organization’s logo. You
can also select the format to use for client names in the address and body of the invoice.
» Creating invoice forms

In this example, we print invoices for clients whose names begin with A through H who received goods or
services between February 19th and March 19th, 2003.

1. From the Accounts Receivable Mail page, click Forms. The Forms page appears.

2. Inthe list on the left, select Invoices and click New on the action bar. The New Invoices screen opens on
the General tab.

In the Include field, select “Invoices”.
In the Transaction date field, select “Specific range”.

In Start date field, select “February 19th” using the calendar. In the End date field, select “March 19th”.
In the Ordered on date field, select “Include all dates”.

No v s~ Ww

In the Include invoices whose status is [ ] then change the status to printed field, select “Not yet
printed”.
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8. In the Print an invoice field, select “Only for the client who the invoice is for”.

I3 Mew Invoices I
Eile Edit “iew Favortez Tools Help

RS R0 2 |

2 Filters | =& Attributesl 4: Farmat |

Include : lm

.Transaction date: |<Specific range> j Start date: ID2H‘ISH2DDBEI End date: m
Ordered on date Ilnclude all dates 'l

Include invaice IDsFrom:I QI o I ﬂl

Include invoizes whose status is: IUnprinted vl then change the status to printed.
Include returns whosze status s IUnprinted vl then change the status to printed.

Frint an invaice: | Orly for the client who the invoice i for j

[~ Create an output query of Ilnvoices 'l

< Bach | Mext = | Cancel | Print Freview Layout

9. Click Next or select the Filters tab.

10. Select clients whose names begin with A through H. For more information about filtering, see the
Program Basics Guide.

I3 Mew Invoices
File Edit “iew Favortes Tools Help

=R R e |

1: General K3 .&ttlibutesl 4: Format |
Filters I Include I Selected Filkers I
Clients Selected David Adams ko Mr, John Edward Harrison
Client attributes all <Al Client Attributes =
Invoices all <Al Invoices >
Invoice Attributes all <Al Invaice Attributes>
Prink Statuses all <Al Prink Statuses =
Returns all <all Returns >
Return Attributes All <Al Return Attributes =
Return Item Statuses all <Al Return Ttem Statuses =

11. Click Next or select the Format tab.

12. In the list on the left, select Detail.

13. Mark Show payment and credit detail.
14. Mark Client address and select “Primary”.



15. Mark USPS bar code.

I3 Mew Invoices

Print Freview

Eile Edit “iew Favortez Tools Help
EH &S & e
1 Eeneral] 2 Filters] 2 Attibutes  4: Farmat l
Detail
=] Sort
2] Miscellaneous W Show payment and credit detail
=l .;ﬁllgn_me:_t Include this information on the invoice:
=] Invoice Format . . -
5] Organization Mame M Client address: |<P”"“‘E"-'f'> j
5] Mame Formats [ Client contact:
[ Ship to address
Address quick view:
el Ll LT
Clignt narne
Address lines
< Back | | Cancel |

Layout

16. In the list on the left, select Sort.
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17. Inthe Sort by and Order by columns on the first row, select “Client Name” and “Ascending” to sort the

invoices alphabetically by client names.

I3 Mew Invoices

File Edit “iew Favortes Toolz Help
H (&= (&E ?-

1 General] 2 Filters] 3 Aftnbutes  4; Format l

=] Orgatization Mame
=] Mame Formats

=] Detail Sort

= Miscellansous Sort by | Order by |
Z] Alignment Cliert Marne: Ascending

2] Invoice Format

Note: If you mark Create an output query of [ ] on the General tab, the Save Static Query screen appears so

you can name and save the query.

18. In the list on the left, select Invoice Format.

19. Mark Print [ ] on the invoice header and select “Amount due”.
20. Mark Print a logo on the form.
21.

In the Logo file name field, browse to the graphic file containing your organization’s logo.
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22.

23.

24,
25.
26.
27.

28.
29.

In the Logo size field, select “Large (5 3/8in. X 1in.)".

I3 Mew Invoices I
Eile Edit “iew Favortez Tools Help

RS R0 2 |

1 Eenerall 2 Filters| 2 Attibutes  4: Farmat |

D etail Invoice Format
2] Sort

Miscellansols Format; IINVBBUSDLBPDM j ILaser format [blank paper)
Alignment

-2 Format [v Print I.é.mount due 'l o invoice header

Drgamization Name
Mame Formats v Print a logo on the form -

Loge file name: |34y PictureshOralogo.jpg =
Logosize  [Largs (5 a/Bin #1in) =l
Mizcelaneous information -

Tranzaction spacing ISingle Fpace j

[~ Print a gray background for every other bransaction
[ Print a gray background for each heading

< Back | et | Cancel | Print | Freview | Layout |

| Press F7 for lookup

Click Preview. A message appears telling you the program is processing the mailing, and the preview
screen for the invoices appears.

Close the preview and return to the Format tab.

Click the Save button on the action bar to save the new forms. The Save Mailing as screen appears.
In the Mailing name field, enter “February/March A to H”.

In the Description field, enter “Invoices for Clients A to H for Feb. 19th through Mar. 19th”.

Save Mailing as I
WMailing name: IFeb!March At H

Desenption: ||rvaices for Clients A ta H for Feb. 19th through bar. 15th

¥ Others can pun this mailing
[ Others can modify this mailing

Hsave | Cancel |

Click Save to save the new forms. You return to the Format tab.

Close the screen. You return to the Forms page, and the invoice form named “February/March A to H”
appears in the grid.

Single Statements

Note: We offer high-quality, customized forms that are specifically designed for use with our software. These

forms,

including checks, student bills, statements, invoices, purchase orders, tax forms, and envelopes, are

pre-printed in color with your organization’s logo and information. For more information, visit our Web site at
http://forms.blackbaud.com or call us toll-free at 866-4-BB-FORMS (866-422-3676).
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Single statements list charge and payment activity you send to one specified client or third party statement
recipient. These are helpful in instances such as when a client requests an additional copy of their statement.

Single Statement Tabs

A single statement has tabs on which you can select parameters: General, Details, Filters, Attributes, and Format.
To move among the tabs, click Next and Back at the bottom of the screen or select the tab. On these tabs you
specify the records to include in the mailing and how the single statements should look.

General Tab

On the General tab for single statements, you select parameter settings specific to single statements. Here you
can select to print or export the information or do both. On the General tab, you can also print single statements
for third-party statement recipients. You can show aging information on the single statements.

M@ Mew Single Statement I
File Edit “iew Favartes Toolz Help

Ha A= - |

1. General |2: Tranzaction Detailsl & I:Iientsl 4: Filters I a8 .l'-\ttlibutesl B Auto F'a_l,ll I Formatl

Statement for:

Clienk Name | Client I0 | sswycroas |
YWhat do you want to do’?
[ Prirt statements [~ Export staterments bo Access
Tranzaction cutaff date: ITcu:Iay ﬂ 08,/05/2005
Statement date: |Tc..;|a_|,| j 08/05/2005

Wwhen a statement recipient paps for multiple clients: {Lse the statement settings for the statement recipient ||

V¥ Include aging infomation on statement: -

Age a3 of: [ < Transaction cutoff date> 7]

Feduce balanzes by unuzed paymentz/creditz beginning with: | The aldest petind j

[~ Create an output query of clients on statements

< HiEck | MHeut » | Cancel Frint | Preview | Layout |

| Press F7 for Client Search

Note: If you mark Print statements, you can also preview the mailing and view a layout of the single
statements. If you mark Export statements to Access, the Preview and Layout buttons become disabled. You
can export single statements only to Microsoft Access.

Statement for. In the Statement for field, you can enter the client’s name or click the binoculars to find the
client for which you want to print the statement.

What do you want to do? In the What do you want to do? frame, you can select to print or export
statements, or both. To print statements on your selected printer, mark Print statements. For more
information about setting up printers, see the Program Basics Guide. If you mark Export statements to
Access, the program creates a *.mdb file containing a database of statement recipients, transactions, and
other statement information that you can use in Microsoft Access.

Transaction cutoff date. In the Transaction cutoff date field, select a date to define the last day for the period
of open transactions to include in the statement. You can select Today, Yesterday, Tomorrow, or a specific
date. The dates used in this period are the transaction dates from payment, charge, and credit records and
the invoice date from invoice records.
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Statement date. In the Statement date field, you can select the date the statement is created — Today,
Yesterday, Tomorrow, a specific date, or the transaction cutoff date.

When a statement recipient pays for multiple clients. In the When a statement recipient pays for
multiple clients field, you can select:

¢ Use the statement settings for the statement recipient — The program compiles client activity according to
your selections on the Statements tab of the client record.

¢ Create one statement per client — The program prints a separate statement for each client.

¢ Combine clients onto one statement — The program prints a single statement for each statement recipient
with payees combined onto the statement.

Include aging information on statement. If you mark Include aging information on statement, you can
select a date in the Age as of field. In Reduce balances by unused payments/credits beginning with, you can
select to reduce balances with unapplied payments and credits by the oldest period or the most recent
period. The reduced balance total appears in the aging periods section at the bottom of the statement. For
more information about defining aging periods, see the Configuration Guide for Accounts Receivable.

Create an output query of clients on statements. Mark Create an output query of clients on statements
to create a query of all clients with activity appearing on any statement in the statement run. You can save
and use an output query later for reports or other mailings.

Details Tab

On the Details tab for statements, you can show summarized or detailed activity and group the information by
client. You can also select whether to summarize and display finance charges.

M@ Mew Single Statement I
File Edit “iew Favartes Toolz Help

e = |

o I:Iientsl 4 Filtersl B Altrbutes | B Auto F'ayl T Formatl

1. General

[~ Summarize transactions before: IThe zame day of previous month based on tranzaction cutoff date j

Summary texk | S urmmary balance as of ¥ | [relide summeandate

Show transaction detail for:

[ Fully paid charges
[ Invoices and returns

[ Sales tax transactions

Shaw tranzaction surmmary far -
[ Transactions on this statement

I Show conmbined summan aerass multiple clents o eack statemert
Surnmarize by ITransaclinn type j
[ Transactions across thiz date range: IThiS fiscal pear ﬂ 0101 /2005 ta 12/31./2005

[T Slicw carmbited suminman aenass mulbipEclients o eack statemett

Summarize by: ITlansaction type j

< Back | Hewt » | Cancel | Frint | Preview | Layout |

Summarize transactions before. Mark Summarize transactions before to add a summary balance of client
activity that occurred before the specified date. This is useful if statements are long. Transactions after the
selected date appear in detail on the statement.

When you mark Summarize transactions before, you must select one of these dates to determine the
summary period:
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¢ The same day of previous month based on transaction cutoff date — If you select this option, the transaction
cutoff date from the General tab is used to determine which day of the previous month to use as a summary
date.

¢ Specific date — If you select this option, the Date field appears so you can enter or select a date.

e Recurring date — If you select this option, the The [ ] day of [ ] fields appear so you can select the date to
use to summarize previous transactions. You must specify both a day and month.

If you include a summary balance, the text “Summary balance as of” prints automatically on statements, but
you can enter your own message in the Summary text field. To print the date following the text, mark Include
summary date.

Show transaction detail for. In the Show transaction detail for frame, you can mark the transactions you
want to show in detail.

If you mark Fully paid charges, fully paid charges, invoices, invoice line items, and refunds appear as separate
lines on the statement. If you leave Fully paid charges unmarked, fully paid charges, invoices, invoice line
items, and refunds are summarized in a single line on the statement.

If you mark Invoices and returns, invoices and returns appear as separate line items on the statement. Each
line item is treated as a charge and appears in a separate line on the statement, just as charges do. If you
leave Invoices and returns unmarked, invoices and returns appear on the statement as a summary of their
line items. An invoice or return transaction may appear on multiple statements if its line items were
distributed to or partially paid by multiple clients. The invoice or return will appear in the statement body or
sub-section of a third party statement for each paying or distributed client. The amount of the invoice or
return is adjusted to reflect each client's portion.

Note: If you mark the business rule not to use sales tax, Sales tax transactions does not appear in the Show
transaction detail for frame. For more information about business rules, see the Configuration Guide for
Accounts Receivable.

If you mark Sales tax transactions, sales tax appears separately from the associated charge or credit. If you
unmark the checkbox, the program adds sales tax transaction totals to the charge or credit total.

Show transaction summary for. In the Show transaction summary for frame, you can mark Transactions on
this statement to print an additional subsection on the statement containing a statement summary. When
this option is marked, you can mark Show combined summary across multiple clients on each statement to
combine the activity of multiple clients into a summarized total. In the Summarize by field, select to
summarize the activity by Transaction type or Product/Billing Item. If you leave Show combined summary
across multiple clients on each statement unmarked, a separate activity summary appears for each client.

Note: If you mark Transactions across this date range and mark Include summary of finance charges in
Finance Charge Format on the Format tab, the date range selected here determines the date range for the
summary of finance charges.

You can mark Transactions across this date range to print an additional subsection on the statement
containing a statement summary for the specified date range. When this option is marked, you can mark
Show combined summary across multiple clients on each statement to combine the activity of multiple
clients into a summarized total. In the Summarize by field, select to summarize the activity by Transaction
type or Product/Billing Item. If you leave Show combined summary across multiple clients on each
statement unmarked, a separate activity summary appears for each client in the date range summary
subsection.
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Clients Tab

You can use the Clients tab to add additional information for clients related to the client you are creating the
statement for. You can also select the clients and payers who should receive statements or copies of statements.

I@ Hew Single Statement I
File Edit “iew Favortes Toolz Help

dadatE A= - |

| 4: Filters | 5 .-’-\ttlibutesl B Auto F'ayl 7 Format

1. General | 2 Tranzaction Detailz

(51 M Tranzactions for these chents j M Include statement copies  ©i Find - Select &1

Include | Clienk Name | Client I0 | SSM [ CFDA #

Include. In the Include field, select Statements for these payers or Transactions for these clients. Select
Statements for these payers to display in the grid all related clients who receive statements for this client.
Select Transactions for these clients to display in the grid all related clients the client receives statements for.

Include statement copies. Mark Include statement copies, to print copies for each payer and related client
you mark to include in the Include column of the grid. If you leave this checkbox unmarked, statement copies
are not printed.

Find. Click Find to access the Find screen. On the Find screen, you can quickly find a client by searching by client
name, client ID, or SSN/CFDA number rather than spending time scrolling through entries. For more
information about using Find, see the Program Basics Guide.

Select All. Click Select All to mark all checkboxes in the Include column.
Deselect All. Click Deselect All to unmark all checkboxes in the Include column.

Include. In the Include column of the grid, mark the checkbox for each payer or related client you want to
include in the statement run.

Client Name. The Client Name column lists all related clients or payers based on your selection in the Include
field. If you selected Statements for these payers, the column displays all related clients who receive
statements for this client. If you selected Transactions for these clients, the column displays all related clients
the client receives statements for. You cannot edit information in this column — it is for informational
purposes only.

Client ID. The Client ID column lists client IDs for clients and payers listed in the Client Name column. You
cannot edit information in this column — it is for informational purposes only.

SSN/CFDA#. The SSN/CFDA# column lists Social Security and Catalog of Federal Domestic Assistance numbers
for clients and payers listed in the Client Name column. You cannot edit information in this column — it is for
informational purposes only.

Filters Tab

Note: It is important to use the Product and Billing Items on Charges or Product and Billing Item Attributes
filters carefully so you do not underbill a client. Filtering by these items may result in some charges being
omitted unintentionally.
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On the Filters tab, you select criteria that determines which items to include in a statement. You can filter by
Product and Billing ltems on Charges or Product and Billing Item Attributes. It is important to use these filters
carefully so you do not underbill a client. When you filter by these items, only charges with the selected products
or billing items appear on the statements; therefore, charges for other products or billing items and any
applications made to these charges (regardless of the application’s billing item) are not included in the
statement. For basic information about filtering criteria, see the Program Basics Guide.

I3 Mew Single Statement E

File Edit “iew Fawortez Toolz Help
dada a4 2- |

21| 5 Attributes | B Auto Pay | 7: Farmat

1: General | 2 Transaction Detailsl 3 Clients

&3 0pen Clear All Filters

Filters I Include Selected Filkers
Product and Billing Items o... &l <8l Product and Biling Items on Charges =
Product and Billing Item Ak... &l <Al Product and Billing Ikem Aktribukes =

Open. To open a selection screen to designate specific filters for the form, select a filter in the grid and click
Open on the action bar.

Clear All Filters. To reset each filter to include all, you can click Clear All Filters.

Note: A filter is a requirement items must meet to be included in a form. For example, if you apply the Clients
filter, only transactions for the selected clients appear in the form.

Filters. The Filters column lists all the filters for the form. You cannot edit this column.

Include. By default, in the Include column, each filter is set to All. To open a selection screen to designate
specific filters for the form, choose Selected.

Selected Filters. Filters you specify on the selection screen appear in the Selected Filters column.
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Selected Filters Screen

From the Filters tab, you can open a selection screen for a filter in several ways: by double-clicking the filter in the
grid, selecting the filter in the grid and clicking Open on the action bar, or choosing Selected in the Include
column for the filter.

Product and Billing Items on Charges I

Include: @ Al O Selected  ® Fange % Query | Fi=zwiaus Filizr  Next Filter

Product or Eilling Item on Chargesl Description |

ar. I Cancel |

Include. For each filter, you can include all or select specific filters. Depending on the filter, you may also be able
to filter by a range or query.

All. If you mark Include: All, you cannot designate specific filters.

Selected or Range. If you mark Include: Selected or Range, a grid appears in which you can specify filters. In a
field, you can click the binoculars to search for information.

Query. If you mark Include: Query, the Query name field appears for you to enter the name of the query by
which to filter the form. In the field, you can click the binoculars to search for the query name.

To create a new query, click the binoculars. Then click Add a New Query on the Open Query screen. For more
information about creating queries, see the Query Guide.

Previous Filter. To view or edit the previous filter without returning to the Filters tab, click Previous Filter.
Next Filter. To view or edit the next filter without returning to the Filters tab, click Next Filter.
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Attributes Tab

You can use the Attributes tab to add, delete, or update attributes for statement recipients and clients who
receive statement copies.

I@ Hew Single Statement
File Edit “iew Favortez Toolz Help

Ba3aga=e- |

B: Auto Pay | 7 Farmat |

1. General | 2 Tranzaction Detailsl & Elientsl 4 Filters

.ﬁ.ctinnl Aktribute Type I Descripkion IShort Descriptinnl Date IRequiredI Comments I

=

Action. In the Action column, you can select to add, delete, or update attributes on the client record when you
generate statements.

Note: Attribute types are established in Configuration. For more information about creating attribute types,
see the Configuration Guide for Accounts Receivable.

Attribute Type. In the Attribute Type column, you can select an attribute type.
Description. In the Description column you can enter or select a description for the attribute type.

Short Description. If you selected a table type attribute that uses short descriptions, in the Short Description
column, select the attribute description. The Description column completes automatically.

Date. In the Date column, select the date you add, delete, or update the attribute.

Note: An attribute is a tool used to group information based on a common theme. With attributes defined, you
can filter information to your specifications.

Required. If the attribute type you select is required, the program automatically marks the checkbox in the
Required column.

Comments. In the Comments column, you can enter free-form text for additional information about the
attribute type.

Auto Pay Tab

If you have the optional module Electronic Funds Transfer, you can use the Auto Pay tab to create automatic EFT
payments for clients with variable amount automatic payments set up on the Automatic Payments tab of their
record.

When you print or export statements, the program generates all charges and credits and applies payments for
the record based on the statement criteria. Payments apply to associated charges as determined by the Accounts
Receivable business rule settings. The automatic payment is recorded on the statement and on the payer’s
Activity and Automatic Payment tabs. The payment also appears on the payee’s Activity tab.



92 CHAPTER

The program creates one deposit and payment record for the calculated balance using the information you enter
on the Auto Pay tab. When you run Create an EFT file in Deposit tasks for Banks, the deposit record updates
automatically with the date the EFT file was created.

M@ Mew Single Statement

File Edit “iew Favortez Toolz Help

DS a2

1. General | 2 Tranzaction Detailsl & Elient$| 4 Filters | & Aftributes

[~ Create automatic variable amaount payments based on statement criteria

Depozit Information -
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< Back | MHeut » | Cancel | Frint | Preview Layout

Create automatic variable amount payments based on statement criteria. Mark this option to
generate variable amount automatic payments. This enables the other options on this tab. If this option is not
marked, no automatic payments are created.

Note: The deposit information entered on the Auto Pay tab is used for all payments in the deposit.

Deposit date. In the Deposit date field, enter the date the deposit is made to the bank account.
Entry date. In the Entry date field, enter the date the deposit is entered in the program.

Status. In the Status field, select Open or Closed. You cannot add new payments to a closed deposit.
Post status. In the Post status field, select a post status for the deposit.

Post date. In the Post date field, enter the date to post the deposit. The information in the Post status and Post
date fields defaults automatically to the payments added to the deposit. You post deposits, not individual
payments.

Description. In the Description field, enter a description of the deposit or any other information you want to
record about the deposit.

Payment date. In the Payment date field, enter the date the payment was received.

Source. For variable payments not paid by EFT, in the Source field, select the payment source such as mail or in
person.

Post status. The post status defaults from the deposit record. You post deposits, not individual payments.
Post date. The post date defaults from the deposit record. You post deposits, not individual payments.
Comment. In the Comment field, you can enter a note about the payment.
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Format Tab

On the Format tab, you designate the format and appearance of the statement. You can sort the information,
make selections for details and formats, and align the statements on paper or forms. You can combine payments
into a single transaction instead of printing them as separate transactions.

Note: If you mark Show barcode, select a font and size in the Font and Font size fields.

Detail. Use Detail to select extra details to print on the statements.

I New Single Statement I
File Edt “iew Faworites Toolz Help

dada o4 ?- |
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If you mark Show statement reference number, the program generates a number to appear on the
statement beneath the statement date. To display the reference number as a barcode, mark Show barcode.

If you mark Show print date on statement, the printing date appears on the statements beneath the
statement date.

If you mark Show credit balances as $0.00, the amount due balance and aging balances appear as a zero
amount if they are credit balances.

If you mark Show statement due date, you can select the date payments are due. In the Due date field, select
Today and a number of days in the plus [ ] days fields or select <Specific date> and use the calendar to select
a date.

If you mark Show minimum amount due as, you can select a percentage of the total due or enter a specific
amount.



94 CHAPTER

Statement Sort. Use Statement Sort to select the order to print statements. When you select Statement Sort,
a grid appears. Select a sorting category in the Sort by column and select Ascending or Descending in the
Order by column. If you make no selections in the Sort by column, the program sorts by client name in

ascending order.

=] Detail

2] Organization Marne

2] address Detail

2] Finance Charge Format
Z] Mame Formats

2] Transaction Sort

] Statement Format

] Statement Message

Miscellaneous. Use Miscellaneous to specify how you want numbers to appear on the statements and the font

size for statements.

i General] 2 Tranzaction Details] a8 Clients] 4 Filters] 5 .-’-‘«ttributes] E: Auto Pay

Statement Sort

I New Single Statement
File  Edt “iew Faworites Toolz Help
#ﬂ g ..i‘:! d'..r_.)%' m..l ? i

(=i L
2] Miscellaneous Sart by | Order by |
=] Alignment Clignt Narme Ascending

I New Single Statement |
File  Edit - Yiew  Fawarites - Tools Help
\'ﬂ‘_\lp é ﬁ'lll;li l ? %
1 General1 2 Tranzaction Details1 2 Clientsi 4 Filters] & .&ttributesi E: At Pay
=] Dretail Miscellaneous
5] Skatement Sart
aneous Show cumency character on All amaounts
2] Alignment Shaow percent sign on All amounts
S ,E.;%amzagon fTame Megative amount format [1234.56]
= ) ress Detal Mumber of digits after decimal for amounts 2
Z] Finance Charge Format = =
2] Mame Formats Mumber of digitz after decimal for percentages 2
5] Trarsaction Sort Show 1000's zeparator Yes
=] Statement Farmat Show blanks instead of zeros Mo
5] Statement Message Fant size 9
Sample amount:
Amount [$1.234.5E]
Percent 100.00%
< Back Cancel Frrint Freview Layout
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Alignment. You can use Alignment to specify vertical and horizontal alignment of the forms and addresses

when you print.

I New Single Statement

File - Edit  “iew - Fawortes

el

]

x|
Toalz  Help
= |

Az Generall 2 Tranzaction Detailsl 3 Clientsl 4 Filtersl B .&ttributesl E: Auta Pay

Detail
Statement Sort
Miscellaneous

‘B Alignment
Orgarization Mame
Address Detail

Finance Charge Format
Mame Formats
Tranzaction Sort
Statement Format
Statement Message

Farm Alignment; -

Wertical alignment: IDefauIt aligrment ﬂ I units = Dinch

Harizantal alignmet: IDefauIt aligriment j | utitz = Oinch
Mate: 1 unit equals 1,/100th of an inch or 0.254 millimeters,

Address Alignment;

Wertical alignment: IDefauIt aligrment j | units = Oinch

Harizontal alignment: IDefauIt aligrment j I units = Dinch

Mate: 1 unit equals 1/100th of an inch or 0.254 millimeters.

< Back | [Hexts

Cancel Frirt Preview Layout

Note: The maximum alignment adjustment you can enter is 99. This moves the margin .99 inch.

In the Form Alignment frame, you can adjust the form’s top and left margins for printing using the Vertical

alignment and Horizontal alignment fields. You can move printed information up or down or left or right and
enter how much to move the information. For example, if you select Move printed information up and enter
2, the information prints .02 inch higher on the page.

Addresses for the statement recipient are aligned by default to fit the first five lines in a standard envelope
address window. If you need to make adjustments, in the Address Alignment frame, you can move printed
information up or down or left or right and enter how much to move the information. For example, if you

select Move printed information up and enter 2, the address prints .02 inch higher on the page.
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Organization Name.

Use Organization Name to print your organization’s information at the top left of the
form. The information that appears in the Organization name and Address fields defaults from the General
tab of Configuration. If you mark Show organization address, you can enter or edit the name and address.
The Address quick view box displays the information as it will appear on statements.

u Hew Single Statement

File Edit Wiew Favortes  Tools  Help
-Eﬁ tal —{‘ ﬁ m‘I ? n
1 Genelal] 2 Tranzachon Details] 3 Clients] 4 Filtersl B .&ttributes] B Auto Pap
2] Detai Organization Name
=] Statement Sort
2] Miscellaneous ¥ Show organization address
-l hgnment Organization name: |Eommunity Semvices [ne.
Orgal ion Mame
5] Address Detail Address: 1234 Main Sireet =]
Z] Finance Charge Format Charlestan. 5C 23123
2] Mame Formats
] Transaction Sort J
=l gtatement :dormat &ddress quick view:
=] Statement Meszage = =
Community Services Inc.
1234 Main Street
Charleston, SC 29123
< Back | | Cancel | Frrint | Freview Layout |

Address Detail. Use Address Detail to select the address information appearing in the address section of

statements.
I New Single Statement
Filz Edit  Wiew Favortes  Toolz  Help
-.-_'f Ll _=,-‘ri *‘_ﬁ m-‘l ? it
e Genelal] 2 Tranzaction Details] 3 Clients] 4 Filtersl B .&ttributes] E: Avuto Pay
=] Detal Address Detail
] Statement Sort
2] Miscellansous [v Show statement recipient address:
=] Alignment Address | <Bill Tox -
-l anlzahon ame [ Show comtact information in address
Addr bai
=] Finance Charge Format | J
=] Mame Formats
2] Transaction Sort | J
2] Statement Farmat [~ Show USPS barcode in address
2] Statement Message Address quick view:
Client Hame Here
ddress line 1
ddrezz line 2
ddress line 3
< Back Cancel Frirt Preview Layout
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If you mark Show statement recipient address, you can select to display the billing, primary, or shipping
address of the recipients.

Note: You enter telephone numbers for contacts on the Client 1 tab of the client record.

To print telephone numbers or Web or email addresses, mark Show contact information in address and
select a number or address in the Contact Number fields. If the client is an organization, the contact’s name
appears in the ATTN line.

You can mark Show USPS barcode in address to print the barcode on the statements above the address.
The Address quick view displays the address information as it will appear on statements.

Finance Charge Format. Use Finance Charge Format to select and define information to appear Finance

Charge Information section of the statements.

I New Single Statement I
Filz Edit  Wiew Favortes  Toolz  Help

Bl Sag alee- |

i Genelall 2 Tranzaction Detailsl 3 Clientsl 4 Filtersl B .&ttributesl E: Avuto Pay

Detai Finance Charge Format
Statement Sort

Mizcelaneous ™ Include closing date of biling cycle: |03£28£2003 EI
Alignment

Drgarization Marme
Address Detail

[ Include finance charge disclosure statement:

=

B Finance Charge Format
Mame Formats
Tranzaction Sort

Statement Format =l
Statement Message

[ Include calculation information for finance charges

™ Include summary of finance charges

Summary date range: I This fizcal period j 03/01/2003 to 03/31/2003

Description: |

< Back | L= | Cancel | Frrint | Freview | Layout |

Mark Include closing date of billing cycle to include the closing date on the statements. The closing date
defaults to the transaction cutoff date from the General tab or you can select a different date. For example, if
you select May 31, 2003, as the closing date, “Closing date of billing cycle: 05/31/2003” appears in the
Finance Charge Information section of the statements.

If you mark Include finance charge disclosure statement, you can create a disclosure statement. Enter the
text for the statement in the text box.

If you mark Include calculation information for finance charges, the calculation date and percentage rate
appear in a message on the statements. For example, “The finance charge dated 0501/2003 was calculated
as of 04/30/2003 using an annual percentage rate of 10%. The balance subject to finance charge was
$100.00.”

If you mark Include summary of finance charges, a total of finance charges appears in the Finance Charge
Information section of the statements. In the Summary date range field, you can include all dates or select a
specific date or range. In the Description field, you can enter text to precede the total finance charge amount
appearing on the statements, for example, “Year-to-date finance charges:”. If you mark Transactions across
this date range on the Details tab, the summary of finance charges is for the same date range selected on the
Details tab.
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Name Formats. Use Name Formats to select the client/organization name, formal or informal address, or a
salutation, as it appears on the client record.

I New Single Statement
Filz Edit  Wiew Favortes  Toolz  Help
-.-_'f Ll _=,-‘ri *‘_ﬁ m-‘l i ? it

3 0aa

e Genelal] 2 Tranzaction Details] 3 Clients] 4 Filtersl B .&ttributes] E: Avuto Pay

Staternent Sort ; - _
j Miscellanzous Farmat names in statement address using: |Elient hame j if present
] Alignment Othenvize use: | J
2] Organization Mame o
2] Address Detail For organizations, use name followed by: | ™ Orgarization |0
2] Finance Charge Fomat [ CFDA #
3 Transaction Sor Format names in charges for box using: |Elient hame ﬂ if present

=] Statement Format Othenwize use: | J
2] Statement Message

For organizations, use name followed by: [ Organization |0
[T CFDa #
Format names in statement body using: |Elient hame ﬂ if present
Othenwize use: | J
For arganizations, use name followed by: [ Organization (D j

[T Contact name =

< Back | | Cancel | Frirt | Preview | Layout |

Tip: We strongly recommend you use <Client name>. If you select Formal Salutation, Informal Salutation,
Salutation 1, Salutation 2, or any user-defined salutations from Configuration, the program reformats each
name, therefore taking much longer to run single statements.

The selection you make in the Format names in statement address using: [ ] if present field appears in the
address area of the statement.

The selection you make in the Format names in charges for box using: [ ] if present appears in the body of
the statement in the section for client activity.

The selection you make in the Format names in statement body using: [ ] if present appears in the body of
the statement in the section for client activity. However, if a statement does not print multiple clients’

activity or does not separate activity by client, the Format names in statement body using: [ ] if present field

does not appear.

Note: You must have the appropriate security rights to output an addressee/salutation with Social Security
numbers. If you do not have security rights, the numbers are masked. For more information, see the Security
chapter of the Administration Guide for The Financial Edge.

You can select a second name format in the Otherwise use field in situations where the first selection is not
present on the client record. For example, if you select Formal Salutation, and you have clients without a
defined Formal Salutation on the Client 2 tab, the second name format is used. If <Client name> is the first
formatting selection, the Otherwise use field is disabled.

In the For organizations, use name followed by box, mark Organization ID, Contact Name, and CFDA # for
these items to appear after the organization name in the different areas of the statement.

Note: If you sort by Transaction Type, the Show credits/payments with their associated charges checkbox
becomes disabled.
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Transaction Sort. Use Transaction Sort to select the order for information to appear in the body of the
statements.

I New Single Statement I
Filz Edit  Wiew Favortes  Toolz  Help

Ao gan alee- |

e Genelall 2 Tranzaction Detailsl 3 Clientsl 4 Filtersl B .&ttributesl E: Avuto Pay

Detai Transaction Sort

Statement Sort
Miscellaneaus St by | Order by | Subtotal? |
Alignmert Client Name Azcending
Orgarization Mame
Address Detail

Finance Charge Format
Marme Formats

H E Tranzaction Sort
Statement Format
Statement Message

Tranzaction D ate Azoending

i A i i

[~ Show credits/payrments with their associated charges
™| Combite paprernt distibuticns inte & sihale @ avment ansaction

< Back | [Hexts | Cancel | Frirt | Preview | Layout |

When you select Sort, a grid displaying the categories you can sort in the statements. Select a sorting
category in the Sort by column and select Ascending or Descending in the Order by column. To print a
subtotal for each category sorted, mark the checkbox in the Subtotal? column.

Note: If you mark Show credits/payments with their associated charges, refunds appear immediately after
the credit/payment applied to them.

If you mark Show credits/payments with their associated charges, applied portions of credits and payments
appear immediately after the charges to which each is applied, in the order in which they were applied,
sorted as designated in the grid.

If you leave Show credits/payments with their associated charges unmarked, credits and payments appear
according to the selection in the Transaction Sort grid. If you sort by Transaction Type and mark Combine
payment distributions into a single payment transaction, you can also show payments as a single
transaction instead of separate transactions.
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Statement Format. Use Statement Format to make formatting selections for the statement forms.

I New Single Statement I
File Edit Wiew Favortes  Tools  Help

dadad dde- |

1 Genelall 2 Tranzachon Detailsl 3 Clientsl 4 Filtersl B .f-\ttributesl B Auto Pap

Detail Statement Format
Statement Sort

izcellaneousz Statement folmat:lSTM,&HUS‘]PPDm j IE.:-: Charge/Credit [Lazer pre-prinked form)
Alignent ; . L
Organization Name Mumber of copies to print for each statement: I‘I = [ Collate
Address Detai I Brint & laga o the farm -
Finance Charge Format ) _
Mame Formats Laga file name: I _I
Transaction Sait Logasize: [Smal (2 1/2in. = 1in) =
‘B Statement Format
Statement Message Miscellaneous information-
Transaction spacing ISingle FPACE j

[~ Print a gray background for every ather transaction
= Eritit & arayw Bar for, each beading
[~ Print total number of pages on each page

< Back | et | Cancel | Erirt | Preview | Layout |

In the Miscellaneous information frame, you can make additional formatting selections. In the Transaction
spacing field, select Single space or Double space as the amount of space to leave between lines. To make
reading statements easier, you can mark Print a gray background for every other transaction or Print a gray
background for each heading. You can record page numbers on the statements by marking Print total
number of pages on each page.
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Statement Message. Use Statement Message to print additional information for recipients.

I New Single Statement [ x|
File Edit Wiew Favorites Tools Help

EIEEEEIEEEE |
1: General' 2 Detailsl & Elientsl 4 Filters| & Attributesl B Auto Pay ¥ Format |

Detail Statement Message

Statement Sort

Mizcelaneous Frint statement comments fram each record: I,.*_\t the end j

Alignment Frint this message at the end of each statement page:-

Organization Name =1
Address Detail I =l

Finance Charge Format |1 g statement copy meszage exists, print this meszage on each copy: -

M ame Formats I
Trangaction Sort

Statement Format IF the copy recipient should not see the amount due, display the amount a$:| <Blanks vl
Frint these mezsages for each aging period: -
Aging meszages will print based on the past due statuz of each balance.

{8 Statement Message

Aging Period Message I
current
31-60
61-90
aver 90
< Back | [ (= | Cancel | Print | Preview | Layout |

In the Miscellaneous information frame, you can make additional formatting selections. In the Transaction
spacing field, select Single space or Double space as the amount of space to leave between lines. To make
reading statements easier, you can mark Print a gray background for every other transaction or Print a gray
background for each heading. You can record page numbers on the statements by marking Print total
number of pages on each page.

Statement Message. If you entered information on the notes tab of a record, you can choose where to Print
statement comments from each record. You can select At the end or At the beginning. You can enter text in
the Print this message at the end of each statement page and If no statement copy message exists, print
this message on each copy fields. If you do not want a recipient to see the amount due, you can select
<Blank>, ***, or 0.00 in the If the copy recipient should not see the amount due, display the amount as [ ]
field. In the aging periods grid, you can enter messages for each period.

Creating Accounts Receivable Single Statements

Note: We offer high-quality, customized forms that are specifically designed for use with our software. These
forms, including checks, student bills, statements, invoices, purchase orders, tax forms, and envelopes, are
pre-printed in color with your organization’s logo and information. For more information, visit our Web site at
http://forms.blackbaud.com or call us toll-free at 866-4-BB-FORMS (866-422-3676).

You can use the Clients tab to include in the statement additional information for clients related to the client you
are creating the statement for. You can also select the clients and payers who should receive statements or
copies of statements.

» Creating Accounts Receivable single statements

In this example, we print a single statement for Ashley Smith containing all of her transactions as of today’s
date.

1. From the Mail page in Accounts Receivable, click Forms. The Forms page appears.
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2.

In the list on the left, select Single Statements and click New on the action bar. The New Single

Statement screen appears.

Note: To export statement information, mark Export statements to Access. For more information about
exporting in Mail, see “Exporting a mailing” on page 15.

3.
4.

In the Statement for grid, select “Ashley Smith” in the Client Name column.

In the What do you want to do? frame, mark Print Statements.

In the Transaction cutoff date and Statement date fields, select “Today”.

File “Edit  “iew Favontes  Tools Help

i3 d9 e

I3 Mew Single Statement I

2 Tranzaction Detailsl & Elientsl 4 Filtersl 5 Attributes | E: Auta F'a_l,JI 7 Formatl

Wwhen a statement recipient pays for multiple clients: IUse the: statement setings for the statement recipient j

¥ Include aging information on statement: -

Statement for. Cliert Hame | Cliert ID | sswicroae |
Ashlew Smith 14

What do pou want to do?

¥ Frint staterments [ Export statements bo Access

Transachion cutoff date; ITDda-'" j 04401 /2003

Statement date; Inga}. j 04/01,/2003

Age as of: |<Transacti0n cutoff date> ¥ |

Reduce balances by unused payments/credits beginning with: | The cldest period j

[~ Create an output queny of clients on statements

¢ Bach | Mest » | Cancel | Frint | Previeﬂl Layout

6. Click Next or select the Details tab.
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7. Mark Transactions on this statement to print an additional subsection on the statement containing a

10.
11.

statement summary. In the Summarize by field, select “Transaction type”.

I Mew Single Statement I
Eile: Edit Wiew  Favontez Toolz Help

da a2t \

1: General |§: Clientsl 4 Filtersl 5 Altributes | B: Auta F'a_l,ll e Formall il Formatl

[ Summarize ransactions befare: IThe zame day of previous month based on transaction cutaff date j

Summary text: ISummal_l,l balance az of ¥ | Include summarny date

Show transaction detail for:
¥ Fully paid charges
IV Irwoices and ratums

¥ Sales tax tranzactions

Show tranzaction summary for
¥ Transactions on this statement

[~ Show combined summany across multiple clients on each stabement

Surnrnarize: by: ITransaction type 'l
[™ Transactions across this date range: IThig fizcal pear vl 0140142003 ko 12431 /2003

™| Shaw combited summan acrass multiple clients on each staterment

Summarize by: ITransaction type 'I

< Back | Mext = | Cancel | Frrint Freview Layout

Select the Format tab.

In the list on the left, select Detail.
Mark Show barcode.

Mark Show statement due date.
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12. Mark Show minimum amount due as [ ], select “Percent of total amount”, and enter “50” in the percent
field.

]|

u Mew Single Statement
Eile Edit ¥iew Favontes  Toolz  Help
Qi S acd a9
i General1 2 Tranzaction Detailsi 3 Elients] & Filters] 5 Attributes ] B Auta Pap

=] Statement Sort
= Miscellansous
S Alignment

V¥ Show statement reference number

v Show barcode
=] Organization Name

5 Adsress Detai Font: |2 of 3 Barcode »| Fontsize: |10 =

& Finance Charge Format| [ Show print date on statement

=] Name Formats
=] Trahzaction Sart
=] Statement Format

[ Show credit balances az $0.00
¥ Show statement dus date

Due date:

<Statement date:

ﬂ plus ,ﬁ days

=] Statement Message

v Show minimum amount due as: |F'ercent of tatal amaount ﬂ |5IJ percent
< Back | | Cancel | Frrint Freview Layout
13. In the list on the left, select Address Detail.
14. Mark Show statement recipient address and select “Bill to”.
15. Mark Show USPS barcode in address.
I3 Mew Single Statement |

Eile Edit ¥iew Favontes  Toolz  Help
D G 2

i General1 2 Tranzaction Detailsi 3 Elients] & Filters] 5 Attributes ] B Auta Pap

=] Detail

=] Statement Sort
g Miscellaneous
=] Alignment

W Show statement recipient address:

Address: | <Bill Tax -

[~ Show contact information in address

[~ |
[~ |

2] Finance Charge Format |
=] Wame Formats |
=] Transaction Sort
=] Statement Format
5] Statement Meszage

¥ Show USPS barcode in addiess

Address quick wiew:

Address Detail

Client Name Here
ddress line 1
ddress line 2
ddressz line 3

¢ Back | | Cancel | Frint Freview

Layout

16. In the list on the left, select Finance Charge Format.
17. Mark Include closing date of billing cycle.
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18. Mark Include finance charge disclosure statement and enter in the text box “An additional charge at a
daily percentage rate of 1.5% may apply to an unpaid balance.”

I Mew Single Statement |
Eile Edit “iew  Favortes - Tools Help
daIs 2t

1: Generali 2 Transaction DetaiI81 2 Clients] 4 Filtersi B Attributes ] E: Auta Pap
=] Detail Finance Charge Format

=] Statement Sort

2] Miscellaneous V| Include closing date of kiling cpcle:  |04/01/2003 =

S Alignment

=] Organization Name

S Address Detal

E Financ arge Format
=] Name Formats
=] Trahzaction Sart
=] Statement Format J
=] Statement Message

¥ Include finance charge disclosure statement:

An additional charge at a daily percentage rate of 1.59% may apply to an unpaidJ
balance.

[ Include calculation information for finance charges

[ Inchude summary of finance charges

04,/01/2003 to 04/30/2003

< Back | | Cancel | Frrint Freview Layout

19. Inthe list on the left, select Statement Message.

20. Enter “Please remit prompt payment of the balance due.” in the Print this message at the end of each
statement page text box.

I3 Mew Single Statement |
File “Edit  “iew Favontes  Tools Help
W@ g

& Clientsi 4 Filters] 5 Attributes 1 E: Auto Pap

2] Detail Statement Message

j ;t.ater:?ent Sort Frint this message at the end of each statement page:
iscellaneous

=] Alignment

=] Organization Narme i L
5 Address Detal If no statement copy message exists, print thiz message on each copy:

1 General1 2 Transaction Detailsi

Please remit prompt payment of the balance due.

=
=

=] Finance Charge Format |

=] Name Fo_rmats If the copy recipent should nat ses the amount due, display the amaunt as: | <Blank: |+
=] Transaction Sert Frint these messages for each aging period:
=] Statement Fomat Aging meszages will print based on the past due statuz of each balance.

S Aging Period Message |
current

3160

£1-30

aver 90

[ Show age of oldest tranzaction

¢ Back | | Cancel | FErrint | Freview | Lapout |

21. Click Preview. A message appears telling you the program is processing the mailing, and the preview
screen for the single statement appears.

22. Close the preview and return to the Format tab.
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23. Click the Save button on the action bar to save the new forms. The Save Mailing as screen appears.
24. In the Mailing name field, enter “Statement for Ashley Smith”.
25. In the Description field, enter “Transactions through 4/1/03".

Save Mailing as I
Mailing name: IStatement for Ashley Smith

Desenption: [Transactions through 4/1/03

¥ Others can pun thiz mailing
™ Others can modify this mailing

EHsave | Cancel |

26. Click Save to save the new forms. You return to the Format tab.

27. Close the screen. You return to the Forms page, and the single statement named “Statement for Ashley
Smith” appears in the grid.

Statements

Note: We offer high-quality, customized forms that are specifically designed for use with our software. These
forms, including checks, student bills, statements, invoices, purchase orders, tax forms, and envelopes, are
pre-printed in color with your organization’s logo and information. For more information, visit our Web site at
http://forms.blackbaud.com or call us toll-free at 866-4-BB-FORMS (866-422-3676).

Statements are records of charge and payment activity you create for multiple clients at one time. You can send
statements to the client who received the goods or services and his payers. A client can also receive a copy of
another client’s statement.

Statement Tabs

A statement has tabs on which you can select parameters: General, Details, Filters, Attributes, and Format. To
move among the tabs, click Next and Back at the bottom of the screen or select the tab. On these tabs you
specify the records to include in the mailing and how the statements should look.
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General Tab

On the General tab for statements, you select parameter settings specific to statements. Here you can select to
print or export the information or do both. On the General tab, you can also print statements for third-party
statement recipients. You can show aging information on the statements.

n Hew Statements i
File Edit “iew Favartes Toolz Help
dadBE a2-

1. General ]g; Tranzaction Details] 3 Filters ] 4 Attibutes | 5 Acto Pay | B Format

W'hat EID o want ko dD‘? ...............................................................................................................................................

[~ E=part statements to Access

Tranzaction cutaff date: lToda}l :J 08,/05/2005

Statement date: ]Tcu:lay _:J 08,/05/2005
i T e AL T o e S O Pt
v A credit balance v & balance over W
¥ Mo activity [~ & balance past due FM.M days
¥ & zero balance

Wwhen a statement recipient pays for multiple clients: |1se the statement settings for the statement recipient | |

W Include aging infomation on statement: -

Age as ok J<Transaction cuboff date>:J

Feduce balanzes by unuzed paymentz/credits beginning with: |The oldest period ;'J
[~ Create an output query of stabement recipisnts [ Create an output queny of clients on statements
| Hewt » I Cancel | Frint I Preview i Layout

Note: If you mark Print statements, you can also preview the mailing and view a layout of the statements. If
you mark Export statements to Access, the Preview and Layout buttons become disabled. You can export
statements only to Microsoft Access.

What do you want to do? In the What do you want to do? frame, you can select to print or export
statements, or both. To print statements on your selected printer, mark Print statements. For more
information about setting up printers, see the Program Basics Guide. If you mark Export statements to
Access, the program creates a *.mdb file containing a database of statement recipients, transactions, and
other statement information that you can use in Microsoft Access.

Transaction cutoff date. In the Transaction cutoff date field, select a date to define the last day for the period
of open transactions to include in the statement. You can select Today, Yesterday, Tomorrow, or a specific
date. The dates used in this period are the transaction dates from payment, charge, and credit records and
the invoice date from invoice records.

Statement date. In the Statement date field, you can select the date the statement is created — Today,
Yesterday, Tomorrow, a specific date, or the transaction cutoff date.

Include statements with. In the Include statements with frame, you can narrow the records to include in the
statement run. To print statements with a credit or zero balance, mark A credit balance and A zero balance.
You can print only statements with a minimum balance due by marking A balance over [ ] and entering an
amount. To print statements with a past-due balance, mark A balance past due [ ] days and enter a number
of days. To print statements that have no activity during the selected period, mark No activity.

If you select to run statements with a past-due balance, A credit balance, No activity, and A zero balance are
disabled because clients without activity or a zero balance are excluded automatically.

In the When a statement recipient pays for multiple clients field, you can select:
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¢ Use the statement settings for the statement recipient — The program compiles client activity according to
your selections on the Statements tab of the client record.

¢ Create one statement per client — The program prints a separate statement for each client.

¢ Combine clients onto one statement — The program prints a single statement for each statement recipient
with payees combined onto the statement.

If you mark Include clients with a zero balance, clients with zero balances appear on the statement
recipient’s statements.

Include aging information on statement. If you mark Include aging information on statement, you can
select a date in the Age as of field. In Reduce balances by unused payments/credits beginning with, you can
select to reduce balances with unapplied payments and credits by the oldest period or the most recent
period. The reduced balance total appears in the aging periods section at the bottom of the statement. For
more information about defining aging periods, see the Configuration Guide for Accounts Receivable.

Create an output query of statement recipients. To create a query of recipients you run statements for,
mark Create an output query of statement recipients. You can save and use an output query later for reports
or other mailings.

Create an output query of clients on statements. To create a query of clients appearing on each
statement, mark Create an output query of clients on statements. You can save and use an output query
later for reports or other mailings.

Details Tab

On the Details tab for statements, you can show summarized or detailed activity and group the information by
client. You can also select whether to summarize and display finance charges.
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Summarize transactions before. Mark Summarize transactions before, to add a summary balance of client
activity that occurred before the specified date. This is useful if statements are long. Transactions after the
selected date appear in detail on the statement.
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When you mark Summarize transactions before, you must select one of these dates to determine the
summary period:

¢ The same day of previous month based on transaction cutoff date — If you select this option, the transaction
cutoff date from the General tab is used to determine which day of the previous month to use as a summary
date.

¢ Specific date — If you select this option, the Date field appears so you can enter or select a date.

¢ Recurring date — If you select this option, the The [ ] day of [ ] fields appear so you can select the date to
use to summarize previous transactions. You must specify both a day and month.

If you select to include a summary balance, the text “Summary balance as of” prints automatically on
statements, but you can enter your own message in the Summary text field. To print the date following the
text, mark Include summary date.

Show transaction detail for. In the Show transaction detail for frame, you can mark the transactions you
want to show in detail.

Note: If you mark the business rule not to use sales tax, Sales tax transactions does not appear in the Show
transaction detail for frame. For more information about business rules, see the Configuration Guide for
Accounts Receivable.

If you mark Fully paid charges, fully paid charges, invoices, invoice line items, and refunds appear as separate
lines on the statement. If you leave Fully paid charges unmarked, fully paid charges, invoices, invoice line
items, and refunds are summarized in a single line on the statement.

If you mark Invoices and returns, invoices and returns appear as separate line items on the statement. Each
line item is treated as a charge and appears in a separate line on the statement, just as charges do. If you
leave Invoices and returns unmarked, invoices and returns appear on the statement as a summary of their
line items. An invoice or return transaction may appear on multiple statements if its line items were
distributed to or partially paid by multiple clients. The invoice or return will appear in the statement body or
sub-section of a third party statement for each paying or distributed client. The amount of the invoice or
return is adjusted to reflect each client's portion.

If you mark Sales tax transactions, sales tax appears separately from the associated charge or credit. If you
unmark the checkbox, the program adds sales tax transaction totals to the charge or credit total.

Show transaction summary for. In the Show transaction summary for frame, you can mark Transactions on
this statement to print an additional subsection on the statement containing a statement summary. When
this option is marked, you can mark Show combined summary across multiple clients on each statement to
combine the activity of multiple clients into a summarized total. In the Summarize by field, select to
summarize the activity by Transaction type or Product/Billing Item. If you leave Show combined summary
across multiple clients on each statement unmarked, a separate activity summary appears for each client.

Note: If you mark Transactions across this date range and mark Include summary of finance charges in
Finance Charge Format on the Format tab, the date range selected here determines the date range for the
summary of finance charges.

You can mark Transactions across this date range to print an additional subsection on the statement
containing a statement summary for the specified date range. When this option is marked, you can mark
Show combined summary across multiple clients on each statement to combine the activity of multiple
clients into a summarized total. In the Summarize by field, select to summarize the activity by Transaction
type or Product/Billing Item. If you leave Show combined summary across multiple clients on each
statement unmarked, a separate activity summary appears for each client in the date range summary
subsection.

Filters Tab

Note: It is important to use filters carefully so you do not underbill a client. Filtering by the client filters,
Product and Billing ltems on Charges, or Product and Billing Item Attributes may result in some clients or
charges being omitted unintentionally.
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On the Filters tab, you select criteria that determines which items to include in a statement. It is important to use
filters carefully so you do not underbill a client. The Clients in Statement Body, Client Statuses, Client Types, and
Client Attributes filters apply to client activity. If you use these filters, only activity for clients that meet these
filter requirements appear on the statements.

You can filter by Product and Billing Items on Charges or Product and Billing Item Attributes. When you filter by
these items, only charges with the selected products or billing items appear on the statements; therefore,
charges for other products or billing items and any applications made to these charges (regardless of the
application’s billing item) are not included in the statement. For basic information about filtering criteria, see the
Program Basics Guide.
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Open. To open a selection screen to designate specific filters for the form, select a filter in the grid and click
Open on the action bar.

Clear All Filters. To reset each filter to include all, you can click Clear All Filters.

Note: A filter is a requirement items must meet to be included in a form. For example, if you apply the Clients
filter, only transactions for the selected clients appear in the form.

Filters. The Filters column lists all the filters for the form. You cannot edit this column.

Include. By default, in the Include column, each filter is set to All. To open a selection screen to designate
specific filters for the form, choose Selected.

Selected Filters. Filters you specify on the selection screen appear in the Selected Filters column.
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Selected Filters Screen

From the Filters tab, you can open a selection screen for a filter in several ways: by double-clicking the filter in the
grid, selecting the filter in the grid and clicking Open on the action bar, or choosing Selected in the Include
column for the filter.

Statement Recipients x| I

Inchude: @ Al P e ® Range @ Ouery | Eravious Filizr  Mest Filker

Statement Fecipient Mame | Statement Recipient ID |

ar. I Cancel |

Include. For each filter, you can include all or select specific filters. Depending on the filter, you may also be able
to filter by a range or query.

All. If you mark Include: All, you cannot designate specific filters.

Selected or Range. If you mark Include: Selected or Range, a grid appears in which you can specify filters. In a
field, you can click the binoculars to search for information.

Query. If you mark Include: Query, the Query name field appears for you to enter the name of the query by
which to filter the form. In the field, you can click the binoculars to search for the query name.

To create a new query, click the binoculars. Then click Add a New Query on the Open Query screen. For more
information about creating queries, see the Query Guide.

Previous Filter. To view or edit the previous filter without returning to the Filters tab, click Previous Filter.
Next Filter. To view or edit the next filter without returning to the Filters tab, click Next Filter.

Attributes Tab

You can use the Attributes tab to add, delete, or update attributes for statement recipients and clients who
receive statement copies.
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Action. In the Action column, you can select to add, delete, or update attributes on the client record when you
generate statements.

Note: Attribute types are established in Configuration. For more information about creating attribute types,
see the Configuration Guide for Accounts Receivable.

Attribute Type. In the Attribute Type column, you can select an attribute type.
Description. In the Description column you can enter or select a description for the attribute type.

Short Description. If you selected a table type attribute that uses short descriptions, in the Short Description
column, select the attribute description. The Description column completes automatically.

Date. In the Date column, select the date you add, delete, or update the attribute.

Note: An attribute is a tool used to group information based on a common theme. With attributes defined, you
can filter information to your specifications.

Required. If the attribute type you select is required, the program automatically marks the checkbox in the
Required column.

Comments. In the Comments column, you can enter free-form text for additional information about the
attribute type.

Auto Pay Tab

If you have the optional module Electronic Funds Transfer, you can use the Auto Pay tab to create automatic EFT
payments for clients with variable amount automatic payments set up on the Automatic Payments tab of their
record.

When you print or export statements, the program generates all charges and credits and applies payments for
the client based on the statement criteria. Payments apply to associated charges as determined by the Accounts
Receivable business rule settings. The automatic payment is recorded on the statement and on the payer’s
Activity and Automatic Payment tabs. The payment also appears on the payee’s Activity tab.
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The program creates one deposit and payment record for the calculated balance using the information you enter
on the Auto Pay tab. When you run Create an EFT file in Deposit tasks for Banks, the deposit record updates
automatically with the date the EFT file was created.
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Create automatic variable amount payments based on statement criteria. Mark this option to
generate variable amount automatic payments. This enables the other options on this tab. If this option is not
marked, no automatic payments are created.

Note: The deposit information entered on the Auto Pay tab is used for all payments in the deposit.

Deposit date. In the Deposit date field, enter the date the deposit is made to the bank account.
Entry date. In the Entry date field, enter the date the deposit is entered in the program.

Status. In the Status field, select Open or Closed. You cannot add new payments to a closed deposit.
Post status. In the Post status field, select a post status for the deposit.

Post date. In the Post date field, enter the date to post the deposit. The information in the Post status and Post
date fields defaults automatically to the payments added to the deposit. You post deposits, not individual
payments.

Description. In the Description field, enter a description of the deposit or any other information you want to
record about the deposit.

Payment date. In the Payment date field, enter the date the payment was received.

Source. For variable payments not paid by EFT, in the Source field, select the payment source such as mail or in
person.

Post status. The post status defaults from the deposit record. You post deposits, not individual payments.
Post date. The post date defaults from the deposit record. You post deposits, not individual payments.
Comment. In the Comment field, you can enter a note about the payment.
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Format Tab

On the Format tab, you designate the format for the mailing. Settings on this tab determine the appearance of
the statements. You can sort the mailing, make selections for details and formats, and align the statements on
paper or forms. You can combine payments into a single transaction instead of printing them as separate
transactions.

Note: If you mark Show barcode, select a font and size in the Font and Font size fields.

Detail. Use Detail to select extra details to print on the statements.
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If you mark Show statement reference number, the program generates a number to appear on the
statement beneath the statement date. To display the reference number as a barcode, mark Show barcode.

If you mark Show print date on statement, the printing date appears on the statements beneath the
statement date.

If you mark Show credit balances as $0.00, the amount due balance and aging balances appear as a zero
amount if they are credit balances.

If you mark Show statement due date, you can select the date payments are due. In the Due date field, select
Today and a number of days in the plus [ ] days fields or select <Specific date> and use the calendar to select
a date.

If you mark Show minimum amount due as, you can select a percentage of the total due or enter a specific
amount.



Statement Sort. Use Statement Sort to select the order to print statements.
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Forms 11

When you select Statement Sort, a grid appears. Select a sorting category in the Sort by column and select
Ascending or Descending in the Order by column. If you make no selections in the Sort by column, the
program sorts by client name in ascending order.

Miscellaneous. Use Miscellaneous to specify how you want numbers to appear on the statements and the font

size for statements.
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Alignment. You can use Alignment to specify vertical and horizontal alignment of the forms and addresses
when you print.
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Note: The maximum alignment adjustment you can enter is 99. This moves the margin .99 inch.

In the Form Alignment frame, you can adjust the form’s top and left margins for printing using the Vertical
alignment and Horizontal alignment fields. You can move printed information up or down or left or right and
enter how much to move the information. For example, if you select Move printed information up and enter
2, the information prints .02 inch higher on the page.

Addresses for the statement recipient are aligned by default to fit the first five lines in a standard envelope
address window. If you need to make adjustments, in the Address Alignment frame, you can move printed
information up or down or left or right and enter how much to move the information. For example, if you
select Move printed information up and enter 2, the address prints .02 inch higher on the page.
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Organization Name. Use Organization Name to print your organization’s information at the top left of the
form. The information that appears in the Organization name and Address fields defaults from the General
tab of Configuration. If you mark Show organization address, you can enter or edit the name and address.

The Address quick view box displays the information as it will appear on statements.
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Address Detail. Use Address Detail to select the address information appearing in the address section of

statements.
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If you mark Show statement recipient address, you can select to display the billing, primary, or shipping
address of the recipients.

Note: You enter telephone numbers for contacts on the Client 1 tab of the client record.

To print telephone numbers or Web or email addresses, mark Show contact information in address and
select a number or address in the Contact Number fields. If the client is an organization, the contact’s name
appears in the ATTN line.

You can mark Show USPS barcode in address to print the barcode on the statements above the address.
The Address quick view displays the address information as it will appear on statements.

Finance Charge Format. Use Finance Charge Format to select and define information to appear Finance
Charge Information section of the statements.
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Mark Include closing date of billing cycle to include the closing date on the statements. The closing date
defaults to the transaction cutoff date from the General tab or you can select a different date. For example, if
you select May 31, 2003, as the closing date, “Closing date of billing cycle: 05/31/2003” appears in the
Finance Charge Information section of the statements.

If you mark Include finance charge disclosure statement, you can create a disclosure statement. Enter the
text for the statement in the text box.

If you mark Include calculation information for finance charges, the calculation date and percentage rate
appear in a message on the statements. For example, “The finance charge dated 0501/2003 was calculated
as of 04/30/2003 using an annual percentage rate of 10%. The balance subject to finance charge was
$100.00.”

If you mark Include summary of finance charges, a total of finance charges appears in the Finance Charge
Information section of the statements. In the Summary date range field, you can include all dates or select a
specific date or range. In the Description field, you can enter text to precede the total finance charge amount
appearing on the statements, for example, “Year-to-date finance charges:”. If you mark Transactions across
this date range on the Details tab, the summary of finance charges is for the same date range selected on the
Details tab.
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Name Formats. Use Name Formats to select the client/organization name, formal or informal address, or a
salutation, as it appears on the client record.
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Tip: We strongly recommend you use <Client name>. If you select Formal Salutation, Informal Salutation,
Salutation 1, Salutation 2, or any user-defined salutations from Configuration, the program reformats each
name, therefore taking much longer to run statements.

The selection you make in the Format names in statement address using: [ ] if present field appears in the
address area of the statement.

The selection you make in the Format names in charges for box using: [ ] if present appears in the body of
the statement in the section for client activity.

The selection you make in the Format names in statement body using: [ ] if present appears in the body of
the statement in the section for client activity. However, if a statement does not print multiple clients’
activity or does not separate activity by client, the Format names in statement body using: [ ] if present field
does not appear.

Note: You must have the appropriate security rights to output an addressee/salutation with Social Security
numbers. If you do not have security rights, the numbers are masked. For more information, see the Security
chapter of the Administration Guide for The Financial Edge.

You can select a second name format in the Otherwise use field in situations where the first selection is not
present on the client record. For example, if you select Formal Salutation, and you have clients without a
defined Formal Salutation on the Client 2 tab, the second name format is used. If <Client name> is the first
formatting selection, the Otherwise use field is disabled.

In the For organizations, use name followed by box, mark Organization ID, Contact Name, and CFDA # for
these items to appear after the organization name in the different areas of the statement.

Note: If you sort by Transaction Type, the Show credits/payments with their associated charges checkbox
becomes disabled.
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Transaction Sort. Use Transaction Sort to select the order for information to appear in the body of the
statements.

I New Statements [ x| I
Fil= Edit “iew Fawortes Tools Help

dasag=e- |

1 Genelall 2 Tranzaction Detailsl & Filters| 4 .-’-‘«ttributesl 5 AutoPay  EB: Format |

Detai Transaction Sort

Statement Sort
Miscellaneaus Stk by | Order by | Subkotal? |
Alignmert Client Mame Ascending
Orgarization Mame
Address Detail

Finance Charge Format
Marme Formats

H E Tranzaction Sort
Statement Format
Statement Message

Transaction Dake Ascending

i A i i S

[~ Show credits/payrments with their associated charges

[ Combine credit/payment distributions into a single credit/payment transaction

When you select Transaction Sort, a grid appears displaying the categories you can sort by in the statements.
Select a sorting category in the Sort by column and select Ascending or Descending in the Order by column.
To print a subtotal for each category sorted, mark the checkbox in the Subtotal? column.

Note: If you mark Show credits/payments with their associated charges, refunds appear immediately after
the credit/payment applied to them.

If you mark Show credits/payments with their associated charges, applied portions of credits and payments
appear immediately after the charges to which each is applied, in the order in which they were applied,
sorted as designated in the grid.

If you leave Show credits/payments with their associated charges unmarked, credits and payments appear
according to the selection in the Transaction Sort grid. If you sort by Transaction Type and mark Combine
payment distributions into a single payment transaction, you can also show payments as a single
transaction instead of separate transactions.
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Statement Format. Use Statement Format to make formatting selections for the statement forms.
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In the Statement format field, you can select a laser pre-printed form or blank paper. In the Number of
copies to print for each statement field, select how many copies of each statement to print and mark Collate
to collate the statements if you print more than one.

Note: If you mark Print a logo on the form, you must select a file name and logo size. Large logos print 5 3/8 in.
x 1in; small logos print 2 1/2 x 1 in.

If you print statements on blank paper, you can print your organization logo on the statements. To print the
logo, mark Print a logo on the form. In the Logo file name field, browse to the file where your logo is saved in
* bmp format. In the Logo size field, select Large or Small as the logo size to use on the statements.

Note: If you mark Print total number of pages on each page, the numbering appears, for example, as Page 1 of
79.

In the Miscellaneous information frame, you can make additional formatting selections. In the Transaction
spacing field, select Single space or Double space as the amount of space to leave between lines. To make
reading statements easier, you can mark Print a gray background for every other transaction or Print a gray
background for each heading. You can record page numbers on the statements by marking Print total
number of pages on each page.
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Statement Message. Use Statement Message to print additional information for recipients.

1@ New Statements [ x|
File Edit Wiew Favorites Tools Help

dadaE o+ e- |

1: General' 2 Detailsl & Filtersl 4 Attributesl 5 Auto Pay B Format |

Detail Statement Message

Statement Sort

tizcelaneous Frint statement comments from each record: I,.*_\t the end j

Alignment Frint this message at the end of each statement page:-

Organization Name =
Address Detail I =l

Finance Charge Format |1 g statemment copy meszage exists, print this message on each copy: -
M ame Formats I

Trangaction Sort

Statement Format IF the copy recipient should not see the amount due, display the amount a$:| <Blanks vl
Frint these mezzages for each aging period: -
Aging meszages will print based on the past due statuz of each balance.

i Statement Message

Aging Period Message I
current
31-60
61-90
aver 90
< Back | Hewt > | Cancel | Print | Preview | Layout |

If you entered information on the notes tab of a record, you can choose where to Print statement comments
from each record. You can select At the end or At the beginning. You can enter text in the Print this message
at the end of each statement page and If no statement copy message exists, print this message on each
copy fields. If you do not want a recipient to see the amount due, you can select <Blank>, ***, or 0.00 in the
If the copy recipient should not see the amount due, display the amount as [ ] field. In the aging periods
grid, you can enter messages for each period.

Creating Accounts Receivable Statements

Note: We offer high-quality, customized forms that are specifically designed for use with our software. These
forms, including checks, student bills, statements, invoices, purchase orders, tax forms, and envelopes, are
pre-printed in color with your organization’s logo and information. For more information, visit our Web site at
http://forms.blackbaud.com or call us toll-free at 866-4-BB-FORMS (866-422-3676).

When you prepare statements, depending on your selections for statements on the client record, all client
activity can appear on the statement. You can summarize activity or show it in detail, and group activity by all or
selected clients. You can also summarize and display finance charges. You can show aging information with or
without messages you create.

» Creating Accounts Receivable statements

In this example, we print statements for statement recipients whose names begin with A through H
containing all transactions as of today’s date.

1. From the Mail page in Accounts Receivable, click Forms. The Forms page appears.

2. Inthe list on the left, select Statements and click New on the action bar. The New Statements screen
appears.

Note: To export statement information, mark Export statements to Access. For more information about
exporting in Mail, see “Exporting a mailing” on page 15.
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3. Inthe What do you want to do? frame, mark Print Statements.
4. In the Transaction cutoff date and Statement date fields, select “Today”.

u Statements |

Eile: - Edit - “iew  Favortes  Tools - Help
A S w2

1: General ]2; Transaction Detailsi 3! Filters] 4 Attributes | B Address | B Aut F'ay] i Format1

‘what do pou want to do?

v [~ Export statements bo Access
Transaction cutoff date; |Today ﬂ 04/03/2003
Statement date: |nga}| j 04/03,/2003

Include statements with:

[v & credit balance [V A balance aver |$0.00

[¥ Mo activity [~ & balance past due daps
¥ & zemo balance
When a statement recipisnt pays for multipls clients: |Use the statement settings for the statement recipient ﬂ

[v Include clients with a zero balance

[v Include aging information on statement:

Age &3 af: |<Transaction cutaff date>ﬂ

Reduce balances by unused payments//credits beginning with: |The oldest period ﬂ
[~ Create an output query of statement recipients [~ Create an output query of clients on statements
| Mext > | Cancel | FErrint | Freview | Lapout

5. Click Next or select the Details tab.

6. Mark Transactions on this statement to print an additional subsection on the statement containing a
statement summary. In the Summarize by field, select “Transaction type”.

I3 Statements |

Eile * Edit ¥iew Favontes  Toolz  Help
S EREE = T R s i

13: Filtersi A Adtributes | 5 Auto F'a_l,Ji B Formati

1: General

[T Summarize ranzactions before: | J

| g
Show transachion detaill for:
¥ Fully paid charges

V' Invoices and returns

[V Sales tax transactions
Show tranzaction summary for;

[V Transactions on this statement

[~ Shaow combined surmmary acraz: multiple clients on each statement

Summarize by: | Transaction type -
[ Transactions across this date range: 01/01/2003 to 12431 /2003

-
[ Tarsacion v ]

¢ Back | Mest » | Cancel | Frint Freview Layout

7. Click Next or select the Filters tab.
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Note: It is important to use filters carefully so you do not underbill a client. Filtering by the client filters,
Product and Billing Items on Charges, or Product and Billing Item Attributes may result in some clients or
charges being omitted unintentionally. For more information, see “Filters Tab” on page 109.

8. Select statement recipients whose names begin with A through H. For more information about filtering,
see the Program Basics Guide.

I3 Statements E I
File Edt “iew Favontes Tool: Help
S o e |

1: Generall 2 Transaction Details : Attributes | 5 Address | B Auto F'a_l,JI Z Formatl

Filkers | Include | Selected Filters

Statement Recipients Selected David Adams ko Mr, John Edward Harrison

Statement Recipient State... All <All Statement Recipient Statement Codes=

Statement Recipient: Orga... Aall <Al Statement Recipient: Organizations,Individuals=

Statement Recipient Attrib, .. Al <All Statement Recipient Attributes=

Clients in Statermnent Body ol <Al Clients in Statement Body =

Client Statuses All <All Client Skatuses=

Client Types ol <Al Client Types=

Client Attributes All <Al Client Attributes =

Product and Billing Items o... Al <Al Praduct and Biling Ikems on Charges s

Product and Billing Item At... All <All Product and Billing Ikem Attributes =

¢ Back | Mest » | Cancel | Frint Freview Layout

9. Select the Format tab.
10. In the list on the left, select Detail.
11. Mark Show barcode.
12. Mark Show statement due date.
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13. Mark Show minimum amount due as [ ], select “Percent of total amount”, and enter “50” in the percent

field.

uStalements
Eile  Edit - “iew Favortes  Tools - Help

A e AT

1 General] 2 Transaction Detailsi 3! Filters] 4 Attributes] 5 .&ddlessi E: Auto Pay

=] Statement Sort
= Miscellansous v Show statement reference number
S Alignment [V Show barcode

=] Organization Name Fant ’—L| Fort size: —
S Address Detal ot 2 of 3 Barcode ontsize: 110 j
& Finance Charge Format| [ Show print date on statement

=] Name Formats [ Show credit balances az $0.00
=] Trahzaction Sart ¥ Show staterment due date

=] Statement Format Due date:
t | «<5tat b dater »| plus |30 daps
=] Statement Message Siemer B2 J

]|

¥ Shaw minimum amount due as: |F'ercent of tatal amaount ﬂ |5IJ percent
< Back | | Cancel | Frrint Freview Layout
14. In the list on the left, select Address Detail.
15. Mark Show statement recipient address and select “Bill to”.
16. Mark Show USPS barcode in address.
I3 Statements |

Eile * Edit ¥iew Favontes  Toolz  Help

SV ET =i

1 General{ 2 Tranzaction Details] 3! Filters] 4 Attributes] 5 Address 1 E: Auto Pap

=] Detail

=] Statement Sort
g Miscellaneous
=] Alignment

2] Finance Charge Format
=] Wame Formats

=] Transaction Sort

=] Statement Format

5] Statement Meszage

Fwhy 2

Address Detail

W Show statement recipient address:

Address: | <Bill Tax -

[~ Show contact information in address

| [~ |
| [~ |

¥ Show USPS barcode in addiess

Address quick wiew:
wllo Ll L L LLOLL L L.

Client Name Here
ddress line 1
ddress line 2
ddressz line 3

¢ Back | |

Cancel | Frint Freview Layout

17. In the list on the left, select Finance Charge Format.

18. Mark Include closing date of billing cycle.



126 CHAPTER

19. Mark Include finance charge disclosure statement and enter in the text box “An additional charge at a
daily percentage rate of 1.5% may apply to an unpaid balance.”

u Statements |
Eile  Edit - Yigw Favontes Tools Help
!ﬁ J oy m»' | _:_"g ? 3

1 General] 2 Tranzaction Detalls] 2 F|Itersl 4 Attnbutesl 5 .&ddlessi E: Auto F'ay

5 Detail Finance Charge Format

=] Statement Sort

2] Miscellaneous V| Include closing date of kiling cpcle:  |04/03/2003 =
o v |nclude finance charge disclosure statement:
ﬂ ’;"Q”me”: " M Includs fi harge disc]
rganization Mame — - m -
] An additional charge at a daily percentage rate of 1.5% mayp apply to an unpaid
S Address Detall balance. J

=] Name Formats

=] Trahzaction Sart
=] Statement Format J
=] Statement Message

[ Include calculation information for finance charges

[ Inchude summary of finance charges

04,/01/2003 to 04/30/2003

< Back | | Cancel | Frrint Freview Layout

Preszs F7 for 2oom.

20. Inthe list on the left, select Statement Message.

21. Enter “Please remit prompt payment of the balance due.” in the Print this message at the end of each
statement page text box.

I3 Statements I
Eile: Edit  Wiew  Favontez - Toolz Help
el i =) 1...J i

1: General] 2 Transactioh Detalls] -3 F|Iters] 4 Attrlbutes] L Address] E Auto F'ay

2] Detail Statement Message

j ;t.ater:?ent Sort Frint this message at the end of each statement page:
iscellaneous

5] Aligrment Flease remit prompt payment of the balance due. =
=] Organization Narme - : : J
2] Address Detail If no statement copy message exists, prink thiz meszage on each copy:

=] Finance Charge Format |
] Wame Formats

5] Trangaction Saort
=] Statement Format

If the copy recipent should not e the amount due, display the amount a5 | <Blank: *
Frint these messages for each aging period:
Aging meszages will print bazed on the pazt due status of each balance.

Aging Period Message |
current
3160
£1-30
aver 90

[ Show age of oldest tranzaction

¢ Back | | Cancel | FErrint | Freview | Lapout |

Press F7 for zoom.

22. Click Preview. A message appears telling you the program is processing the mailing, and the preview
screen for the statements appears. Click the right arrow to view each statement in the run.

23. Close the preview and return to the Format tab.
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24. Click the Save button on the action bar to save the new forms. The Save Mailing as screen appears.
25. In the Mailing name field, enter “Statements for A through H”.
26. In the Description field, enter “Transactions through 4/3/03".

Save Mailing as I
Mailing name: IStatements for & through H

Desenption: [Transactions through 4/3/03

¥ Others can pun thiz mailing
™ Others can modify this mailing

EHsave | Cancel |

27. Click Save to save the new forms. You return to the Format tab.

28. Close the screen. You return to the Forms page, and “Statements for A through H” appears in the grid.
Cash Receipts Forms

Note: We offer high-quality, customized forms that are specifically designed for use with our software. These
forms, including checks, student bills, statements, invoices, purchase orders, tax forms, and envelopes, are
pre-printed in color with your organization’s logo and information. For more information, visit our Web site at
http://forms.blackbaud.com or call us toll-free at 866-4-BB-FORMS (866-422-3676).

In Forms for Cash Receipts, you can generate CR receipts for miscellaneous payments received.

CR Receipt Forms

You can generate CR receipts for miscellaneous payments received.

CR Receipt Tabs

An CR receipt has tabs on which you select parameters: General, Filters, Attributes, and Format. To move among
the tabs, click Next and Back at the bottom of the screen or select the tab. On these tabs you specify the records
to include in the mailing and how the forms should look.
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General Tab

On the General tab for CR receipts, you select parameter settings specific to CR receipts.

1@ Hew CR Receipts
File Edit “iew Favortez Toolz Help
H &S & L

l 2 Filtersl a .t’-‘n.ttributes] 4 Format ]

Include payments with these dates:

Payment date: |Include all dates 7|
Dreposit date: [Include all dates =]
Include payment numbers from: | ﬂ to | ﬂ
Ihclude deposit nunibers fram: | ﬂ ta | ﬂ

Include payments whose status is: | Unprinted | then change the statuz to printed.

[T Create an output query of

| Hemt » | Cancel Print Preview ‘ Layout |

Payment date. In the Payment date field, select a date or date range for payment dates to include in the
receipt.

If you select <Specific range>, you can specify a start and end date. If the Start date field is blank, all activity is
included up to the end date. If the End date field is blank, all activity from the start date until present is
included. If both fields are blank, all activity is included.

Note: You must have the appropriate security rights to output credit card numbers. If you do not have security
rights, the numbers are masked. For more information, see the Security chapter of the Administration Guide
for The Financial Edge.

Deposit date. In the Deposit Date field, select a date or date range for deposit dates to include in the receipt.

If you select <Specific range>, you can specify a start and end date. If the Start date field is blank, all activity is
included up to the end date. If the End date field is blank, all activity from the start date until present is
included. If both fields are blank, all activity is included.

Include payment numbers from [ ] to [ ]. In the Include payment numbers from [ ] to [ ] field, enter or
select a range of payment numbers to include in the receipt. If you leave both fields blank, the form includes
all payment numbers.

Include deposit numbers from [ ] to [ ]. In the Include deposit numbers from [ ] to [ ] field, enter or select a
range of deposit numbers to include in the receipt. If you leave both fields blank, the form includes all deposit
numbers.

Include payments whose status is [ ] then change the status to printed. In the Include payments
whose status is [ ] field, select Not yet printed, Reprint, or Both. After printing the receipt, the print status is
changed to printed on the payment record.
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Create an output query of [ ]. Mark this option to create a query of payments, deposits, or clients that
appear in the receipt. You can save and use an output query later for other mailings or reports.

Filters Tab

On the Filters tab, you select criteria that determines which items to include in the receipts. For more information
about filtering, see the Program Basics Guide.

I@ Hew CR Receipts
Fil=e Edit “iew Favortez Toolz Help

B =2 |

| a .t’-‘n.ttributesl ES Fulmatl

f®0pen ) Clear Al Filters

Filters I Include I Selected Filkers
Payment For all <Al Payment for =
Banks Al <Al Banks =
Deposits all <Al Deposits =
Pavments all <Al Payments =
Pawment Aktribukes all <8l Payment aktributes =

Open. To open a selection screen to designate specific filters for the form, select a filter in the grid and click
Open on the action bar.

Clear All Filters. To reset each filter to include all, you can click Clear All Filters.

Note: A filter is a requirement items must meet to be included in a form. For example, if you apply the Clients
filter, only transactions for the selected clients appear in the form.

Filters. The Filters column lists all the filters for the form. You cannot edit this column.

Include. By default, in the Include column, each filter is set to All. To open a selection screen to designate
specific filters for the form, choose Selected.

Selected Filters. Filters you specify on the selection screen appear in the Selected Filters column.
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Selected Filters Screen

From the Filters tab, you can open a selection screen for a filter in several ways: by double-clicking the filter in the
grid, selecting the filter in the grid and clicking Open on the action bar, or choosing Selected in the Include
column for the filter.

R |

Include: @ Al 5 = ® Range Previous Filter  Mest Filter

Payrnent | Payment For |

ar. I Cancel |

(0]

Include. For each filter, you can include all or select specific filters. Depending on the filter, you may also be able
to filter by a range or query.

All. If you mark Include: All, you cannot designate specific filters.

Selected or Range. If you mark Include: Selected or Range, a grid appears in which you can specify filters. In a
field, you can click the binoculars to search for information.

Query. If you mark Include: Query, the Query name field appears for you to enter the name of the query by
which to filter the form. In the field, you can click the binoculars to search for the query name.

To create a new query, click the binoculars. Then click Add a New Query on the Open Query screen. For more
information about creating queries, see the Query Guide.

Previous Filter. To view or edit the previous filter without returning to the Filters tab, click Previous Filter.
Next Filter. To view or edit the next filter without returning to the Filters tab, click Next Filter.

Attributes Tab

You can use the Attributes tab to add, delete, or update transaction attributes for Cash Receipts payments.

I3 Mew CR Receipts E

File Edit “iew Favontez Toolz Help
SRR = |

1. General | 2 Filters

: Format I

Actionl Altribute Type I Drescription IShortDescripti...I Date IFlequiredI Comments I

-
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Action. In the Action column, you can select to add, delete, or update attributes on the payment record when
you generate receipts.

Note: Attribute types are established in Configuration. For more information about creating attribute types,
see the Configuration Guide for Accounts Receivable.

Attribute Type. In the Attribute Type column, you can select an attribute type.
Description. In the Description column you can enter or select a description for the attribute type.

Short Description. If you selected a table type attribute that uses short descriptions, in the Short Description
column, select the attribute description. The Description column completes automatically.

Date. In the Date column, select the date you add, delete, or update the attribute.

Note: An attribute is a tool used to group information based on a common theme. With attributes defined, you
can filter information to your specifications.

Required. If the attribute type you select is required, the program automatically marks the checkbox in the
Required? column.

Comments. In the Comments column, you can enter free-form text for additional information about the
attribute type.

Format Tab

On the Format tab, you designate the format for the mailing. Settings on this tab determine the appearance of
the receipts. You can sort the mailing and add messages to appear on the form.

Detail. Use Detail to select extra items of detail to print on CR receipts.

I3 Mew CR Receipts

File Edit Wiew Favortes Tools Help
RS- =T

1 Generall 2 Filtersl 20 Attributes

B Detai Detail
Sort

Receipt Message ¥ Include payer address on receipt.

Receipt Format
Drganization Mame

To show payment applications or distributions, mark Show and select Charges this payment was applied to or
Client this payment was distributed to. To display the reference number as a barcode, mark Show barcode.

You can also select which client address and contact phone numbers to use. Mark USPS bar code and Ship to
address to include these items on the form. The Address quick view box displays the contact information as
it will appear on the form.

Tip: We strongly recommend you use <Client name>. If you select Formal Salutation, Informal Salutation,
Salutation 1, Salutation 2, or any user-defined salutations from Configuration, the program reformats each
name, therefore taking much longer to run CR receipts.
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Sort. You can use Sort to select the order for items to appear on the CR receipt.

I New CR Receipts
File Edit %iew Favortes Tools Help

e = el |

1 Genelall s Filtersl 3 Altibutes  4: Format |

Detail Sort
. Fieceipt Message Sart by | Order by I
Receipt Format Receipt Date Azcending

Organization Mame

In the first row in the Sort by column, select the item to sort the CR receipt by. You can sort by receipt date,
deposit number, receipt number, client name, payment type, or zip code.

In the Order by column, select Ascending to sort the forms alphabetically or Descending to sort them in
reverse alphabetical order.

Miscellaneous. Use Miscellaneous to specify how you want numbers to appear on the receipts and the font
size for receipts.

N} New CR Receipts |
File Edit View Favorites Tools Help

FIE = |

1 General' 2 Filtersl 2 Altributes  4: Format I

Detal Miscellaneous
Sort

3 Show currency character on All amounts

Receipt Message Show percent sign on All amounts
Alignr!went Negative amount format (1234.56)
E?g:ar:lijztafiz:n;tame MNumber of digits after dedmal for amounts 2

Mumber of digits after dedmal for percentages 2

Show 1000's separator ‘Yes

Show blanks instead of zeros Mo

Font size g

Sample amount:
Amount (51,234.56)
Percent 100.00%

< Back | Text > Cancel Frint Freview Lapout
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Receipt Message. Use Receipt Message to enter text you want to appear at the end of each receipt.

I New CR Receipts
File Edit %iew Favortes Tools Help

FlEE =]l |
1 Genelall s Filtersl 3 Altibutes  4: Format |

Detail Receipt Message
2] Sort
]

This text will print at the end of each receipt:

| eipt Mezsage
Receipt Format
Organization Mame

Alignment. You can use Alignment to specify vertical and horizontal alignment of the forms and addresses
when you print.

A&} New CR Receipts |
File Edit Yiew Favorites Tools Help

B aId a2 |

1 General' & Filtersl 3 Attributez  4: Format I

Detail Form Alignment
) Sart

Miscellaneous Form Alig k-
Receipt Message

Ef 5 Wertical alighment: IDefauIt lignment j I units = 0 irch
i E Alignment

Receipt Format Harizontal alignment: IDefauIt alighment | I units = 0 inch
Drganization Name

Mate: 1 unit equals 1/100th of an inch or 0.254 millimeters.

Address Alig ek
WYertical alighment: IDefauIt alignment j I units = 0 irch
Horizontal alignment: IDefauIt alignment j I units = 0 irch

Mote: 1 unit eguals 1/100th of an inch or 0.254 millimeters.

< Back | et > Cancel FErint Presview Lapout

Note: The maximum alignment adjustment you can enter is 99. This moves the margin .99 inch.

In the Form Alignment frame, you can adjust the form’s top and left margins for printing using the Vertical
alignment and Horizontal alignment fields. You can move printed information up or down or left or right and
enter how much to move the information. For example, if you select Move printed information up and enter
2, the information prints .02 inch higher on the page.

Addresses for the receipt recipient are aligned by default to fit the first five lines in a standard envelope
address window. If you need to make adjustments, in the Address Alignment frame, you can move printed
information up or down or left or right and enter how much to move the information. For example, if you
select Move printed information up and enter 2, the address prints .02 inch higher on the page.
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Receipt Format. You can use Receipt Format to select formatting features for receipts.

I New CR Receipts
File Edit Wiew Favorites Tools Help

e = e |

1 Generall & Filtersl 3 Altributes  4: Format |

Detail Receipt Format
Sort
Receipt Message [ Use an electionic signature -

1= Fi'?':"?i"- F':'"""ﬁ'- Autharized signature: |<No signatures ﬂ
Organization Marne ’

[~ Print & logo on the form

Loga file name: I _I

Logosize: Large (5 3/Gin #1in) =l

To print an electronic signature, mark Use an electronic signature. In the Authorized signature field, select
the signature to use on the forms. For more information about creating electronic signatures, see the
Administration Guide.

Note: If you mark Print a logo on the form, you must select the logo file name and logo size. Large logos are
53/8in.x1in; small logosare 21/2in. x 1 in.

To print your organization’s logo on the forms, mark Print a logo on the form. In the Logo file name field,

browse to the file where your logo is saved in *.bmp format. In the Logo size field, select Large or Small for
the logo size to use on the forms.

In the Miscellaneous information frame, you can make additional formatting selections. In the Transaction
spacing field, select single space or double space for the amount of space to leave between lines. To make

reading the forms easier, you can mark Print a gray background for every other transaction or Print a gray
background for each heading.
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Organization Name. Use Organization Name to print your organization’s information at the top left of the
form. The information that appears in the Organization name and Address fields defaults from the General
tab of Configuration. If you mark Show organization address, you can enter or edit the name and address.
The Address quick view box displays the information as it will appear on receipts.

I3 New CR Receipts
File  Edt “iew Fawaortes Toolz Help

= D= R = 2

]|

1 Generall 2 Filtersl 2 Attributes 4 Farmat |

Detai Organization Name
Sort
Receipt Meszage [¥ Shaow organization address
ece't meat Organization name: |Eommunity Semvices [ne.
‘B Orgarnization Mame
Address: [1234 Main Street =
Charleston, SC 29789
Address quick wiew:
Community Services Inc.
1234 Main Street
Charleston, 5C 29789
< Back | L= Cancel Print Freview Layout

Creating CR Receipt Forms

Note: We offer high-quality, customized forms that are specifically designed for use with our software. These
forms, including checks, student bills, statements, invoices, purchase orders, tax forms, and envelopes, are
pre-printed in color with your organization’s logo and information. For more information, visit our Web site at
http://forms.blackbaud.com or call us toll-free at 866-4-BB-FORMS (866-422-3676).

You can add a message to the receipt, use an electronic signature, and print your organization’s logo.

» Creating CR receipt forms

In this example, we print CR receipts for application fee payments received between February 19th and

March 19th, 2003.

1. From the Cash Receipts Mail page, click Forms. The Forms page appears.
2. Inthe list on the left, select CR Receipts and click New on the action bar. The New CR Receipts screen

opens on the General tab.

3. In the Payment date field, select “Specific range”.
In Start date field, select “February 19th” using the calendar. In the End date field, select “March 19th”.

5. In the Deposit date field, select “Include all dates”.
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6. Inthe Include payments whose status is [ ] then change the status to printed field, select “Not yet
printed”.

1@ Mew CR Receipts I
File Edit “iew Favortes Tools Help

=R R e |

1: General |2: Filters| K3 .&ttlibutesl 4 Formatl

Include payments with these dates:
Paymentdate:  [<Speciicranges | »] Start date: [02/13/2003 ] End dete: [03/13/2003 =]
Deposit date: Ilnclude all dates 'I

Include payment numbers from; I ﬂl ta I ﬂl
Irciude deposit numbers from: I ﬁl ta I ﬁl

Include payments whose status is: ILInprinted vI then change the status to printed.

[~ Create an output queny of IF'ayments Vl

< Bach | Mext = | Cancel | Print | Freview | Layout |

| Press F3 for today's date, F7 for calendar

7. Click Next or select the Filters tab. Select payments for application fees. For more information about
filtering, see the Program Basics Guide.

I Mew CR Receipts
Eile Edit “iew Favortez Tools Help

RS R0 2 |

2 Attibutes I 4: Farmat |

1: General 4

Clear &1l Filters

Filters I Include I Selected Filkers I
Payment For Selected Application fees
Banks all <Al Banks>
Deposits Al <All Deposits =
Payments all <Al Payments =
Payment Atkributes Al <Al Payment Attributes=

8. Select the Format tab.
9. Inthe list on the left, select Sort.
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10. In the Sort by and Order by columns on the first row, select “Receipt Date” and “Ascending” to sort the
CR receipts numerically by receipt date.

1@ Mew CR Receipts
File Edit “iew Favortes Tools

Help

=R R e |

1 Generall 2 Filters| 3 Aftnbutes  4; Format |

Feceipt Message
Receipt Format
Organization N ame

Sort

Sort by

Order by

Receipt Date

Azcending

Note: If you mark Create an output query of [ ] on the General tab, the Save Static Query screen appears so
you can name and save the query.

11. Inthe list on the left, select Receipt Message.

12. Enter “Thank you for your prompt payment.” in the text box.

1@ Mew CR Receipts

File Edit “iew Favortes Tools

Help

= Hie= R el |

1 Generall 2 Filters| 3 Aftnbutes  4; Format I

Detail
Sort

pt 3
Receipt Format
Organization Name

Receipt Message

This text will pritit at the end of each receipt:

Thark you for your prompt payment,

13. In the list on the left, select Receipt Format.

14. Mark Print a logo on the form.

15. In the Logo file name field, browse to the graphic file containing your organization’s logo.
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16. In the Logo size field, select “Large (5 3/8 in. X 1in.)".

I Mew CR Receipts
Eile Edit “iew Favortez Tools Help

RS R0 2 |

1 Eeneral' 2 Filters| 2 Attibutes  4: Farmat |

Detail Receipt Format

Sart

Feceipt Meszage [~ Usze an electronic sighature
B Feceipt Fommat
Organization Mame

Authonized signature: |<Ng sighaturnes j

¥ Frint a logo on the form
Logo file name; |E:\My Pictures\Orgloga.jpg _I

Logosize:  [Large (53/Bin #1in) =l

17. Click Preview. A message appears telling you the program is processing the mailing, and the preview
screen for the CR receipts appears.

18. Close the preview and return to the Format tab.
19. Click the Save button on the action bar to save the new forms. The Save Mailing as screen appears.
20. Inthe Mailing name field, enter “CR Receipts for Application fees”.

Student Billing Forms

In Student Billing, you can create several types of forms to help manage billing for students and their payers.

Debit Memos — You can create debit memos for charges such as finance charges, tuition, and non-sufficient
funds.

Credit Memos — You can send credit memos to reflect credits such as those for overpayments.

Receipts — You can generate receipts for payments received and include details about the charges to which
payments were applied or the records to which payments were distributed.

Single Statements — Single statements list charge and payment activity for one student, individual, or
organization. These are helpful in instances such as when someone requests an additional copy of their
statement.

Statements — Statements list charge and payment activity for multiple students, individuals, and organizations
at one time.

Statements of Projected Charges — Statements of projected charges report charges and credits that will be
assessed to students, individuals, and organizations for a given period of time. These statements include
generated and ungenerated transactions that are scheduled (or will be scheduled based on bill codes) for a
specified time period.

“Publishing Statements to NetClassroom” on page 243. If you have the optional module NetClassroom,

you can publish single statements and statements to NetClassroom.
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Debit Memo Forms

Note: We offer high-quality, customized forms that are specifically designed for use with our software. These
forms, including checks, student bills, statements, invoices, purchase orders, tax forms, and envelopes, are
pre-printed in color with your organization’s logo and information. For more information, visit our Web site at
http://forms.blackbaud.com or call us toll-free at 866-4-BB-FORMS (866-422-3676).

You can create debit memos for individual charges such as tuition, finance charges, and non-sufficient funds fees.
For example, a student makes a payment by check but it is returned by the bank for non-sufficient funds. You can
send the student a debit memo notifying him that the check was returned and he now owes for the non-sufficient
fund fee plus the original payment amount.

Debit Memo Tabs

A debit memo has tabs on which you select parameters: General, Filters, Attributes, Address, and Format. To
move among the tabs, click Next and Back at the bottom of the screen or select the tab. On these tabs you
specify the records to include in the mailing and how the forms should look.

General Tab

On the General tab for debit memos, you select parameter settings specific to debit memos.

A Mew Debit Memos
File Edit “iew Favortez Toolz Help

H &S 5w 4w

l 2 Filters] 3 Attributes] EN Addres3| B Format

Include charges with these dates:

Transaction date: |Include all dates ﬂ
Past date: | Inchude all dates =l
Include charge branzaction numbers fram | ﬂ to | ﬁ

Include charges whose status is: Mot yet printed | then change the status to printed.

v Combine sales tax charges into debit memo total

[T Create an output guery of

| Mewut » | Cancel Prrint | Preview ‘ Layout

Transaction date. In the Transaction date field, select a date or date range for the transactions to include in
the form.

If you select <Specific range>, you can specify a start and end date. If the Start date field is blank, all activity is
included up to the end date. If the End date field is blank, all activity from the start date until present is
included. If both fields are blank, all activity is included.

Post date. In the Post date field, select a date or date range of post dates to include in the debit memo.
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If you select <Specific range>, you can specify a start and end date. If the Start date field is blank, all activity is
included up to the end date. If the End date field is blank, all activity from the start date until present is
included. If both fields are blank, all activity is included.

Include charge transaction numbers from [ ] to [ ]. In the Include charge transaction numbers from [ ] to
[ 1field, enter or select a range of charge transaction numbers to include in the form. If you leave both fields
blank, the form includes all charge transaction numbers.

Include charges whose status is [ ] then change the status to printed. In the Include charges whose
status is [ ] field, select Not yet printed, Reprint, or Both. After printing the debit memo, the print status is
changed to printed on the charge record.

Combine sales tax charges into debit memo total. Mark this checkbox to include sales tax in the total of
the debit memo. When marked, no separate debit memos print for sales tax charges.

Create an output query of [ ]. Mark Create an output query of [ ] to create a query of the records or charges
included in the debit memo. You can save and use an output query later for other mailings or reports.

Filters Tab

On the Filters tab, you select criteria that determines which items to include in a debit memo. For more
information about filtering, see the Program Basics Guide.

I@ Hew Debit Memos I
Fil=e Edit “iew Favortes Toolz Help
=R = e |

1 General {2 | a .t’-‘n.ttributesl ES .t’-‘n.ddressl 5 Farmat

f®0pen ) Clear Al Filters

Filkars I Include I Selected Filkers

Records all <Al Records =

Record Types all <Al Record Types >

Student Attributes all <All Student Attributes=

Individual Attributes all <Al Individual Attributes =

Drganization Aktributes all <Al Crganization Attributes =

Charges all <Al Charges =

Charge Aktribukes all <Al Charge Attributes =

< Back | Hemt » | Cancel | Print | Preview | Layout |

Open. To open a selection screen to designate specific filters for the form, select a filter in the grid and click
Open on the action bar.

Clear All Filters. To reset each filter to include all, you can click Clear All Filters.

Note: A filter is a requirement items must meet to be included in a form. For example, if you apply the Records
filter, only transactions for the selected records appear in the form.

Filters. The Filters column lists all the filters for the form. You cannot edit this column.
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Include. By default, in the Include column, each filter is set to All. To open a selection screen to designate
specific filters for the form, choose Selected.

Selected Filters. Filters you specify on the selection screen appear in the Selected Filters column.

Selected Filters Screen

From the Filters tab, you can open a selection screen for a filter in several ways: by double-clicking the filter in the
grid, selecting the filter in the grid and clicking Open on the action bar, or choosing Selected in the Include
column for the filter.

Selected Statement Recipients E= I

Include: @ &) Selecte ® [uen | Er=sious Filizr Mest Filter

Statement Recipient | Record 1D |

ar. I Cancel |

Include. For each filter, you can include all or select specific filters. Depending on the filter, you may also be able
to filter by a range or query.

All. If you mark Include: All, you cannot designate specific filters.

Selected or Range. If you mark Include: Selected or Range, a grid appears in which you can specify filters. In a
field, you can click the binoculars to search for information.

Query. If you mark Include: Query, the Query name field appears for you to enter the name of the query by
which to filter the form. In the field, you can click the binoculars to search for the query name.

To create a new query, click the binoculars. Then click Add a New Query on the Open Query screen. For more
information about creating queries, see the Query Guide.

Previous Filter. To view or edit the previous filter without returning to the Filters tab, click Previous Filter.
Next Filter. To view or edit the next filter without returning to the Filters tab, click Next Filter.

Attributes Tab

Note: An attribute is a tool used to group information based on a common theme. With attributes defined, you
can filter information to your specifications.
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You can use the Attributes tab to add, delete, or update transaction attributes for the charges included in the
debit memo.

A3 Mew Debit Memos
Fil= Edit “iew Favartes Toolz Help

4230 = - |

1. General I 2 Filters

: Address I 5 Format I

Ackion I Attribute Type I Descripkion I Shart Descriptionl Date I Required I Camments

| r

Action. In the Action column, you can select to add, delete, or update attributes on the charge record when you
generate debit memos.

Note: Attribute types are established in Configuration. For more information about creating attribute types,
see the Configuration Guide for Student Billing.

Attribute Type. In the Attribute Type column, you can select an attribute type.
Description. In the Description column you can enter or select a description for the attribute type.

Short Description. If you selected a table type attribute that uses short descriptions, in the Short Description
column, select the attribute description. The Description column completes automatically.

Date. In the Date column, select the date you add, delete, or update the attribute.

Required. If the attribute type you select is required, the program automatically marks the checkbox in the
Required? column.

Comments. In the Comments column, you can enter free-form text for additional information about the
attribute type.

Address Tab

Use the Address tab to specify whether addresses appear on debit memos. The program compares the
parameters you define on this tab with address information entered on the Addresses tab of the recipient’s
record to identify the appropriate address to use.
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On the Address tab, you select a validation date and then define the order in which the program evaluates
address types. The program first checks the validation date, then seasonal addresses, other address types (in the
order you determine), and attributes. The first address found on the recipient’s record that meets the defined
parameters is used on the debit memo. You can also specify what to do if no valid address is found.

I3 New Debit Memos I
File Edit View Favorites Tools Help

DI o~ 2- |

Bk Generall 2 Filtersl 2 Altributes

I 5: Format |

¥ Show record address
Yalidate addresses as of: IToday j
¥ Consider seasonal addresses
If no seasonal addrezses are found. consider these addresses
Addresses Addrezzes to caonsider, in order of importance

<First address found: -

Harme

Business

" acation

Summer

Action Attribute Type I Value

<l | 2
If nio address is found, IF'rint with ho address j

< Back | Mext = | Cancel | FErint | Freview | Layout |

Step 1. Mark Show record address to include the recipient’s address on the debit memo. If you unmark this
checkbox, all options on this tab are disabled and no address appears on the form.

Step 2. In the Validate addresses as of [ ] field, select a date to determine which address to use. Any address
that is valid on this date is considered for use on the debit memo. Any addresses that are not valid on this
date are automatically excluded from consideration.

Step 3. Determine whether to include seasonal addresses as possible addresses. If you mark Consider seasonal
addresses, the program uses the first valid seasonal address found on the student/relationship record and
does not consider any other addresses.

If the seasonal address has the Send no mail attribute, the seasonal address is excluded automatically as a
possible address. If a valid seasonal address is not found, the program considers the address types selected in
Step 4.

Step 4. In the If no seasonal addresses are found, consider these addresses frame, select which address types
to use if no valid seasonal addresses exist.

In the Addresses box, select an address type and click the right arrow to move it into the Addresses to
consider, in order of importance box. The first address type in the list that matches the validation date is
used on the debit memo. You can change the order addresses are considered by selecting an address type
and clicking the up and down arrows next to the list.

If a valid address is not found from these address types, the program considers the attributes selected in
Step 5.

Step 5. In the grid, you can select address attribute types to consider. For example, you have a “Billing address”
attribute you use to flag addresses for billing forms. When you select Include in the Action column and Billing
address in the Attribute column of the grid, the program automatically uses any valid addresses assigned this
attribute.
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Step 6. In the If no address is found field, select what to do if a valid address is not found. You can select Print
with no address, Remove record from run, or Print specific address. If you select to print a specific address,
the Use field appears so you can select the address type to use when a student/relationship does not have an
address of the types you added to the Addresses to consider, in order of importance list.

Format Tab

On the Format tab, you designate the format for the mailing. Settings on this tab determine the appearance of
the forms. For example, you can sort the mailing and select formats for displaying monetary amounts.

Detail. You can specify whether to include contact information in the address and which phone types to use.
Mark USPS bar code to print the recipient’s bar code with the address. The Address quick view box displays
the contact information as it will appear on the form. Options on the Detail screen are disabled if you
unmarked Show record address on the Address tab.

A& New Debit Memos
File Edit Yiew Favorites Tools Help

dada o= 2-

x|

1 General' 2 Filtersl i .&ttributesl 4 Address

Sort

Mizcellaneous
Form Alignment
Debit Memo Format
Organization Name
i Mame Formats

i [2] Memo Address
----- Mema Bady

Include this infarmation an the memo;

[~ Show contact information in address:

Caontact number: |<Ngne> 'I
Cantact number: I(None) YI

[~ USPS bar code

Address quick view:

Recond name
Address Lines
Address Lines

< Back | Hext » | Cancel |

FErint | F'reviegl Lapout |

Sort. You can use Sort to select the order for items to appear in the debit memo.

I3 New Debit Memos
File Edit Yiew Favorites Tools Help

Bada =2

il General' & Filtersl 2l .&ttributesl 4 Address 5 Format |

Debit Memo Format
Organization Name
i Mame Formats
i 2] Mema Address
i [2] Memo Baody

. Dietail Sort

‘B Sort

Mizcellaneous Sort by I Order by Iﬂ
Form Alignment Charge Date Ascending

In the first row in the Sort by column, select the item to sort the debit memo by. You can sort by charge date,

charge number, record name, or zip code.
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In the Order by column, select Ascending to sort the forms alphabetically or Descending to sort them in

reverse alphabetical order.

Miscellaneous. Use Miscellaneous to specify how you want numbers to appear on the debit memos and the

font size for debit memos.

I3 New Debit Memos
File Edit Yiew Favorites Tools Help

da 3P| ]| 2-

]|

1 Generall 2 Filtersl &t Attributesl 4 Addiess 5 Format I

Dietail
Sort

Forrm Alignmen Show percent sign on All amounts
BEb't Memo ::rmat Megative amount format (1234.56)
raanization Name Mumber of digits after dedmal for amounts 2
{5 Mame Formats

Mumber of digits after dedmal for percentages 2

Show 1000's separator fes

Show blanks instead of zeros Mo

Font size 3

Miscellaneous

Show currency character on All amounts

Sample amount:

Amount (51,234.56)
Percent 100.00%
< Back | Tiest > | Eancell FErint | F'reviegl Layout |

Form Alignment. You can use Form Alignment to specify vertical and horizontal alignment of the forms when

you print.

'Q New Debit Memos

File Edit View Favorites Tools

Help

dada a|=2-

BlE General' 2 Filtersl 2 Attributesl 4 Address 5 Format |

Deta Form Alignment
Sort

j I uhits = 0 inch

Mizcellaneous Wertical alignment; IDefauIt alignment
B Form Alignment ; :

Diehit Mermo Format Harizantal alignment: IDefauIt alignment
Organization Namne

i3 Mame Formats
; temo Address

j I uhits = 0 inch

Mote: 1 unit eguals 1/100th of an inch or 0.254 milimeters.

Note: The maximum alighment adjustment you can enter is 99. This moves the margin .99 inch.

In the Vertical alignment field, you can adjust the top margin for printing. You can select Default alignment,
Move printed information up, or Move printed information down and enter how much to move the
information. For example, if you select Move printed information up and enter 2, the information prints .02

inch higher on the page.
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In the Horizontal alignment field, you can adjust the left margin for printing. You can select Default
alignment, Move printed information left, or Move printed information right and enter how much to move
the information. For example, if you select Move printed information left and enter 2, the information prints

.02 inch toward the left on the page.

Debit Memo Format. You can use Debit Memo Format to select formatting features for debit memos.

I New Debit Memos
File Edit “iew Fawortes Toolz Help

BHRE & =2

]|

1 Generall 2 Filtersl 2 .-’-‘n.ttrit-utesl 4 Address & Format |

D etail Debit Memo Format
Sart
Miscellaneous Format: ||N\IBB|_|SD|_PPUD1 j ILaser format [pre-printed)
Formn &ligrment
‘B Debit Memo Format I=| Fiinta laggr o the farm -
Organization Marne Laoga file name: I _I
I_ = Mame Formats L - - -
Memo Address g0 FZe ILarge B30 % 1in] j
temao Body tizcellaneous information
Tranzaction spacing ISingle space j
[¥ Print & gray background for every other transaction
™| Brint & araw backanound for each beading
< Back | [dEnt s | Caticel | Erint | Freview | Lapout |

In the Format field, select the laser form you use for printing debit memos. If you select a blank paper format,

you can print a logo on the forms.

Note: If you mark Print a logo on the form, you must select the logo file name and logo size. Large logos are

53/8in.x1in; small logos are 2 1/2 in. x 1 in.

To print your organization’s logo on the forms, mark Print a logo on the form. In the Logo file name field,
browse to the file where your logo is saved in *.bmp format. In the Logo size field, select Large or Small for

the logo size to use on the forms.

In the Miscellaneous information frame, you can make additional formatting selections. In the Transaction
spacing field, select single space or double space for the amount of space to leave between lines. To make
reading the forms easier, you can mark Print a gray background for every other transaction or Print a gray

background for each heading.
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Organization Name. Use Organization Name to print your organization’s information at the top left of the
form. The information that appears in the Organization name and Address fields defaults from the General
tab of Configuration. If you mark Show organization address, you can enter or edit the name and address.

The Address quick view box displays the information as it will appear on debit memos.

I Hew Debit Memos
File  Edit “iew Fawarites

]|

Tonlz Help

= MW= R i

Dietail

Sort

Miscelaneous
Form &lignment
Drebit Memo Fomat
‘B Oiganization Mame
7 Mame Formats
Mema Address

----- Memo Body

1 Generall 2 Filtersl 2 .-’-\ttributesl 4: Address & Format |

Organization Name

¥ Show organization address

Organization name: |Eommunit_l,l Services Inc.

Address: ﬂ

Address quick view:

Community Services Inc.

< Back | L=

Cancel Print Freview Layout

Tip: We strongly recommend you use <Full name>. If you select Informal Addressee, Informal Salutation, or
any user-defined salutations from Configuration, the program reformats each name, therefore taking much
longer to run debit memos.
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Name Formats. Using Name Formats, you can format how names appear for organizations, individuals, and
students in the address and body sections of the debit memo. In the tree view on the left, you can select the
area of the form you want to format. Click Memo address to format how names appear in the header. Click
Memo body to format how names appear in the body area of the form.

I Hew Debit Memos I
File  Edt “iew Fawaortes Toolz Help
e == - |
1 Generall 2 Filtersl 2 .-’-\ttributesl 4: Address & Format |
Detsil Debit Memo Address Name Formats
Efrt I Organization-
ISCEtanenus Use name followed by: [~ Organization 10 [~ CFDA# I™ Cantact Name
Form &lignment Individual
Dbt Memo Format :
Digarization Mame Select addressee/zalutation fram: IHecnrd VI
I Mame Formats Use: [<Full name> -
; 5 Memo Address I J
Mema Body IF ot present, select addresseedsalutation from: IHecord vI
User| <Full name> =
Student -
Select addressea//zalutation from: IFlecnrd VI
Uz |<Fu|| narne:> j
|f mot prezent, select addresseezalutation from: IHecord vI
User| <Full name> =l
< Back | L= | Cancel | Print | Freview | Layout |

In the Organization frame, mark Organization ID, Contact name, and CFDA # for these items to appear after
the organization name.

In the Individual and Student frames, select Record or Configuration in the Select addressee/salutation from
[ 1 field.

If you select Record, in the Use field, select the full name, primary addressee, primary salutation, directory
name, diploma name, informal addressee, or informal salutation as defined on the individual or student
record.

If you select Configuration, in the Use field, select from one of the formats defined in Configuration.

Note: You must have the appropriate security rights to output an addressee/salutation with Social Security
numbers. If you do not have security rights, the numbers are masked. For more information, see the Security
chapter of the Administration Guide for The Financial Edge.

In the If not present...Select addressee/salutation from field, you can select a second name format for
situations where the first selection is not present on individual or student records. For example, if you select
Primary salutation, and you have students without a Primary salutation defined on the
Addressees/Salutations tab, the second name format is used. If you select <Full name> or Configuration in
the Use field, this field is disabled.

Creating Debit Memo Forms

Note: We offer high-quality, customized forms that are specifically designed for use with our software. These
forms, including checks, student bills, statements, invoices, purchase orders, tax forms, and envelopes, are
pre-printed in color with your organization’s logo and information. For more information, visit our Web site at
http://forms.blackbaud.com or call us toll-free at 866-4-BB-FORMS (866-422-3676).
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You can print debit memos on blank or pre-printed forms. For blank forms, you can add your organization’s logo.
You can also select the format to use for record names in the address and body of the memo.

» Creating debit memo forms

In this example, we print debit memos for students with charges this month.
1. From the Mail page in Student Billing, click Forms. The Forms page appears.
2. Inthe list on the left, select Debit Memos and click New on the action bar. The New Debit Memos screen

opens on the General tab.
3. In the Transaction date field, select “This month”.
In the Post date field, select “Include all dates”.

5. In the Include charges whose status is [ ] then change the status to printed field, select “Not yet

printed”.
I3 Mew Debit Memos
File Edit “iew Favontez Toolz Help
b

= e =R =

2 Filtersl 3 Attributesl 4 Addressl 5: Format

Include charges with these dates:

Tranzaction date; IThiS month vI 03/01/2005 to 03431 /2005
Ilnc:lude all dates ’I

Pozt date:

| o | |
Include charges whose status is: INDt yet printed vl then change the status to printed.

Include charge transaction numbers from I

[v Combine sales tax charges into debit memo taotal

[T Create an output query of ICharges 'I

< Back | Mest » | Cancel | Print

Freview

Layout

6. Click Next or select the Filters tab.
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7. Select “Student” for the Record Types filter. For more information about filtering, see the Program Basics
Guide.

I3 Mew Debit Memos
File Edit “iew Favortes Toolz Help

IRl R |

1: General ”_: i
Filters I Include I Selected Filkers I
Records all <Al Records =
Record Types Selected Student
Student Attributes all <Al Student Attributes=
Individual Attributes all <Al Individual Attributes
Organization Attributes all <All Drganization Attributes =
Charges all <Al Charges=
Charge Attributes all <All Charge Attributes=

Select the Format tab.
9. Inthe list on the left, select Sort.

10. In the Sort by and Order by columns on the first row, select “Record Name” and “Ascending” to sort the
debit memos alphabetically by record names.

I3 Mew Debit Memos E

File Edit “iew Favontes Tools Help
== R el |

1 Generall 2 Filters | 3 .&ttlibutesl 4 Address

Detail Sort

B Sort

Miscellaneous Sort by | Order by |
Form Alignment Recard Name Ascending

Debit Memo Format
Organization Name
|5 Mame Farmats
temo Address
temo Body

11. Click Preview. A message appears telling you the program is processing the mailing, and the preview
screen for the debit memos appears.

12. Close the preview and return to the Format tab.
13. Click the Save button on the action bar to save the new forms. The Save Mailing as screen appears.

14. In the Mailing name field, enter “Student Debit Memos”.
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15. In the Description field, enter “Debit Memos for March 2005”.

Save Mailing as I

ailing name: IStudent Debit Memos

Description: |Debit Memos far March 2005

¥ Others can run this mailing
[ Others can modify this mailing

H 5ave | Cancel |

16. Click Save to save the new forms. You return to the Format tab.
17. Close the screen. You return to the Forms page, and the debit memo form appears in the grid.

Credit Memo Forms

Note: We offer high-quality, customized forms that are specifically designed for use with our software. These
forms, including checks, student bills, statements, invoices, purchase orders, tax forms, and envelopes, are
pre-printed in color with your organization’s logo and information. For more information, visit our Web site at
http://forms.blackbaud.com or call us toll-free at 866-4-BB-FORMS (866-422-3676).

You can send credit memos to reflect standalone credits such as those for overcharges. For example, a student
calls to notify your school that he was overcharged on his last bill. You verify the mistake, credit the student’s
account for the amount he was overcharged, and mail him a credit memo as a record that the credit was made.

Credit Memo Tabs

A credit memo has tabs on which you select parameters: General, Filters, Attributes, Address, and Format. To
move among the tabs, click Next and Back at the bottom of the screen or select the tab. On these tabs you
specify the records to include in the mailing and how the forms should look.
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General Tab

On the General tab for credit memos, you select parameter settings specific to credit memos.

13 new Credit Memos I
File Edit View Favorites Tools Help

dadag = e |

1: General |g: Filtersl 3 Attributesl 4: Address | 5: Format

Include credits with these dates:

Transaction date; Include all dates

Post date: Ilnclude all dates 'I
Include credit tranzaction numbers from I ﬂ ta I ﬂ

Include credits whose status iz INgt_.,.et prinked vI then change the status to printed.
[~ Create an output queny of IEredits "l

< Back | Mest » | Cancel | Frint | Freview | Lapout |

Transaction date. In the Transaction date field, select a date or date range for the credit transactions to
include in the credit memo.

If you select <Specific range>, you can specify a start and end date. If the Start date field is blank, all activity is
included up to the end date. If the End date field is blank, all activity from the start date until present is
included. If both fields are blank, all activity is included.

Post date. In the Post date field, select a date or date range of post dates to include in the credit memo.

If you select <Specific range>, you can specify a start and end date. If the Start date field is blank, all activity is
included up to the end date. If the End date field is blank, all activity from the start date until present is
included. If both fields are blank, all activity is included.

Include credit transaction numbers from [ ] to [ ]. In the Include credit transaction numbers from [ ] to[ ]
field, enter or select a range of credit transaction numbers to include in the credit memo. If you leave both
fields blank, the credit memo includes all credit transaction numbers.

Include credits whose status is [ ] then change the status to printed. In the Include credits whose
status is [ ] field, select Not yet printed, Reprint, or Both. After printing the credit memo, the print status is
changed to printed on the credit record.

Create an output query of [ ]. Mark Create an output query of [ ] to create a query of the records or credits
included in the credit memos. You can save and use an output query later for other mailings or reports.
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Filters Tab

On the Filters tab, you select criteria that determines which items to include in a credit memo. For more
information about filtering, see the Program Basics Guide.

13 Hew Credit Memos
File Edit View Favorites Tools Help

dada - \

1: Genera :Attributesl 4: .&ddressl 5 Folmatl
&5 Open 7, Clear Al Filers
Filters | tndude | Selected Filters |
Records Al <All Records =
Record Types All <All Record Types=
Student Attributes Al <Al Student Attributes>
Individual Attributes all <All Individual Attributes=>
Organization Attributes all <Al Organization Attributes>
Credits Al <Al Credits >
Credit Attributes Al <All Credit Attributes >

Open. To open a selection screen to designate specific filters for the form, select a filter in the grid and click
Open on the action bar.

Clear All Filters. To reset each filter to include all, you can click Clear All Filters.

Note: A filter is a requirement items must meet to be included in a form. For example, if you apply the Records
filter, only transactions for the selected records appear in the form.

Filters. The Filters column lists all the filters for the form. You cannot edit this column.

Include. By default, in the Include column, each filter is set to All. To open a selection screen to designate
specific filters for the form, choose Selected.

Selected Filters. Filters you specify on the selection screen appear in the Selected Filters column.
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Selected Filters Screen

From the Filters tab, you can open a selection screen for a filter in several ways: by double-clicking the filter in the

grid, selecting the filter in the grid and clicking Open on the action bar, or choosing Selected in the Include
column for the filter.

Selected Records B I

Includs: @ All & ® Range @ Query . Breyious Filier  MestFilter [

I Record Mame I Record ID I

|

(]S I Cancel |

Include. For each filter, you can include all or select specific filters. Depending on the filter, you may also be able
to filter by a range or query.

All. If you mark Include: All, you cannot designate specific filters.

Selected or Range. If you mark Include: Selected or Range, a grid appears in which you can specify filters. In a
field, you can click the binoculars to search for information.

Query. If you mark Include: Query, the Query name field appears for you to enter the name of the query by
which to filter the form. In the field, you can click the binoculars to search for the query name.

To create a new query, click the binoculars. Then click Add a New Query on the Open Query screen. For more
information about creating queries, see the Query Guide.

Previous Filter. To view or edit the previous filter without returning to the Filters tab, click Previous Filter.
Next Filter. To view or edit the next filter without returning to the Filters tab, click Next Filter.

Attributes Tab

Note: An attribute is a tool used to group information based on a common theme. With attributes defined, you
can filter information to your specifications.

You can use the Attributes tab to add, delete, or update transaction attributes for the credits included in the
credit memo.

12 New Credit Memos
File Edit View Favorites Tools Help

dladal - ?- \

ol General' 2 Filters

| 4 Addressl b Formatl

Acﬁonl Attribute Type | Description |ShcrtDescri|:lﬁcn| Date |Required| Comments |

-
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Action. In the Action column, you can select to add, delete, or update attributes on credit records when you
generate credit memos.

Attribute Type. In the Attribute Type column, you can select an attribute type.

Description. In the Description column you can enter or select a description for the attribute type.

Note: Attribute types are established in Configuration. For more information about creating attribute types,
see the Configuration Guide for Student Billing.

Short Description. If you selected a table type attribute that uses short descriptions, in the Short Description
column, select the attribute description. The Description column completes automatically.

Date. In the Date column, select the date you add, delete, or update the attribute.

Required. If the attribute type you select is required, the program automatically marks the checkbox in the
Required? column.

Comments. In the Comments column, you can enter free-form text for additional information about the
attribute type.

Address Tab

Use the Address tab to specify whether addresses appear on credit memos. The program compares the
parameters you define on this tab with address information entered on the Addresses tab of the recipient’s
record to identify the appropriate address to use.

On the Address tab, you select a validation date and then define the order in which the program evaluates
address types. The program first checks the validation date, then seasonal addresses, other address types (in the
order you determine), and attributes. The first address found on the recipient’s record that meets the defined
parameters is used on the credit memo. You can also specify what to do if no valid address is found.

x]|

13 New Credit Memos
File Edit View Favorites Tools Help
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Step 1. Mark Show record address to include the recipient’s address on the credit memo. If you unmark this
checkbox, all options on this tab are disabled and no address appears on the form.

Step 2. In the Validate addresses as of [ ] field, select a date to determine which address to use. Any address
that is valid on this date is considered for use on the credit memo. Any addresses that are not valid on this
date are automatically excluded from consideration.
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Step 3. Determine whether to include seasonal addresses as possible addresses. If you mark Consider seasonal
addresses, the program uses the first valid seasonal address found on the student/relationship record and
does not consider any other addresses.

If the seasonal address has the Send no mail attribute, the seasonal address is excluded automatically as a
possible address. If a valid seasonal address is not found, the program considers the address types selected in
Step 4.

Step 4. In the If no seasonal addresses are found, consider these addresses frame, select which address types
to use if no valid seasonal addresses exist.

In the Addresses box, select an address type and click the right arrow to move it into the Addresses to
consider, in order of importance box. The first address type in the list that matches the validation date is
used on the credit memo. You can change the order addresses are considered by selecting an address type
and clicking the up and down arrows next to the list.

If a valid address is not found from these address types, the program considers the attributes selected in
Step 5.

Step 5. In the grid, you can select address attribute types to consider. For example, you have a “Billing address”
attribute you use to flag addresses for billing forms. When you select Include in the Action column and Billing
address in the Attribute column of the grid, the program automatically uses any valid addresses assigned this
attribute.

Step 6. In the If no address is found field, select what to do if a valid address is not found. You can select Print
with no address, Remove record from run, or Print specific address. If you select to print a specific address,
the Use field appears so you can select the address type to use when a student/relationship does not have an
address of the types you added to the Addresses to consider, in order of importance list.

Format Tab

On the Format tab, you designate the format for the mailing. Settings on this tab determine the appearance of
the forms. For example, you can sort the mailing and select formats for displaying monetary amounts.

Detail. You can specify whether to include contact information in the address and which phone types to use.
Mark USPS bar code to print the recipient’s bar code with the address. The Address quick view box displays
the contact information as it will appear on the form. Options on the Detail screen are disabled if you
unmarked Show record address on the Address tab.

I3 new Credit Memos I
File Edit Yiew Favorites Tools Help
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Sort
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Cantact number: |<N0ne> 'I
Cantact number: I{None} 'I

[~ USPS bar code

Address quick view:

Fecord name
Address Lines
Address Lines

< Back | st >

Cancel FErint Freview Layout




Forms 15

Sort. You can use Sort to select the order for items to appear in the credit memo.

13 new Credit Memos

= TS R Nl

File Edit Yiew Favorites Tools Help

3|

?v

x]|

Detail
‘B Sort

Mizcellaneous
Form Alignment
Credit Mema Format
Organization Name
b~ Mame Formats
; temo Address

] General' 2 Filtersl gt .&ttributesl 4 Address 5 Format I

Sort

Sort by

Credit Date

I Order by Iﬂ
Ascending

In the first row in the Sort by column, select the item to sort the credit memo by. You can sort by credit date,
credit number, record name, or zip code.

In the Order by column, select Ascending to sort the forms alphabetically or Descending to sort them in
reverse alphabetical order.

font size for credit memos.

Miscellaneous. Use Miscellaneous to specify how you want numbers to appear on the credit memos and the

I3 new Credit Memos I
File Edit View Favorites Tools Help
EIERE Y= X |
1 Generall 2 Filtersl & Attributesl 4 Addiess 5 Format I
Detai Miscellaneous
Sort
¢ 5 EOUS Show currency character on All amounts
Form Alignment Show percent sign on All amounts
grEd't .Merno ;ormat Megative amount format (1234.56)
raanization Name Mumber of digits after dedmal for amounts 2
{5 Mame Formats
F Memo Address Mumber of digits after dedmal for percentages 2
i tema Body Show 1000's separator Yes
Show blanks instead of zeros Mo
Font size 3
Sample amount:
Amount (81,234.56)
Percent 100.00%
< Back | Hext > Cancel FErint Freview Layout
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Form Alignment. You can use Form Alignment to specify vertical and horizontal alighment of the forms when
you print.

I New Credit Memos [ x| I
Fil= Edit “iew Fawortes Tools Help

IR IRl el R |

1 Genelall 2 Filtersl 3 .-’-‘n.ttributesl 4: Address & Format |

Detail Form Alignment

Sart
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‘B Fom Alignment : ) . .
Credit Memo Fomat Harizontal alignmet: |Defau|t aligrment j I units = Oinch
ﬁ;g;:|:2:|;2t§ ame Mate: 1 unit equals 1/100th of an inch or 0.254 millimeters.

b [B] Memo Address

----- Mo Body

< Back | [Hexts Cancel Frrint Preview Layout

Note: The maximum alignment adjustment you can enter is 99. This moves the margin .99 inch.

In the Vertical alighment field, you can adjust the top margin for printing. You can select Default alignment,
Move printed information up, or Move printed information down and enter how much to move the
information. For example, if you select Move printed information up and enter 2, the information prints .02

inch higher on the page.

In the Horizontal alignment field, you can adjust the left margin for printing. You can select Default
alignment, Move printed information left, or Move printed information right and enter how much to move
the information. For example, if you select Move printed information left and enter 2, the information prints
.02 inch toward the left on the page.
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Credit Memo Format. You can use Credit Memo Format to select formatting features for credit memos.

I3 new Credit Memos
File Edit Yiew Favorites Tools Help
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b General' 2 Filtersl al .&ttributesl 4 Address 5 Format I

Detail Credit Memo Format
Sort
Miscellaneous Format; IINVBBUSDLPF’DD‘I j |Laser format [pre-printed)
Form Alignment :
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Organization Name Loga file name: I _I
i Mame Formats : i - -
: WMemo Address 090 SI2e ILarge [BE3Bin«Tin) j
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Transaction spacing ISingle space j
v Print a gray background for every ather transaction
7 aray backg Y
[ Fiint & gray backaraund for each heading
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In the Format field, select the laser form you use for printing credit memos. If you select a blank paper

format, you can print a logo on the forms.

Note: If you mark Print a logo on the form, you must select the logo file name and logo size. Large logos are

53/8in.x 1in; small logos are 2 1/2 in. x 1 in.

To print your organization’s logo on the forms, mark Print a logo on the form. In the Logo file name field,
browse to the file where your logo is saved in *.bmp format. In the Logo size field, select Large or Small for

the logo size to use on the forms.

In the Miscellaneous information frame, you can make additional formatting selections. In the Transaction
spacing field, select single space or double space for the amount of space to leave between lines. To make
reading the forms easier, you can mark Print a gray background for every other transaction or Print a gray

background for each heading.
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Organization Name. Use Organization Name to print your organization’s information at the top left of the

form. The information that appears in the Organization name and Address fields defaults from the General
tab of Configuration. If you mark Show organization address, you can enter or edit the name and address.
The Address quick view box displays the information as it will appear on credit memos.

I3 new Credit Memos
File Edit View Favorites Tools Help

daINP| =] 2-
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Dietail

Sort
Miscellaneous
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¥ Show organization address

Organization Name

Organization name: ICommunity Services Inc.
Credit Memao Format
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{5 Mame Formats
i [2) Memo Address

Charleston, SC 23403
Phone: [800] 488-2424

Addrezs quick view:

Address: |3 Broad Street ;I

----- tema B ody LI

Community Services Inc.
3 Broad Street

Charleston, SC 29403

Phone: (800) 488-2424

< Back | st > Cancel FErint Freview

Layout

Tip: We strongly recommend you use <Full name>. If you select Diploma Name, Informal Addressee, Informal

Salutation, or any user-defined salutations from Configuration, the program reformats each name, therefore
taking much longer to run credit memos.
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Name Formats. Using Name Formats, you can format how names appear for organizations, individuals, and
students in the address and body sections of the credit memo. In the tree view on the left, you can select the
area of the form you want to format. Click Memo Address to format how names appear in the header. Click
Memo Body to format how names appear in the body area of the form.

I3 new Credit Memos I
File Edit Yiew Favorites Tools Help
dad a2 |
1 Generall 2 Filtersl 2 Attributesl 4 Addiess 5 Format I
Detai Credit Memo Address Name Formats
if[t I 0 ization
IBEElaneouE Use name followed by: [~ Organization D [~ CFDAH [ Contact Name
Form dlignment Individual.
Credit Memao Format ;
Digarization Name Select addreszeezalutation from: IHecord vI
Name Format Use: |<Fu|| hames ﬂ
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Student -
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Use: |<Fu|| name: j
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< Back | Heqt > | Cancel | FErint | Freview | Layout |

In the Organization frame, mark Organization ID, CFDA #, and Contact name for these items to appear after
the organization name.

In the Individual and Student frames, select Record or Configuration in the Select addressee/salutation from
[ 1field.

If you select Record, in the Use field, select the full name, primary addressee, primary salutation, directory
name, diploma name, informal addressee, or informal salutation as defined on the individual or student
record.

If you select Configuration, in the Use field, select from one of the formats defined in Configuration.

Note: You must have the appropriate security rights to output an addressee/salutation with Social Security
numbers. If you do not have security rights, the numbers are masked. For more information, see the Security
chapter of the Administration Guide for The Financial Edge.

In the If not present, select addressee/salutation from field, you can select a second name format for
situations where the first selection is not present on individual or student records. For example, if you select
Primary salutation, and you have students without a Primary salutation defined on the
Addressees/Salutations tab, the second name format is used. If you select <Full name> in the Use field or
Configuration in the Select addressee/salutation from field, this field is disabled.

Creating Credit Memo Forms

Note: We offer high-quality, customized forms that are specifically designed for use with our software. These
forms, including checks, student bills, statements, invoices, purchase orders, tax forms, and envelopes, are
pre-printed in color with your organization’s logo and information. For more information, visit our Web site at
http://forms.blackbaud.com or call us toll-free at 866-4-BB-FORMS (866-422-3676).



162 CHAPTER

You can print credit memos on blank or pre-printed forms. For blank forms, you can add your organization’s logo.
You can also select the format to use for record names in the address and body of the memo.

» Creating credit memo forms
In this example, we print credit memos for students with credits this month.

1. From the Mail page in Student Billing, click Forms. The Forms page appears.

2. Inthe list on the left, select Credit Memos and click New on the action bar. The New Credit Memos
screen opens on the General tab.

3. Inthe Transaction date field, select “This month”.
In the Post date field, select “Include all dates”.
5. In the Include credits whose status is [ ] then change the status to printed field, select “Not yet printed”.

I3 Mew Credit Memos I

File Edit “iew Favontes Tools Help
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6. Click Next or select the Filters tab.
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Select “Student” for the Record Types filter. For more information about filtering, see the Program Basics
Guide.

I3 new Credit Memos E3

File Edit View Favorites Tools Help
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Select the Format tab.
In the list on the left, select Sort.

In the Sort by and Order by columns on the first row, select “Record Name” and “Ascending” to sort the
credit memos alphabetically by record names.

I3 Mew Credit Memos E
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Click Preview. A message appears telling you the program is processing the mailing, and the preview
screen for the credit memos appears.

Close the preview and return to the Format tab.

Click the Save button on the action bar to save the new forms. The Save Mailing as screen appears.
In the Mailing name field, enter “Student Credit Memos”.

In the Description field, enter “Credit Memos for March 2005”.

Click Save to save the new forms. You return to the Format tab.

Close the screen. You return to the Forms page, and the credit memo form appears in the grid.
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Receipt Forms

Note: We offer high-quality, customized forms that are specifically designed for use with our software. These
forms, including checks, student bills, statements, invoices, purchase orders, tax forms, and envelopes, are
pre-printed in color with your organization’s logo and information. For more information, visit our Web site at
http://forms.blackbaud.com or call us toll-free at 866-4-BB-FORMS (866-422-3676).

You can generate receipts for payments received and include details about the charges to which payments were
applied or the records to which payments were distributed.
Receipt Tabs

A receipt has tabs on which you select parameters: General, Filters, Attributes, Address, and Format. To move
among the tabs, click Next and Back at the bottom of the screen or select the tab. On these tabs you specify the
records to include in the mailing and how the forms should look.

General Tab

On the General tab, you select parameter settings specific to receipts.
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Note: You must have the appropriate security rights to output credit card numbers. If you do not have security
rights, the numbers are masked. For more information, see the Security chapter of the Administration Guide
for The Financial Edge.

Payment date. In the Payment date field, select a date or date range for payment dates to include in the
receipt.

If you select <Specific range>, you can specify a start and end date. If the Start date field is blank, all activity is
included up to the end date. If the End date field is blank, all activity from the start date until present is
included. If both fields are blank, all activity is included.

Deposit date. In the Deposit date field, select a date or date range for deposit dates to include in the receipt.
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If you select <Specific range>, you can specify a start and end date. If the Start date field is blank, all activity is
included up to the end date. If the End date field is blank, all activity from the start date until present is
included. If both fields are blank, all activity is included.

Include payment numbers from [ ] to [ ]. In the Include payment numbers from [ ] to [ ] field, enter or
select a range of payment numbers to include in the receipt. If you leave both fields blank, the form includes
all payment numbers.

Include deposit numbers from [ ] to [ ]. In the Include deposit numbers from [ ] to [ ] field, enter or select a
range of deposit numbers to include in the receipt. If you leave both fields blank, the form includes all deposit
numbers.

Include payments whose status is [ ] then change the status to printed. In the Include payments
whose status is [ ] field, select Not yet printed, Reprint, or Both. After printing the receipt, the print status is
changed to printed on the payment record.

Create an output query of [ ]. Mark this option to create a query of payments, deposits, or records that
appear in the receipts. You can save and use an output query later for other mailings or reports.

Filters Tab

On the Filters tab, you select criteria that determines which items to include in a receipt. For more information
about filtering, see the Program Basics Guide.
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Open. To open a selection screen to designate specific filters for the form, select a filter in the grid and click
Open on the action bar.

Clear All Filters. To reset each filter to include all, you can click Clear All Filters.
Note: A filter is a requirement items must meet to be included in a form. For example, if you apply the Records
filter, only transactions for the selected records appear in the form.

Filters. The Filters column lists all the filters for the form. You cannot edit this column.

Include. By default, in the Include column, each filter is set to All. To open a selection screen to designate
specific filters for the form, choose Selected.
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Selected Filters. Filters you specify on the selection screen appear in the Selected Filters column.

Selected Filters Screen

From the Filters tab, you can open a selection screen for a filter in several ways: by double-clicking the filter in the
grid, selecting the filter in the grid and clicking Open on the action bar, or choosing Selected in the Include
column for the filter.

Selected Records B I

Includs: @ All ! & ® Range @ Query . Fi= Filier  Mest Filter |

I Record Mame I Record ID I

|

(]S I Cancel |

Include. For each filter, you can include all or select specific filters. Depending on the filter, you may also be able
to filter by a range or query.

All. If you mark Include: All, you cannot designate specific filters.

Selected or Range. If you mark Include: Selected or Range, a grid appears in which you can specify filters. In a
field, you can click the binoculars to search for information.

Query. If you mark Include: Query, the Query name field appears for you to enter the name of the query by
which to filter the form. In the field, you can click the binoculars to search for the query name.

To create a new query, click the binoculars. Then click Add a New Query on the Open Query screen. For more
information about creating queries, see the Query Guide.

Previous Filter. To view or edit the previous filter without returning to the Filters tab, click Previous Filter.
Next Filter. To view or edit the next filter without returning to the Filters tab, click Next Filter.
Attributes Tab

You can use the Attributes tab to add, delete, or update transaction attributes for payments.

I3 New SB Receipts I
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Action. In the Action column, you can select to add, delete, or update attributes on the payment record when
you generate receipts.

Note: Attribute types are established in Configuration. For more information about creating attribute types,
see the Configuration Guide for Student Billing.

Attribute Type. In the Attribute Type column, you can select an attribute type.
Description. In the Description column you can enter or select a description for the attribute type.

Short Description. If you selected a table type attribute that uses short descriptions, in the Short Description
column, select the attribute description. The Description column completes automatically.

Date. In the Date column, select the date you add, delete, or update the attribute.

Note: An attribute is a tool used to group information based on a common theme. With attributes defined, you
can filter information to your specifications.

Required. If the attribute type you select is required, the program automatically marks the checkbox in the
Required? column.

Comments. In the Comments column, you can enter free-form text for additional information about the
attribute type.

Address Tab

Use the Address tab to specify whether addresses appear on receipts. The program compares the parameters
you define on this tab with address information entered on the Addresses tab of the payer’s record to identify the
appropriate address to use.

On the Address tab, you select a validation date and then define the order in which the program evaluates
address types. The program first checks the validation date, then seasonal addresses, other address types (in the
order you determine), and attributes. The first address found on the recipient’s record that meets the defined
parameters is used on the receipt. You can also specify what to do if no valid address is found.

A& New SB Receipts |
Eile Edit Wiew Favorites Tools Help

W& ]2 |

1 General' 2 Filtersl 2: Attributes

I 5: Format |

v Show payer address [~ Check for address on payment record first
Yalidate addresses as of: IToda_l,l j

v Consider seasonal addresses

If no seasonal addresses are found, consider these addresses -
Addreszes Addresses to consider, in order of importance
<First address found: <Primary address:

Home
Business

" acation
Summer

Action Attribute Type I Value

4] | |

If no address iz found. IF'rint with no address j

< Back | Mest » | Cancel Frint Preview | Lapout |




168 CHAPTER

Step 1. Mark Show payer address to include the payer’s address on the receipt. If you unmark this checkbox, all
options on this tab are disabled and no address appears on the form. Mark Check for address on payment
record first to use the address selected on the payment record. If no address was selected on the payment,
the program uses the other settings on this tab to identify which address to use.

Step 2. In the Validate addresses as of [ ] field, select a date to determine which address to use. Any address
that is valid on this date is considered for use on the receipt. Any addresses that are not valid on this date are
automatically excluded from consideration.

Step 3. Determine whether to include seasonal addresses as possible addresses. If you mark Consider seasonal
addresses, the program uses the first valid seasonal address found on the student/relationship record and
does not consider any other addresses.

If the seasonal address has the Send no mail attribute, the seasonal address is excluded automatically as a
possible address. If a valid seasonal address is not found, the program considers the address types selected in
Step 4.

Step 4. In the If no seasonal addresses are found, consider these addresses frame, select which address types
to use if no valid seasonal addresses exist.

In the Addresses box, select an address type and click the right arrow to move it into the Addresses to
consider, in order of importance box. The first address type in the list that matches the validation date is
used on the receipt. You can change the order addresses are considered by selecting an address type and
clicking the up and down arrows next to the list.

If a valid address is not found from these address types, the program considers the attributes selected in
Step 5.

Step 5. In the grid, you can select address attribute types to consider. For example, you have a “Billing address”
attribute you use to flag addresses for billing forms. When you select Include in the Action column and Billing
address in the Attribute column of the grid, the program automatically uses any valid addresses assigned this
attribute.

Step 6. In the If no address is found field, select what to do if a valid address is not found. You can select Print
with no address, Remove record from run, or Print specific address. If you select to print a specific address,
the Use field appears so you can select the address type to use when a student/relationship does not have an
address of the types you added to the Addresses to consider, in order of importance list.

Format Tab

On the Format tab, you designate the format for the mailing. Settings on this tab determine the appearance of
the receipts. For example, you can sort the mailing and select formats for displaying monetary amounts.



Detail. Use Detail to select what items of detail to print on receipts.

I New Receipts
File Edit Wiew Favorites Tools Help

1 Genelall 2 Flltersl 3 Attnbutesl 4 Addres

Detail
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Mizcellaneous v Sholeharges thiz payment was applied to J
Fieceipt Message N ) )
Alignment Include this infarmation on the receipt:
Fieceipt Farmat [ Show contact information in address:
Organization Mame Contact number: |<N0ne> vI
7 Mame Formats
L [B) Receipt Address Contact number: I(None> vI
i [2) Recsipt Body ™ USPS bar code
Address quick view:
Record name
Address Lines
Address Lines
< Back | et | Cancel | Print | Preview | Layout |
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To show payment applications or distributions, mark Show and select Charges this payment was applied to or

Records this payment was distributed to.

You can also specify whether to include contact information in the address and which phone types to use.
Mark USPS bar code to print payer’s bar code with the address. The Address quick view box displays the
contact information as it will appear on the form. Address options on the Detail screen are disabled if you

unmarked Show payer address on the Address tab.
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Sort. You can use Sort to select the order for items to appear in the receipt.

I New Receipts I
File Edit Wiew Favorites Tools Help

e = e |

1 Genelall s Filtersl 3 Attributesl 4 Address B Format |

Sort

Dretail
E ik

Mizcelaneous Sort by | Order by |
Receipt Message Payment Date Ascending

Alignment

Feceipt Format
Orgarization Marme
7 Mame Formats

i 2] Receipt Address

< Back | et | Cancel | Print | Preview | Layout |

In the first row in the Sort by column, select the item to sort the receipt by. You can sort by payment date,
deposit number, payment number, record name, payment type, or zip code.

In the Order by column, select Ascending to sort the forms alphabetically or Descending to sort them in
reverse alphabetical order.
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Miscellaneous. Use Miscellaneous to specify how you want numbers to appear on the receipts and the font

size for receipts.

n Mew Receipts
Fil=  Edit Wiew Faworites

EH <=2

Toolz: Help
? -

1 Genelal] 2 Filters] 3 .-’-\ttributes] 4: Address & Format ]

=] Detail
5] Sort

Miscellaneous

uz Show currency character on All amounts
=] Receipt Message Show percent sign on all amounts
=l .-’-‘n.lignr!'lent Megative amount Format {1234.58)
j E?gcaer:?zlaiiz:n;lame Mumber of digits after decimal for amounts z
“5) Mame Formats Mumber of digits after decimal For percentages z
E] Receipt Address Show 1000's separator Yes
- |Z] Receipt Body Show blanks instead of zeros Mo
Font size g
Sample amaoLint:
Amount ($1,234.56)
Percent 100.00%
< Back | | Caticel Frint Preview Lapout |

Receipt Message. Use Receipt Message to enter text you want to appear at the end of each receipt.

n Mew Heceipts

File Edit “iew Faworites

H &2 %W

=] Detail
=] Sort

=] Miscellaneous

1
=] alignment
2] Receipt Format
2] Organization Mame
| Mame Formats
i [2] Receipt Address
i [2] Receipt Body

Toole Help
? -

1 General] 2 Filters] 2 .-’-‘n.ttrit-utesl 4 Address & Format ]

Receipt Message

This text will print at the end of each receipt:

< Back

Cancel

Erint

Freview

Lapout
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Alignment. You can use Alignment to specify vertical and horizontal alignment of the forms and addresses
when you print.

1@ New Receipts [ x| I
Fil= Edit “iew Fawortes Tools Help
e == 2 |
1 Genelall 2 Filtersl 3 .-’-‘n.ttributesl 4: Address & Format |
Deetail Form Alignment
Sart )
Miscellaneaus Form Alignment:
Ce'pt Message Wertical slignment: IDefauIt aligrment j | unitz = Oinch
‘B Algnment
Receipt Format Harizontal alignment: IDefauIt aligrrment j I units = Oinch
Organization Mame
=] Mame Formats Mate: 1 unit equals 1/100th of an inch or 0.254 millimeters.
i [2) Receipt Address
..... Recsipt Body Address Alignment: .
Wertical alignment: IDefauIt aligrment j I units = Dinch
Harizantal slignment: IDefauIt aligrment j | uritz = Oinch
Mate: 1 unit equals 1,/100th of an inch or 0.254 millimeters.
< Back | [Hexts Cancel Frrint Preview Layout

Note: The maximum alignment adjustment you can enter is 99. This moves the margin .99 inch.

In the Form Alignment frame, you can adjust the form’s top and left margins for printing using the Vertical
alignment and Horizontal alignment fields. You can move printed information up or down or left or right and
enter how much to move the information. For example, if you select Move printed information up and enter
2, the information prints .02 inch higher on the page.

Addresses for the receipt recipient are aligned by default to fit the first five lines in a standard envelope
address window. If you need to make adjustments, in the Address Alignment frame, you can move printed
information up or down or left or right and enter how much to move the information. For example, if you
select Move printed information up and enter 2, the address prints .02 inch higher on the page.



Receipt Format. You can use Receipt Format to select formatting features for receipts.

I New Receipts I
File Edit Wiew Favorites Tools Help
SR =l |
1 Genelall s Filtersl 3 Attributesl 4 Address B Format |
Detail Receipt Format
Sort
Mizcellaneaus [ Use an electionic signature -
H?CEiDl Meszage Avtharized signature: |<Nc. signatures j
Alignment
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N F t )
Gl ame Formats [~ Print & logo on the form
Loga file name: I _I
Logosize: Large (5 3/Gin #1in) =
Mizcelaneous information
Transaction spacing ISingIe space j
[~ Print & gray background far every ather transaction
[~ Print a gray backaground for each heading
< Back | et | Cancel | Print | Preview | Layout |
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To print an electronic signature, mark Use an electronic signature. In the Authorized signature field, select
the signature to use on the forms. For more information about creating electronic signatures, see the

Administration Guide.

Note: If you mark Print a logo on the form, you must select the logo file name and logo size. Large logos are

53/8in.x1in; small logosare 21/2in. x 1 in.

To print your organization’s logo on the forms, mark Print a logo on the form. In the Logo file name field,
browse to the file where your logo is saved in *.bmp format. In the Logo size field, select Large or Small for

the logo size to use on the forms.

In the Miscellaneous information frame, you can make additional formatting selections. In the Transaction
spacing field, select single space or double space for the amount of space to leave between lines. To make
reading the forms easier, you can mark Print a gray background for every other transaction or Print a gray

background for each heading.
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Organization Name. Use Organization Name to print your organization’s information at the top left of the
form. The information that appears in the Organization name and Address fields defaults from the General
tab of Configuration. If you mark Show organization address, you can enter or edit the name and address.
The Address quick view box displays the information as it will appear on receipts.

I3 New Receipts I
File  Edt “iew Fawaortes Toolz Help
e == - |

1 Generall 2 Filtersl 2 .-’-\ttributesl 4: Address & Format |

Detal Organization Name

Sort

Mizcelaneous ¥ Show organization address

Receipt Message Organization name: |Eommunit_l,l Services Inc.

ligriment

Receipt Format Address: =]

‘B Organization Name

I Mame Formats

i B Recsipt Address s

Address quick view:

Community Services Inc.

< Back | L= Cancel Print Freview Layout

Tip: We strongly recommend you use <Full name>. If you select Diploma Name, Informal Addressee, Informal

Salutation, or any user-defined salutations from Configuration, the program reformats each name, therefore
taking much longer to run receipts.
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Name Formats. Using Name Formats, you can format how names appear for organizations, individuals, and
students in the address and body sections of the receipt. In the tree view on the left, you can select the area
of the form you want to format. Click Memo Address to format how names appear in the header. Click
Memo Body to format how names appear in the body area of the form.

I3 New Receipts I
File  Edt “iew Fawaortes Toolz Help
RS R 2 |
1 Generall 2 Filtersl 2 .-’-\ttributesl 4: Address & Format |
Detal Receipt Address Name Formats
sort Organization
Miscelaneous U ) [
A ze name followed by: [~ Organization 1D [~ CFDa # [~ Contact Narme
Fieceipt Message .
) Individual
Alignrnent ;
Receipt Format Select addressee/zalutation fram: IHemrd vI
Organization Mame Uz |<FuII R j
I Marne Formats
S PAIE |[ 10l piesent select addiesseesalutation from: Im
; Receipt Body LISE1|<FuII harigs j
Student -
Select addressea//zalutation from: IHecord vI
Uz |<Fu|| narne:> j
If ot prezent, select addressee /salutation from: IHecord vI
Use: I <Full names =l
< Back | L= | Cancel | Print | Freview | Layout |

In the Organization frame, mark Organization ID, CFDA #, and Contact name for these items to appear after
the organization name.

In the Individual and Student frames, select Record or Configuration in the Select addressee/salutation from
[ 1 field.

If you select Record, in the Use field, select the full name, primary addressee, primary salutation, directory
name, diploma name, informal addressee, or informal salutation as defined on the individual or student
record.

If you select Configuration, in the Use field, select from one of the formats defined in Configuration.

Note: You must have the appropriate security rights to output an addressee/salutation with Social Security
numbers. If you do not have security rights, the numbers are masked. For more information, see the Security
chapter of the Administration Guide for The Financial Edge.

In the If not present, select addressee/salutation from field, you can select a second name format for
situations where the first selection is not present on individual or student records. For example, if you select
Primary salutation, and you have students without a Primary salutation defined on the
Addressees/Salutations tab, the second name format is used. If you select <Full name> in the Use field or
Configuration in the Select addressee/salutation from field, this field is disabled.

Creating Receipt Forms

Note: We offer high-quality, customized forms that are specifically designed for use with our software. These
forms, including checks, student bills, statements, invoices, purchase orders, tax forms, and envelopes, are
pre-printed in color with your organization’s logo and information. For more information, visit our Web site at
http://forms.blackbaud.com or call us toll-free at 866-4-BB-FORMS (866-422-3676).
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You can add a message to the receipt, use an electronic signature, and print your organization’s logo. You can also
select the format to use for record names in the address and body of the receipt.

» Creating receipt forms

In this example, we print receipts for students who made payments this month.

1.
2.

6.

From the Mail page in Student Billing, click Forms. The Forms page appears.

In the list on the left, select Receipts and click New on the action bar. The New Receipts screen opens on
the General tab.

In the Payment date field, select “This month”.
In the Deposit date field, select “Include all dates”.

In the Include payments whose status is [ ] then change the status to printed field, select “Not yet
printed”.

I3 New Receipts E I
File Edit “iew Favontez Toolz Help

2o R0 e 2- |

2 Filtersl 3 Attributesl 4 Addressl 5: Format

Include payments with these dates:

Payment date: IThis manth vl 02/01,/2005 to 03431/2005
Deposit date: I Include all dates b I

Include payment numbers from: I ﬂl to I ﬁl
Include deposit numbers from: I ﬁl to I QI

Include pagments whose status is: INQ[ et printed vI then change the status to printed.
[ Create an output query of IF'a_l,Jments 'I

< Back | Mest » | Cancel | Print Freview Layout

Click Next or select the Filters tab.




7.

10.

11.

12.
13.
14.
15.
16.
17.

Forms 17

Select “Student” for the Record Types filter. For more information about filtering, see the Program Basics
Guide.

A3 New SB Receipts I
File Edit View Favorites Tools Help
B3 3 a2 |

1: General ¥ 2 Altributes I 4 Address I 5: Farmat

&5 Open 7 Cle:

Filters | tncude | Selected Filters |

Records Al <Al Records >

Record Types all <Al Record Types>

Student Attributes Al <Al Student Attributes =

Individual Attributes Al <Al Individual Attributes>

Organization Attributes All <Al Organization Attributes >

Banks all <Al Banks =

Deposits All <All Deposits =

Deposit Statuses All <All Deposit Statuses=

Payments all <Al Payments =

Fayment Atiributes all <Al Payment Attributes =

Payment Sources All <All Payment Sources =

Payment Methods All <Al Payment Methods >

< Back | Mext = | Cancel | FErint Freview Layout

Select the Format tab.
In the list on the left, select Sort.

In the Sort by and Order by columns on the first row, select “Record Name” and “Ascending” to sort the
receipts alphabetically by record names.

I3 Mew Receipts E
File Edit “iew Favontes Tools Help

I el |

1 Generall 2 Filters | 3 .&ttlibutesl 4 Address

Sort

Order by I
Ascending

Miscellaneous Sort by |
Receipt Meszage
Aligriment

Receipt Format
Organization Name
5 Mame Formats
Receipt Address

Receipt Baody

Record MName

Click Preview. A message appears telling you the program is processing the mailing, and the preview
screen for the receipts appears.

Close the preview and return to the Format tab.

Click the Save button on the action bar to save the new forms. The Save Mailing as screen appears.
In the Mailing name field, enter “Student Receipts”.

In the Description field, enter “Receipts for March 2005”.

Click Save to save the new forms. You return to the Format tab.

Close the screen. You return to the Forms page, and the receipt form appears in the grid.
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Single Statements

Note: We offer high-quality, customized forms that are specifically designed for use with our software. These
forms, including checks, student bills, statements, invoices, purchase orders, tax forms, and envelopes, are
pre-printed in color with your organization’s logo and information. For more information, visit our Web site at
http://forms.blackbaud.com or call us toll-free at 866-4-BB-FORMS (866-422-3676).

Single statements list transaction activity for one student, individual, or organization. These are helpful in
instances such as when someone requests an additional copy of their statement.

If you have the optional module NetClassroom, you can publish single statements to NetClassroom for students
and parents to view. For more information about publishing statements, see “Publishing Statements to
NetClassroom” on page 243.

Single Statement Tabs

A single statement has tabs on which you can select parameters: General, Details, Summary, Records, Filters,
Attributes, Address, Auto Pay, and Format. To move among the tabs, click Next and Back at the bottom of the
screen or select the tab. On these tabs you specify the records to include in the mailing and how the single
statements should look.

General Tab

On the General tab for single statements, you select parameter settings.

13 Hew Single Statement I
Eile Edit Wiew Favorites Tools Help

EIEEEEEER S |
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v Include aging information on statement: -

Age as of: |<Transaction cutoff dater ¥ |

Reduce balances by unused payments/credits beginning with: | The: oldest period ﬂ
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< Back | Mest » Cancel Frint | Freview | Lapout

| Fress F7 for Record Search

Note: If you mark Print statements, you can also preview the mailing and view a layout of the single
statements. If you mark Export statements to Access, the Preview and Layout buttons become disabled. You
can export single statements only to Microsoft Access.

Statement for. In the Statement for field, you can enter the name of the student, individual, or organization, or
click the binoculars to find the record for which you want to print the statement.
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What do you want to do? In the What do you want to do? frame, you can select to print or export
statements, or both. To print statements on your selected printer, mark Print statements. For more
information about setting up printers, see the Program Basics Guide. If you mark Export statements to
Access, the program creates a *.mdb file containing a database of statement recipients, transactions, and
other statement information that you can use in Microsoft Access.

Transaction cutoff date. In the Transaction cutoff date field, select a date to define the last day for the period
of open transactions to include in the statement. You can select Today, Yesterday, Tomorrow, or a specific
date. The dates used in this period are the transaction dates from payment, charge, and credit records and
the invoice date from invoice records.

Statement date. In the Statement date field, you can select the date the statement is created — Today,
Yesterday, Tomorrow, a specific date, or the transaction cutoff date.

Include aging information on statement. If you mark Include aging information on statement, you can
select the date in the Age as of field.

Reduce balances by unused payments/credits beginning with. ,In this field you can select to reduce
the balances of the oldest or most recent period by the unapplied payments and credits balance. The reduced
balance total appears in the aging periods section at the bottom of the statement. For more information
about defining aging periods, see the Configuration Guide for Student Billing.

Create an output query of records on statements. Mark Create an output query of records on
statements to create a query of all records with activity appearing on any statement in the statement run.
You can save and use an output query later for reports or other mailings.

Details Tab

On the Details tab for statements, you can format information that appears in the details section of the
statement. This tab is enabled only if you selected “Summary and Detail” or “Detail only” in the Format field of
the General tab.

A3 new Single Statement I
File Edit View Favorites Tools Help

a3 aal=] - |
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[~ Combine previous balances inta one summarny line
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Combine previous balances into one summary line. Mark Combine previous balances into one
summary line, to display a summary balance of record activity that occurred before the specified date. This is
useful if statements are long. Transactions before the selected date are included in the summary balance line.
Transactions after the selected date appear in detail on the statement.

Summarize before [ ]. When you mark Combine previous balances into one summary line, you must select
one of these dates to determine the summary period:

¢ Same day of previous month based on cutoff date — If you select this option, the transaction cutoff date
from the General tab is used to determine which day of the previous month to use as a summary date.

¢ Specific date — If you select this option, the Date field appears so you can enter or select a date.

¢ Recurring date — If you select this option, the The [ ] day of [ ] fields appear so you can select the date to
use to summarize previous transactions. You must specify both a day and month.

Summary text. If you include a summary balance, the text “Summary balance as of” prints automatically on
statements, but you can enter your own message in the Summary text field. To print the date following the
text, mark Include summary date.

Note: Fully paid transactions refers to charges, advanced deposits, or refunds with a balance of $O.

Combine fully paid transactions into one summary line. If you mark Combine fully paid transactions
into one summary line, fully paid charges, advanced deposits, and refunds are summarized in a single line on
the statement along with the corresponding transactions that made each considered fully paid. If you leave
Combine fully paid transactions into one summary line unmarked, fully paid transactions appear as separate
lines on the statement.

Show line item information for invoices and returns. If you mark Show line item information for
invoices and returns, invoices, invoice line items, returns, and return line items appear on the statement.

Show credit/payment distributions as a single transaction. If you mark Show credit/payment
distributions as a single transaction, payments appear as a single transaction instead of separate
transactions.

Note: If you mark Show credits/payments with their related charges, refunds appear immediately after the
credit/payment applied to them.

Show credits/payments with their related charges. If you mark Show credits/payments with their
related charges, applied portions of credits and payments appear immediately after the charges to which
each is applied, in the order in which they were applied.

If you leave Show credits/payments with their related charges unmarked, credits and payments appear
according to the selection in the grid.

For example, a parent makes a $500 payment which is applied to three different charges: $100 for an activity
fee, $100 for charges at the bookstore, and $300 for tuition. When this checkbox is marked, only one entry
for the $500 payment appears on the statement. When this checkbox is not marked, three entries appear on
the statement for the payment.

Include ungenerated financial aid. Mark Include ungenerated financial aid to include financial aid that is
scheduled but not yet generated.

Note: Only fully paid advance deposits appear on statements.

Include ungenerated advanced deposits. Mark Include ungenerated advance deposits in the transaction
details section to include advance deposits that are scheduled but not yet generated in the transaction
details section.

Note: If you mark the business rule not to use sales tax, the Show sales tax option does not appear. For more
information about business rules, see the Configuration Guide for Student Billing.
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Show sales tax as [ ]. In the Show Sales tax as [ ] field, you can select “part of its associated transaction”, “a
separate line from its associated transaction”, “a single line totaling of all the items”. If you select “part of its
associated transaction”, the program adds sales tax transaction totals to the charge or credit total. If you
select “a separate line from its associated transaction”, sales tax appears separately from the associated
charge or credit. If you select “a single line totaling of all the items”, the program combines all sales tax

charges into a single line item for each detail grouping.

Sorting grid. In the grid at the bottom of the screen, you can select the order transactions are sorted in the
statement. If you marked Show credits/payments with their related charges, the grid is disabled.

Summary Tab

On the Summary tab for statements, you can format information that appears in the summary section of the
statement. This tab is enabled only if you selected “Summary and Detail” or “Summary only” in the Format field
of the General tab.
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Summary sections to include. In this field you select which summary sections to include. You can select
Statement Summary and Date Range Summary, Statement Summary Only, or Date Range only.

Summarize included transactions by [ ]. In the Summarize included transactions by [ ] field, you can
select to summarize activity in the statement summary section by Transaction type or Product/Billing Item.

Show combined summary across multiple records on each statement. You can mark Show combined
summary across multiple records on each statement to combine the activity of multiple records into a
summarized total. If you leave Show combined summary across multiple records on each statement
unmarked, a separate activity summary appears for each record.

Note: If you mark Include transactions across this date range and mark Include summary of finance charges
in Finance Charge Format on the Format tab, the date range selected here determines the date range for the
summary of finance charges.
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Include transactions across this date range [ ]. In the Include transactions across this date range [ ] to
print an additional subsection on the statement containing a statement summary for the specified date
range.

Show combined summary across multiple records on each statement. Mark Show combined
summary across multiple records on each statement to combine the activity of multiple records into a
summarized total. If you leave this option unmarked, a separate activity summary appears for each record in
the date range summary subsection.

Summarize by. In the Summarize by field, you can select to summarize activity in the date range summary
section by Transaction type or Product/Billing Item.

Note: Only fully paid advance deposits appear on statements.

Ungenerated advanced deposits in the date range using description [ ]. Mark Ungenerated
advanced deposits in the date range using description [ ] to include advance deposits that are scheduled but
not yet generated in the summary section. You can use the default heading for the advanced deposit section
or enter a different one in the field.

Ungenerated financial aid in the date range using description [ ]. Mark Ungenerated financial aid in
date range using description to include financial aid that is scheduled but not yet generated in the summary
section. You can use the default heading for the financial aid section or enter a different one in the field.

Records Tab

You can use the Records tab to select the records and payers who should receive statements or copies of
statements.

I@ New Single Statement I
File Edit View Favorites Tools Help

a3 A= - |
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Include. In the Include field, select Statements for these payers or Transactions for these records. Select
Statements for these payers to display in the grid all related records who receive statements for the record
selected on the General tab. Select Transactions for these records to display in the grid all related records the
record selected on the General tab receives statements for.

Find. Click Find to access the Find screen. On the Find screen, you can quickly find a record by searching by
record name, record ID, or SSN/CFDA number rather than spending time scrolling through entries. For more
information about using Find, see the Program Basics Guide.

Select All. Click Select All to mark all checkboxes in the Include column.
Deselect All. Click Deselect All to unmark all checkboxes in the Include column.

Include. In the Include column of the grid, mark the checkbox for each payer or related record you want to
include in the statement run.
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Record Name. The Record Name column lists all related records or payers based on your selection in the
Include field. If you selected Statements for these payers, the column displays all related records who receive
statements for the record selected on the General tab. If you selected Transactions for these records, the
column displays all related records the record receives statements for. You cannot edit information in this
column — it is for informational purposes only.

Record ID. The Record ID column lists record IDs for records and payers listed in the Record Name column. You
cannot edit information in this column — it is for informational purposes only.

SSN/CFDA#. The SSN/CFDA# column lists Social Security and Catalog of Federal Domestic Assistance numbers
for records and payers listed in the Record Name column. You cannot edit information in this column — it is
for informational purposes only.

Filters Tab

Note: It is important to use the Product and Billing Items on Charges or Product and Billing Item Attributes
filters carefully so you do not underbill a record. Filtering by these items may result in some charges being
omitted unintentionally.

On the Filters tab, you select criteria that determines which items to include in a statement. You can filter by
Product and Billing Iltems on Charges or Product and Billing Item Attributes. It is important to use these filters
carefully so you do not underbill a record. When you filter by these items, only charges with the selected
products or billing items appear on the statements; therefore, charges for other products or billing items and any
applications made to these charges (regardless of the application’s billing item) are not included in the
statement.

Another potential issue is that specified charges and credits can be hidden on statements if you have the Hide
transactions on statements business rule set to “Allow” in Student Billing Configuration. This business rule
enables the Hide this transaction on printed statements option on charge and credit records. By marking the
checkbox on charges and credits, you can hide erroneous transactions. If this business rule is enabled,
out-of-balance statements are possible because each user is responsible for consistently hiding the same amount
of charges and credits.

For basic information about filtering criteria, see the Program Basics Guide.

I3 New Single Statement E3 I
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Open. To open a selection screen to designate specific filters for the form, select a filter in the grid and click
Open on the action bar.

Clear All Filters. To reset each filter to include all, you can click Clear All Filters.

Note: A filter is a requirement items must meet to be included in a form. For example, if you apply the Records
filter, only transactions for the selected records appear in the form.

Filters. The Filters column lists all the filters for the form. You cannot edit this column.
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Include. By default, in the Include column, each filter is set to All. To open a selection screen to designate
specific filters for the form, choose Selected.

Selected Filters. Filters you specify on the selection screen appear in the Selected Filters column.

Selected Filters Screen

From the Filters tab, you can open a selection screen for a filter in several ways: by double-clicking the filter in the
grid, selecting the filter in the grid and clicking Open on the action bar, or choosing Selected in the Include
column for the filter.

Selected Statement Recipients E= I

Include: @ &) Selecte ® [uen | Er=sious Filizr Mest Filker

Statement Recipient | Record 1D |

ar. I Cancel |

Include. For each filter, you can include all or select specific filters. Depending on the filter, you may also be able
to filter by a range or query.

All. If you mark Include: All, you cannot designate specific filters.

Selected or Range. If you mark Include: Selected or Range, a grid appears in which you can specify filters. In a
field, you can click the binoculars to search for information.

Query. If you mark Include: Query, the Query name field appears for you to enter the name of the query by
which to filter the form. In the field, you can click the binoculars to search for the query name.

To create a new query, click the binoculars. Then click Add a New Query on the Open Query screen. For more
information about creating queries, see the Query Guide.

Previous Filter. To view or edit the previous filter without returning to the Filters tab, click Previous Filter.
Next Filter. To view or edit the next filter without returning to the Filters tab, click Next Filter.
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Attributes Tab

You can use the Attributes tab to add, delete, or update attributes for statement recipients and records who
receive statement copies.

I@ New Single Statement I
File Edit View Favorites Tools Help
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Action. In the Action column, you can select to add, delete, or update attributes on the record when you
generate statements.

Record Type. In the Record Type column, select the record type to add the attribute to. The record type you
select determines the attribute types available in the Attribute Type column for that row.

Note: Attribute types are established in Configuration. For more information about creating attribute types,
see the Configuration Guide for Student Billing.

Attribute Type. In the Attribute Type column, you can select an attribute type.
Description. In the Description column you can enter or select a description for the attribute type.

Short Description. If you selected a table type attribute that uses short descriptions, in the Short Description
column, select the attribute description. The Description column completes automatically.

Date. In the Date column, select the date you add, delete, or update the attribute.

Note: An attribute is a tool used to group information based on a common theme. With attributes defined, you
can filter information to your specifications.

Required. If the attribute type you select is required, the program automatically marks the checkbox in the
Required column.

Comments. In the Comments column, you can enter free-form text for additional information about the
attribute type.

Address Tab

Use the Address tab to specify whether addresses appear on single statements. The program compares the
parameters you define on this tab with address information entered on the Addresses tab of the payer’s record
to identify the appropriate address to use.
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On the Address tab, you select a validation date and then define the order in which the program evaluates
address types. The program first checks the validation date, then seasonal addresses, other address types (in the
order you determine), and attributes. The first address found on the recipient’s record that meets the defined
parameters is used on the single statement. You can also specify what to do if no valid address is found.
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Step 1. Mark Show statement recipient address to include the recipient’s address on the single statement. If
you unmark this checkbox, all options on this tab are disabled and no address appears on the form.

Step 2. In the Validate addresses as of [ ] field, select a date to determine which address to use. Any address
that is valid on this date is considered for use on the single statement. Any addresses that are not valid on this

date are automatically excluded from consideration.

Step 3. Determine whether to include seasonal addresses as possible addresses. If you mark Consider seasonal
addresses, the program uses the first valid seasonal address found on the recipient record and does not
consider any other addresses.

If the seasonal address has the Send no mail attribute, the seasonal address is excluded automatically as a
possible address. If a valid seasonal address is not found, the program considers the address types selected in
Step 4.

Step 4. In the If no seasonal addresses are found, consider these addresses frame, select which address types
to use if no valid seasonal addresses exist.

In the Addresses box, select an address type and click the right arrow to move it into the Addresses to

consider, in order of importance box. The first address type in the list that matches the validation date is
used on the statement. You can change the order addresses are considered by selecting an address type and

clicking the up and down arrows next to the list.
If a valid address is not found from these address types, the program considers the attributes selected in
Step 5.

Step 5. In the grid, you can select address attribute types to consider. For example, you have a “Billing
statement address” attribute you use to flag addresses for statements. When you select Include in the Action
column and Billing statement address in the Attribute column of the grid, the program automatically uses
any valid addresses assigned this attribute.
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Step 6. In the If no address is found field, select what to do if a valid address is not found. You can select Print
with no address, Remove record from run, or Print specific address. If you select to print a specific address,
the Use field appears so you can select the address type to use when a recipient does not have an address of
the types you added to the Addresses to consider, in order of importance list.

Auto Pay Tab

If you have the optional module Electronic Funds Transfer, you can use the Auto Pay tab to create automatic EFT
payments for records with variable amount automatic payments set up on the Automatic Payments tab of their
record.

When you print or export statements, the program generates all charges and credits and applies payments for
the record based on the statement criteria. Payments apply to associated charges as determined by the Student
Billing business rule settings. The automatic payment is recorded on the statement and on the payer’s Activity
and Automatic Payment tabs. The payment also appears on the payee’s Activity tab.

The program creates one deposit and payment record for the calculated balance using the information you enter
on the Auto Pay tab. When you run Create an EFT file in Deposit tasks for Banks, the deposit record updates
automatically with the date the EFT file was created.

I3 New Single Statement E3 I
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Create automatic variable amount payments based on statement criteria. Mark this option to
generate variable amount automatic payments. This enables the other options on this tab. If this option is not
marked, no automatic payments are created.

Note: The deposit information entered on the Auto Pay tab is used for all payments in the deposit.

Deposit date. In the Deposit date field, enter the date the deposit is made to the bank account.
Entry date. In the Entry date field, enter the date the deposit is entered in the program.

Status. In the Status field, select Open or Closed. You cannot add new payments to a closed deposit.
Post status. In the Post status field, select a post status for the deposit.
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Post date. In the Post date field, enter the date to post the deposit. The information in the Post status and Post
date fields defaults automatically to the payments added to the deposit. You post deposits, not individual
payments.

Description. In the Description field, enter a description of the deposit or any other information you want to
record about the deposit.

Payment date. In the Payment date field, enter the date the payment was received.

Source. For variable payments not paid by EFT, in the Source field, select the payment source such as mail or in
person.

Post status. The post status defaults from the deposit record. You post deposits, not individual payments.
Post date. The post date defaults from the deposit record. You post deposits, not individual payments.

Comment. In the Comment field, you can enter a note about the payment.

Format Tab

On the Format tab, you designate the format and appearance of the statement. You can sort the statements and
recipient order, make selections for details and formats, and align the statements on paper or forms.

Detail. Use Detail to select extra details to print on the statements.
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If you mark Show statement reference number, the program generates a number to appear on the
statement beneath the statement date. To display the reference number as a barcode, mark Show barcode
using [ ] and select a font and font size.

If you mark Show print date on statement, the printing date appears on the statements beneath the
statement date.

If you mark Show credit balances as $0.00, the amount due balance and aging balances appear as a zero
amount if they are credit balances.

If you mark Show statement due date using [ ] plus [ ] days, you can select the date payments are due and
plus the number of days.
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If you mark Show minimum amount due as [ ], you can select a percentage of the total due or enter a specific
amount.

If you mark Display transaction comments, transaction comments print below the transaction.

If you mark Show payer ID as [ ], you can select whether to print the payer’s record ID or Social Security
Number.

In the When a statement recipient pays for multiple records, you can select:

¢ Use the statement settings for the statement recipient — The program includes record activity according
to your selections on the Statements tab of the record.

¢ Create one statement per record — The program prints a separate statement for each record.

¢ Combine records onto one statement — The program prints a single statement with payees combined on
the statement.

If you mark Include records with a zero balance, the statement includes records with zero balances.

Statement Sort. Use Statement Sort to select the order to print statements. When you select Statement Sort,
a grid appears. Select a sorting category in the Sort by column and select Ascending or Descending in the
Order by column. If you make no selections in the Sort by column, the program sorts by recipient name in
ascending order.
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Miscellaneous. Use Miscellaneous to specify how you want numbers to appear on the statements and the font
size for statements.
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Form Alignment. You can use Form Alignment to specify vertical and horizontal alignment of the forms and
addresses when you print.
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Note: The maximum alignment adjustment you can enter is 99. This moves the margin .99 inch.

In the Form Alignment frame, you can adjust the form’s top and left margins for printing using the Vertical
alignment and Horizontal alignment fields. You can move printed information up or down or left or right and
enter how much to move the information. For example, if you select Move printed information up and enter
2, the information prints .02 inch higher on the page.

Addresses for the statement recipient are aligned by default to fit the first five lines in a standard envelope
address window. If you need to make adjustments, in the Address Alignment frame, you can move printed
information up or down or left or right and enter how much to move the information. For example, if you
select Move printed information up and enter 2, the address prints .02 inch higher on the page.

Organization Name. Use Organization Name to print your organization’s information at the top left of the
form. The information that appears in the Organization name and Address fields defaults from the General
tab of Configuration. If you mark Show organization address, you can enter or edit the name and address.
The Address quick view box displays the information as it will appear on statements.
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Address Detail. Use Address Detail to select additional information to appear in the address section of

statements. The options on this screen are disabled if the Show statement recipient address is unmarked on
the Address tab.
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Note: You enter contact information on the Bio 1 tab of records.

To print telephone numbers or Web or email addresses, mark Show contact information in address and
select a number or address in the Contact Number fields. If the record is an organization, the contact’s name
appears in the ATTN line.

You can mark Show USPS barcode in address to print the barcode on the statements above the address.
The Address quick view box displays the address information as it will appear on statements.



Forms 19

Finance Charge Format. Use Finance Charge Format to select and define information to appear Finance
Charge Information section of the statements.
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Mark Include closing date of billing cycle to include the closing date on the statements. The closing date
defaults to the transaction cutoff date from the General tab or you can select a different date. For example, if
you select May 31, 2005, as the closing date, “Closing date of billing cycle: 05/31/2005” appears in the
Finance Charge Information section of the statements.

If you mark Include finance charge disclosure statement, you can create a disclosure statement. Enter the
text for the statement in the text box.

If you mark Include calculation information for finance charges, the calculation date and percentage rate
appear in a message on the statements. For example, “The finance charge dated 0501/2005 was calculated
as of 04/30/2005 using an annual percentage rate of 10%. The balance subject to finance charge was
$100.00”

If you mark Include summary of finance charges, a total of finance charges appears in the Finance Charge
Information section of the statements. In the Summary date range field, you can include all dates or select a
specific date or range. In the Description field, you can enter text to precede the total finance charge amount
appearing on the statements, for example, “Year-to-date finance charges:”. If you mark Transactions across
this date range on the Summary tab, the summary of finance charges is for the same date range selected on
the Summary tab.

Tip: We strongly recommend you use <Full name>. If you select Diploma Name, Informal Addressee, Informal
Salutation, or any user-defined salutations from Configuration, the program reformats each name, therefore
taking much longer to run single statements.
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Name Formats. Using Name Formats, you can format how names appear for organizations, individuals, and
students in the address and body sections of the single statement. In the tree view on the left, select
Statement Recipient, Statement For, or Statement Body to format names for that area of the statement.
Click Statement Recipient or Statement For to format how names appear in the header. Click Statement
Body to format how names appear in the body area of the form.
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In the Organization frame, mark Organization ID, CFDA #, and Contact name for these items to appear after
the organization name.

In the Individual and Student frames, select Record or Configuration in the Select addressee/salutation from
[ field.

If you select Record, in the Use field, select the full name, primary addressee, primary salutation, directory
name, diploma name, informal addressee, or informal salutation as defined on the individual or student
record.

Note: You must have the appropriate security rights to output an addressee/salutation with Social Security
numbers. If you do not have security rights, the numbers are masked. For more information, see the Security
chapter of the Administration Guide for The Financial Edge.

If you select Configuration, in the Use field, select from one of the formats defined in Configuration.

In the If not present, select addressee/salutation from field, you can select a second name format for
situations where the first selection is not present on individual or student records. For example, if you select
Primary salutation, and you have students without a Primary salutation defined on the
Addressees/Salutations tab, the second name format is used. If you select <Full name> in the Use field or
Configuration in the Select addressee/salutation from field, this field is disabled.
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Statement Format. Use Statement Format to make formatting selections for the statement forms.
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In the Statement format field, you can select a laser pre-printed form or blank paper. In the Number of
copies to print for each statement field, select how many copies of each statement to print and mark Collate
to collate the statements if you print more than one.

Note: If you mark Print a logo on the form, you must select a file name and logo size. Large logos print 5 3/8 in.
x 1in; small logos print 2 1/2 x 1 in.

If you print statements on blank paper, you can print your organization logo on the statements. To print the
logo, mark Print a logo on the form. In the Logo file name field, browse to the file where your logo is saved in
* bmp format. In the Logo size field, select Large or Small as the logo size to use on the statements.

Note: If you mark Print total number of pages on each page, the numbering appears, for example, as Page 1 of
79.

In the Miscellaneous information frame, you can make additional formatting selections. In the Transaction
spacing field, select Single space or Double space as the amount of space to leave between lines. To make
reading statements easier, you can mark Print a gray background for every other transaction or Print a gray
background for each heading. You can record page numbers on the statements by marking Print total
number of pages on each page.

If you have The Registrar’s Office, in the Display grade level from field, you can select the grade level to
display on the statements. The program refers to the student’s progression entry as of that date to determine
the student’s grade level. For example, if you print statements for the next billing cycle, a student may need
to be billed for the next grade level based on the progression entry.
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Statement Message. Use Statement Message to print additional information for recipients.
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If you entered information on the notes tab of a record, you can choose where to Print statement comments
from each record. You can select At the end or At the beginning. You can enter text in the Print this message
at the end of each statement page and If no statement copy message exists, print this message on each
copy fields. If you do not want a recipient to see the amount due, you can select <Blank>, ***, or 0.00 in the
If the copy recipient should not see the amount due, display the amount as [ ] field. In the aging periods
grid, you can enter messages for each period.

Creating Student Billing Single Statements

Note: We offer high-quality, customized forms that are specifically designed for use with our software. These
forms, including checks, student bills, statements, invoices, purchase orders, tax forms, and envelopes, are
pre-printed in color with your organization’s logo and information. For more information, visit our Web site at
http://forms.blackbaud.com or call us toll-free at 866-4-BB-FORMS (866-422-3676).

On the Statements tab of student, individual, and organization records, you can select which records and payers
receive statements or copies of statements. You can also add additional information and notes for recipients. For
more information, see the Records Guide for Student Billing.

» Creating Student Billing single statements

In this example, we print a single statement for Jennifer Andrews containing a summary of her transactions
as of today’s date. We add a due date and minimum amount due, include a billing cycle closing date and
finance charge disclosure statement, and add a statement message that says, “Please remit prompt payment
of the balance due”.

1. From the Mail page in Student Billing, click Forms. The Forms page appears.

2. Inthe list on the left, select Single Statements and click New on the action bar. The New Single
Statement screen appears.
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Note: To export statement information, mark Export statements to Access. For more information about
exporting in Mail, see “Exporting a mailing” on page 15.

3. Inthe Statement for grid, select “Jennifer Andrews” in the Record Name column.

4. Inthe What do you want to do? frame, mark Print Statements.

5. In the Transaction cutoff date and Statement date fields, select “Today”.

I3 New Single Statement I
File Edit View Favorites Tools Help

dadam =2 |

: Detailsl & Summaryl 4 Hecordsl 5 Filtersl E: ﬁttributesl i .&ddressl 8 Auto F'ayl & Formatl

Statemert for. Record Name | Record ID | ssnycroaz |
Jennifer Lynn Andrews 0634 222-33-4444

What do pou want to do?

¥ Print statements [~ Export statements to Access

Tranzaction cutoff date: Ingay j 01/05/2007

Statement date: IT.;.da}. j 01/05/2007

v Include aging information on statement:

Age az of |<Transaclion cutoff date> ¥ |

Reduce balances by unused payments/credits beginning with: | The oldest period j

[~ Create an output query of records on statements

< Back | Mest » | Catcel | Print Freview Layout

6. Click Next or select the Summary tab.

7. In the Summarize included transactions by field, select “Transaction type”.

I New Single Statement I
Eile Edit View Favorites Tools Help

EIEEEEIEEEE |

1 General' 2 Detailz

£ Hecords' 53 Filtersl E: Attributesl s Address' 8 Auto Payl & Formatl

Specify how the Summary gection of the statement should dizplay information.

Summary sections to include: IStatement Summary and D ate Range Summary j

Stab nt Summary

Summarnize included transactions by: ITransaction type Vl

[~ Show combined summany across multiple records on each staternent

Date Bange Summary -
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[~ Ungenerated advance deposits in dabe range using description: IUngenerated advance depozits

[ Ungenerated financial aid in date range using description: IUngenerated financial aid

< Back | MNext > Catcel Print Preview Layout
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Select the Format tab.
9. Inthe list on the left, select Detail.

10. Mark Show statement due date using [ ] and select “Transaction cutoff date”, and enter “30” in the plus
[ 1 days field.

11. Mark Show minimum amount due as [ ], select “Percent of total amount”, and enter “50” in the percent
field.

I3 New Single Statement E I

File Edit View Favorites Tools Help
= =R |
1 Generall 2 Detailsl 3 Summaryl 4 Hecordsl 5 Filtersl E: Attributesl s Addressl 8 Auto Pap 3 Format |

Statement Sort

Mizcellaneaus [V Shaow statement reference number

Form Alignment [~ Show barcods using: |3 of 9 Barcode j Font size: |1D j
Organization Hame .

Addiess Detail [~ Shaow print date on statement

Finamce Charge Format . [~ Show credit balances as $0.00

(1 Name Formats I Show statement dus date using: | < Transaction cutoff datey > | plus [30 | daps

; Staterment Recipisr

v Show minimurm amount dug as: IPercent of tatal amount j IED percent

Statement Body [V Display transaction comments
Statement Format
Statement Message B Sl e D IHBCDId D ‘I

When a statement recipient pays for multiple records:

IUse stabernent tab to determing # of statements j

[V Include recards with a zem balance

< Back | st > | Camrcel | Print | Freview Layout

12. In the list on the left, select Finance Charge Format.
13. Mark Include closing date of billing cycle and select a date.
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14. Mark Include finance charge disclosure statement and enter in the text box “An additional charge at a
daily percentage rate of 1.5% may apply to an unpaid balance.”

Wncusngiestatement K|
File Edit View Favorites Tools Help
= =R |

1 Generall 2 Detailsl 3 Summaryl 4 Hecordsl 5 Filtersl E: Attributesl s Addressl 8 Auto Pap 3 Format |

Detail Finance Charge Format

Statement Sort
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Form Alignment
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v Include finance charge disclosure statement:

. Ain additional charge at a daily percentage rate of 1.5% may apply to an unpaid;l
Address Detail
B Financ balance.
i Mame Formats
; Staterment Recipisr
Staternent For =

----- Staternent Body

Stat \F X [ Include calculation infarmation for finance charges
atement Forma

Statement Message [ Include surmary of finance charges
Summary date range:l Thiis fiscal period - I 01,/071/2007 to 01./37 /2007
Description: |

< Back | st > | Camrcel | Print Freview Layout

| Press F7 for 2o0m.

15. Inthe list on the left, select Statement Message.

16. Enter “Please remit prompt payment of the balance due.” in the Print this message at the end of each
statement page text box.

I Hew Single Statement I
Eil= Edit View Favortes Tools Help

SRR =0 el |

1 Generall 2: Tranzaction Detailsl 3 Hecordsl 4 Filtersl & Attributesl E: Address' T Auto Pap 8 Format |

Detal Statement Message

St.atement Bort Pririt this message at the end of each statement page:
Miscellaneous

Form Alignment
Organization Mame
Address Detail If o shatement copy message exists, print this meszage on each copy: -
Finance Charge Format |
Advance Deposits I the copy recipent should not see the amount due, display the amaunt as:lm
Financial Aid

=] Mame Formats

i [F Statement Recipisr

Staternent For

5 Statement Body

Plzase remit prampt payrment of the balance dus.

=
=

Tranzaction Sork
Statement Format

< Back | et > | Catcel | Print | Preview | Layout |

| Press F7 for 2oom.

17. Click Preview. A message appears telling you the program is processing the mailing, and the preview
screen for the single statement appears.

18. Close the preview and return to the Format tab.
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19. Click the Save button on the action bar to save the new forms. The Save Mailing as screen appears.
20. In the Mailing name field, enter “Statement for Jennifer Andrews”.
21. In the Description field, enter “Transactions through Today”.

Save Mailing as I

b ailing nanne: |Statement for Jennifer Andrews

Diescription: {Transactions through T oday

¥ Others can mn this maiing
[ Others can modify this mailing

& 5ave | Cancel |

22. Click Save to save the new forms. You return to the Format tab.

23. Close the screen. You return to the Forms page, and the single statement named “Statement for Jennifer
Andrews” appears in the grid.

Statements

Note: We offer high-quality, customized forms that are specifically designed for use with our software. These
forms, including checks, student bills, statements, invoices, purchase orders, tax forms, and envelopes, are
pre-printed in color with your organization’s logo and information. For more information, visit our Web site at
http://forms.blackbaud.com or call us toll-free at 866-4-BB-FORMS (866-422-3676).

Statements list transaction activity for multiple statement recipients at one time.

If you have the optional module NetClassroom, you can publish single statements to NetClassroom for students
and parents to view. For more information about publishing statements, see “Publishing Statements to
NetClassroom” on page 243.

Statement Tabs

A statement has tabs on which you can select parameters: General, Details, Summary, Filters, Attributes,
Address, Auto Pay, and Format. To move among the tabs, click Next and Back at the bottom of the screen or
select the tab. On these tabs you specify the records to include in the mailing and how the statements should
look.
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General Tab

On the General tab for statements, you select parameter settings specific to statements. Here you can select to
print or export the information or do both. You can show aging information on the statements.

I@ New Statements I
File Edit View Favorites Tools Help

dlié-ﬂim | =
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What do you want to do?
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[~ Create an output query of stabement recipisnts [~ Create an output query of records on statements
< Back | MHewt » Cancel Frint | Preview | Layout

Note: If you mark Print statements, you can also preview the mailing and view a layout of the statements. If
you mark Export statements to Access, the Preview and Layout buttons become disabled. You can export
statements only to Microsoft Access.

What do you want to do? In the What do you want to do? frame, you can select to print or export
statements, or both. To print statements on your selected printer, mark Print statements. For more
information about setting up printers, see the Program Basics Guide. If you mark Export statements to
Access, the program creates a *.mdb file containing a database of statement recipients, transactions, and
other statement information that you can use in Microsoft Access.

Transaction cutoff date. In the Transaction cutoff date field, select a date to define the last day for the period
of open transactions to include in the statement. You can select Today, Yesterday, Tomorrow, or a specific
date. The dates used in this period are the transaction dates from payment, charge, and credit records.

Statement date. In the Statement date field, you can select the date the statement is created — Today,
Yesterday, Tomorrow, a specific date, or the transaction cutoff date.

Include recipients receiving [ ]. I n the Include recipients receiving field, seIect the type of recipients you are
prmtmg statements for. You can select “Statements and statement copies”, Statements only”, and
“Statement copies only”. If you select “Statements only”, only records designated as a statement recipient on
the Statements tab of a record are included. If you select “Statement copies only”, only records designated as
statement copy recipients on the Statements tab of a record are included.

Format. In the Format field, select which sections of the statement to include — Summary and Detail, Summary
only, or Detail only. This selection determines whether the Summary and Detail tabs are enabled.

Include statements with. In the Include statements with frame, you can narrow the records to include in the
statement run.
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To print statements for records with no activity and records with no activity and a zero balance, mark A zero
balance and no activity.

To print statements for records with no activity or a zero balance, mark both the No activity and Zero balance
checkboxes.

To print statements for records that have no activity during the selected period, mark No activity. This option
does not include records that have no activity and a zero balance.

To print statements with a zero balance during the selected period, mark A Zero balance. This option does
not include records that have a zero balance and no activity.

To print statements for records with a credit balance, mark A credit balance.
To print statements with a minimum balance due, mark A balance over [ ] and entering an amount.

To print statements with a past-due balance, mark A balance past due [ ] days and enter a number of days. If
you run statements with a past-due balance, A credit balance, No activity, and A zero balance are disabled
because records without activity or a zero balance are excluded automatically.

Include aging information on statement aged as of [ ]. If you mark Include aging information on
statement aged as of [ ], you can select a date in the field.

The total unapplied payments and credits balance should reduce the balance of the oldest or most recent
period

Reduce balances by unused payments/credits beginning with [ ]. ,In this field you can select to reduce
the balances of the oldest or most recent period by the unapplied payments and credits balance. The reduced
balance total appears in the aging periods section at the bottom of the statement. For more information
about defining aging periods, see the Configuration Guide for Student Billing.

Create an output query of statement recipients. To create a query of recipients you run statements for,
mark Create an output query of statement recipients. You can save and use an output query later for reports
or other mailings.

Create an output query of records on statements. To create a query of records appearing on each
statement, mark Create an output query of records on statements. You can save and use an output query
later for reports or other mailings.
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Details Tab

On the Details tab for statements, you can format information that appears in the details section of the
statement. This tab is enabled only if you selected “Summary and Detail” or “Detail only” in the Format field of
the General tab.

I3 new Statements I
File Edit View Favorites Tools Help
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Combine previous balances into one summary line. Mark Combine previous balances into one
summary line, to display a summary balance of record activity that occurred before the specified date. This is
useful if statements are long. Transactions before the selected date are included in the summary balance line.
Transactions after the selected date appear in detail on the statement.

Summarize before [ ]. When you mark Combine previous balances into one summary line, you must select
one of these dates to determine the summary period:

¢ Same day of previous month based on cutoff date — If you select this option, the transaction cutoff date
from the General tab is used to determine which day of the previous month to use as a summary date.

¢ Specific date — If you select this option, the Date field appears so you can enter or select a date.

¢ Recurring date — If you select this option, the The [ ] day of [ ] fields appear so you can select the date to
use to summarize previous transactions. You must specify both a day and month.

Summary text. If you include a summary balance, the text “Summary balance as of” prints automatically on
statements, but you can enter your own message in the Summary text field. To print the date following the
text, mark Include summary date.

Note: Fully paid transactions refers to charges, advanced deposits, or refunds with a balance of $O.

Combine fully paid transactions into one summary line. If you mark Combine fully paid transactions
into one summary line, fully paid charges, advanced deposits, and refunds are summarized in a single line on
the statement along with the corresponding transactions that made each considered fully paid. If you leave
Combine fully paid transactions into one summary line unmarked, fully paid transactions appear as separate
lines on the statement.
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Show line item information for invoices and returns. If you mark Show line item information for
invoices and returns, invoices, invoice line items, returns, and return line items appear on the statement.

Show credit/payment distributions as a single transaction. If you mark Show credit/payment
distributions as a single transaction, payments appear as a single transaction instead of separate
transactions.

Note: If you mark Show credits/payments with their related charges, refunds appear immediately after the
credit/payment applied to them.

Show credits/payments with their related charges. If you mark Show credits/payments with their
related charges, applied portions of credits and payments appear immediately after the charges to which
each is applied, in the order in which they were applied.

If you leave Show credits/payments with their related charges unmarked, credits and payments appear
according to the selection in the grid.

For example, a parent makes a $500 payment which is applied to three different charges: $100 for an activity
fee, $100 for charges at the bookstore, and $300 for tuition. When this checkbox is marked, only one entry
for the $500 payment appears on the statement. When this checkbox is not marked, three entries appear on
the statement for the payment.

Include ungenerated financial aid. Mark Include ungenerated financial aid to include financial aid that is
scheduled but not yet generated.

Note: Only fully paid advance deposits appear on statements.

Include ungenerated advanced deposits. Mark Include ungenerated advance deposits in the transaction
details section to include advance deposits that are scheduled but not yet generated in the transaction
details section.

Note: If you mark the business rule not to use sales tax, the Show sales tax option does not appear. For more
information about business rules, see the Configuration Guide for Student Billing.

n u

Show sales tax as [ ]. In the Show Sales tax as [ ] field, you can select “part of its associated transaction”, “a
separate line from its associated transaction”, “a single line totaling of all the items”. If you select “part of its
associated transaction”, the program adds sales tax transaction totals to the charge or credit total. If you
select “a separate line from its associated transaction”, sales tax appears separately from the associated
charge or credit. If you select “a single line totaling of all the items”, the program combines all sales tax
charges into a single line item for each detail grouping.

Sorting grid. In the grid at the bottom of the screen, you can select the order transactions are sorted in the
statement. If you marked Show credits/payments with their related charges, the grid is disabled.
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Summary Tab

On the Summary tab for statements, you can format information that appears in the summary section of the
statement. This tab is enabled only if you selected “Summary and Detail” or “Summary only” in the Format field
of the General tab.

I3 new Statements I
File Edit View Favorites Tools Help
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Summary sections to include. In this field you select which summary sections to include. You can select
Statement Summary and Date Range Summary, Statement Summary Only, or Date Range only.

Summarize included transactions by [ ]. In the Summarize included transactions by [ ] field, you can
select to summarize activity in the statement summary section by Transaction type or Product/Billing Item.

Show combined summary across multiple records on each statement. You can mark Show combined
summary across multiple records on each statement to combine the activity of multiple records into a
summarized total. If you leave Show combined summary across multiple records on each statement
unmarked, a separate activity summary appears for each record.

Note: If you mark Include transactions across this date range and mark Include summary of finance charges
in Finance Charge Format on the Format tab, the date range or billing cycle selected here determines the date
range for the summary of finance charges.

Include transactions across this date range [ ]. Using the Include transactions across this date range [ ]
field, you can include an additional subsection on the statement containing a statement summary for the
specified date range or billing cycle.

Show combined summary across multiple records on each statement. Mark Show combined
summary across multiple records on each statement to combine the activity of multiple records into a
summarized total. If you leave this option unmarked, a separate activity summary appears for each record in
the date range summary subsection.

Summarize by. In the Summarize by field, you can select to summarize activity in the date range summary
section by Transaction type or Product/Billing Item.
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Note: Only fully paid advance deposits appear on statements.

Ungenerated advanced deposits in the date range using description [ ]. Mark Ungenerated
advanced deposits in the date range using description [ ] to include advance deposits that are scheduled but
not yet generated in the summary section. You can use the default heading for the advanced deposit section
or enter a different one in the field.

Ungenerated financial aid in the date range using description [ ]. Mark Ungenerated financial aid in
date range using description to include financial aid that is scheduled but not yet generated in the summary
section. You can use the default heading for the financial aid section or enter a different one in the field.

Filters Tab

Note: It is important to use filters carefully so you do not underbill a record. Filtering by the record filters,
Product and Billing ltems on Charges, or Product and Billing Item Attributes may result in some records or
charges being omitted unintentionally.

On the Filters tab, you select criteria that determines which items to include in a statement. It is important to use
filters carefully so you do not underbill a record. The Records in Statement Body, Record Billing Statuses, Record
Types, and Student/Individual/Organization Attributes filters apply to record activity. If you use these filters, only
activity for records that meet these filter requirements appear on the statements.

Another potential issue is that specified charges and credits can be hidden on statements if you have the Hide
transactions on statements business rule set to “Allow” in Student Billing Configuration. This business rule
enables the Hide this transaction on printed statements option on charge and credit records. By marking the
checkbox on charges and credits, you can hide erroneous transactions. If this business rule is enabled,
out-of-balance statements are possible because each user is responsible for consistently hiding the same amount
of charges and credits.

If you filter by Statement Recipient Statement Codes, the statement codes determine which records are included
in the run, not what statements those records receive.
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You can filter by Product and Billing Items on Charges or Product and Billing Item Attributes. When you filter by
these items, only charges with the selected products or billing items appear on the statements; therefore,
charges for other products or billing items and any applications made to these charges (regardless of the
application’s billing item) are not included in the statement. For basic information about filtering criteria, see the
Program Basics Guide.

Bnewstatemens &
File Edit WView Favorites Tools Help
FIEEEEIEEIR R |
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Open. To open a selection screen to designate specific filters for the form, select a filter in the grid and click
Open on the action bar.

Clear All Filters. To reset each filter to include all, you can click Clear All Filters.

Note: A filter is a requirement items must meet to be included in a form. For example, if you apply the Records
filter, only transactions for the selected records appear in the form.

Filters. The Filters column lists all the filters for the form. You cannot edit this column.

Include. By default, in the Include column, each filter is set to All. To open a selection screen to designate
specific filters for the form, choose Selected.

Selected Filters. Filters you specify on the selection screen appear in the Selected Filters column.
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Selected Filters Screen

From the Filters tab, you can open a selection screen for a filter in several ways: by double-clicking the filter in the
grid, selecting the filter in the grid and clicking Open on the action bar, or choosing Selected in the Include
column for the filter.

Selected Statement Recipients x| I

Include: @ All Q¥ Selected & Querny | Frzvious Filizr Mext Filker

Statement Fecipient | Record 1D |

ar. I Cancel |

Include. For each filter, you can include all or select specific filters. Depending on the filter, you may also be able
to filter by a range or query.

All. If you mark Include: All, you cannot designate specific filters.

Selected or Range. If you mark Include: Selected or Range, a grid appears in which you can specify filters. In a
field, you can click the binoculars to search for information.

Query. If you mark Include: Query, the Query name field appears for you to enter the name of the query by
which to filter the form. In the field, you can click the binoculars to search for the query name.

To create a new query, click the binoculars. Then click Add a New Query on the Open Query screen. For more
information about creating queries, see the Query Guide.

Previous Filter. To view or edit the previous filter without returning to the Filters tab, click Previous Filter.
Next Filter. To view or edit the next filter without returning to the Filters tab, click Next Filter.
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Attributes Tab

You can use the Attributes tab to add, delete, or update attributes for statement recipients and records who
receive statement copies.

I@ New Statements I
File Edit View Favorites Tools Help
dadamal4?- |
| B .ﬁ.ddressl T Ao F'ayl k=S Furmatl
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Action. In the Action column, you can select to add, delete, or update attributes on the recipient’s record when
you generate statements.

Note: Attribute types are established in Configuration. For more information about creating attribute types,
see the Configuration Guide for Student Billing.

Record Type. In the Record Type column, select the record type to add the attribute to. The record type you
select determines the attribute types available in the Attribute Type column for that row.

Attribute Type. In the Attribute Type column, you can select an attribute type.
Description. In the Description column you can enter or select a description for the attribute type.

Short Description. If you selected a table type attribute that uses short descriptions, in the Short Description
column, select the attribute description. The Description column completes automatically.

Date. In the Date column, select the date you add, delete, or update the attribute.

Required. If the attribute type you select is required, the program automatically marks the checkbox in the
Required column.

Comments. In the Comments column, you can enter free-form text for additional information about the
attribute type.

Address Tab

Use the Address tab to specify whether addresses appear on statements. The program compares the parameters
you define on this tab with address information entered on the Addresses tab of the recipient’s record to identify
the appropriate address to use.
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On the Address tab, you select a validation date and then define the order in which the program evaluates
address types. The program first checks the validation date, then seasonal addresses, other address types (in the
order you determine), and attributes. The first address found on the recipient’s record that meets the defined
parameters is used on the statement. You can also specify what to do if no valid address is found.

I3 New Statements E3 I
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Step 1. Mark Show statement recipient address to include the recipient’s address on the single statement. If
you unmark this checkbox, all options on this tab are disabled and no address appears on the form.

Step 2. In the Validate addresses as of [ ] field, select a date to determine which address to use. Any address
that is valid on this date is considered for use on the single statement. Any addresses that are not valid on this
date are automatically excluded from consideration.

Step 3. Determine whether to include seasonal addresses as possible addresses. If you mark Consider seasonal
addresses, the program uses the first valid seasonal address found on the recipient record and does not
consider any other addresses.

If the seasonal address has the Send no mail attribute, the seasonal address is excluded automatically as a
possible address. If a valid seasonal address is not found, the program considers the address types selected in

Step 4.

Step 4. In the If no seasonal addresses are found, consider these addresses frame, select which address types
to use if no valid seasonal addresses exist.

In the Addresses box, select an address type and click the right arrow to move it into the Addresses to
consider, in order of importance box. The first address type in the list that matches the validation date is
used on the statement. You can change the order addresses are considered by selecting an address type and
clicking the up and down arrows next to the list.

If a valid address is not found from these address types, the program considers the attributes selected in
Step 5.

Step 5. In the grid, you can select address attribute types to consider. For example, you have a “Billing
statement address” attribute you use to flag addresses for statements. When you select Include in the Action
column and Billing statement address in the Attribute column of the grid, the program automatically uses
any valid addresses assigned this attribute.
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Step 6. In the If no address is found field, select what to do if a valid address is not found. You can select Print
with no address, Remove record from run, or Print specific address. If you select to print a specific address,
the Use field appears so you can select the address type to use when a recipient does not have an address of
the types you added to the Addresses to consider, in order of importance list.

Auto Pay Tab

If you have the optional module Electronic Funds Transfer, you can use the Auto Pay tab to create automatic EFT
payments for records with variable amount automatic payments set up on the Automatic Payments tab of their
record.

When you print or export statements, the program generates all charges and credits and applies payments for
the record based on the statement criteria. Payments apply to associated charges as determined by the Student
Billing business rule settings. The automatic payment is recorded on the statement and on the payer’s Activity
and Automatic Payment tabs. The payment also appears on the payee’s Activity tab.

The program creates one deposit and payment record for the calculated balance using the information you enter
on the Auto Pay tab. When you run Create an EFT file in Deposit tasks for Banks, the deposit record updates
automatically with the date the EFT file was created.

|
File Edit WView Favorites Tools Help
G damE = 2- |
1: General | 2 Detailsl & Summaryl 4 Fillersl 5 Attributes | B Address |§: Format
[~ Create automatic varable amount payrents based on staterment criteria
Depozit Information -
Depozit date: Im Pogt gtatus: IW
Entry date: Im Fogt date: Im
Status; m
Dezcription: I
Bank account: Im GL cash account: IW
Payment Infarmnation -
Pawment date: Im Puost status: IW
Source: Iﬁ Pzt date: W
Commet: |
< Back | Hemt » | Cancel | Frint | Preview Layout
|

Create automatic variable amount payments based on statement criteria. Mark this option to
generate variable amount automatic payments. This enables the other options on this tab. If this option is not
marked, no automatic payments are created.

Deposit date. In the Deposit date field, enter the date the deposit is made to the bank account.

Note: The deposit information entered on the Auto Pay tab is used for all payments in the deposit.
Entry date. In the Entry date field, enter the date the deposit is entered in the program.
Status. In the Status field, select Open or Closed. You cannot add new payments to a closed deposit.

Post status. In the Post status field, select a post status for the deposit.
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Post date. In the Post date field, enter the date to post the deposit. The information in the Post status and Post
date fields defaults automatically to the payments added to the deposit. You post deposits, not individual
payments.

Description. In the Description field, enter a description of the deposit or any other information you want to
record about the deposit.

Payment date. In the Payment date field, enter the date the payment was received.

Source. For variable payments not paid by EFT, in the Source field, select the payment source such as mail or in
person.

Post status. The post status defaults from the deposit record. You post deposits, not individual payments.
Post date. The post date defaults from the deposit record. You post deposits, not individual payments.
Comment. In the Comment field, you can enter a note about the payment.

Format Tab

On the Format tab, you designate the format for the mailing. Settings on this tab determine the appearance of
the statements. You can sort the mailing, make selections for details and formats, and align the statements on
paper or forms. You can combine payments into a single transaction instead of printing them as separate
transactions.

Detail. Use Detail to select extra details to print on the statements.

I3 New Statements I
File Edit Yiew Favorites Tools Help

A2 a2 \
ik General' 2 Detailsl at Summar_l,ll 4 Filtersl i Attributesl E: Addressl T Auto Pay

Staterent Sort

Miscellaneous W Show statement reference number
ED”'“ .f«ligr?meat [~ Show barcode using: |3 of 9 Barcode j Fant size: Im j
rganization Name :

Address Detail [ Show print date on statement

Finance Charge Format | [ Show credit balances as $0.00

(3 Hame Formats Show statement due date using:
: ] < Stat b dates | plus |30 daps
i Statement Recipier L : I Siement dais J

Staterment For [ Show minimurn amaunt due as: IF'ercent of total amant j | percent
; Statement Body ¥ Display tranzaction comments

Statement Format :
Statement Message B s L IHBCDFd D 'I

Deferred Payment Plan: ‘When a statement recipient paps for multiple records:

IUse statement tab to determine § of statements ﬂ

V¥ Include recaords with a zer balance

< Back | Hext » | Cancel | FErint | Preview | Lapout |

If you mark Show statement reference number, the program generates a number to appear on the
statement beneath the statement date. To display the reference number as a barcode, mark Show barcode
using [ ] and select a font type and font size.

If you mark Show print date on statement, the printing date appears on the statements beneath the
statement date.

If you mark Show credit balances as $0.00, the amount due balance and aging balances appear as a zero
amount if they are credit balances.

If you mark Show statement due date using [ ] plus [ ] days, you can select the date payments are due and
plus the number of days.
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If you mark Show minimum amount due as, you can select a percentage of the total due or enter a specific
amount.

If you mark Display transaction comments, transaction comments print below the transaction.

If you mark Show payer ID as [ ], you can select whether to print the payer’s record ID or Social Security
Number.

In the When receiving multiple statements [ ] field, you can select:

¢ Use statement tab to determine the # of statements — The program includes record activity according to
your selections on the Statements tab of the record.

¢ Create one statement per record — The program prints a separate statement for each record.

¢ Combine records onto one statement — The program prints a single statement with payees combined on
the statement.

If you mark Include records with a zero balance, the statement includes records with zero balances.

Statement Sort. Use Statement Sort to select the order to print statements.

I3 new Statements I
File Edit View Favorites Tools Help

dadam a2 \

e General' z Detailsl & Summar_l,ll 4 FiIters' 5 Attributes' B Addressl T Auto Pay 8 Format I

5] Detai Statement Sort

: nent S ort
Mizcellaneous Sort by I Order by Iﬂ
Farm Alignment Redipient Mame Ascending

Organization Name
Address Detail

Finance Charge Format
i3 Mame Formats
Statemert Recipier LI
Statement For

Staternent Format
Statement Message
Defered Payment Plan:

< Back | Hext s | Cancel | Frint | Freview | Layout |

When you select Statement Sort, a grid appears. Select a sorting category in the Sort by column and select
Ascending or Descending in the Order by column. If you make no selections in the Sort by column, the
program sorts by record name in ascending order.
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Miscellaneous. Use Miscellaneous to specify how you want numbers to appear on the statements and the font
size for statements.

I3 New Statements I
File Edit View Favorites Tools Help

dadan a2 \

il General' z Detailsl 2 Summar_l,ll 4 FiIters' & Attributes' B Addressl T Auto Pay 8 Format I

Detail Miscellaneous

Staternent Sort

] aneaLs ow currency character on amoun
] Sh charactel Al ts
Farrm Alignment Show percent sign on All amounts
g;g;nlzagon f.\IJame Megative amount format (1234.56)
ress Detal
E . Mumber of digits after dedmal for amounts 2
Finance Charge Format
=) Name Farmats Mumber of digits after decimal for percentages 2
i [ Statement Recipier |Show 1000's separator Yes
Show blanks instead of zeros Mo
Font size 8

Staternent Format
Statement Message
Defered Payment Plan:

Sample amount:

Amount (51,234.56)
Percent 100,00%
< Back | st | Cancel | Frint | Previe@l Layout |

Form Alignment. You can use Form Alignment to specify vertical and horizontal alignment of the forms and
addresses when you print.

1@ new Statements [ x| I
File Edit WView Favorites Tools Help

daga o= |
1 Genelall 2 Details' 3 Summar_l,.l' 4 Filtersl 5 Attlibutes' E: Addless' 7 Auto Pay  8: Format |

Dt Alignment

Statement Sort

; = ]
Miscellansou Form Alignment: -

] - = Wertical alignment; Default alignment - unitz = D inch
Organ I d J I

Address Detail Horizontal alignment: IDefauIt aligriment j I units = 0 inch
Finance Charge Format

{5 Mame Formats Mate: 1 unit equals 1/100th of an inch or 0.254 milrmeters.
i [F) Statement Fecipisr

Address Alignment:

Statement Body
Statement Format
Statement Message Harizantal slignment: IDefauIt aligrment j | uritz = Oinch

Wertical alignment: IDefauIt aligrment j I units = Dinch

Mate: 1 unit equals 1,/100th of an inch or 0.254 millimeters.

< Back | [Hexts Cancel Frirnt Preview Layout

Note: The maximum alignment adjustment you can enter is 99. This moves the margin .99 inch.
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In the Form Alignment frame, you can adjust the form’s top and left margins for printing using the Vertical
alignment and Horizontal alignment fields. You can move printed information up or down or left or right and
enter how much to move the information. For example, if you select Move printed information up and enter
2, the information prints .02 inch higher on the page.

Addresses for the statement recipient are aligned by default to fit the first five lines in a standard envelope
address window. If you need to make adjustments, in the Address Alignment frame, you can move printed
information up or down or left or right and enter how much to move the information. For example, if you
select Move printed information up and enter 2, the address prints .02 inch higher on the page.

Organization Name. Use Organization Name to print your organization’s information at the top left of the
form. The information that appears in the Organization name and Address fields defaults from the General
tab of Configuration. If you mark Show organization address, you can enter or edit the name and address.
The Address quick view box displays the information as it will appear on statements.

I3 New Statements I
File Edit Wiew Favorites Tools Help

e = e |

1 Genelall 2 Tranzachion Detailsl & Filtersl 4 ﬁ-\ttributesl 5 Addressl E: Auto Pay 7 Format |

Detal Organization Name

Statement Sort

Mizcelaneous ¥ Show organization addiess

Farm &ligrment

‘B Organization Name
Address Detai Address: ;I
Finance Charge Format

advance Deposits

Financial id =

(3_ Marne Formats Address quick view:
i[5 Statement Recipisr = =
Community Services Inc.

] Staternent For

‘ Statement Body
Tranzaction Sort
Statemnent Format
Statement Message

Organization name: IEDmmunit_l,l Services nc.

< Back | et Cancel Erirt Preview Layout
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Address Detail. Use Address Detail to select the address information appearing in the address section of

statements. The options on this screen are disabled if the Show statement recipient address is unmarked on
the Address tab.

I New Statements I
File Edit View Favorites Tools Help

EIEEE =T |

1 Generall 2 Details' 2 5ummary| 4 Filtersl 5 Attributes' B Address' 7 Auto Pay  8: Format |

D etail Address Detail
Statement Sort

Miscellaneous [~ Show contact information in addiess
E?;;:z“gtr;;:'uea;me Contact Mumber: |<Dg not print j
B Adde Cantact Mumber: |<D0 nak print> j
:Ji;fnr;cl?g?;:;ge Format [~ Show USPS barcode in address

; Statement Flecipier Address quick view:

Statemnent For Record Hame Here
Staterment Body ddress I!ne 1
Statement Format gg:g:: :::2 g
Statement Message

< Back | et Cancel Frrint Freview Layout

Note: You enter contact information on the Bio 1 tab of records.

To print telephone numbers or Web or email addresses, mark Show contact information in address and
select a number or address in the Contact Number fields. If the record is an organization, the contact’s name
appears in the ATTN line.

You can mark Show USPS barcode in address to print the barcode on the statements above the address.
The Address quick view displays the address information as it will appear on statements.
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Finance Charge Format. Use Finance Charge Format to select and define information to appear Finance

Charge Information section of the statements.

I3 New Statements I
File Edit View Favorites Tools Help

dagdam = |

H: General' 2 Detailsl I Summar_l,ll 4 FiIters' & Attributes' B Addressl T Auto Pay 8 Format I

Detail Finance Charge Format

Statemnent Sort

Mizcelaneous [ Include closing date of billing cycle: |12£11H2DD? T"]l

Fairn .@.xllgrjment [ Include finance charge disclosure statement:

Organization Name ;I
Address Detail

B Finance Charge Format
t_5 Mame Formats

i [3] Statement Recipier

i~ [3] Statement For LI

Stat VF X I Include calculation information for finance charges
atement Formal

Staternent Message I Include summary of finance charges
Deferted Payment Flan: gy e dale ange This fiscol period 2] 12401 /2007 6 12431/2007

Clazcription: |

< Back | Hext s | Cancel | Frint | Freview | Layout |

Mark Include closing date of billing cycle to include the closing date on the statements. The closing date
defaults to the transaction cutoff date from the General tab or you can select a different date. For example, if
you select May 31, 2005, as the closing date, “Closing date of billing cycle: 05/31/2005” appears in the
Finance Charge Information section of the statements.

If you mark Include finance charge disclosure statement, you can create a disclosure statement. Enter the
text for the statement in the text box.

If you mark Include calculation information for finance charges, the calculation date and percentage rate
appear in a message on the statements. For example, “The finance charge dated 0501/2005 was calculated
as of 04/30/2005 using an annual percentage rate of 10%. The balance subject to finance charge was
$100.00.”

If you mark Include summary of finance charges, a total of finance charges appears in the Finance Charge
Information section of the statements. In the Summary date range field, you can include all dates or select a
specific date or range. In the Description field, you can enter text to precede the total finance charge amount
appearing on the statements, for example, “Year-to-date finance charges:”. If you mark Transactions across
this date range on the Summary tab, the summary of finance charges is for the same date range selected on
the Summary tab.

Tip: We strongly recommend you use <Full name>. If you select Diploma Name, Informal Addressee, Informal
Salutation, or any user-defined salutations from Configuration, the program reformats each name, therefore
taking much longer to run statements.
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Name Formats. Using Name Formats, you can format how names appear for organizations, individuals, and
students in the address and body sections of the single statement. In the tree view on the left, select
Statement Recipient, Statement For, or Statement Body to format names for that area of the statement.
Click Statement Recipient or Statement For to format how names appear in the header. Click Statement
Body to format how names appear in the body area of the form.

1@ new Statements I
File Edit View Favorites Tools Help

dada@ a2 |

1 Generall 2 Detail$| 2 Summary' 4 Filtersl =5 Attribute&' E Addres&' 7 Auto Pay B Format |

Detail Statement Recipient Name Formats
Statement Sort P
. Organization-
t;lmcei?neousl Use name followed by: [~ Organization D [ CFDA # I™ Cantact Name
armn Alignmen ..
Orgarization Marme Individual :
Address Detail Select addressea//zalutation from: IFlecnrd VI
:;inanc;:a Charge Format = |<Fu|| —— j
arne Formats
! EYUPRMMMMEIRE [ riot present, select addresseesalutation from: IHecord vI
Statement For Use:
€ -
i [B) Statement Body |<FuII name” [-
Statement Format Student -
Statement Message Select addressees/zalutation from: IHecord 'I
Uze: |<FuII rames j
If ot prezent, select addressee/salutation from: IF!ec:-:rd vI
Use: I <Full name: j
< Back | et | Caticel | FErrint | Freview | Lapout |

In the Organization frame, mark Organization ID, CFDA #, and Contact name for these items to appear after
the organization name.

In the Individual and Student frames, select Record or Configuration in the Select addressee/salutation from
[ field.

If you select Record, in the Use field, select the full name, primary addressee, primary salutation, directory
name, diploma name, informal addressee, or informal salutation as defined on the individual or student
record.

Note: You must have the appropriate security rights to output an addressee/salutation with Social Security
numbers. If you do not have security rights, the numbers are masked. For more information, see the Security
chapter of the Administration Guide for The Financial Edge.

If you select Configuration, in the Use field, select from one of the formats defined in Configuration.

In the If not present, select addressee/salutation from field, you can select a second name format for
situations where the first selection is not present on individual or student records. For example, if you select
Primary salutation, and you have students without a Primary salutation defined on the
Addressees/Salutations tab, the second name format is used. If you select <Full name> in the Use field or
Configuration in the Select addressee/salutation from field, this field is disabled.
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Statement Format. Use Statement Format to make formatting selections for the statement forms.

I3 New Statements
File Edit Yiew Favarites Tools Help

dadaEa=]2- |

1 General' 2 Detailsl 3 Summar_l,ll & Filtersl & Attributesl E: Addlessl I Auto Pay  8: Format |

Detai Statement Format

Statemnent Sort
Mizcelansous Statement format:l STHMSELSTPPOOR j IB.:-: Amount/B slance [Laser pre-printed form)
Farm Alignment _ _ —

Organization Mame MNurnber of copies to print for each statement: |1 = [~ Collate

Address Detail ™ Fiint & [oge ar the farm) -
Finance Charge Format ) _
=) Name Formats Logo file name: I _I

- [ Statement Recipier| Lagasiee: | Small (21/2in « 1 in) =
- 2] Statement For
- [ Statement Body Mizcellanzous information-

Tranzaction spacing: ISingle space ﬂ

=1t ent Format
Statemert Message

I~ Print a arap background for every other ransaction
I~ | Fiirit & gray bar for each heading
[ Frint total number of pages on each page

Digplay grade level from: INe:-:t billing cycle 'l

< Back Hext = | Cancel | Print | Preview Layout

Note: If you mark Print a logo on the form, you must select a file name and logo size. Large logos print 5 3/8 in.
x 1in; small logos print 2 1/2 x 1 in.

In the Statement format field, you can select a laser pre-printed form or blank paper. In the Number of
copies to print for each statement field, select how many copies of each statement to print and mark Collate
to collate the statements if you print more than one.

If you print statements on blank paper, you can print your organization logo on the statements. To print the
logo, mark Print a logo on the form. In the Logo file name field, browse to the file where your logo is saved in
* bmp format. In the Logo size field, select Large or Small as the logo size to use on the statements.

Note: If you mark Print total number of pages on each page, the numbering appears, for example, as Page 1 of
79.

In the Miscellaneous information frame, you can make additional formatting selections. In the Transaction
spacing field, select Single space or Double space as the amount of space to leave between lines. To make
reading statements easier, you can mark Print a gray background for every other transaction or Print a gray
background for each heading. You can record page numbers on the statements by marking Print total
number of pages on each page.

If you have The Registrar’s Office, in the Display grade level from field, you can select the grade level to
display on the statements. The program refers to the student’s progression entry as of that date to determine
the student’s grade level. For example, if you print statements for the next billing cycle, a student may need
to be billed for the next grade level based on the progression entry.
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Statement Message. Use Statement Message to print additional information for recipients.

1@ New Statements

File Edit Yiew Favaorites Tools Help
I EEIFEEIR A |
1 General' & Detailsl & Summar_l,ll 4 Filtersl 5 Attributesl E Addressl T Auto Pay 8 Fomat I

Detai Statement Message
Statement Sort
Mizcelaneous Pritit statement comments from each recond: |A[ the end j
Farm Alignment Pritit this message at the end of sach statement page: -
Organization Name =i
Address Detal =
Finance Charge Fomat |t g ctatement copy message exists, print this message on each copy: -
{5 Mame Formats
i [2] Statement Fecipier
Statement Far If the copy recipient should not see the amount due, display the amaunt as:l <Blarkz vl
..... Statement Body Print these messages for each aging period: -
Staternent Fomal Aiging meszages will print based on the past due status of each balance.
B Statement & Aging Period Message |
current
31-60
B61-90
over 90
< Back | et » | Cancel | FErint | Preview | Lapout |

If you entered information on the notes tab of a record, you can choose where to Print statement comments
from each record. You can select At the end or At the beginning. You can enter text in the Print this message
at the end of each statement page and If no statement copy message exists, print this message on each
copy fields. If you do not want a recipient to see the amount due, you can select <Blank>, ***, or 0.00 in the
If the copy recipient should not see the amount due, display the amount as [ ] field. In the aging periods
grid, you can enter messages for each period.

Creating Student Billing Statements

Note: We offer high-quality, customized forms that are specifically designed for use with our software. These
forms, including checks, student bills, statements, invoices, purchase orders, tax forms, and envelopes, are
pre-printed in color with your organization’s logo and information. For more information, visit our Web site at
http://forms.blackbaud.com or call us toll-free at 866-4-BB-FORMS (866-422-3676).

On the Statements tab of student, individual, and organization records, you can select which records and payers
receive statements or copies of statements. You can also add additional information and notes for recipients. For
more information, see the Records Guide for Student Billing.

If the statement recipient is a payer for more than one student, individual, or organization, you can format the
statement using the settings defined on the recipient’s Statements tab, create separate statements for each
record, or combine the information for all his payees on one statement.

» Creating Student Billing statements

In this example, we print statements for organizations who are statement recipients containing a summary of
transactions as of today’s date. We add a due date and minimum amount due, include a billing cycle closing
date and finance charge disclosure statement, and add a statement message that says, “Please remit prompt
payment of the balance due”. We also use the Auto Pay tab to create automatic EFT payments for
organizations with automatic payments set up on their record.

1. From the Mail page in Student Billing, click Forms. The Forms page appears.

2. Inthe list on the left, select Statements and click New on the action bar. The New Statements screen
appears on the General tab.
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Note: To export statement information, mark Export statements to Access. For more information about
exporting in Mail, see “Exporting a mailing” on page 15.

3. Inthe What do you want to do? frame, mark Print Statements.
4. In the Transaction cutoff date and Statement date fields, select “Today”.

I3 Hew Statements I
File Edit View Favorites Tools Help

EIEEEEIEEE |

1. General |g; Detailsl 3 Summaryl 4 Filtersl 5 Attributes | & Addlessl 7 Auto Pay | 8 Format

What do pou want to do?

v i [~ Export statements to Access
Tranzaction cutoff date: IT.;,da_v j 01/05;/2007
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Include recipients receiving: | Statements and statement copies ¥| Famtat: [Summary and Detail x|

Include statements with: -
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[~ Create an output query of statement recipients [~ Create an output query of recards on statements
< Back | Next = | Catcel | Brint | Preview | Layout

5. Click Next or select the Summary tab.
6. Inthe Summarize included transactions by field, select “Transaction type”.

I3 New Statements I
File Edit View Favorites Tools Help

EIEEEEIEEL |

4 Filtersl 5 Attributes | E: Addlessl 7 Auto F'a_l,ll 8 Format

1 Generall 2: Detailz

Specify how the Surmary section of the statement should dizplay information.

Summary gections to includs: IStatement Surmmary and Date Range Summarny j

Stab it Summary

Summarnize included transactions by: ITransaction tupe 'l
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< Back | MNest » | Catcel | Pritit Praview Layout

7. Click Next or select the Filters tab.
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Note: It is important to use filters carefully so you do not underbill a record. Filtering by the record filters,
Product and Billing Items on Charges, or Product and Billing Item Attributes may result in some records or
charges being omitted unintentionally. For more information, see “Statements Filters Tab” on page 192.

8. Select “Organization” for the Statement Recipient Record types filter. For more information about
filtering, see the Program Basics Guide.

I New Statements I
Eile Edit View Favorites Tools Help
FIEEEEIEEEE |

1 General' 2 Details' 3 Summary 4 Filbers |§: Attributes | B: Addressl 7 Auta Pay | 8 Farmat

&3 Open * Clear Al Filters

Filters I Incude I Selected Filters |ﬂ

Statement Recdipients All <All Statement Redpients =

Statement Recipient Stat... |All <All Statement Recipient Statement Codes =

Statement Recipient Reco.,. Selected Organization

Student Statement Redpi... |All <Al Student Statement Recipient Atiributes>

Individual Statement Redi,.. |All <All Individual Statement Recipient Attributes =
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Student Attributes All <Al Student Attributes =

Individual Attributes All <Al Individual Attributes> ;I
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9. Select the Auto Pay tab.
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10. Mark Create automatic variable amount payments based on statement criteria. Use the default deposit
and payment information.

11.
12.
13.

14.

File Edit View Favorites Tools Help
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Select the Format tab.

In the list on the left, select Detail.

Mark Show statement due date using [ ] and select “Transaction cutoff date”, and enter “30” in the plus

[

] days field.

Mark Show minimum amount due as [ ], select “Percent of total amount”, and enter “50” in the percent
field.

I New Statements I

Eile Edit View Favorites Tools Help
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Staternent Body [+ Display iansaction comments
Statement Format

Sh I as I I
Statement Message {_1Fshow paperiDias: | Fecord 1D -
‘When a statement recipient pays far multiple reconds:

IUse statement tab to determine # of statements j

W Include recards with & zer balance

< Back | Hext > | Catcel | Print Preview Layout




224 CHAPTER

15. Inthe list on the left, select Finance Charge Format.
16. Mark Include closing date of billing cycle and select a date.

17. Mark Include finance charge disclosure statement and enter in the text box “An additional charge at a
daily percentage rate of 1.5% may apply to an unpaid balance.”

I3 Hew Statements I
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18. In the list on the left, select Statement Message.

19. Enter “Please remit prompt payment of the balance due.” in the Print this message at the end of each
statement page text box.
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20. Click Preview. A message appears telling you the program is processing the mailing, and the preview
screen for the statements appears.

21. Close the preview and return to the Format tab.

22. Click the Save button on the action bar to save the new forms. The Save Mailing as screen appears.
23. In the Mailing name field, enter “Statements for Organizations”.

24. In the Description field, enter “Transactions through Today”.

Save Mailing as I

b ailing name: |Statements for Organizatiohs

Desenption: [Tranzactions through Today

¥ Others can n this maiing
[ Others can modify this maiing

& 5ave | Cancel |

25. Click Save to save the new forms. You return to the Format tab.
26. Close the screen. You return to the Forms page, and the statement appears in the grid.

Statements of Projected Charges

Note: We offer high-quality, customized forms that are specifically designed for use with our software. These
forms, including checks, student bills, statements, invoices, purchase orders, tax forms, and envelopes, are
pre-printed in color with your organization’s logo and information. For more information, visit our Web site at
http://forms.blackbaud.com or call us toll-free at 866-4-BB-FORMS (866-422-3676).

Statements of projected charges report charges and credits that will be assessed to students, individuals, and
organizations for a given period of time. These statements include generated and ungenerated transactions that
are scheduled (or will be scheduled based on bill codes) for a specified time period.

Statements of Projected Charges Tabs

A statement of projected charges has tabs on which you can select parameters: General, Filters, Attributes,
Address, and Format. To move among the tabs, click Next and Back at the bottom of the screen or select the tab.
On these tabs you specify the records to include in the mailing and how the statements of projected charges
should look.
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General Tab

On the General tab for statements of projected charges, you select parameter settings specific to statements.
Here you can print or export the information or do both.
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Note: If you mark Print statements, you can also preview the mailing and view a layout of the statements. If
you mark Export statements to Access, the Preview and Layout buttons become disabled. You can export
statements only to Microsoft Access.

What do you want to do? In the What do you want to do? frame, you can print or export statements, or
both. To print statements on your selected printer, mark Print statements. For more information about
setting up printers, see the Program Basics Guide. If you mark Export statements to Access, the program
creates a *.mdb file containing a database of statement recipients, transactions, and other statement
information that you can use in Microsoft Access.

Statement date. In the Statement date field, you can select the date the statement is created — Today,
Yesterday, Tomorrow, a specific date, or the transaction cutoff date.

Include projected activity within this range [ ]. In this field, select the time period of activity to include. If
you select <Specific range>, enter dates in the To and From fields. When including grade based billing items in
the statement, only one grade is considered. For this reason, we recommend you run this report for a single
academic year at a time.

For grade based billing, use the students’ grade as of [ ]. This option appears only if you have
Registrar’s Office. You can mark this option to include grade-based fees based on the student’s grade as of
the date selected in the field. The program determines the student’s grade based on the date and the student
progression table.

For grade based billing, bill for next grade. This option appears if you do not have Registrar’s Office. You
can mark this option to calculate grade-based fees based on the student’s next grade.

When a statement recipient pays for multiple records [ ]. In the When a statement recipient pays for
multiple records field, you can select:
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¢ Use the statement settings for the statement recipient — The program includes record activity according
to your selections on the Statements tab of the record.

¢ Create one statement per record — The program prints a separate statement for each record.

¢ Combine records onto one statement — The program prints a single statement with payees combined on
the statement.

Include records with a zero balance. If you mark Include records with a zero balance, records with zero
balances appear on the statement recipient’s statements.

Create an output query of statement recipients. To create a query of recipients you run statements for,
mark Create an output query of statement recipients. You can save and use an output query later for reports
or other mailings.

Create an output query of records on statements. To create a query of records appearing on each
statement, mark Create an output query of records on statements. You can save and use an output query
later for reports or other mailings.

Filters Tab

Note: It is important to use filters carefully so you do not underbill a record. Filtering by the record filters,
Product and Billing ltems on Charges, or Product and Billing Item Attributes may result in some records or
charges being omitted unintentionally.

On the Filters tab, you select criteria that determines which items to include in a statement. It is important to use
filters carefully so you do not underbill a record. The Records in Statement Body, Record Billing Statuses, Record
Types, and Student/Individual/Organization Attributes filters apply to record activity. If you use these filters, only
activity for records that meet these filter requirements appear on the statements.
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You can filter by Product and Billing Items on Charges or Product and Billing Item Attributes. When you filter by
these items, only charges with the selected products or billing items appear on the statements; therefore,
charges for other products or billing items and any applications made to these charges (regardless of the
application’s billing item) are not included in the statement. For basic information about filtering criteria, see the
Program Basics Guide.
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Open. To open a selection screen to designate specific filters for the form, select a filter in the grid and click
Open on the action bar.

Clear All Filters. To reset each filter to include all, you can click Clear All Filters.
Filters. The Filters column lists all the filters for the form. You cannot edit this column.

Include. By default, in the Include column, each filter is set to All. To open a selection screen to designate
specific filters for the form, choose Selected.

Selected Filters. Filters you specify on the selection screen appear in the Selected Filters column.
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Selected Filters Screen

From the Filters tab, you can open a selection screen for a filter in several ways: by double-clicking the filter in the
grid, selecting the filter in the grid and clicking Open on the action bar, or choosing Selected in the Include
column for the filter.

Selected Statement Recipients x| I

Include: @ All Q¥ Selected & Querny | Frzvious Filizr Mext Filker

Statement Fecipient | Record 1D |

ar. I Cancel |

Include. For each filter, you can include all or select specific filters. Depending on the filter, you may also be able
to filter by a range or query.

All. If you mark Include: All, you cannot designate specific filters.

Selected or Range. If you mark Include: Selected or Range, a grid appears in which you can specify filters. In a
field, you can click the binoculars to search for information.

Query. If you mark Include: Query, the Query name field appears for you to enter the name of the query by
which to filter the form. In the field, you can click the binoculars to search for the query name.

To create a new query, click the binoculars. Then click Add a New Query on the Open Query screen. For more
information about creating queries, see the Query Guide.

Previous Filter. To view or edit the previous filter without returning to the Filters tab, click Previous Filter.
Next Filter. To view or edit the next filter without returning to the Filters tab, click Next Filter.
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Attributes Tab

You can use the Attributes tab to add, delete, or update attributes for statement recipients and records who
receive statement copies.
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Action. In the Action column, you can select to add, delete, or update attributes on the recipient’s record when
you generate statements.

Note: Attribute types are established in Configuration. For more information about creating attribute types,
see the Configuration Guide for Student Billing.

Record Type. In the Record Type column, select the record type to add the attribute to. The record type you
select determines the attribute types available in the Attribute Type column for that row.

Attribute Type. In the Attribute Type column, you can select an attribute type.
Description. In the Description column you can enter or select a description for the attribute type.

Short Description. If you selected a table type attribute that uses short descriptions, in the Short Description
column, select the attribute description. The Description column completes automatically.

Date. In the Date column, select the date you add, delete, or update the attribute.

Note: An attribute is a tool used to group information based on a common theme. With attributes defined, you
can filter information to your specifications.

Required. If the attribute type you select is required, the program automatically marks the checkbox in the
Required column.

Comments. In the Comments column, you can enter free-form text for additional information about the
attribute type.
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Address Tab

Use the Address tab to specify whether addresses appear on statements of projected charges. The program
compares the parameters you define on this tab with address information entered on the Addresses tab of the
recipient’s record to identify the appropriate address to use.

On the Address tab, you select a validation date and then define the order in which the program evaluates
address types. The program first checks the validation date, then seasonal addresses, other address types (in the
order you determine), and attributes. The first address found on the recipient’s record that meets the defined
parameters is used on the statement. You can also specify what to do if no valid address is found.
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Step 1. Mark Show statement recipient address to include the recipient’s address on the statement. If you
unmark this checkbox, all options on this tab are disabled and no address appears on the form.

Step 2. In the Validate addresses as of [ ] field, select a date to determine which address to use. Any address
that is valid on this date is considered for use on the statement. Any addresses that are not valid on this date
are automatically excluded from consideration.

Step 3. Determine whether to include seasonal addresses as possible addresses. If you mark Consider seasonal
addresses, the program uses the first valid seasonal address found on the recipient record and does not
consider any other addresses.

If the seasonal address has the Send no mail attribute, the seasonal address is excluded automatically as a
possible address. If a valid seasonal address is not found, the program considers the address types selected in
Step 4.

Step 4. In the If no seasonal addresses are found, consider these addresses frame, select which address types
to use if no valid seasonal addresses exist.

In the Addresses box, select an address type and click the right arrow to move it into the Addresses to
consider, in order of importance box. The first address type in the list that matches the validation date is
used on the statement. You can change the order addresses are considered by selecting an address type and
clicking the up and down arrows next to the list.
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If a valid address is not found from these address types, the program considers the attributes selected in
Step 5.

Step 5. In the grid, you can select address attribute types to consider. For example, you have a “Billing
statement address” attribute you use to flag addresses for statements. When you select Include in the Action
column and Billing statement address in the Attribute column of the grid, the program automatically uses
any valid addresses assigned this attribute.

Step 6. In the If no address is found field, select what to do if a valid address is not found. You can select Print
with no address, Remove record from run, or Print specific address. If you select to print a specific address,
the Use field appears so you can select the address type to use when a recipient does not have an address of
the types you added to the Addresses to consider, in order of importance list.

Format Tab

On the Format tab, you designate the format for the mailing. Settings on this tab determine the appearance of
the statements. You can sort the mailing, make selections for details and formats, and align the statements on
paper or forms. You can combine payments into a single transaction instead of printing them as separate
transactions.

Detail. Use Detail to select extra details to print on the statements.
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Note: You can enter the statement reference number on the payment record in the Reference # column.

If you mark Show statement reference number, the program generates a number to appear on the
statement beneath the statement date. To display the reference number as a barcode, mark Show barcode.

If you mark Show print date on statement, the printing date appears on the statements beneath the
statement date.

If you mark Show credit balances as $0.00, the amount due balance and aging balances appear as a zero
amount if they are credit balances.
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If you mark Show statement due date, you can select the date payments are due. In the Due date field, select
Today and a number of days in the plus [ ] days fields or select <Specific date> and use the calendar to select

a date.

If you mark Show minimum amount due as, you can select a percentage of the total due or enter a specific

amount.

Statement Sort. Use Statement Sort to select the order to print statements.
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When you select Statement Sort, a grid appears. Select a sorting category in the Sort by column and select
Ascending or Descending in the Order by column. If you make no selections in the Sort by column, the

program sorts by record name in ascending order.
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Miscellaneous. Use Miscellaneous to specify how you want numbers to appear on the statements and the font

size for statements.
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Form Alignment. You can use Form Alignment to specify vertical and horizontal alignment of the forms and

addresses when you print.
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Note: The maximum alignment adjustment you can enter is 99. This moves the margin .99 inch.

In the Form Alignment frame, you can adjust the form’s top and left margins for printing using the Vertical
alignment and Horizontal alignment fields. You can move printed information up or down or left or right and
enter how much to move the information. For example, if you select Move printed information up and enter
2, the information prints .02 inch higher on the page.

Addresses for the statement recipient are aligned by default to fit the first five lines in a standard envelope
address window. If you need to make adjustments, in the Address Alignment frame, you can move printed
information up or down or left or right and enter how much to move the information. For example, if you
select Move printed information up and enter 2, the address prints .02 inch higher on the page.

Organization Name. Use Organization Name to print your organization’s information at the top left of the
form. The information that appears in the Organization name and Address fields defaults from the General
tab of Configuration. If you mark Show organization address, you can enter or edit the name and address.
The Address quick view box displays the information as it will appear on statements.

lE Mew Statements of Projected Charges I
File  Edt “iew Fawaortes Toolz Help

B e R =] 2 |

1 Generall 2 Filtersl 2 .-’-\ttributesl 4: Address & Format |

Detail Form Alignment

Statement Sort

Mizcelaneous I~ Show organization address

Dlm |igment Organization name: I

‘B Drgarization Name

Address Detail Address: =
7 Mame Formats

Statement Flecipier
Statement For =]
""" Statement Body | Address quick view:

Statement Format
Statement Meszage

< Back | L= Cancel Frrint Freview Layout




236 CHAPTER

Address Detail. Use Address Detail to select the address information appearing in the address section of

statements. The options on this screen are disabled if the Show statement recipient address is unmarked on
the Address tab.
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Note: You enter contact information on the Bio 1 tab of records.

To print telephone numbers or Web or email addresses, mark Show contact information in address and

select a number or address in the Contact Number fields. If the record is an organization, the contact’s name
appears in the ATTN line.

You can mark Show USPS barcode in address to print the barcode on the statements above the address.
The Address quick view displays the address information as it will appear on statements.

Tip: We strongly recommend you use <Full name>. If you select Diploma Name, Informal Addressee, Informal
Salutation, or any user-defined salutations from Configuration, the program reformats each name, therefore
taking much longer to run statements of projected charges.
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Name Formats. Using Name Formats, you can format how names appear for organizations, individuals, and
students in the address and body sections of the single statement. In the tree view on the left, select
Statement Recipient, Statement For, or Statement Body to format names for that area of the statement.
Click Statement Recipient or Statement For to format how names appear in the header. Click Statement
Body to format how names appear in the body area of the form.
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In the Organization frame, mark Organization ID, CFDA #, and Contact name for these items to appear after
the organization name.

In the Individual and Student frames, select Record or Configuration in the Select addressee/salutation from
[ field.

If you select Record, in the Use field, select the full name, primary addressee, primary salutation, directory
name, diploma name, informal addressee, or informal salutation as defined on the individual or student
record.

Note: You must have the appropriate security rights to output an addressee/salutation with Social Security
numbers. If you do not have security rights, the numbers are masked. For more information, see the Security
chapter of the Administration Guide for The Financial Edge.

If you select Configuration, in the Use field, select from one of the formats defined in Configuration.

In the If not present, select addressee/salutation from field, you can select a second name format for
situations where the first selection is not present on individual or student records. For example, if you select
Primary salutation, and you have students without a Primary salutation defined on the
Addressees/Salutations tab, the second name format is used. If you select <Full name> in the Use field or
Configuration in the Select addressee/salutation from field, this field is disabled.
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Statement Format. Use Statement Format to make formatting selections for the statement forms.
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In the Statement format field, you can select a laser pre-printed form or blank paper. In the Number of
copies to print for each statement field, select how many copies of each statement to print and mark Collate
to collate the statements if you print more than one.

Note: If you mark Print a logo on the form, you must select a file name and logo size. Large logos print 5 3/8 in.
x 1in; small logos print 2 1/2 x 1 in.

If you print statements on blank paper, you can print your organization logo on the statements. To print the
logo, mark Print a logo on the form. In the Logo file name field, browse to the file where your logo is saved in
* bmp format. In the Logo size field, select Large or Small as the logo size to use on the statements.

Note: If you mark Print total number of pages on each page, the numbering appears, for example, as Page 1 of
79.

In the Miscellaneous information frame, you can make additional formatting selections. In the Transaction
spacing field, select Single space or Double space as the amount of space to leave between lines. To make
reading statements easier, you can mark Print a gray background for every other transaction or Print a gray
background for each heading. You can record page numbers on the statements by marking Print total
number of pages on each page.

If you have The Registrar’s Office, in the Display grade level from field, you can select the grade level to
display on the statements. The program refers to the student’s progression entry as of that date to determine
the student’s grade level. For example, if you print statements for the next billing cycle, a student may need
to be billed for the next grade level based on the progression entry.
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Statement Message. Use Statement Message to print additional information for recipients.
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Detail Statement Message
Staternent Sort

Miscellaneaus Frint statement comments from sach record: I,.*_\t the end j

Farm Alignment Frint this meszage at the end of each statement page: -
Orgarization M ame I

Address Detail

@ MName Formats If ho statement copy message exists, print this message on each copy: -
Statement Fecipier I

Statement For

=
=

If the copy recipient should not see the amount due, display the amaount as:l <Blankz vl

< Back | Hewt > | Cancel | Brint | Preview | Layaout |

If you entered information on the notes tab of a record, you can choose where to Print statement comments
from each record. You can select At the end or At the beginning. You can enter text in the Print this message
at the end of each statement page and If no statement copy message exists, print this message on each
copy fields. If you do not want a recipient to see the amount due, you can select <Blank>, ***, or 0.00 in the
If the copy recipient should not see the amount due, display the amount as [ ] field.

Creating Student Billing Statements of Projected Charges

Note: We offer high-quality, customized forms that are specifically designed for use with our software. These
forms, including checks, student bills, statements, invoices, purchase orders, tax forms, and envelopes, are
pre-printed in color with your organization’s logo and information. For more information, visit our Web site at
http://forms.blackbaud.com or call us toll-free at 866-4-BB-FORMS (866-422-3676).

On the Statements tab of student, individual, and organization records, you can select which records and payers
receive statements or copies of statements. You can also add additional information and notes for recipients. For
more information, see the Records Guide for Student Billing. If the statement recipient is a payer for more than
one record, you can format the statement using the settings defined on the recipient’s record, create separate
statements for each record, or combine the information for all the records onto one statement.

» Creating Student Billing statements
In this example, we print statements of projected charges during this month for organizations.

1. From the Mail page in Student Billing, click Forms. The Forms page appears.

2. Inthe list on the left, select Statements and click New on the action bar. The New Statements screen
appears.

Note: To export statement information, mark Export statements to Access. For more information about
exporting in Mail, see “Exporting a mailing” on page 15.
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3. Inthe What do you want to do? frame, mark Print Statements.

4. In the Statement date field, select “Today”.
5. In the Include projected activity within this range [ ] field, select “This month”.

lQ New Statements of Projected Charges I
File Edit Yiew Favorites Tools Help

I =R |

1: General |g: Filtersl af .&ttributesl 4 Addlessl 5: Format

What do pou want to do?
¥ [~ Export statements to Access

Statement date: IToday ﬂ 12411 /2007

Include projected activity within this range: I This calendar year vl 01/01/2007 to 12/31/2007
For grade-based biling, use the students' grade as of: Inga_.,. vl 1241172007

[~ Create an output query of statement recipients

[~ Create an output query of records on statemnents

< Back | Mesxt » | Cancel | Frint Preview Lapout

|
6. Click Next or select the Filters tab.

Note: It is important to use filters carefully so you do not underbill a record. Filtering by the record filters,
Product and Billing ltems on Charges, or Product and Billing Item Attributes may result in some records or
charges being omitted unintentionally. For more information, see “Statements of Projected Charges Filters

Tab” on page 203.
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7. Select “Organization” for the Statement Recipient Record Types filter. For more information about

10.
11.

filtering, see the Program Basics Guide.

Ig MNew Statements of Projected Charges I
File Edit “iew Favortes Tools Help

e R |

1: General K3 .&ttlibutesl 4 Addressl 5 Format |

Filters | Inchide | Selected Filkers ﬂ

Statement Recipients all <Al Statement Recipients =

Statement Recipient Statement Codas  all <Al Staterent Recipient Staterment Codes =

Statement Recipient Record Types Selected COrganization

Student Statement Recipient Attributes Al
Individual Statement Recipient Attrib, ., Al
CQrganization Stakement Recipient Att.,. all

<Al Student Statement Recipient Attributes>
<Al Individual Statement Recipient Attributes =
<Al Organization Statement Recipient Attributes =

Records in Statement Body all <Al Records in Statement Body =

Record Types all <pll Record Types=

Record Eiling Statuses all <Al Record Biling Statuses >

Student Attributes all <ill Student attributess

Individual Attributes All <Al Individual Attributes =

Organization Attribukes all <l Organization Attribubes = =

-1 | I I B » e Pl 2 _DI—I

< Back | Mext = | Cancel | Frrint Freview | Layout |

Select the Format tab.

In the list on the left, select Detail.
Mark Show statement due date.

Mark Show minimum amount due as [ ], select “Percent of total amount”, and enter “50” in the percent

field.

l@ Mew Statements of Projected Charges I
Eile Edit “iew Favortez Tools Help

RS R0 =2 |

1 Eenerall 2 Filters| =& Attributesl 4 Addresz 5 Format |

Staternent Sort
Miscellaneous

Form Alignment
Organization Mame
Address Detail

5 Mame Formats

Statemnent Recipier

Statement For
Statement Body

W Shiow staternent reference number
[~ Show barcode

Font: IBDESBarcode 'l Font size: I'ID :I'

[T Shiow prick date on statement
[ Show credit balances as $0.00
[V Show statement due date

Due date: | <Statement dates =| plus |30 daws
Staternent Format J
Statemant M essage ¥ Shiow minirurn amount due 2z |F'ercent of tatal amaunt j |5E| percent
< Back | et Cancel Frrint Freview Layout
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12.
13.

14.
15.

16.

17.
18.
19.
20.
21.

In the list on the left, under Name Formats, select Statement Recipient Name Formats.
In the Use name followed by field of the Organization frame, mark Contact Name.

Ig MNew Statements of Projected Charges I
File Edit “iew Favortes Toolz Help

IRl R |

1 Generall 2 Filters| K3 .&ttlibutesl 4 Address 5: Format I

Detail Statement Recipient Name Formats
Statemnent Sort

K Drganization-
I;_-'llscel‘la_neoust Use name followed by: [~ Organization |0 [~ CFDaH =
orm Alignmen

S Individual
Organization Name narvcua

Address Detail Select addressee/salutation fram: I Fecord - I

I Nam Formats __ Uss: |<FuII P j
B Statement Recipier
If not prezent, select addresses salutation from: IHecold vl
Statemnert Body W
& <Full 5 ¥
Statement Format I Lnsme =

Statement Meszage Student

Select addressee/salutation fram: I Record < I

LUse: |<Fu|| nharnes j
If not prezent, select addresses salutation from: IHecold vI
Use: I <Full name> j

¢ Back | fest > | Cancel | FErrint | Freview | Lapout |

In the list on the left, select Statement Message.

Enter “Please remit prompt payment of the balance due.” in the Print this message at the end of each
statement page text box.

Ig Mew Statements of Projected Charges E

File Edit “iew Favontes Tools Help
== R el e |
1 Generall 2 Filtersl 3 .&ttributesl 4 Addrezz  5: Format I

Detail Statement Message

St.atement Sort Prinit this message at the end of each statement page: -
Miscellaneous

Farm Alignment Flease remit prompt payment of the balance due ;I
Organization Mame ; o -
Address Detail If no statement copy message exists, print this message on each copy: -

I Mame Farmats |

Statement Recipier |f the copy recipent should not see the amaunt due. displap the amount 533|<Blank> vl
Statement For

Statemnent Body
Statement Fomat
B Stae

Click Preview. A message appears telling you the program is processing the mailing, and the preview
screen for the statements appears.

Close the preview and return to the Format tab.

Click the Save button on the action bar to save the new forms. The Save Mailing as screen appears.
In the Mailing name field, enter “Projected Charges for Organizations”.

In the Description field, enter “Transactions Through This Month”.

Click Save to save the new forms. You return to the Format tab.
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22. Close the screen. You return to the Forms page, and the statement of projected charges appears in the
grid.

Publishing Statements to NetClassroom

If you have the optional module NetClassroom, you can publish single statements and statements to
NetClassroom. By publishing, you export a PDF file that can be viewed in NetClassroom. NetClassroom users can
view these statements if you enable the feature when setting up NetClassroom in Configuration in Registrar’s
Office. For more information about granting rights to features in NetClassroom, see the Configuration Guide for
Registrar’s Office.

To avoid a processing error, do not publish statements while a user is accessing the information in NetClassroom.
To prevent this possibility, disable the feature, publish the information, then enable the feature again.

You can also remove published statements.

» Publishing statements to NetClassroom
1. From the Mail page in Student Billing, click Forms. The Forms page appears.
In the list on the left, select Single Statement or Statements.
In the right pane, select the single statement or statements to publish.
From the shell menu bar, select File, Publish to NetClassroom.
The Publish screen appears, calculating the number of records to process.

o vk wnN

When processing is complete, a screen appears showing the number of students with statements
published. Click OK.

» Removing statements from NetClassroom

From the Mail page in Student Billing, click Forms. The Forms page appears.
In the list on the left, select Single Statement or Statements.

In the right pane, select the single statement or statements to remove.
From the shell menu bar, select File, Remove from NetClassroom.

The Publish screen appears, calculating the number of records to process.

SN A S o

When processing is complete, a screen appears showing the number of students selected in the
statement parameter file, not necessarily the number of students that had published statements. Click
OK.
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The Mail page is the central location for generating labels in The Financial Edge. On the navigation bar, click Mail
to access the Mail page. To create labels in:

¢ Accounts Payable or Accounts Receivable —
click Labels, Cards, and Envelopes.

o Fixed Assets — click Labels.

e Student Billing — click Labels and Envelopes.
Then you can create new labels, open saved labels, and delete labels.

Note: We recommend you read this chapter thoroughly. Information on these pages provides you with a
working knowledge of printing labels. Hands-on experience is the best way to learn, so we encourage you to
try these procedures with the sample database before creating labels with your data. Visit our Web site at
www.blackbaud.com for the latest documentation and information.

When you select Labels in the list on the left of the page, a grid appears on the right displaying saved labels. You
can specify parameters for labels on the General, Fields to Include, Filters, Relationship Filters, Attributes,
Address, and Format tabs. Whether you create new labels or open saved labels, the screen opens to the General
tab. You can use a variety of parameters to define the output for labels in The Financial Edge. Saving these
parameters also makes future label preparation easier.

Label Tabs

In Labels, you select parameters on tabs: General, Fields to Include, Filters, Relationship Filters, Attributes,
Address, and Format. To move among the tabs, click Next and Back at the bottom of the screen or select the tab.
On these tabs, you specify records, fields, and formatting options for the labels. Each tab helps you enter
information in an easy and logical manner.
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General Tab

You can use the General tab to select parameter settings specific to labels.

I3 New Labels x|
File Edit Wiew Favorites Tools Help
dadam o= 2?-

1: General |2: Fields to Includel 2 Filters | 4: Attributes | 5: Farmat

Create labels for:

Label type: Type I Size | Across I Down I Description

Z fovery® 5161 Txd 2 10 Laser Address I
Label font: ITimes Wew Roman j
Font size: oo

Start printing iy row |1 ﬂ[ﬁolumn: I‘I ﬂ

[~ Default invoice address:

[~ Default purchaze order address:

[~ Create an output queny of vendars

< Back | Mest » | Cancel | Brint | Preview | Lapout |

Create labels for. In this area of the General tab, you can mark a checkbox to select addresses to print on labels

for Accounts Payable or Accounts Receivable.

In Accounts Payable — To print the primary address from the vendor record, mark Primary address for
vendor. To print addresses used on invoices and purchase orders, mark Default invoice address and Default
purchase order address.

In Accounts Receivable — To print the primary address from the client record, mark Primary address for
client. To print labels using the Bill to and Ship to addresses, mark these options.

In Student Billing — In the Create labels for field, select the record type to print labels for. You can create
labels for students, student relationships, individuals, individual relationships, organizations, organization
relationships, records, and record relationships.

Exclude deceased? In Student Billing, if you select a relationship in the Create labels for field, the Exclude

deceased? option appears. Mark this option to omit deceased relations from the run of labels.

Note: The Type column also displays a graphic representation for the label type. For example, labels that print
on a laser printer display a printer graphic next to the label type.

Label type. In the Label type grid, you can select the type of label to use. The Type and Size columns list label

types and dimensions compatible with The Financial Edge. The Across column displays the number of labels
across the width of a sheet of labels, and the Down column displays the number of labels down the length of
a sheet. The Description column provides additional details about each label type.

The Financial Edge is compatible with many standard label types. If the label size you use is not available, you
can export a data file with the information so you can print labels using another application. Also, keep in
mind The Financial Edge is compatible only with laser printers. For more information about exporting, see
the Mail Basics chapter.
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Warning: The font type and size you select may impact the amount of information you can print on the labels.

Label font. In the Label font field, select a text type to use on the labels.

Barcode font. If you are printing barcodes in Fixed Assets, select the font to use for the barcode in the Barcode
font field.

Font size. In the Font size field, select a size for the text on the labels.

Start printing in row/column. You can start printing labels at any location on a sheet of labels. For example, if
you have a sheet that is partially used, you can use the Start printing in row/column fields to indicate the
location of the first unused label on the sheet.

Create an output query of [ ]. To create a query of the records for which you run labels, mark Create an
output query of [ ] and select the record type.

Report orientation. Labels created in Fixed Assets automatically print in portrait orientation.

Fields to Include Tab

You can use the Fields to Include tab to select fields to appear on the labels processed by the mail task, for
example, address, contact name, and phone number. The fields that appear depend on which program you are
using. You cannot add to the list of available fields.

I3 New Labels
File Edt “iew Favorites Tools Help

= Tl e |

1 General 2 Fields to Include |§: Filtersl 4: Aftributes | B Format

Select optional fieldz wou wizh to include by moving them to the right-hand box

Available Fields: Fields ta Include:
Address = B Phone number Options. .. |
Address description
Alias

Contact name

Wendaor narme
[Z1 1I5PE har code

Cantact pozsitian >
B Subsidiany name 33
Tax D J
Wendar D 4
<

Available Fields. The Available Fields box contains all the fields you can print on labels. The fields that appear
depend on which program you are using. Use the up and down arrows to change the order of the fields.

Note: Certain fields have additional selections associated with them. When you move these fields to the Fields
to Include box, the Field Options screen appears. For example, if you select Phone number, you can select
Business or Fax as the phone type to use.

Fields to Include. The Fields to Include box contains all fields selected to print on the labels. To move a field
from the Available Fields box to the Fields to Include box, select the field and click the single right arrow or
double-click the field. To move all the fields from the Available Fields box to the Fields to Include box, click
the double right arrow.

Options. When you include a field with associated options, you can click Options to see more information about
the field. If a field does not have associated options, the Options button is disabled.

Note: A mail task is a specific mailing process, such as printing 1099 forms or envelopes. Fields and options for
a mail task are arranged on tabs so you can access all the information quickly and easily.
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The Fields to Include tab in Fixed Assets displays a grid so you can select the fields to appear on the labels
processed by the mail task. You can also select to print the barcode for each field.

| 1@ Hew Labels
File Edit “iew Fawvortez Tool: Help

FIeERE = e |

1: General  2: Fields ta Include | X Fillersl 4 Abtributes | 5 Formall

Frirt theze fields in thiz order on each label:

Field Mame I Options I Bar Code I Imzert

Delete...

Up

o

Lk

B A0 i o L i i

Field Name. In the Field Name column, select the fields to print on the labels.

Note: Certain fields have additional selections associated with them. When you select these fields in the Field
Name column, you must select additional information for that field in the Options column. For example, if you
select Disposal Method, you can select Sale or Stolen to use on the labels.

Options. When you select a field with associated options, you can select additional information for the field. If a
field does not have associated options, N/A appears in the Options column.

Bar Code. In the Bar Code column for each field, you can select whether to print the bar code for the field.

Filters Tab

You can use the Filters tab to select criteria that determines which records to include in the run of labels. The
items by which you can filter depend on the program you are using. For example, in Fixed Assets, you can include
a selected department, such as Administration, and assets from the administration department appear on the
report. For more information about filtering in The Financial Edge, see the Program Basics chapter of the
Program Basics Guide.

12 new Labels x|
File Edit Wiew Favorites Tools Help

dadam al=?- |

1 Generall 2: Figlds to Include

|ﬂ_1: Aftributes | 5: Format

&3 Open - Clear All Filters

Filters Indude | Selected Filters
Vendors All <Al Vendors=
Vendor Attributes All <Al Vendor Attributess>
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Tip: You can also double-click a filter in the grid to open the selection screen.

Open. To open a selection screen to designate specific filters for the report, select a filter in the grid and click
Open on the action bar.

Clear All Filters. To reset each filter to include all, you can click Clear All Filters.
Filters. The Filters column lists all the filters for the report. You cannot edit this column.

Include. By default, in the Include column, each filter is set to All. To open a selection screen to designate
specific filters for the report, choose Selected.

Selected Filters. Filters you specify on the selection screen appear in the Selected Filters column.
Selected Filters Screen

From the Filters tab, you can open a selection screen for a filter in several ways: by double-clicking the filter in the
grid, selecting the filter in the grid and clicking Open on the action bar, or choosing Selected in the Include
column for the filter.

Selected Yendors E I

Include: @ All P = ® Bange ® Ly Previn Mesxt Filker

Vendor Name I Wendor ID |

ar. I Cancel |

Include. For each filter, you can select to include all or select specific filters. Depending on the filter, you may
also be able to filter by a range or query.

All. If you mark Include: All, you cannot designate specific filters.

Selected or Range. If you mark Include: Selected or Range, a grid appears in which you can specify filters. In a
field, you can click the binoculars to search for information.

Query. If you mark Include: Query, the Query name field appears for you to enter the name of the query by
which to filter the report. In the field, you can click the binoculars to search for the query name.

To create a new query, click the binoculars. Then click Add a New Query on the Open Query screen. For more
information about creating queries, see the Query Guide.

Previous Filter. To view or edit the previous filter without returning to the Filters tab, click Previous Filter.
Next Filter. To view or edit the next filter without returning to the Filters tab, click Next Filter.
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Relationship Filters Tab

In Student Billing, if you select a relationship record type in the Create label for field on the General tab, the
Relationship Filters tab appears. On this tab you select filters to determine which relationship types to include in
the label run. For example, to address labels to the father and mother of students, you select Father and Mother
for the Relationship Type filter.

If you use a Related <Record Type> filter, such as Related Individuals, you can select individuals or use a query. If
you use more than one of the Related <Record Type> filters, the label run includes a combination of the filters
results. For example, if you select a query of related Individuals and a query of Related Students, the records
included in the label run include the selected Related Individuals in addition to the selected Related Students.

I3 Student Labels I

File Edit Yiew Favortes Tools Help
eIl ElE R |

1: General | 2: Fields to Includel 2 Filters

|5 .-’-‘-.ltributesl B .&ddressl i Formatl

Filkers I Include I Selected Filters I
Relationship Tvpes all <Al Relationship Tvpes
Related Records all <Al Relaked Records >
Related Recard Tvpes all <Al Related Recard Typesz
Lirnit results ba:

Fayers: I Igniare i I
Statement recipients: Ilgnnre 7 I
Statement copy recipients: Ilgnore 'I

< Back | Hemt » | Cancel | Print | Preview | Layout |

Using the options below the filters grid, you can define additional criteria for including or excluding relations. If
you select “Ignore” for a criterion, the program does not consider it when processing.

Payers [ ]. You can select to include, exclude, or ignore relations designated as payers.

Statement recipients [ ]. You can select to include, exclude, or ignore relations designated to receive
statements.

Statement copy recipients [ ]. You can select to include, exclude, or ignore relations designated to receive
statement copies.



252 CHAPTER

Attributes Tab

You can use the Attributes tab to add, delete, or update attributes for vendors, clients, assets, or students when
you print labels. For example, you may want to print labels for vendors who are also volunteers with your
organization. You can add the attribute to the vendor record when you print the labels.

I3 New Labels o x|

Eile Edit View Favorites Tools Help

dadam ol=e- |

1 Generall 2 Fields to Includel 3: Filters

Act’onl Attribute Type | Desdiption IShortDescripﬁonI Date |Required| Comments |

=

Action. In the Action column, you can add, delete, or update attributes on the records when you print labels.

Note: Attribute types are established in Configuration. For more information about defining attributes, see
the Configuration Guide that program.

Attribute Type. In the Attribute Type column, you can select an attribute type.
Description. In the Description column you can enter or select a description for the attribute type.

Short Description. In the Short Description column, a brief description of the attribute type appears when you
select a type in the Attribute Type column.

Date. In the Date column, select the date you add, delete, or update the attribute.

Note: An attribute is a tool used to group information based on a common theme. With attributes defined, you
can filter information to your specifications. Records in The Financial Edge that can have attributes include
accounts, projects, transactions, actions, vendors, purchase orders, invoices, credit memos, and assets.

Required. If the attribute type you select is required, the program automatically marks the checkbox in the
Required column.

Comments. In the Comments column, you can enter additional information about the attribute type.

Address Tab

In Student Billing, you use the Address tab to specify which addresses to use for labels. The program compares
the parameters you define on this tab with address information entered on the Addresses tab of records to
identify the appropriate address to use.

On the Address tab, you select a validation date and then define the order in which the program evaluates
address types. The program first checks the validation date, then seasonal addresses, other address types (in the
order you determine), and attributes. The first address found on the record that meets the defined parameters is
used on the label. You can also specify what to do if no valid address is found.
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If you selected Organizations in the Create labels for field on the General tab, the Mail to field appears. In this
field, select the organization address to use.

File Edit View Favorites Tools Help

a3 ol 2- |

1. General I 2 Fields to Includel £ Filtersl 4 Altributes | & Fnrmatl

Yalidate addresses az of: ITDda}l j

[¥ Consider seazonal addresses

If no seasonal addrezses are found, consider these addreszses

Addresses Addresses to consider, in order of importance
<Primary address:»

<First address found:

ry
H
ELT;?:ESS j A
3
H

' acation
School
Action Attribute Type I Value
KIS i
If o addresz iz found, IF'rint with no address j
¢ Back | Hewt » | Cancel FPrint Preview | Layout |

Note: Any address with No mail selected in the Send [ ] to this address field on the Address Attributes tab is
automatically excluded as a possible address.

Step 1. In the Validate addresses as of [ ] field, select a date to determine which address to use. Any address that
is valid on this date is considered for use on the label. Any addresses that are not valid on this date are
automatically excluded from consideration.

Step 2. Determine whether to include seasonal addresses as possible addresses. If you mark Consider seasonal
addresses, the program uses the first valid seasonal address found on the student/relationship record and

does not consider any other addresses.

If the seasonal address has the Send no mail attribute, the seasonal address is excluded automatically as a
possible address. If a valid seasonal address is not found, the program considers the address types selected in
Step 3.

Step 3. Inthe If no seasonal addresses are found, consider these addresses frame, select which address types to
use if no valid seasonal addresses exist.

In the Addresses box, select an address type and click the right arrow to move it into the Addresses to
consider, in order of importance box. The first address type in the list that matches the validation date is used
on the label. You can change the order addresses are considered by selecting an address type and clicking the
up and down arrows next to the list.

If a valid address is not found from these address types, the program considers the attributes selected in
Step 4.

Step 4. In the grid, you can select address attribute types to consider. For example, you have a “Holiday
greetings” attribute you use to flag addresses to use for holiday cards. When you select Include in the Action
column and Holiday greetings in the Attribute column of the grid, the program automatically uses any valid
addresses assigned this attribute.
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Step 5. In the If no address is found field, select what to do if a valid address is not found. In Student Billing, you
can select “Print with no address”, “Remove record from run”, or “Print specific address”.

If you select to print a specific address, the Use field appears so you can select the address type to use when
a record does not have an address of the types you added to the Addresses to consider, in order of
importance list.

Format Tab

You can use the Format tab to designate the format of the labels. Settings on this tab determine the appearance
of the labels. You can sort the labels and make selections for truncation reports. When you select a formatting
area from the list on the left, selections appear on the right.

You can print a truncation report to determine the records whose information does not fit on the label as you
designed it to print. The report displays truncation information for a variety of font sizes so you can determine
the best options for the labels. When you print a truncation report from Labels, the program checks settings
entered on the labels tabs to determine records whose information does not fit on the label. For more
information about label truncation reports, see the Label Truncation Report chapter.

Detail. You can use Detail to make printing selections for the labels.

File Edit Wew Favorites Tools Help

dasam o

1 Generall 2 Fields to Includel &l Filtersl 4 Attibutes

2 |
B Sort

Truncation Reports Omit punctuation from mailing -
Print address in ALL CAPS r
Mumber of lines to gkip before printing the firt line i]
Mumber of spaces to include before each line i]
Ihciude total number of labels r

To print no punctuation on the labels, mark the checkbox in the Omit punctuation from mailing row.

To print the address or the name of the asset in all capital letters, mark the checkbox in the Print
address/asset in ALL CAPS row.

To leave space before the first row of printing on the labels, enter a number in the Number of lines to skip
before printing the first line row.

To leave space at the beginning of each line on the labels, enter a number in the Number of spaces to include
before each line row.

To print the total number of labels processed in the run immediately after the last label, mark the checkbox in
the Include total number of labels row.

Include message on the same line as [ ] — To print a message before a selected field on the same line, select
a field in this row. The available fields are those you selected on the Fields to Include tab. You define the
message to print by selecting the User-defined message field on the Fields to Include tab and entering the
message on the Field Options screen that appears.

Combine labels for each spouse pair — Mark this checkbox to print one label for each married couple. This
option appears only if you selected a relationship record type in the Create labels for field on the General tab.
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For example, when printing labels for student relationships, if you mark this option, one label prints for both
the mother and father of a student. The address and name used for the spousal pair is the first of the spouses
listed on the record’s Relationship tab. If this option is unmarked, two labels print— one for each parent.

Combine labels for <record type> with the same related record — Mark this checkbox to print one label for
each relationship. This option appears only if you selected a relationship record type in the Create labels for
field on the General tab.

For example, when two students have the same father, if this option is marked, only one label prints for the
father. If the option is unmarked, two labels print for the father — one for each student. If you mark this
option and also mark Combine labels for each spouse pair, one label prints for the mother and father of the
two students.

If you mark Combine labels for <record type> with the same related record and include the <Record type>
name field on the Fields to Include tab, the name for each record related to the relation prints as a separate
line on the label.

Sort. You can use Sort to select the order to print labels. When you select Sort, a grid displays the categories,
such as Vendor Name, Client Name, Asset Number, Employee Name, or Student Name, you can sort for the
labels.

& New Labels e x|

Ele Edit View Favorites Tools Help

d a3l o
1 Genelall 2 Fields to Includel 25 Filtersl 4 Aftributes B Format |
_ Detail Sort

Truncation Feparts Sortby | Order by Iil
Vendor Name Ascending

2. ‘

Note: We recommend you preview the run before printing to help minimize errors in printing the labels.

In the first row in the Sort by column, select the record type by which to sort the labels.

In the Order by column, select Ascending to sort labels alphabetically or Descending to sort them in reverse
alphabetical order.
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Truncation Reports. You can use Truncation Reports to determine the records whose information does not fit
on the label as you designed it to print.

u Hew Labels
File Edit ‘“iew Favortes Toolz Help
EH &S W B

1 Genelal] 2 Fields to Include] 3 Filtersl 4 Attibutes 5 Format l

5 Detail Truncation Reports

=] Sort

‘ Truncation Reparts [v Frint Truncation reports befare label run
v Check for horizontal truncations

W Check for vertical truncations

If truncations are found using font Times Mew Boman at zsize 10

[~ Create exception queny

[ Euchude record from label run

To preview or print a truncation report before printing labels, mark Print Truncation reports before label run.
The truncation report compares information selected on the tabs with the font size and label type selected. If
you preview the labels, you can also preview the report. When you print, export, or send the labels as email,
the report prints.

To check for horizontal and vertical truncations, mark Check for horizontal truncations and Check for vertical
truncations.

To create a static query of records for which labels truncate, mark Create exception query.

Note: If you mark Exclude record from label run, we recommend you also mark Create exception query so you
have a record of labels that do not print.

After the program prints the truncation report, you get a message asking if you want to print the labels. If you
mark Exclude record from label run, truncated labels do not print.

Name Formats. In Student Billing, you can use Name Formats to format how names appear on
labels you can format how names appear for employees, organizations, individuals, students, and
relationships. In the tree view on the left, you can select the record type to format.

I Student Labels
Fil=  Edit “iew Fawortes Tools Help

H o= @wWoE?-

1 Genelal] 2: Fields to Include] 3 Filtersl 4: Relationzhip Filtersl 5 .-’-‘«ttributes] E: Address ¥ Format ]

=] Detail Student Name Formats

=] Sor Student

=] Truncation Reparts .

~ Name Fomats Select addresses//zalutation from: Record hd
i Eitu::lnt:z: ' Uz |<Fu|| name: ﬂ
i |Z] Relationships

If you selected Organization or Organization Relationships in the Create labels for field on the General tab, in
the Organization frame, mark Organization ID, CFDA #, and Contact name for these items to appear after the

organization name.



LABELS 25

For Students or Individuals, in the Select addressee/salutation from [ ] field, select Record or Configuration.
If you select Record, in the Use field, select the full name, primary addressee, or primary salutation as defined
on the record.

If you select Configuration, in the Use field, select from one of the formats defined in Configuration.

In the If not present...Select addressee/salutation from field, you can select a second name format for
situations where the first selection is not present on records. For example, if you select to use the Primary
salutation, and you have students without a defined Primary salutation on the Addressees/Salutations tab,
the second name format is used. If you select <Full name> in the Use field, this field is disabled.

Creating Labels

Using Labels, you can create labels with vendor, client, and asset information. For example, in Accounts Payable,
you can print mailing labels for vendors, or, in Fixed Assets, you can print labels to affix to office furniture.

The Financial Edge is compatible with many standard label sizes; however, if the label size you use is not
compatible, you can export the information gathered by the mail task to another application compatible with the
label type you want to use. For more information about exporting in Mail, see the Mail Basics chapter.

» Creating labels

For the following example, we create labels for assets. Specific entries and selections may be different, but
you can follow the same procedure for creating labels in Accounts Payable, Accounts Receivable, or Student

Billing.

Note: If you are creating labels in Accounts Payable or Accounts Receivable, click Labels, Cards, and Envelopes
from the Mail page. In Student Billing, click Labels Envelopes

1. From the Mail page in Fixed Assets, click Labels or select the Labels navigation tab. The Labels page
appears.

2. Inthe list on the left, select Labels and click New on the action bar. The New Labels screen opens on the
General tab.

3. Inthe Label type grid, select “Avery® 5161”, the label type you are using.

In the Label font and Barcode font fields, select “Arial” and “3 of 9 Barcode”, the fonts to use for the text
and bar code on the label.

5. Inthe Font size field, select “8”, the font size for the labels.
In the Start printing in row and Column fields, select “1” because you are using a new sheet of labels.
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7. To create a static query of the asset records for which you are printing labels, mark Create an output
query of assets.

I3 New Labels
File Edit “iew Favontez Toolz Help

e = el |

1: Gereral |2: Fields ta Includel & Filtersl ES Attributesl 5 Formatl

Label type: Type | Size | Across | Down | Description
5 Avery® 5151 Tx4 2 10 Laser Address I~
Label font: IA[ia| j Barcode font: |3 of 9 Barcode j

Fant size: IB 'l

Start printing in row: |1 onlumn: I‘I ill

[V Create an output quemny of assets

Repaort Orientation: Paortrait

Note: Certain fields have additional selections associated with them. When you select these fields in the Field
Name column, you must select additional information for that field in the Options column. For example, if you
select Disposal Method, you can select Sale or Stolen to use on the labels.

8. Click Next or select the Fields to Include tab.

9. In the Field Name column, select “Asset No.”, as a field to print on the labels. In the Bar Code column,
mark the checkbox so the number prints as a bar code.

Repeat the steps to select “Asset Description”, “Department”, and “Location”. Mark the checkbox to use
the bar code for the department and location.

I3 Mew Labels
File Edit “iew Fawaortez Toolk Help

BRE R - e-

1: General 2 Fields to Include |§: Filters | 4 .&ttributesl 5: Format |

Frint these fields in this order on each label:

Field Marne I Options I Bar Code I Inzert |

| Asset Mo, [T =
| |Asset Description N8 r Delete... |
| Department [T =
| |Location ({13 |
r
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10. Click Next or select the Filters tab. Select the filters for records for which to print labels. For more
information about filtering in The Financial Edge, see the Program Basics Guide.

11.

I3 New Labels E2

File Edit “iew Favortes Tool: Help

= RN = e R

1 Generall 2 Fields toInclude 3 Filkers | & .ﬁ.ttributesl 5 Folmatl

€% Open ~ Clear Al Filkers
Filters I Include I Selected Filkers I
Assets Al <Al Assekss
Aszet attributes Al <Al Assek Attributes =
Classes all ZAll Classes>
Depattments Selected Administration QI
Depreciation Methods all <Al Depreciation Mathods =
Disposal Methods all Al Disposal Methods =
Locations Al <Al Locations=

Click Next or select the Attributes tab.

12. Inthe Action column, select “Add”. This adds the attribute to the asset record.

Note: Attributes are established in Configuration. For more information about creating attributes, see the
Configuration Guide for that program.

13.
14.
15.

16.
17.

In the Attribute Type column, select an attribute, for example, “Inventory Manager”.

In the Description column, enter “Mike Jones”, the inventory manager for your organization.

In the Date column, enter 11/07/2002, the date you add the attribute.

File  Edit “iew Fawortes Tool: Help

= = R = [l

I3 Mew Labels E2

1: General | 2 Fields to Include | 2 Filters 4 Attributes | 53 Formatl

Action I Aftribute Type I Description I Shart Descriptionl Date | Flequiredl Comnmernkts I
Add Inventory Manager Mike Jones 11./07/2002 I

Click Next or select the Format tab.

In the list on the left, select Detail. In the Omit punctuation from mailing row, mark the checkbox so the

information prints with no punctuation marks.
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18. To make it easier to read the labels at a glance, mark the checkbox in the Print asset in ALL CAPS row.

nNew Labels
File Edit “iew Fawvortez Toaol: Help

(= BN R =g ea i N

1 General] 2: Fields to Include] 3 Filters] 4 Attributes  5: Format l

=] Sort

Detail

=l Truncation Reports Omit punctuation from mailing

Print azzet in ALL CAPS

Mumber of lines to zkip before printing the first line
Mumber of spaces ta include before each line
Inciude total number of labels

19. In the list on the left, select Sort. In the Sort by and Order by columns on the first row, select “Asset
Number” and “Ascending” to sort the labels numerically by asset number.

20.

21.
22.

[ New Labels

Eil= Edit “iew Favortes Toole Help
H & & W) e ?-

1 General] 2 Fields to Include] 3 Filters] 4 Attnbutes  5: Format ]

Sort

=] Detail

=] Truncation Repaorts Sart by

Order by |

Agset Mumber

Azcending

In the list on the left, select Truncation Reports and mark Print Truncation reports before label run to
print a truncation report using the settings you selected on the tabs. To be sure labels print correctly,
mark both Check for horizontal truncations and Check for vertical truncations.

So that you can have a record of labels not printed in the run, mark Create exception query.

Because you do not want labels in this run to print truncated, mark Exclude record from label run.

nNew Labels
File Edit ‘iew Favortes Toolz Help

(= RN Rl Ea i N i

1 General] 2: Fields to Include] 3 Filtersl 4 Attributes  5: Farmat l

2] Detail
=] Sart

I Truncation Reports

[v Print Truncation reports before label run

V¥ Check faor harizontal runcations

v Check fior vertical truncations

If truncations are found uzing font Arial at zize 8
v Create exception guery

v Exclude record from label run

Truncation Reports
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Note: If you mark Create an output query of vendors on the General tab, you get a message asking if you want
to save the query.

23. Click Preview. A message appears telling you the program is processing the mailing, and the preview
screen for the labels appears. We recommend you preview the run before printing to help minimize

errors in printing the labels.
24. Close the preview and return to the Format tab. For more information about previewing, see “Previewing

a mailing” on page 14.
25. Click the Save button on the action bar to save the labels. The Save Mailing as screen appears.

Note: A parameter is any field, option, or filter that narrows information included in an import, mailing, report,
or global change. By specifying parameters, you define the output of the process. You can save parameter files

to use again.
26. Inthe Mailing name and Description fields, enter a name and description for the parameter file.

Save Mailing as

Mailing name: |Admin Dept

Desenptian: [pike s inventary

[v Others can mun this maiing
[~ Others can modify this mailing

Eisave | Cancel |

27. Click Save to save the labels. You return to the Format tab.
28. Close the screen. You return to the Labels page, and the labels file appears in the grid.

% The Financial Edge

File Edit View Go Favoites Tools Help
4 Back % Eoryvan ICommunitf Services Inc, ™ + Fixed Assets ~

'Ft"f Hane New |Dgan ‘Qelele... Mail
Name |Description | Date Created | Created By | Dthers May Modify | 01
LabelsProc 04/04/2002  Supervisor r

New Labels 04/04/2002  Supervisor ~

Shartcuts

Adrin Dept M
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The Mail page is the central location for creating label truncation reports in The Financial Edge. On the navigation
bar, click Mail to access the Mail page. To create a Label Truncation Report in:

¢ Accounts Payable or Accounts Receivable —
click Labels, Cards, and Envelopes.

¢ Student Billing — click Labels and Envelopes.

Then you can create new reports, open saved reports, and delete reports. The Label Truncation Report provides
the address or asset information that does not fit on a selected label type. When the program checks for
horizontal truncation, it determines which labels have too many characters on a single line using the selected font
or font size. When creating a Label Truncation Report, we recommend you use the same options, fields, and
checkboxes you use in Labels.

Warning: We recommend you read this chapter thoroughly. Information on these pages provides you with a
working knowledge of running label truncation reports. Hands-on experience is the best way to learn, so we
encourage you to try these procedures with the sample database before creating label truncation reports with
your data. Visit our website at www.blackbaud.com for the latest documentation and information.

When you select Label Truncation Report in the list on the left of the page, a grid appears on the right displaying
saved reports. You can specify parameters for a Label Truncation Report on the General, Fields to Include, Filters,
Relationship Filters, Attributes, Address, and Format tabs. Whether you create a new report or open a saved one,
the screen opens to the General tab. You can use a variety of parameters to define the output for the Label
Truncation Report in The Financial Edge. Saving these parameters also makes future report preparation easier.

Label Truncation Report Tabs

With the Label Truncation Report, you select parameters on tabs: General, Fields to Include, Filters, Relationship
Filters, Attributes, Address, and Format. To move among the tabs, click Next and Back at the bottom of the
screen or select the tab. On these tabs, you specify records, fields, and formatting options for the labels. Each tab
helps you enter information in an easy and logical manner.
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General Tab

You can use the General tab to select parameters specific to the Label Truncation Report. When you create labels,

fields you select may not fit on the label type you use.

@ ew Label Truncation Report x|
Eile Edit View Favorites Tools Help

dada@ =2

1. General |2: Fields to Includel 3: Filters | ES Formatl

Truncations based on: [V P

Label type: Tyvpe I Size | ACToss I Ciowan I Drescription
e Aovery® 5161 Tud 2 10 Lazer Address lad
Label fant: ITimes Mew Roman j

Fram size: I‘ID 'I Tosize:l‘lﬁ 'I

[~ Default imvoice address:

[~ Default purchasze order address:

W Check for vertical truncations

¥ Check for harizomkal uncations

[T Create an output queny of vendars

Report Orientation: Portrait

< Back | Mest » | Cancel | Print | Preview |

Truncations based on. This area appears on the General tab in Accounts Payable and Accounts Receivable so

you can check the truncation for addresses to use on the labels.

In Accounts Payable — To check truncation for the primary address from the vendor record, mark Primary
address for vendor. To check truncation for addresses used on invoices and purchase orders for the vendors,
mark Default invoice address and Default purchase order address.

In Accounts Receivable — To check truncation for the client record, mark Primary address for client. To
check truncation for the Bill to and Ship to addresses, mark these options.

In Student Billing — In the Truncations based on field, select the record type to check label truncation for.
You can create labels for students, student relationships, individuals, individual relationships, organizations,
organization relationships, records, and record relationships.

Exclude deceased? In Student Billing, if you select a relationship in the Truncations based on field, the

Exclude deceased? option appears. Mark this option to omit deceased relations from the truncation report.

Note: The Type column also displays a graphic representation for the label type. For example, labels that print
on a laser printer display a printer graphic next to the label type.

Label type. In the Label type grid, you can select the type of label for which to check truncation. The Type and

Size columns list label types and dimensions compatible with The Financial Edge. The Across column displays
the number of labels across the width of a sheet of labels, and the Down column displays the number of
labels down the length of a sheet. The Description column provides additional details about each label type.

The Financial Edge is compatible with many standard label types; however, if the label size you use is not
available, you can export a data file with the information so you can print labels using another application.
For more information about exporting, see the Mail Basics chapter.

Label font. In the Label font field, select a text type to use on the labels.
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Note: Based on selections in the From size and To size fields, the report displays the number of characters for
each font size that fit vertically on the label type you select. You can check 10 font sizes at a time, ranging from
size 6 to 19.

From size. In the From size field, select the smallest size text for the program to check.
To size. In the To size field, select the largest size text for the program to check.

Check for vertical truncations. To determine whether fields you select fit on the label, mark Check for
vertical truncations.

Check for horizontal truncations. To determine whether characters fit on a single line on the label, mark
Check for horizontal truncations.

Create an output query of [ ]. To create a query of the records for which you check truncation, mark Create
an output query of [ ] and select the record type.

Report orientation. The Label Truncation Report automatically prints in portrait orientation.

Fields to Include Tab

You can use the Fields to Include tab to select fields to appear on the label truncation report, for example,
address, contact name, and phone number. The fields that appear depend on which program you are using. You
cannot add to the list of available fields.

lB Hew Label Truncation Report [ x|
File Edit “iew Faworitez Toolz Help

SR el |

1: General 2 Fields to Include | 3 Fillelsl 4 Format

Select optional fisldz wou wizh bo include by moving them to the nght-hand box

Available Fields; Fields ta lnclude:
Address = Options... |
Address description
Alias

Contact name
Contact position A
Phone rumber ﬂ
Subsidiary name

TaxID <
Yendar ID ﬂ

USPS bar code
Uzer-defined meszage

Rk =
*¥]
< Back | Mest » | Cancel | Print | Prewiew |

Note: The fields you select appear on the label truncation report in the order you select. Use the up and down
arrows to change the order of the fields.

Available Fields. The Available Fields box contains all the fields you can print on labels. The fields available
depend on the program in which you are working.
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Fields to Include. The Fields to Include box contains all fields selected to print on the labels. To move a field
from the Available Fields box to the Fields to Include box, select the field and click the single right arrow. To
move all the fields from the Available Fields box to the Fields to Include box, click the double right arrow.

Note: Certain fields have additional selections associated with them. When you move these fields to the Fields
to Include box, the Field Options screen appears. For example, if you select Phone number, you can select
Business or Fax as the phone type to use.

Options. When you include a field with associated options, you can click Options to see more information about
the field. If a field does not have associated options, the Options button is disabled.

Filters Tab

You can use the Filters tab to include records based on selected criteria, such as vendors, clients, asset numbers,
or students. For more information about filtering in The Financial Edge, see the Program Basics Guide.

@ New Label Truncation Report x|

File Edit Wew Favorites Tools Help

dada a?- |

1 Generall 2: Fields to Inchuds | 4 Formatl

& Open ) Clear Al Filters

Filters Indude | Selected Filters
Vendors all <Al vendors >
Vendor Attributes All <Al vendor Attributes=

Tip: You can also double-click a filter in the grid to open the selection screen.

Open. To open a selection screen to designate specific filters for the report, select a filter in the grid and click
Open on the action bar.

Clear All Filters. To reset each filter to include all, you can click Clear All Filters.
Filters. The Filters column lists all the filters for the report. You cannot edit this column.

Include. By default, in the Include column, each filter is set to All. To open a selection screen to designate
specific filters for the report, choose Selected.

Selected Filters. Filters you specify on the selection screen appear in the Selected Filters column.
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Selected Filters Screen

From the Filters tab, you can open a selection screen for a filter in several ways: by double-clicking the filter in the
grid, selecting the filter in the grid and clicking Open on the action bar, or choosing Selected in the Include
column for the filter.

Selected Vendors x| I

Inchude: @ Al Selecte ® Bange @ Query | Erawious Filier  Mest Filter

Vendor Mame | Yendor ID |

ar. I Cancel |

Include. For each filter, you can select to include all or select specific filters. Depending on the filter, you may
also be able to filter by a range or query.

All. If you mark Include: All, you cannot designate specific filters.

Selected or Range. If you mark Include: Selected or Range, a grid appears in which you can specify filters. In a
field, you can click the binoculars to search for information.

Query. If you mark Include: Query, the Query name field appears for you to enter the name of the query by
which to filter the report. In the field, you can click the binoculars to search for the query name.

To create a new query, click the binoculars. Then click Add a New Query on the Open Query screen. For more
information about creating queries, see the Query Guide.

Previous Filter. To view or edit the previous filter without returning to the Filters tab, click Previous Filter.
Next Filter. To view or edit the next filter without returning to the Filters tab, click Next Filter.

Relationship Filters Tab

In Student Billing, if you select a relationship record type in the Truncations based on field on the General tab,
the Relationship Filters tab appears. On this tab you select filters to determine which relationship types to include
in the label truncation report. For example, to address labels to the father and mother of students, you select
Father and Mother for the Relationship Type filter.
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If you use a Related <Record Type> filter, such as Related Individuals, you can select individuals or use a query. If
you use more than one of the Related <Record Type> filters, the truncation report includes a combination of the
filters results. For example, if you select a query of related Individuals and a query of Related Students, the
records included in the report include the selected Related Individuals in addition to the selected Related

Students.

IQ Mew Label Truncation Report I

File Edt “iew Favontes Toolz Help
R E A= e |

|§: Address | E Formatl

1. General | 2 Fields ta Includel 3 Filters

Filkers I Include I Selected Filters I
Relationship Tvpes all <Al Relationship Tvpes >
Related Records Al <Al Related Records =
Related Record Types all <fll Related Record Types=

Lirnit results ta:

Fayers: I lgnore i I
Statement recipietts: Ilgnore i I
Statement copy recipisnts: Ilgnore 'I

< Back | Heut » | Cancel | Print | Preview |

Using the options below the filters grid, you can define additional criteria for including or excluding relations. If
you select “Ignore” for a criterion, the program does not consider it when processing.

Payers [ ]. You can select to include, exclude, or ignore relations designated as payers.

Statement recipients [ ]. You can select to include, exclude, or ignore relations designated to receive
statements.

Statement copy recipients [ ]. You can select to include, exclude, or ignore relations designated to receive
statement copies.

Address Tab

In Student Billing, use the Address tab to specify which addresses to use for the label truncation report. The
program compares the parameters you define on this tab with address information entered on the Addresses tab

of records to identify the appropriate address to use.

On the Address tab, you select a validation date and then define the order in which the program evaluates
address types. The program first checks the validation date, then seasonal addresses, other address types (in the
order you determine), and attributes. The first address found on the record that meets the defined parameters is
used on the report. You can also specify what to do if no valid address is found.
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If you selected Organizations in the Truncations based on field on the General tab, the Mail to field appears. In
this field, select the organization address to use.

13 Mew Label Truncation Report ;s x|

File Edit Yiew Favorites Tools Help

dagdad o= ?-

1 Generall 2 Fields to Includel 3: Filters | 15 Formatl

Yalidate addresses az of: IToday j

v Consider seasonal addresses

If no seasonal addresses are found. consider these addresses -

Addreszes Addresses ko consider, in order of impaortance
<First addreszs found> <Primary address>

Hame
Business
W acation
Schaol

Action Attribute Type | Value

<] | i

If o address i found, IF'rinl with no address j

< Back | MHext > | Cancel Erint Preview |

Note: Any address with No mail selected in the Send [ ] to this address field on the Address Attributes tab is
automatically excluded as a possible address.

Step 1. In the Validate addresses as of [ ] field, select a date to determine which address to use. Any address that
is valid on this date is considered for use on the label truncation report. Any addresses that are not valid on
this date are automatically excluded from consideration.

Step 2. Determine whether to include seasonal addresses as possible addresses. If you mark Consider seasonal
addresses, the program uses the first valid seasonal address found on the student/relationship record and
does not consider any other addresses.

If the seasonal address has the Send no mail attribute, the seasonal address is excluded automatically as a
possible address. If a valid seasonal address is not found, the program considers the address types selected in
Step 3.

Step 3. In the If no seasonal addresses are found, consider these addresses frame, select which address types to
use if no valid seasonal addresses exist.

In the Addresses box, select an address type and click the right arrow to move it into the Addresses to
consider, in order of importance box. The first address type in the list that matches the validation date is used
on the truncation report. You can change the order addresses are considered by selecting an address type and
clicking the up and down arrows next to the list.

If a valid address is not found from these address types, the program considers the attributes selected in
Step 4.

Step 4. In the grid, you can select address attribute types to consider. For example, you have a “Holiday
greetings” attribute you use to flag addresses to use for holiday cards. When you select Include in the Action
column and Holiday greetings in the Attribute column of the grid, the program automatically uses any valid
addresses assigned this attribute.
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Step 5. In the If no address is found field, select what to do if a valid address is not found. You can select Print
with no address, Remove record from run, or Print specific address. If you select to print a specific address,
the Use field appears so you can select the address type to use when a record does not have an address of the
types you added to the Addresses to consider, in order of importance list.

If you selected Organizations in the Truncations based on field on the General tab, the If no contact is found
field appears. You can select Print organization name with no address, Remove record from run, or Print
specific organization address.

Format Tab

You can use the Format tab to designate the format and sorting order of the labels in the report. When you select
a formatting area from the list on the left, selections appear on the right.

Detail. You can use Detail to make printing selections for the labels.

@ New Label Truncation Report x|

File Edit View Favorites Tools Help

= IS RE R R=1N

1 Generall 2: Fields to Include | 3 Filters

.- |
Detail
Sort

Omit punctuation from mailing -
Print address in ALL CAPS r
MHurnber of lines to zkip befare printing the first line 0
Mumber of spaces ta include before each line 0

To print no punctuation on the labels, mark the checkbox in the Omit punctuation from mailing row.

To print the address or the name of the asset in all capital letters, mark the checkbox in the Print
address/asset in ALL CAPS row.

To leave space before the first row of printing on the labels, enter a number in the Number of lines to skip
before printing the first line row.

To leave space at the beginning of each line on the labels, enter a number in the Number of spaces to include
before each line row.

To leave space at the beginning of each line on the labels, enter a number in the Number of spaces to include
before each line row.

Include message on the same line as [ ] — To print a message before a selected field on the same line, select
a field in this row. The available fields are those you selected on the Fields to Include tab. You define the
message to print by selecting the User-defined message field on the Fields to Include tab and entering the
message on the Field Options screen that appears.

Combine labels for each spouse pair — Mark this checkbox to print one label for each married couple. This
option appears only if you selected a relationship record type in the Create labels for field on the General tab.

For example, when printing labels for student relationships, if you mark this option, one label prints for both
the mother and father of a student. The address and name used for the spousal pair is the first of the spouses
listed on the record’s Relationship tab. If this option is unmarked, two labels print— one for each parent.

Combine labels for <record type> with the same related record — Mark this checkbox to print one label for
each relationship. This option appears only if you selected a relationship record type in the Create labels for
field on the General tab.



272 CHAPTER

For example, when two students have the same father, if this option is marked, only one label prints for the
father. If the option is unmarked, two labels print for the father — one for each student. If you mark this
option and also mark Combine labels for each spouse pair, one label prints for the mother and father of the
two students.

If you mark Combine labels for <record type> with the same related record and include the <Record type>
name field on the Fields to Include tab, the name for each record related to the relation prints as a separate
line on the label.

Sort. You can use Sort to select the order to print labels. When you select Sort, a grid displays the categories,
such as ZIP Code or asset number, you can sort.

I3 New Label Truncation Report |
File Edit View Favorites Tools Help

dadaa a=2- |

1 Eenerall 2 Fields to Includel 3 Fiters 4 Farmat |

Sort

Sort by | Order by Iﬂ
Vendor Name Ascending

Dretail

In the first row in the Sort by column, select the record type by which to sort the labels.

In the Order by column, select Ascending to sort labels alphabetically or Descending to sort them in reverse
alphabetical order.
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Name Formats. In Student Billing, you can use Name Formats to format how names appear on
labels you can format how names appear for employees, organizations, individuals, students, and
relationships. In the tree view on the left, you can select the record type to format.

lE Mew Label Truncation Report I
File  Edt “iew Fawaortes Toolz Help
e == - |
1 Generall 2: Fieldz to Includel 2 Filtersl 4 Relationzhip Filtersl 5 Address & Format |
Detal Relationship Name Formats
Sort Organizati
N Formats rganization- -
C."l ame llge name followed by [~ Organization [D [~ CFDA# [~ Contact Name
Students -
" " Individual
E Relationships .
Select addressee/zalutation fram: IHecnrd VI
Uze: |<Fu|| narne ﬂ
If niot prezent, zelect addreszee/zalutation from: IHecord vI
Use: I <Full name> ¥
Student -
Select addressea//zalutation from: IFlecnrd VI
Uz |<Fu|| narne:> j
|f mot prezent, select addresseezalutation from: IHecord vI
User| <Full name> =l
< Back | L= | Cancel | Print | Freview |

If you selected Organization or Organization Relationships in the Create labels for field on the General tab, in
the Organization frame, mark Organization ID, CFDA #, and Contact name for these items to appear after the
organization name.

For Students or Individuals, in the Select addressee/salutation from [ ] field, select Record or Configuration.

If you select Record, in the Use field, select the full name, primary addressee, or primary salutation as defined
on the record.

If you select Configuration, in the Use field, select from one of the formats defined in Configuration.

In the If not present...Select addressee/salutation from field, you can select a second name format for
situations where the first selection is not present on records. For example, if you select to use the Primary
salutation, and you have students without a defined Primary salutation on the Addressees/Salutations tab,
the second name format is used. If you select <Full name> in the Use field, this field is disabled.

Creating Label Truncation Reports

With the Label Truncation Report, you can run a report and easily determine the information that does not fit on
the label you create. This can save you time running labels because you can make sure everything fits on the
labels before printing them. The Financial Edge is compatible with many standard label sizes; however, if the
label size you use is not available, you can export the information gathered by the mail task to another
application compatible with the label type you use. For more information about exporting in Mail, see the Mail
Basics chapter.



274 CHAPTER

» Creating a label truncation report

Specific entries and selections may differ, but you can follow the same procedure for creating the Label
Truncation Report in Accounts Payable, Accounts Receivable, or Student Billing.

Note: If you are creating the Label Truncation Report in Accounts Payable or Accounts Receivable, click Labels,
Cards, and Envelopes on the Mail page.

1.
2.

From the Mail page, click Labels and Envelopes. The Labels and Envelopes page appears.

In the list on the left, select Label Truncation Report and click New on the action bar. The New Label
Truncation Report screen opens on the General tab.

In the Label type grid, select “Avery® 5161”, a label type you use.

In the Label font and Barcode font fields, select “Arial” and “3 of 9 Barcode”, the fonts to use for the text
and barcode on the label.

In the From size field, select “10”, the smallest font size to check. In the To size field, select “19”, the
largest font size to check.

To determine whether selected fields fit on the label, mark Check for vertical truncations.

To determine whether characters in the selected font and size fit on a single line on the label, mark
Check for horizontal truncations.

To create a static query of the asset records for which you are printing labels, mark Create an output
query of assets.

I3 New Label Truncation Report i x|
File Edit View Favorites Tools Help

dada@ o= 2-

1: General |g: Fields to Includel & FiIters' 4 Formatl

Label lype: Type Size Acrozs | Down Description

Label fant: ITimes Mew Raman |

From size: I‘IEI 'I Tosize:I‘IS 'l

[¥ Check for vertical tuncations

[¥ Check faor harizontal truncations

[~ Create an output query of

Report Orientation; Portrait

< Back | Mest » | Cancel | Frint | Freview |

Note: The fields you select appear on the labels, cards, or envelopes in the order you select. Use the up and
down arrows to change the order of the fields.

8. Click Next or select the Fields to Include tab.
9. Select Employee name, and Employee ID as fields to appear in the report.
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The items that appear in the Available Fields box depend on the program you are using.

I3 new Label Truncation Report x|

File Edit View Favorites Tools Help

HaddE =] 2-

1 General  2: Fields to Include |§: FiIlers' 4 Formatl

Select optional fields you wish to include by moving them to the right-hand box.

Aailable Fields: Fields to Inchude:

i ne Employee name O
Birth date B Emplayes ID s |

Current status

Primary department

Primary position

Supervizar

Job level

Start date

Address

Address description

Phore number o
USPS barcode

User-defined message LI

L T 1 PO PR

L iRd
< Back | Mext > | Cancel | FErint | Freview |

10. Click Next or select the Filters tab. Select the filters determining for which records you want to check
labels. For more information about filtering in The Financial Edge, see the Program Basics Guide.

I3 New Label Truncation Report x|
File Edit Yiew Favorites Tools Help

dadam

Filters Include | Selected Filters I
Employees All <All Employees =
Employee Attributes All <All Employee Attributes =

11. Click Next or select the Format tab.

12. Inthe list on the left, select Detail. So the information appears with no punctuation marks, in the Omit
punctuation from mailing row, mark the checkbox.

Note: In Accounts Payable and Accounts Receivable, the checkbox appears as Print address in ALL CAPS.
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To see if all capital letters fit on the label, mark the checkbox in the Print asset in ALL CAPS row.

I3 new Label Truncation Report x|

File Edit Yiew Favorites Tools Help

dasaw =2 |

1 General' 2 Fields to Includel 3 Filters 4 Format |

Detail
Sart

Mame Formats

Omit punctuation from mailing

=
Print address in ALL CAPS r

13. In the list on the left, select Sort. In the Sort by and Order by columns on the first row, select “Employee
Name” and “Ascending” to sort the labels numerically by asset number.

&} Hew Label Truncation Report |

File Edit WYiew Favorites Tools Help

dadam e
1 General' 2: Fields to Includel 3 Filters  4: Format |

Detail Sort

5| Name Formats Sort by | orderby H

Employes Name Ascending

?- |

Note: If you mark Create an output query of on the General tab, the Save Static Query screen appears so you
can name and save the query.

14. Click Preview. A message appears telling you the program is processing the mailing, and the preview
screen for the Label Truncation Report appears.

15. Close the preview and return to the Format tab.

16. Click the Save button on the action bar to save the labels. The Save Mailing as screen appears.
17. In the Mailing name and Description fields, enter a name and description for the report.

18. Click Save to save the Label Truncation Report. You return to the Format tab.

Note: If you are in Accounts Payable or Accounts Receivable, you return to the Labels, Cards, and Envelopes
page.

19. Close the screen. You return to the Labels page, and the report appears in the grid.
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The Mail page is the central location for generating Rolodex and index cards in Accounts Payable. On the
navigation bar, click Mail to access the Mail page. To create cards, click Labels, Cards, and Envelopes. From here,
you can create new cards, open saved cards, and delete cards.

Warning: We recommend you read this chapter thoroughly. Information on these pages provides you with a
working knowledge of printing cards. Hands-on experience is the best way to learn, so we encourage you to try
these procedures with the sample database before creating cards with your data. Visit our website at
www.blackbaud.com for the latest documentation and information.

When you select Rolodex and Index Cards in the list on the left of the page, a grid appears on the right displaying
saved cards. You can specify parameters for cards on the General, Fields to Include, Filters, Attributes, and
Format tabs. Whether you create new cards or open saved cards, the screen opens to the General tab. You can
use a variety of parameters to define the output for cards in Accounts Payable. Saving these parameters also
makes future card preparation easier.

Card Tabs

In Rolodex and Index Cards, you select parameters on tabs: General, Fields to Include, Filters, Attributes, and
Format. To move among the tabs, click Next and Back at the bottom of the screen or select the tab. On these
tabs, you specify records, fields, and formatting options for the cards. Each tab helps you enter information in an
easy and logical manner.

General Tab

You can use the General tab to select parameter settings specific to cards.

@ New Rolodex and Index Cards |

Eile Edit Wiew Favorites Tools Help

dadam =

1: General IZ: Figlds to Includel & Filters| 4 Altributes | 5 Formatl

?-

Create cards for:

[~ Default invoice address:

[~ Default purchase order address:

Card type: Type | Size I Acrozs I Do I Description
52 fvery® 5385 216 x4 2 4 Rotary Card i)
Card font: ITimes Mew Roman j

Font gize: |1D 'I

Start printing in row: |1 jColumn: |1 j

[~ Create an output query of vendars

< Back | Mest » | Cancel | Frint | Preview | Lapout |

Create cards for. In this area of the General tab, you can select addresses to print on the cards. To print the
primary address from the vendor record, mark Primary address for vendor. To print addresses used on
vendor invoices and purchase orders, mark Default invoice address and Default purchase order address.
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Note: The Type column also displays a graphic representation for the card type. For example, cards that print
on a rotary Rolodex card display a rotary card graphic next to the card type.

Card type. In the Card type grid, select the type of card to use. The Type and Size columns list card types and
dimensions. The Across column displays the number of cards across the width of a sheet of cards, and the
Down column displays the number of cards down the length of a sheet. The Description column provides
additional details about each card type.

The Financial Edge is compatible with many standard card types; however, if the card you use is not
available, you can export a data file with the information so you can print cards using another application. For
more information about exporting, see the Mail Basics chapter.

Card font. In the Card font field, select a text type to use on the cards.

Note: The font type and size you select may impact the amount of information you can print on the cards.

Font size. In the Font size field, select a size for the text on the cards.

Start printing in row/Column. You can start printing cards at any location on a sheet of cards. For example, if
you have a sheet that is partially used, you can use the Start printing in row/column fields to indicate the
location of the first unused card on the sheet.

Create an output query of vendors. To create a query of vendors for which you run cards, mark Create an
output query of vendors.

Fields to Include Tab

You can use the Fields to Include tab to select fields to appear on the cards processed by the mail task, for
example, vendor ID, contact name, and phone number. All fields appear automatically in the Fields to Include
box. To remove fields from the cards, select a field and click the left arrow to move it into the Available Fields
box.

@ New Rolodex and Index Cards i x|

File Edit View Favorites Tools Help

E IFEEEIEE

1: General 2 Fields to Include |§: FiIters' 4 Attrbutes | & Formatl

?v

Select optional fields you wish to include by moving them to the right-hand box.

Auwvailable Fields: Fields to Include:

B i |
d Ophiors...
Address

Alias
Bank account
Contact name

Credit limit amaunt A
Discount days ﬂ
Discount percent

Due days Q
O hold <]

Phone number

Subsidiany name

Tax 1D .
Wendor D

[Z1 vendor name
The fields will print in predefined pogitions on the card.

-

< Back | Mext = Cancel | FErint Freview Layout

Note: The fields you select appear on the labels, cards, or envelopes in the order you select. Use the up and
down arrows to change the order of the fields.
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Available Fields. The Available Fields box contains all fields you can include on cards.

Fields to Include. The Fields to Include box contains all fields included on the cards. To move a field from the
Available Fields box to the Fields to Include box, select the field and click the single right arrow or
double-click the field. To move all the fields from the Available Fields box to the Fields to Include box, click
the double right arrow.

Note: Certain fields have additional selections associated with them. When you move these fields to the Fields
to Include box, the Field Options screen appears. For example, if you select Phone number, you can select
Business or Fax as the phone type to use.

Options. When you include a field with associated options, you can click Options to see more information about
the field. If a selected field does not have associated options, the Options button is disabled.

Filters Tab

You can use the Filters tab to include records based on selected criteria, such as vendors or vendor attributes. For
example, you may be printing new Rolodex cards for vendors but not all of them at one time. You can include
only those vendors whose names begin with A through H. For more information about filtering in The Financial
Edge, see the Program Basics Guide.

13 new Rolodex and Index Cards x|

File Edit View Favorites Tools Help
dadE o= 2- |

4 Attrbutes | 5 Format I

1 General' 2: Fields to Include : ;

&5 Open = Clear All Filters

Filters Include I Selected Filters I
Vendors all <Al vendors =
Vendor Attributes Al <Al Vendor Attributes >

Open. To access the Selected <Filter> screen so you can select specific filters, select a filter in the grid and click
Open.

Clear All Filters. To remove all selected filters from the cards, click Clear All Filters.

Note: A filter is a requirement records must meet to be included in a query, report, mailing, template, or other
grouping. For example, if you apply the Vendors filter when creating a mailing, only the vendors you select are
included in the mailing. For more information about filtering in The Financial Edge, see the Program Basics
Guide.

Filters. The Filters column lists all filters available for the cards. You cannot edit this column.

Include. In the Include column, select All or Selected. If you choose Selected, the Selected <Filter> screen opens
so you can designate specific filters.

Selected Filters. The filters you specify appear in the Selected Filters column.
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Attributes Tab

You can use the Attributes tab to add, delete, or update attributes for vendors when you print cards. For
example, you may want to print Rolodex cards for vendors who are also volunteers with your organization. You
can add the attribute to the vendor record when you print the cards.

13 New Rolodex and Index Cards x|

File Edit Wiew Favorites Tools Help

dadam o

ilE General' 2 Fields to Includel 3 Filters

- |

Actionl Attribute Type | Description ShortDescriptionI Date |Required| Comments |

Note: An attribute is a tool used to group information based on a common theme. With attributes defined, you
can filter information to your specifications. Records in The Financial Edge that can have attributes include
accounts, projects, transactions, actions, vendors, purchase orders, invoices, credit memos, and assets.

Action. In the Action column, you can add, delete, or update attributes on the records when you print cards.
Attribute Type. In the Attribute Type column, you can select an attribute type.
Description. In the Description column you can enter or select a description for the attribute type.

Short Description. In the Short Description column, a brief description of the attribute type appears when you
select a type in the Attribute Type column.

Date. In the Date column, select the date you add, delete, or update the attribute.
Required. If the attribute type you select is required, the program automatically marks the checkbox in the
Required column.

Note: Attribute types are established in Configuration. For more information about attributes, see the
Configuration Guide for Accounts Payable.

Comments. In the Comments column, you can enter additional information about the attribute type.

Format Tab

You can use the Format tab to designate the format of the cards. Settings on this tab determine the appearance
of the cards. You can sort the cards and adjust alignment of the printing on the cards. When you select a
formatting area from the list on the left, selections appear on the right.
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Detail. You can use Detail to make printing selections for the cards.

lQ Mew Rolodex and Index Cards [ x|
File Edit “iew Favortes Toolz Help
=l |

1 Genelall 2 Fields to Include| 3 Filtersl 4: Attributes  5: Format |

Sart

Farm Alignment Drnit punctuation fram rnailing
Print address in ALL CAPS

Include total number of cards

AT

To print no punctuation on the cards, mark the checkbox in the Omit punctuation from mailing row.
To print the vendor address in all capital letters, mark the checkbox in the Print address in ALL CAPS row.

To print the total number of cards processed in the run immediately after the last card, mark the checkbox in
the Include total number of cards row.

Sort. You can use Sort to select the order to print cards. When you select Sort, a grid displays the categories you
can sort for the cards.

13 Hew Rolodex and Index Cards x|
File Edit View Favorites Tools Help
Bacsas o= |
1 General' 2 Fields to Includel ab Filtersl 4 Attributes B Format I
Sort
Sort by I Order by Iﬂ
Vendor Mame Ascending

In the first row in the Sort by column, select the record type by which to sort the cards, such as vendor name
or ZIP Code.

In the Order by column, select Ascending to sort cards alphabetically or Descending to sort them in reverse
alphabetical order.
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Form Alignment. You can use Form Alignment to specify vertical and horizontal alignment of the cards when
you print.

IQ Hew Rolodex and Index Cards [ x|
File Edit “iew Favortes Toolz Help

e = el |

1 Genelall 2 Fields to Includel 3 Filtersl 4 Attibutes 5 Format |

Detail Form Alignment

Sort

B Form Alignment Wertical alignment: IDefauIt alignment ﬂ I urits = Dinch

Harizantal alignment; IDefauIt alignment j I units = Dinch

Mate: 1 unit equals 1,/100th of an inch or 0.254 millimeters,

Note: The maximum alignment adjustment you can enter is 99. This moves the margin .99 inch.

In the Vertical alighment field, you can adjust the top margin for printing. You can select Default alignment,
Move printed information up, or Move printed information down and enter how much to move the
information. For example, if you select Move printed information up and enter 2, the information prints .02
inch higher on the page.

In the Horizontal alignment field, you can adjust the left margin for printing. You can select Default alignment,
Move printed information left, or Move printed information right and enter how much to move the
information. For example, if you select Move printed information left and enter 2, the information prints .02
inch toward the left on the page.

Creating Cards

Using the Labels, Cards, and Envelopes mail task, you can print Rolodex and index cards with vendor information.
The Financial Edge is compatible with many standard card sizes; however, if the card size you use is not
compatible, you can export the information gathered by the mail task to another application compatible with the
card type you want to use. For more information about exporting in Mail, see the Mail Basics chapter.

» Creating cards
For the following example, we create index cards with vendor contact information.

1. From the Mail page in Accounts Payable, click Labels, Cards, and Envelopes or select the Labels, Cards,
and Envelopes navigation tab. The Labels, Cards, and Envelopes page appears.

2. Inthe list on the left, select Rolodex and Index Cards and click New on the action bar. The New Rolodex
and Index Cards screen opens on the General tab.

To print the vendor’s primary address, mark Primary address for vendor.

To print laser index cards, select “Avery 5388” in the Card type grid.

In the Card font and Font size fields, select “Times New Roman” and “10”.

In the Start printing in row and Column fields, select “1” because you are using a new sheet of cards.

o v kW
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7. To create a static query of the vendor records for which you are printing cards, mark Create an output
query of vendors.

& new Rolodex and Index Cards x|

File Edit Yiew Favorites Tools Help

Hadaw [« 2-

1: General |g: Fields to Includel 3 Fillelsl 4: Attributes | 5B Formatl

Create cards for: WV P
[~ Default invoice address:

[ Defaul purchaze order address:

Card type: Type I Size I Acrozs I Drawn I Description
= Averp® 5385 21804 2 4 Ratary Card |
Card fant: ITimes Mew Faman ﬂ

Font size: I m - I

Start printing in row: |1 illDJIumn: |1 ill

[~ Create an output query of vendors

< Back Mext » Cancel FErint Freview Layout

Note: The fields you select appear on the labels, cards, or envelopes in the order you select. Use the up and
down arrows to change the order of the fields.
8. Click Next or select the Fields to Include tab.
9. Select Vendor name, Vendor ID, Address, Contact name, and Phone number.
When you select Phone number, the Field Options screen appears. Select “Business”.

10. Click OK. You return to the Fields to Include tab and the fields you selected appear in the Fields to Include
box.

11. Click Next or select the Filters tab. Select the filters for records for which you want to print cards. For
example, you may want to print cards only for vendors with names beginning with A through C. For more
information about filtering in The Financial Edge, see the Program Basics Guide.

12. Click Next or select the Attributes tab.
13. To add an attribute to the vendor record when you print the cards, select “Add” in the Action column.

Note: Attributes are established in Configuration. For more information about defining attributes, see the
Configuration Guide for Accounts Payable.

14. In the Attribute Type column, select an attribute.
15. In the Description column, select a description of the attribute.



16. In the Date column, enter the date you add the attribute.

@ New Rolodex and Index Cards

Fil= Edit “iew Favortez Tool: Help

HRSRw 2.

1 General] 2 Fields to Include] 3 Filters  4: Attributes lﬁ: Format]
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]

Action | Attribute Type | Diezcription | Short Descriptionl Date |F|equired|
Add Solicit for Donations Yes

Carmments

. 1040972002 I

17. Click Next or select the Format tab.

18. In the list on the left, select Detail.
19.
number of cards.

u Mew Rolodex and Index Cards

Contact for capital ca..

To print the total number of cards processed in the run immediately after the last card, mark Include total

Eil= Edit Wiew Favortes Tools Help
H &= W T-
1: General] 2 Fields to Include] 3 Filters] 4: Aftributes  5: Format ]
Detail
=] Sort
Z] Fom Alignment Dt punctuation from mailing -
Print address in ALL CAPS ™
Include total number of cands =2

20. Inthe list on the left, select Sort. In the Sort by and Order by columns on the first row, select how to sort

the cards.

n Mew Rolodex and Index Cards
File  Edit “iew Favortes Tools

H LGS @

1 General] 2: Fields to Include] 3 Filters] 4: Attributes B Format l

Sort

Help
? =

=] Detail

=] Form Alignment Sort by

| Order by |

Wendor Mame

Agcending

Note: If you mark Create an output query of on the General tab, the Save Static Query screen appears so you

can name and save the query.

21.
screen for the cards appears.

Click Preview. A message appears telling you the program is processing the mailing, and the preview

22. Close the preview and return to the Format tab.

23.

Click the Save button on the action bar to save the cards. The Save Mailing as screen appears.
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Note: A parameter is any field, option, or filter that narrows information included in an import, mailing, report,
or global change. By specifying parameters, you define the output of the process. You can save parameter files
to use again.

24. In the Mailing name and Description fields, enter a name and description for the parameter file.

Save Mailing as

tailing name: IVendors

Deseription: [y endar cantact infarmatian

V¥ Others can n this mailing
[~ Others can modify this mailing

Egave | Caricel |

25. Click Save to save the cards. You return to the Format tab.

26. Close the screen. You return to the Labels, Cards, and Envelopes page, and the new cards appear in the
grid.

#h The Financial Edge
Ele Edit Yiew Go Favoites Tools Help

% Back  ® Eoryan I Community Services Inc, ™ = Accounts Payable ™

% Mail « Labels, Cards, and Envelopes

Shartcuts

[l Home: -
IF"T = Mew |Dgen |Qe\ele Mail
= [T P —— Faorms
Ervelopes Rolodex and Index Cards [Foms |
Label Tiuncation Report Labels,
Labels Mame | Description Diate Created | Created By | Others May Modify E:;‘i?a;;d
nd | Vendors Yel tact informat... 04410/2004  Supervisor
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Note: Visit our website at www.blackbaud.com for the latest documentation and information.

The Mail page is the central location for printing envelopes in The Financial Edge. On the navigation bar, click
Mail to access the Mail page. To create envelopes in:

¢ Accounts Payable or Accounts Receivable — click Labels, Cards, and Envelopes.

e Student Billing — click Labels and Envelopes.
Then you can create new envelopes, open saved envelopes, and delete envelopes.

Note: We offer the only checks, student bills, statements, invoices, purchase orders, tax forms, envelopes and
other forms that are 100% compatible with The Financial Edge and fully supported by our support team. These
quality forms are pre-printed in color with your organization’s logo and information. For details, call

866-4-BB-Formes, visit http://forms.blackbaud.com, or send an email with questions to forms@blackbaud.com.

When you select Envelopes in the list on the left of the page, a grid appears on the right displaying saved
envelopes. You can specify parameters for envelopes on the General, Fields to Include, Filters, Relationship
Filters, Attributes, Address, and Format.

Envelope Tabs

In Envelopes, you select parameters on tabs: General, Fields to Include, Filters, Relationship Filters, Attributes,
Address, and Format. To move among the tabs, click Next and Back at the bottom of the screen or select the tab.
On these tabs, you specify records, fields, and formatting options for the envelopes. Each tab helps you enter
information in an easy and logical manner.

General Tab

You can use the General tab to select parameter settings specific to envelopes.
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Create envelopes for. In this area of the General tab, you can mark a checkbox to select addresses to print on
envelopes.

In Accounts Payable — To print the primary address from the vendor record, mark Primary address for
vendor. To print default addresses from invoice and purchase order records, mark Default invoice address
and Default purchase order address.

In Accounts Receivable — To print the primary address from the client record, mark Primary address for
client. To print envelopes using the Bill to and Ship to addresses, mark these options.

In Student Billing — In the Create envelopes for field, select the record type to print envelopes for. You can
create envelopes for students, student relationships, individuals, individual relationships, organizations,
organization relationships, records, and record relationships.

Exclude deceased? In Student Billing, if you select a relationship in the Create envelopes for field, the
Exclude deceased? option appears. Mark this option to omit deceased relations from the run of envelopes.

Envelope type. In the Envelope type grid, you can select the type of envelope to use. The Envelope Type and
Size columns list available envelope types and dimensions. The Description column provides additional
details about each envelope type.

The Financial Edge is compatible with many standard envelope types; however, if the envelope size you use
is not available, you can export a data file with the information so you can print envelopes using another
application. For more information about exporting, see the Mail Basics chapter.

Envelope font. In the Envelope font field, select a text type to use on the envelopes.

Warning: The font type and size you select may impact the amount of information you can print on the
envelopes.

Font size. In the Font size field, select a size for the text on the envelopes.

Create an output query of [ ]. To create a query of the records which you print envelopes, mark Create an
output query of and select the record type.
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Fields to Include Tab

You can use the Fields to Include tab to select fields to appear on the envelopes processed by the mail task, for
example, address, contact name, and USPS barcode. The fields that appear depend on which program you are
using. You cannot add to the list of available fields.

& New Envelopes i x|
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Note: The fields you select appear on the labels, cards, or envelopes in the order you select. Use the up and
down arrows to change the order of the fields.

Available Fields. The Available Fields box contains all the fields you can include on envelopes. The fields
available depend on the program in which you are working.

Fields to Include. The Fields to Include box contains all fields included on the envelopes. To move a field from
the Available Fields box to the Fields to Include box, select the field and click the single right arrow or

double-click the field. To move all the fields from the Available Fields box to the Fields to Include box, click
the double right arrow.

Note: Certain fields have additional selections associated with them. When you move these fields to the Fields

to Include box, the Field Options screen appears. For example, if you select Phone number, you can select
Business or Fax as the phone type to use.

Options. When you include a field with associated options, you can click Options to see more information about
the field. If a field does not have associated options, the Options button is disabled.
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Filters Tab

You can use the Filters tab to select criteria that determines which records to include in the run of envelopes. The
items by which you can filter depend on the program you are using. For example, in Accounts Payable, you may
be preparing a mailing for vendors who are volunteers for your organization. You can select to include records
with the vendor attribute of Member/Volunteer on their records. For more information about filtering in

The Financial Edge, see the Program Basics Guide.

I3 New Envelopes x|
File Edit View Favorites Tools Help
FIEEEE |
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Tip: You can also double-click a filter in the grid to open the selection screen.

Open. To open a selection screen to designate specific filters for the report, select a filter in the grid and click
Open on the action bar.

Clear All Filters. To reset each filter to include all, you can click Clear All Filters.
Filters. The Filters column lists all the filters for the report. You cannot edit this column.

Include. By default, in the Include column, each filter is set to All. To open a selection screen to designate
specific filters for the report, choose Selected.

Selected Filters. Filters you specify on the selection screen appear in the Selected Filters column.
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Selected Filters Screen

From the Filters tab, you can open a selection screen for a filter in several ways: by double-clicking the filter in the
grid, selecting the filter in the grid and clicking Open on the action bar, or choosing Selected in the Include
column for the filter.

Selected Vendors x| I

Inchude: @ Al O Selected  ® Bange 9 Query | Erawious Filier  Mest Filter

Vendor Mame | Yendor ID |

ar. I Cancel |

Include. For each filter, you can select to include all or select specific filters. Depending on the filter, you may
also be able to filter by a range or query.

All. If you mark Include: All, you cannot designate specific filters.

Selected or Range. If you mark Include: Selected or Range, a grid appears in which you can specify filters. In a
field, you can click the binoculars to search for information.

Query. If you mark Include: Query, the Query name field appears for you to enter the name of the query by
which to filter the report. In the field, you can click the binoculars to search for the query name.

To create a new query, click the binoculars. Then click Add a New Query on the Open Query screen. For more
information about creating queries, see the Query Guide.

Previous Filter. To view or edit the previous filter without returning to the Filters tab, click Previous Filter.
Next Filter. To view or edit the next filter without returning to the Filters tab, click Next Filter.
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Attributes Tab

You can use the Attributes tab to add, delete, or update vendor or client attributes on the records for which
envelopes print. For example, in Accounts Payable you may want to print envelopes for vendors who are also
volunteers for your organization. You can add the attribute to the vendor record when you print the envelopes.

I3 New Envelopes x|
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Action. In the Action column, you can add, delete, or update attributes on the client or vendor records when you
print envelopes.

Note: Attribute types are established in Configuration. For more information about defining attributes, see the
Configuration Guide for that program.

Attribute Type. In the Attribute Type column, you can select an attribute type.
Description. In the Description column you can enter or select a description for the attribute type.

Short Description. In the Short Description column, a brief description of the attribute type appears when you
select a type in the Attribute Type column.

Date. In the Date column, select the date you add, delete, or update the attribute.

Required. If the attribute type you select is required, the program automatically marks the checkbox in the
Required column.

Comments. In the Comments column, you can enter additional information about the attribute type.

Address Tab

In Student Billing, use the Address tab to specify which addresses to use for envelopes. The program compares
the parameters you define on this tab with address information entered on the Addresses tab of records to
identify the appropriate address to use.

On the Address tab, you select a validation date and then define the order in which the program evaluates
address types. The program first checks the validation date, then seasonal addresses, other address types (in the
order you determine), and attributes. The first address found on the record that meets the defined parameters is
used on the envelope. You can also specify what to do if no valid address is found.
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If you selected Organizations in the Create envelopes for field on the General tab, the Mail to field appears. In
this field, select the organization address to use.
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Note: Any address with No mail selected in the Send [ ] to this address field on the Address Attributes tab is
automatically excluded as a possible address.

Step 1. In the Validate addresses as of [ ] field, select a date to determine which address to use. Any address that
is valid on this date is considered for use on the envelope. Any addresses that are not valid on this date are
automatically excluded from consideration.

Step 2. Determine whether to include seasonal addresses as possible addresses. If you mark Consider seasonal
addresses, the program uses the first valid seasonal address found on the student/relationship record and
does not consider any other addresses.

If the seasonal address has the Send no mail attribute, the seasonal address is excluded automatically as a
possible address. If a valid seasonal address is not found, the program considers the address types selected in
Step 3.

Step 3. In the If no seasonal addresses are found, consider these addresses frame, select which address types to
use if no valid seasonal addresses exist.

In the Addresses box, select an address type and click the right arrow to move it into the Addresses to
consider, in order of importance box. The first address type in the list that matches the validation date is used
on the envelope. You can change the order addresses are considered by selecting an address type and clicking
the up and down arrows next to the list.

If a valid address is not found from these address types, the program considers the attributes selected in
Step 4.

Step 4. In the grid, you can select address attribute types to consider. For example, you have a “Holiday
greetings” attribute you use to flag addresses to use for holiday cards. When you select Include in the Action
column and Holiday greetings in the Attribute column of the grid, the program automatically uses any valid
addresses assigned this attribute.
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Step 5. In the If no address is found field, select what to do if a valid address is not found. You can select Print

with no address, Remove record from run, or Print specific address. If you select to print a specific address,
the Use field appears so you can select the address type to use when a record does not have an address of the
types you added to the Addresses to consider, in order of importance list.

If you selected Organizations in the Create envelopes for field on the General tab, the If no contact is found

field appears. You can select Print organization name with no address, Remove record from run, or Print
specific organization address.

Format Tab

You can use the Format tab to designate the format of the envelopes. Settings on this tab determine the

appearance of the envelopes. You can sort the envelopes and make selections for the return address. When you

select a formatting area from the list on the left, selections appear on the right.

Detail. You can use Detail to make printing selections for the envelopes.
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To print no punctuation on the envelopes, mark the checkbox in the Omit punctuation from mailing row.
To print the vendor address in all capital letters, mark the checkbox in the Print address in ALL CAPS row.

Include message on the same line as [ ] — To print a message before a selected field on the same line, select
a field in this row. The available fields are those you selected on the Fields to Include tab. You define the
message to print by selecting the User-defined message field on the Fields to Include tab and entering the
message on the Field Options screen that appears.

Combine envelopes for each spouse pair — Mark this checkbox to print one envelope for each married
couple. This option appears only if you selected a relationship record type in the Create envelopes for field on
the General tab.

For example, when printing envelopes for student relationships, if you mark this option, one envelope prints
for both the mother and father of a student. The address and name used for the spousal pair is the first of the
spouses listed on the record’s Relationship tab. If this option is unmarked, two envelopes print— one for each
parent.

Combine envelopes for <record type> with the same related record — Mark this checkbox to print one
envelope for each relationship. This option appears only if you selected a relationship record type in the
Create envelopes for field on the General tab.

For example, when two students have the same father, if this option is marked, only one envelope prints for
the father. If the option is unmarked, two envelopes print for the father — one for each student. If you mark
this option and also mark Combine envelopes for each spouse pair, one envelope prints for the mother and
father of the two students.

If you mark Combine envelopes for <record type> with the same related record and include the <Record
type> name field on the Fields to Include tab, the name for each record related to the relation prints as a
separate line on the envelope.



296 CHAPTER

Sort. You can use Sort to select the order to print envelopes. When you select Sort, a grid displays the categories
you can sort for the envelopes.

I3 new Envelopes

X
File Edit Wew Favorites Tools Help

daIa o= 2-

1 Generall 2: Fields to Includel &k Filtersl 4 Attibutes  5: Format |

Sort

Sort by I

Order by Iﬂ
Ascending

Vendor Mame

In the first row in the Sort by column, select the item by which to sort the envelopes.

In the Order by column, select Ascending to sort envelopes alphabetically or numerically. Select Descending
to sort them in reverse alphabetical or numeric order.

Return Address. You can use Return Address to make selections for the return address on the envelopes.
1@ New Envelopes
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To print a return address on the envelopes, mark Print return address on envelope. Your organization’s
address, as recorded in Configuration, appears in the box. You can edit the address for the mailing.

In the Font field, select a text type to use on the envelopes.

Warning: The font type and size you select may impact the amount of information you can print on the
envelopes.

In the Font size field, select a size for the text on the envelopes.
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Name Formats. In Student Billing, you can use Name Formats to format how names appear on

envelopes you can format how names appear for organizations, individuals, students, and relationships. In the
tree view on the left, you can select the record type to format.
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If you selected Organization or Organization Relationships in the Create envelopes for field on the General
tab, in the Organization frame, mark Organization ID, CFDA #, and Contact name for these items to appear
after the organization name.

For Students or Individuals, in the Select addressee/salutation from [ ] field, select Record or Configuration.

If you select Record, in the Use field, select the full name, primary addressee, or primary salutation as defined
on the record.

If you select Configuration, in the Use field, select from one of the formats defined in Configuration.

In the If not present...Select addressee/salutation from field, you can select a second name format for
situations where the first selection is not present on records. For example, if you select to use the Primary
salutation, and you have students without a defined Primary salutation on the Addressees/Salutations tab,
the second name format is used. If you select <Full name> in the Use field, this field is disabled.

Creating Envelopes

Using the Labels, Cards, and Envelopes mail task, you can create envelopes addressed to vendors or clients, or for
recipients to return replies to you. The Financial Edge is compatible with many standard envelope sizes;
however, if the envelope size you use is not compatible, you can export the information gathered by the mail task
to another application compatible with the envelope type you want to use. For more information about exporting
in Mail, see the Mail Basics chapter.

»

Creating envelopes

For the following example, we create envelopes addressed to your organization’s local vendors. You will sort
the envelopes by ZIP Code. While this procedure demonstrates how to create envelopes in Accounts
Payable, the process is essentially the same for Accounts Receivable, or Student Billing.

1. From the Mail page in Accounts Payable, click Labels, Cards, and Envelopes or select the Labels, Cards,
and Envelopes navigation tab. The Labels, Cards, and Envelopes page appears.

2. Inthe list on the left, select Envelopes and click New on the action bar. The New Envelopes screen opens
on the General tab.

3. Inthe Create envelopes for area, mark Primary address for vendor.
In the Envelope type grid, select “Size 10”, a business envelope you are using.

5. Inthe Envelope font and Font size fields, select “Times New Roman” and “12”, the font and size to use for
the text on the envelopes.
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6. To create a static query of the vendor records for which you are printing envelopes, mark Create an
output query of vendors.
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Note: The fields you select appear on the labels, cards, or envelopes in the order you select. Use the up and
down arrows to change the order of the fields.

7. Click Next or select the Fields to Include tab.

8. Select Vendor ID, Address, and USPS bar code as fields to print on the envelopes.

9. If afield has associated options, you can click Options for additional selections related to the field. If a
field has no associated options, the Options button is disabled.
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11.
12.
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Click Next or select the Filters tab. Select the filters for records for which you want to print envelopes. For
more information about filtering in The Financial Edge, see the Program Basics Guide.

Click Next or select the Attributes tab.

In the Action column, select “Add”. This adds the attribute to the vendor record.

Note: Attributes are established in Configuration. For more information about creating attributes, see the
Configuration Guide for that program.

13.
14.
15.
16.
17.

18.

19.

20.
21.

In the Attribute Type column, select an attribute.

In the Description column, enter a description of the attribute.
In the Date column, enter the date you add the attribute.

Click Next or select the Format tab.

In the list on the left, select Detail. Leave Omit punctuation from mailing and Print address in ALL CAPS
unmarked so the addresses print with punctuation marks and in a standard format.

In the list on the left, select Sort. In the Sort by and Order by columns on the first row, select “ZIP Code”
and “Ascending” to sort the envelopes numerically.
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On the left, select Return Address. Mark Print return address on envelope so that your organization’s
return address prints on the envelopes.

In the Font field, select “Times New Roman”
In the Font size field, select “8”.
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22. If you mark Create an output query of vendors on the General tab, the Save Static Query screen appears
so you can name and save the query.

23. Click Preview. A message appears telling you the program is processing the mailing, and the preview
screen for the envelopes appears.

24. Close the preview and return to the Format tab.
25. Click the Save button on the action bar to save the envelopes. The Save Mailing as screen appears.

Note: A parameter is any field, option, or filter that narrows information included in an import, mailing, report,
or global change. By specifying parameters, you define the output of the process. You can save parameter files
to use again.

26. Inthe Mailing name and Description fields, enter a name and description for the parameter file.

Save Mailing as E

Mailing narme: |Vendors

Deseription: v endor contact information

¥ Others can pun this mailing
™ Others can modify this mailing

Hsave | Caricel |

27. Click Save to save the envelopes. You return to the Format tab.

28. Close the envelopes screen. You return to the Labels, Cards, and Envelopes page, and the parameter file
for the envelopes appears in the grid.
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Note: We recommend you read the documentation for The Financial Edge thoroughly. Descriptions
presented here provides you with basic information about forms in Mail. Hands-on experience is the best way
to learn, so we encourage you to try various options with the sample database.
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